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About This Guide
Installations of SUSE Linux Enterprise Server are possible in many different ways. It
is impossible to cover all combinations of boot, or installation server, automated instal-
lations or deploying images. This manual should help with selecting the appropriate
method of deployment for your installation.

Part I, “Architecture Specific Installation Considerations” (page 5)
The standard deployment instructions differ depending on the architecture used.
For differences and requirements regarding the architecture, see this part.

Part II, “Manual Deployment” (page 77)
Most tasks that are needed during installations are described here. This includes
the manual setup of your computer as well as additional software and remote instal-
lations.

Part III, “Imaging and Creating Products” (page 281)
Mass installations often require the preparation of images or products furnished
with the features that are needed in this special case. Several options are described
that allow the administrator to prepare these deployment methods.

Part IV, “Automated Installations” (page 311)
To do unattended installations, either use the installation with AutoYaST or prepare
an image with kiwi or firstboot. This part describes methods to deploy these instal-
lations with a minimum of user interaction.

Many chapters in this manual contain links to additional documentation resources, in-
cluding additional documentation that is available on the system as well as documenta-
tion available on the Internet.

For an overview of the documentation available for your product and the latest docu-
mentation updates, refer to http://www.suse.com/documentation or to the
following section.

1 Available Documentation
We provide HTML and PDF versions of our books in different languages. The following
manuals for users and administrators are available on this product:

http://www.suse.com/documentation


Deployment Guide (page 1)
Shows how to install single or multiple systems and how to exploit the product
inherent capabilities for a deployment infrastructure. Choose from various approach-
es, ranging from a local installation or a network installation server to a mass de-
ployment using a remote-controlled, highly-customized, and automated installation
technique.

Administration Guide (↑Administration Guide)
Covers system administration tasks like maintaining, monitoring and customizing
an initially installed system.

Security Guide (↑Security Guide)
Introduces basic concepts of system security, covering both local and network se-
curity aspects. Shows how to make use of the product inherent security software
like AppArmor (which lets you specify per program which files the program may
read, write, and execute) or the auditing system that reliably collects information
about any security-relevant events.

System Analysis and Tuning Guide (↑System Analysis and Tuning Guide)
An administrator's guide for problem detection, resolution and optimization. Find
how to inspect and optimize your system by means of monitoring tools and how
to efficiently manage resources. Also contains an overview of common problems
and solutions and of additional help and documentation resources.

Virtualization with Xen (↑Virtualization with Xen)
Offers an introduction to virtualization technology of your product. It features an
overview of the various fields of application and installation types of each of the
platforms supported by SUSE Linux Enterprise Server as well as a short description
of the installation procedure.

Virtualization with KVM
Offers an introduction to setting up andmanaging virtualization with KVM (Kernel-
based Virtual Machine) on SUSE Linux Enterprise Server. Learn how to manage
KVM with libvirt or QEMU. The guide also contains detailed information about
requirements, limitations, and support status.

Storage Administration Guide
Provides information about how to manage storage devices on a SUSE Linux En-
terprise Server.

In addition to the comprehensive manuals, several quick start guides are available:

x Deployment Guide



Installation Quick Start (↑Installation Quick Start)
Lists the system requirements and guides you step-by-step through the installation
of SUSE Linux Enterprise Server from DVD, or from an ISO image.

Linux Audit Quick Start
Gives a short overview how to enable and configure the auditing system and how
to execute key tasks such as setting up audit rules, generating reports, and analyzing
the log files.

AppArmor Quick Start
Helps you understand the main concepts behind AppArmor®.

Find HTML versions of most product manuals in your installed system under /usr/
share/doc/manual or in the help centers of your desktop. Find the latest documen-
tation updates at http://www.suse.com/documentation where you can
download PDF or HTML versions of the manuals for your product.

2 Feedback
Several feedback channels are available:

Bugs and Enhancement Requests
For services and support options available for your product, refer to http://www
.novell.com/services/.

To report bugs for a product component, log into the Novell Customer Center from
support.novell.com/ and selectMy Support > Service Request.

User Comments
We want to hear your comments about and suggestions for this manual and the
other documentation included with this product. Use the User Comments feature
at the bottom of each page in the online documentation or go to http://www
.suse.com/documentation/feedback.html and enter your comments
there.

Mail
For feedback on the documentation of this product, you can also send a mail to
doc-team@suse.de.Make sure to include the document title, the product version
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and the publication date of the documentation. To report errors or suggest enhance-
ments, provide a concise description of the problem and refer to the respective
section number and page (or URL).

3 Documentation Conventions
The following typographical conventions are used in this manual:

• /etc/passwd: directory names and filenames

• placeholder: replace placeholder with the actual value

• PATH: the environment variable PATH

• ls, --help: commands, options, and parameters

• user: users or groups

• Alt, Alt + F1: a key to press or a key combination; keys are shown in uppercase as
on a keyboard

• File, File > Save As: menu items, buttons

• ►amd64 em64t ipf: This paragraph is only relevant for the architectures amd64,
em64t, and ipf. The arrows mark the beginning and the end of the text block. ◄

►ipseries zseries: This paragraph is only relevant for the architectures System
z and ipseries. The arrows mark the beginning and the end of the text block. ◄

• Dancing Penguins (Chapter Penguins, ↑Another Manual): This is a reference to a
chapter in another manual.
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1Planning for SUSE Linux
Enterprise Server
The implementation of an operating system either in an existing IT environment or as
a completely new rollout must be carefully prepared. SUSE Linux Enterprise Server
11 SP2 provides a variety of new features. It is impossible to describe all the new features
here. The following is just a list of major enhancements that might be of interest.

Xen 4.0 Virtualization
Runs many virtual machines on a single server, each with its own instance of an
operating system. For more information, seeVirtualization with Xen (↑Virtualization
with Xen).

YaST
Several new configuration options have been developed for YaST. These are nor-
mally described in the chapters about the technology involved.

SPident
The management utility SPident gives an overview of the installed software base
and clarifies the current service pack level of the system.

Directory Services
Several LDAP-compliant directory services are available:

• Microsoft Active Directory

• OpenLDAP

Planning for SUSE Linux Enterprise Server 1



AppArmor
Harden your System with the AppArmor technology. This service is described in
depth in Part “Confining Privileges with AppArmor” (↑Security Guide).

AIDE
This is an intrusion detection system that can be setup to detect unauthorized changes
to the system.

iSCSI
iSCSI provides an easy and reasonably inexpensive solution for connecting Linux
computers to central storage systems. Find more information about iSCSI in SLES
11 SP2: Storage Administration Guide (↑SLES 11 SP2: Storage Administration
Guide).

Network File System v4
Starting with version 10, SUSE Linux Enterprise Server supports NFS also in ver-
sion 4. This gives you performance improvements, strong security, and a “stateful”
protocol.

Oracle Cluster File System 2
OCFS2 is a general-purpose journaling file system that is fully integrated in the
Linux 2.6 kernel and later. Find an overview of OCFS2 in the High Availability
Guide .

Linux Kernel Crash Dump
Debugging kernel-related problems is now much easier when using Kexec and
Kdump. This technology is available on x86, AMD64, Intel 64, and POWER
platforms.

1.1 Considerations for Deployment of
a SUSE Linux Enterprise Server

At the beginning of the planning process, you should try to define the project goals and
needed features. This must always be done individually for each project, but the questions
to answer should include the following:

• How many installations should be done? Depending on this, the best deployment
methods differ. See also Chapter 5, Deployment Strategies (page 79).
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• Will the system run as physical host or as a virtual machine?

• Will the system be in a hostile environment? Have a look at Chapter 1, Security and
Confidentiality (↑Security Guide) to get an overview of consequences.

• How will you get regular updates? All patches are provided online for registered
users. Find the registration and patch support database at http://download
.novell.com/patch/finder/.

• Do you need help for your local installation? Novell provides training, support, and
consulting for all topics pertaining to SUSE Linux Enterprise Server. Find more in-
formation about this at http://www.novell.com/products/server/.

• Do you need third-party products? Make sure that the required product is also sup-
ported on the desired platform. Novell can provide help to support software on dif-
ferent platforms when needed.

1.2 Deployment of SUSE Linux
Enterprise Server

To make sure that your system will run flawlessly, always try to use certified hardware.
The hardware certification process is an ongoing process and the database of certified
hardware is updated regularly. Find the search form for certified hardware at http://
developer.novell.com/yessearch/Search.jsp.

Depending on the number of desired installations, it is beneficial to use installation
servers or even completely automatic installations. Have a look at Chapter 5,Deployment
Strategies (page 79) for more information.When using Xen virtualization technologies,
network root file systems or network storage solutions like iSCSI should be considered.

SUSE Linux Enterprise Server provides you with a broad variety of services. Find an
overview of the documentation in this book in About This Guide (↑Administration
Guide). Most of the needed configurations can be made with YaST, the SUSE configu-
ration utility. In addition, manymanual configurations are described in the corresponding
chapters.

In addition to the plain software installation, you should consider training the end users
of the systems as well as help desk staff.

Planning for SUSE Linux Enterprise Server 3
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1.3 Running SUSE Linux Enterprise
Server

The SUSE Linux Enterprise Server operating system is a well-tested and stable system.
Unfortunately, this does not prevent hardware failures or other causes for downtime or
data loss. For any serious computing task where data loss could occur, a regular backup
should be done.

For optimal security and data safety, you should make regular updates of all the operated
machines. If you have a mission critical server, you should run a second identical (pre-
production) machine where you can apply all changes for testing purposes before doing
so in production. This also gives you the possibility of switching machines in the case
of hardware failure.
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2Installation on x86, AMD64,
Intel 64, and Itanium
This chapter describes the steps necessary to prepare for the installation of SUSE Linux
Enterprise Server on x86, AMD64, Intel 64, and Itanium computers. It introduces the
steps required to prepare for various installation methods. The list of hardware require-
ments provides an overview of supported systems supported by SUSELinux Enterprise
Server. Find information about available installation methods and several common
known problems. Also learn how to control the installation, provide installation media,
and boot with regular methods.

2.1 Required Background
To keep the scope of these guidelines manageable, certain technical assumptions have
been made:

• You have some computer experience and are familiar with common technical terms.

• You are familiar with the documentation for your system and the network on which
it runs.

• You have a basic understanding of Linux systems.

For an overview of the documentation available for your product and the latest docu-
mentation updates, refer to http://www.suse.com/documentation.

Installation on x86, AMD64, Intel 64, and Itanium 7
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2.2 System Requirements for
Operating Linux

The SUSE®Linux Enterprise Server operating system can be deployed on a wide range
of hardware. It is impossible to list all the different combinations of hardware SUSE
Linux Enterprise Server supports. However, to provide you with a guide to help you
during the planning phase, the minimum requirements are presented here.

If you want to be sure that a given computer configuration will work, find out which
computers have been certified by SUSE. Find a list of these computers at http://
developer.novell.com/yessearch/Search.jsp.

2.2.1 Hardware for x86
Computers based on x86 constitute a cost-effective way of building high-performance
systems. The preconditions for operating SUSE Linux Enterprise Server on this platform
are as follows:

CPU
The number of CPUs supported depends on the kernel used. Specifically, these are
as follows:

Table 2.1 CPUs Supported by the Kernel

Maximum Number
of CPUs

Oldest CPU TypeKernel

32PentiumPro, Athlonkernel-default

128Pentium II, Athlon XPkernel-pae

Memory Requirements
A minimum of 512 MB is required. The recommended memory is 1 GB. For a
multiprocessor system, 256 MB per processor is required. Systems with less than
1 GB main memory need additional swap space that extends the virtual memory
to 1 GB.

8 Deployment Guide
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Hard Disk Requirements
The disk requirements depend largely on the installation. Commonly, you need
more space than the installation software itself needs to have a system that works
properly. Minimal requirements for different selections are:

Hard Disk RequirementsSystem

1.2 GBMinimal X Window System

3.2 GBGNOME Desktop

2.7 GBKDE Desktop

10 GBAll patterns

Boot Methods
The computer can be booted for installation from DVD, USB hard drive, floppy,
or the network. A special boot server is required to boot over the network. This
boot server can be configured with SUSE Linux Enterprise Server. To use USB
hard drives, the BIOS or firmware must support booting fromUSB devices. Create
a bootable USB hard drive with mkbootdisk, which is found on the first instal-
lation DVD in the directory /boot/i386/ or /boot/x86_64. For more infor-
mation, read the documentation below the /boot directory.

2.2.2 Hardware for Itanium
The Itanium architecture is 64-bit and allows the operation of large servers.

CPU
II (older ItaniumCPUs are no longer supported). Dual core CPUs and hyperthread-
ing are also supported.

Maximum Number of CPUs
At most, 4096 CPUs are supported. For the calculation of the CPU count, a dual-
core CPU counts as two CPUs and a hyperthreaded CPU with two siblings also
counts as two CPUs. 1024 CPUs could mean 512 dual cores, 512 single cores with
hyperthreading, or 256 dual cores with hyperthreading.

Installation on x86, AMD64, Intel 64, and Itanium 9



Memory
A minimum of 1GB RAM per CPU socket is recommended.

Hard Disk Requirements
The disk requirements depend largely on the installation selected. Commonly, you
need more space than the installed software itself needs to have a system that works
properly. Minimal requirements for different selections are:

Hard Disk RequirementsSystem

4 GBMinimal System

10 GBRecommended

Boot Methods
Options for booting the computer depend on the available hardware. All boot
methods available to the machine should work. A special boot server is required
to use PXE boot over the network. This may also be set up with SUSE Linux En-
terprise Server.

2.2.3 Hardware for AMD64 and Intel 64
The AMD64 and Intel 64 architectures support the simple migration of x86 software
to 64 bits. Like the x86 architecture, they constitute a value-for-money alternative.

CPU
All CPUs available on the market to date are supported. This includes dual-core
CPUs.

Maximum Number of CPUs
The maximum number of CPUs supported by AMD64 and Intel 64 is 128.

Memory Requirements
A minimum of 512MB of memory is required. Requirements depend on the appli-
cation. However, the minimum recommended is 1024 MB or 512 MB per CPU on
multiprocessor computers. The theoretical upper limit on the amount of memory
supported by the kernel is 512 GB.
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Hard Disk Requirements
The disk requirements depend largely on the installation selected. The required
space for this architecture is similar to x86 but you should allocate some space for
compatibility libraries. Minimum requirements for different selections are:

Hard Disk RequirementsSystem

1.4 GBMinimal X Window System

3.5 GBGNOME Desktop

3 GBKDE Desktop

8.5 GBAll patterns

Boot Methods
The computer can be booted from a CD or a network. A special boot server is re-
quired to boot over the network. This can be set up with SUSE Linux Enterprise
Server.

2.3 Installation Considerations
This section encompasses many factors that need to be considered before installing
SUSE Linux Enterprise Server on x86, AMD64, Intel 64, and Itanium hardware.

2.3.1 Installation Type
SUSE Linux Enterprise Server is normally installed as an independent operating system.
With the introduction of Xen, it is also possible to run multiple instances of SUSE
Linux Enterprise Server on the same hardware. However, the controlling Domain-0
installation for Xen is performed like a typical installationwith some additional packages.
The installation of Xen guests is described in Chapter 3, Setting Up Virtual Machines
(↑Virtualization with Xen).
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2.3.2 Boot Methods
Depending on the hardware used, the following boot methods are available for the first
boot procedure (prior to the installation of SUSE Linux Enterprise Server).

Table 2.2 Boot Options

UseBoot Option

The simplest booting method. The system requires a locally-
available CD-ROM or DVD-ROM drive for this.

CD or DVD
drive

Find the images required for creating boot disks on the first
CD or DVD in the /boot directory. See also the README

Floppy or USB
disks

in the same directory. Booting from a USB memory stick is
only possible if the BIOS of the machine supports this
method.

Must be supported by the BIOS or by the firmware of the
system used. This option requires a boot server in the network.

PXE or bootp

This task can be handled by a separate SUSELinux Enterprise
Server.

SUSE Linux Enterprise Server can also be booted from hard
disk. For this, copy the kernel (linux) and the installation

Hard disk

system (initrd) from the /boot/loader directory of
the first CD or DVD onto the hard disk and add an appropriate
entry to the boot loader.

2.3.3 Installation Source
When installing SUSE Linux Enterprise Server, the actual installation data must be
available in the network, on a hard disk partition, or on a local DVD. To install from
the network, you need an installation server. To make the installation data available,
set up any computer in a Unix or Linux environment as an NFS, HTTP, SMB, or FTP
server. To make the installation data available from a Windows computer, release the
data with SMB.
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The installation source is particularly easy to select if you configure an SLP server in
the local network. For more information, see Section 14.2, “Setting Up the Server
Holding the Installation Sources” (page 223).

2.3.4 Installation Target
Most installations are to a local hard disk. Therefore, it is necessary for the hard disk
controllers to be available to the installation system. If a special controller (like a RAID
controller) needs an extra kernel module, provide a kernel module update disk to the
installation system.

Other installation targets may be various types of block devices that provide sufficient
disk space and speed to run an operating system. This includes network block devices
like iSCSI or SAN. It is also possible to install on network file systems that offer the
standard Unix permissions. However, it may be problematic to boot these, because they
must be supported by the initramfs before the actual system can start. Such instal-
lations are useful if there is a need to start the same system in different locations or if
you intend to use Xen features like domain migration.

2.3.5 Different Installation Methods
SUSE Linux Enterprise Server offers several different methods for controlling installa-
tion:

• Installation on the console

• Installation via serial console

• Installation with AutoYaST

• Installation with KIWI images

• Installation via SSH

• Installation with VNC

By default, the graphical console is used. If you have a large number of similar computers
to install, it is advisable to create an AutoYaST configuration file or a KIWI preload
image and make this available to the installation process. See also the documentation
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for autoyast2 in Chapter 21, Automated Installation (page 313) and KIWI in Chap-
ter 17, KIWI (page 283).

2.4 Boot and Installation Media
When installing the system, the media for booting and for installing the system may be
different. All combinations of supported media for booting and installing may be used.

2.4.1 Boot Media
Booting a computer depends on the capabilities of the hardware used and the availabil-
ity of media for the respective boot option.

Booting from DVD
This is the most common possibility of booting a system. It is straightforward for
most computer users, but requires a lot of interaction for every installation process.

Booting from a USB Hard Drive or Floppy Disk
Depending on the hardware used, it is possible to boot from a USB hard drive or
a floppy disk. The respective media must be created with the utility mkbootdisk,
which can be found together with its documentation on the first CD or DVD in the
directory /boot/<architecture>.

Booting from the Network
You can only boot a computer directly from the network if this is supported by the
computer's firmware or BIOS. This booting method requires a boot server that
provides the needed boot images over the network. The exact protocol depends on
your hardware. Commonly you need several services, such as tftp and dhcp or
pxeboot. If you need a boot server, also read Section 14.1.3, “Remote Installation
via VNC—PXE Boot and Wake on LAN” (page 218).

2.4.2 Installation Media
The installation media contain all the necessary packages and meta information that is
necessary to install a SUSE Linux Enterprise Server. These must be available to the
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installation system after booting for installation. Several possibilities for providing the
installation media to the system are available with SUSE Linux Enterprise Server.

Installation from DVD
All necessary data is delivered on the boot media. Depending on the selected instal-
lation, a network connection or add on media may be necessary.

Networked Installation
If you plan to install several systems, providing the installation media over the
network makes things a lot easier. It is possible to install from many common
protocols, such as NFS, HTTP, FTP, or SMB. For more information on how to run
such an installation, refer to Chapter 14, Remote Installation (page 215).

2.5 Installation Procedure
This section offers an overview of the steps required for the complete installation of
SUSE® Linux Enterprise Server in the required mode. Part II, “Manual Deploy-
ment” (page 77) contains a full description of how to install and configure the system
with YaST.

2.5.1 Booting from a Local Interchangeable
Drive

CD-ROM and floppy drives and USB memory sticks can be used for installation pur-
poses. Adjust your computer to your needs:

1. Make sure that the drive is entered as a bootable drive in the BIOS.

2. Insert the boot medium in the drive and start the boot procedure.

3. The boot menu of the CD, DVD, floppy, or USB disk allows transferring different
parameters to the installation system. See also Section 14.4.2, “Using Custom Boot
Options” (page 244). If the installation should be performed over the network, specify
the installation source here.

4. If unexpected problems arise during installation, use safe settings to boot.
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2.5.2 Installing over the Network
An installation server is required to perform the installation by using a network source.
The procedure for installing this server is outlined in Section 14.2, “Setting Up the
Server Holding the Installation Sources” (page 223).

If you have an SLP server, select SLP as the installation source in the first boot screen.
During the boot procedure, select which of the available installation sources to use.

If the DVD is available on the network, use it as an installation source. In this case,
specify the parameter install=<URL>with suitable values at the boot prompt. Find
a more detailed description of this parameter in Section 14.4.2, “Using Custom Boot
Options” (page 244).

2.6 Controlling the Installation
Control the installation in one of several ways. The method most frequently used is to
install SUSE® Linux Enterprise Server from the computer console. Other options are
available for different situations. Find more information about the available installation
methods in Chapter 5, Deployment Strategies (page 79).

2.6.1 Installation on the Computer Console
The simplest way to install SUSE Linux Enterprise Server is using the computer console.
With this method, a graphical installation program guides you through the installation.
This installation method is discussed in detail in Chapter 6, Installation with
YaST (page 89).

You can still perform the installation on the console without a working graphics mode.
The text-based installation program offers the same functionality as the graphical version.
Find some hints about navigation in this mode in Section “Navigation in Modules”
(Chapter 3, YaST in Text Mode, ↑Administration Guide).
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2.6.2 Installation Using a Serial Console
For this installation method, you need a second computer that is connected by a null
modem cable to the computer on which to install SUSE Linux Enterprise Server. De-
pending on the hardware, even the firmware or BIOS of the computer may already be
accessible to the serial console. If this is possible, you can carry out the entire installation
using this method. To activate the serial console installation, additionally specify the
parameter console=ttyS0 at the boot prompt after the boot process has completed
and before the installation system starts.

On most computers, there are two serial interfaces, ttyS0 and ttyS1. For the installation,
you need a terminal program like minicom or screen. To initiate the serial connection,
launch the screen program in a local console by entering the following command:

screen /dev/ttyS0 9600

This means that screen listens to the first serial port with a baud rate of 9600. From this
point on, the installation proceeds similarly to the text-based installation over this ter-
minal.

2.6.3 Installation with SSH
If you do not have direct access to the computer hardware and, for example, the instal-
lation should be launched from a management console, control the entire installation
process over the network. To do this, enter the parameters UseSSH=1 and
SSHPassword=<secret> at the boot prompt. An SSH daemon is then launched in
the system and you can log in to the system as user root with the password “secret”.
To connect, use the command ssh -X root@<ipaddr>.

If you do not have a DHCP server available in your local network, manually assign an
IP address to the installation system. Do this by entering the option
HostIP=<ipaddr> at the boot prompt.

As soon as you are logged in to the installation system, launch the actual installation
with the command yast for a text-based installation or yast2 to proceed with the
graphical installation. This then guides you through the installation. This procedure is
described in detail in Section 14.1.5, “Simple Remote Installation via SSH—Dynamic
Network Configuration” (page 221).
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2.6.4 Installation over VNC
If you do not have direct access to the system, but want a graphical installation, install
SUSE Linux Enterprise Server over VNC. This method is described in detail in Sec-
tion 14.5.1, “VNC Installation” (page 247).

As suitable VNC clients are also available for other operating systems, such asMicrosoft
Windows and MacOS, the installation can also be controlled from computers running
those operating systems.

2.6.5 Installation with AutoYaST
If you need to install SUSE Linux Enterprise Server on a number of computers with
similar hardware, it is recommended you perform the installations with the aid of
AutoYaST. In this case, start by installing one SUSE Linux Enterprise Server and use
this to create the necessary AutoYaST configuration files.

AutoYaST is extensively documented in Chapter 21, Automated Installation (page 313).

2.7 Dealing with Boot and Installation
Problems

Prior to delivery, SUSE® Linux Enterprise Server is subjected to an extensive test
program. Despite this, problems occasionally occur during boot or installation.

2.7.1 Problems Booting
Boot problems may prevent the YaST installer from starting on your system. Another
symptom is when your system does not boot after the installation has been completed.

Installed System Boots, Not Media
Change your computer's firmware or BIOS so that the boot sequence is correct. To
do this, consult the manual for your hardware.
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The Computer Hangs
Change the console on your computer so that the kernel outputs are visible. Be sure
to check the last outputs. This is normally done by pressing Ctrl + Alt + F10. If you
are unable to resolve the problem, consult the SUSELinux Enterprise Server support
staff. To log all system messages at boot time, use a serial connection as described
in Section 2.6, “Controlling the Installation” (page 16).

The Itanium Boot Loader
If you have manually altered the kernel or initrd on your system, run
/sbin/elilo before shutting down the computer. If you leave out this step,
your system may not be bootable.

Boot Disk
The boot disk is a useful interim solution if you have difficulties setting the other
configurations or if you want to postpone the decision regarding the final boot
mechanism. A boot disk may also be a suitable solution in connection with OS/2
or Windows NT. Fore more details on creating boot disks, see Section “Creating
Boot CDs” (Chapter 10, The Boot Loader GRUB, ↑Administration Guide).

Virus Warning after Installation
There are BIOS variants that check the structure of the boot sector (MBR) and er-
roneously display a virus warning after the installation of GRUB or LILO. Solve
this problem by entering the BIOS and looking for corresponding adjustable settings.
For example, switch off virus protection. You can switch this option back on again
later. It is unnecessary, however, if Linux is the only operating system you use.

2.7.2 Problems Installing
If an unexpected problem occurs during installation, information is needed to determine
the cause of the problem. Use the following directions to help with troubleshooting:

• Check the outputs on the various consoles. You can switch consoles with the key
combination Ctrl + Alt + Fn. For example, obtain a shell in which to execute various
commands by pressing Ctrl + Alt + F2.

• Try launching the installation in failsafe mode. If the installation works without
problems in this case, there is an incompatibility that causes either ACPI or APIC
to fail. In some cases, a BIOS or firmware update fixes this problem.
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• Check the system messages on a console in the installation system by entering the
command dmesg.

2.7.3 Redirecting the Boot Source to the
Boot DVD

To facilitate the installation process and avoid accidental installations, the default setting
on the installation DVD for SUSE Linux Enterprise Server is that your system is booted
from the first hard disk. At this point, an installed boot loader normally takes over
control of the system. This means that the boot DVD can stay in the drive during an
installation. To start the installation, choose one of the installation possibilities in the
boot menu of the media.
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3Installation on IBM POWER
This chapter describes the procedure for preparing the installation of SUSE® Linux
Enterprise Server on IBM POWER systems.

3.1 Requirements
A standard installation requires at least 256 MB of RAM. The installation of a standard
system requires at least 2.0 GB of free hard disk space.

3.1.1 Hardware Requirements
The SUSE®Linux Enterprise Server operating system can be operated on a wide range
of hardware. To provide you with a guide to help you during the planning phase, the
minimum requirements are presented here.

If you want to be sure that a given computer configuration will work, check the database
of hardware certified by SUSE. Find a list of certified hardware at http://
developer.novell.com/yessearch/Search.jsp.

SUSE Linux Enterprise Server may support additional IBMPOWER systems not listed
below. For the latest information, see the IBM Information Center for Linux athttp://
publib.boulder.ibm.com/infocenter/lnxinfo/v3r0m0/index.jsp
?topic=%2Fliaam%2Fliaamdistros.htm.
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Find up-to-date firmware at IBM FixCentral (http://www.ibm.com/support/
fixcentral/). Select your system from the Product Group list.

All systems listed below are operated with a PPC64 kernel.

3.1.1.1 IBM POWER7 Systems
POWER7 systems

• Power 710 Express

• Power 720 Express

• Power 730 Express

• Power 740 Express

• Power 750 Express

• Power 755

• Power 770

• Power 780

• Power 795

POWER7 BladeCenter Models

• IBM BladeCenter PS700

• IBM BladeCenter PS701

• IBM BladeCenter PS702

• IBM BladeCenter PS703

• IBM BladeCenter PS704
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3.1.1.2 IBM PowerLinux Systems
• IBM PowerLinux 7R2

3.1.1.3 IBM POWER5 and POWER6 Systems
POWER5 Systems

• OpenPower 710

• System p5 520

• System i5 520

POWER6 Systems

• IBM Power 550

• IBM Power 570

POWER6 BladeCenter models

• IBM BladeCenter JS12

• IBM BladeCenter JS22

• IBM BladeCenter JS23

• IBM BladeCenter JS43

3.2 Preparation
This section describes the preparatory steps that must be taken before the actual instal-
lation. The installation procedure depends on the system used. See the following docu-
mentation:

• For IBM eServer p5 Systems, see Section 3.2.1, “Preparing for Installation on IBM
eServer p5, System p, and OpenPower Models” (page 25)
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• For IBM pSeries systems, see Section 3.2.2, “Preparing for Installation on IBM
pSeries Models” (page 31)

• For IBM JS20/JS21/JS22 Blades, see Section 3.2.3, “Preparing an Installation on
IBM JSxx BladeCenter” (page 34)

If SUSE® Linux Enterprise Server needs to be installed on a number of systems or
partitions, it is recommended you create a network installation source. The same source
can also be used for the concurrent installation on several partitions or several systems.
The configuration of a network installation source is described in Section 14.2.1, “Setting
Up an Installation Server Using YaST” (page 224).

The installation can be controlled with a VNC client. For more information about VNC,
see Section 14.1.1, “Simple Remote Installation via VNC—Static Network Configura-
tion” (page 216).

To participate in the linuxppc-devmailing list, sign up using the forms at http://
lists.ozlabs.org/listinfo/linuxppc-dev/. The following links are
pertinent to the maintenance of an installation:

• http://www.novell.com/support/products/server/ is an effective
help tool for assisting customers in solving problems. A corresponding article is
published whenever SUSE discover that a special case could lead to serious problems.
Search the portal using keywords like PPC or POWER.

• Find security alerts athttp://www.suse.com/support/security/. SUSE
also maintains two security-related mailing lists to which anyone may subscribe.

• suse-security—General discussion of security regarding Linux and
SUSE. All security alerts for SUSE Linux Enterprise Server are sent to this list.

• suse-security-announce— The SUSE mailing list exclusively for se-
curity alerts.
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3.2.1 Preparing for Installation on IBM
eServer p5, System p, and OpenPower
Models

This section covers the preparatory steps for installing SUSE®Linux Enterprise Server
on IBM eServer p5 systems. It explains the installation from a built-in CD-ROM drive
and over the network.

This section assumes you have set up your HMC and connected it to your system. Find
more information about using the wizard to configure the HMC in “Configuring the
HMC using the Guided Setup Wizard”: http://publib.boulder.ibm.com/
infocenter/systems/scope/hw/topic/iphai_p5/confighmcgs.htm
?

3.2.1.1 Modern Features of IBM eServer p5 Systems
IBM eServer p5 systems offer the possibility of partitioning the system. This enables
the concurrent operation of up to 254 operating systems on onemachine. These operating
systems are installed in LPARs (logical partitions). One or several of these partitions
can contain a SUSE Linux Enterprise Server environment.

To prepare an LPAR for SUSE Linux Enterprise Server, first configure the system over
theHMC. Refer to the IBM documentation for details: http://publib.boulder
.ibm.com/infocenter/systems/scope/hw/topic/iphbi/
iphbikickoff.htm

3.2.1.2 Hard Disk Space
Make sure that you have sufficient hard disk space for installing SUSE Linux Enterprise
Server. The standard system requires at least 4 GB of free hard disk space.

3.2.1.3 Assigning an Installation Device to an LPAR
SUSE Linux Enterprise Server can be installed from a CD-ROMor DVD drive or using
a network installation source. Make the CD-ROM, DVD drive, or network device
available to the LPAR to install.
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Figure 3.1 HMC: Server Management—Properties

Procedure 3.1 Assigning a CD-ROM or DVD Drive to an LPAR

1 Open the HMC application and go to Server and Partition > Server Management.

2 From the available servers, expand the server and partition to install.

3 Right-click the profile to use for installation and select Properties—see Figure 3.1,
“HMC: Server Management—Properties” (page 26).

4 In the Logical Partition Profile Properties dialog, select the Physical I/O tab.

5 FromManaged system I/O devices, select the Other Mass Storage Controller from
the bus where it is installed. To assign this DVD drive to the partition, click Add as
required.

The result should look like Figure 3.2, “HMC:Managed System I/ODevices” (page 27).
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Figure 3.2 HMC: Managed System I/O Devices

Now insert the SUSE Linux Enterprise Server CD1 or DVD1 in the drive.

Procedure 3.2 Assigning a Network Device to an LPAR

1 Open the HMC application and go to Server and Partition > Server Management.

2 From the available servers, open the server and partition to install.

3 Right-click the profile to use for installation and select Properties—see Figure 3.1,
“HMC: Server Management—Properties” (page 26).

4 In the Logical Partition Profile Properties dialog, select the Physical I/O tab.

5 FromManaged system I/O devices, select PCI 10/100/1000Mbps Ethernet UTP 2-
port from the bus where it is installed. Then click Add as required.

If you plan to install using a virtual ethernet adapter, refer to the IBM documentation.

Create a network installation source if SUSE Linux Enterprise Server should be installed
on a number of partitions. This eliminates the need to change CDs during installation.
The same source can also be used for concurrent installation of various systems. The
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configuration of the network installation source is described in Section 14.2.1, “Setting
Up an Installation Server Using YaST” (page 224).

3.2.1.4 Starting the Installation
To start the installation, reboot the system. Right-click the profile name, selectActivate,
and press OK in the following dialog.

Use the screen console or connect to a serial console as described in the IBM documen-
tation. One simple way to start a serial console is to open a VTerm while activating the
partition. To do this, activateOpen a terminal window or console session in the Activate
Logical Partition dialog.

Enter the system firmware by pressing F1 or 1 when using a serial console or a virtual
console during the system check when the system is rebooted:

IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM
IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM
IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM
IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM
IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM
IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM
IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM
IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM
IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM IBM

1 = SMS Menu 5 = Default Boot List
8 = Open Firmware Prompt 6 = Stored Boot List

memory keyboard network scsi speaker

Press F1 or 1while the SCSI devices are checked. Select 5. Select Boot Options to enter
the boot options dialog:

Version SF220_004
SMS 1.5 (c) Copyright IBM Corp. 2000,2003 All rights reserved.
---------------------------------------------------------------------
Main Menu
1. Select Language
2. Setup Remote IPL (Initial Program Load)
3. Change SCSI Settings
4. Select Console
5. Select Boot Options
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---------------------------------------------------------------------
Navigation Keys:

X = eXit System Management Services
---------------------------------------------------------------------
Type the number of the menu item and press Enter or select Navigation

Key:5

Select 1. Select Install/Boot Device to set the Install Device. Go to 7. List all Devices
to see the list of available devices:

Version SF220_011
SMS 1.5 (c) Copyright IBM Corp. 2000,2003 All rights reserved.
--------------------------------------------------------------------------
Select Device
Device Current Device
Number Position Name
1. - Virtual Ethernet

( loc=U9111.520.10D3CCC-V1-C3-T1 )
2. - Ethernet

( loc=U787A.001.DNZ00XG-P1-T5 )
3. - Ethernet

( loc=U787A.001.DNZ00XG-P1-T6 )
4. - IDE CD-ROM

( loc=U787A.001.DNZ00XG-P4-D3 )
5. 1 SCSI 73407 MB Harddisk

( loc=U787A.001.DNZ00XG-P1-T10-L8-L0 )

--------------------------------------------------------------------------
Navigation keys:
M = return to Main Menu
ESC key = return to previous screen X = eXit System Management Services
--------------------------------------------------------------------------
Type the number of the menu item and press Enter or select Navigation Key:

3.2.1.5 Booting from the CD-ROM Drive
Select the CD-ROM drive (4 in this example):
SMS 1.5 (c) Copyright IBM Corp. 2000,2003 All rights reserved.
--------------------------------------------------------------------------
Select Task

IDE CD-ROM
( loc=U787A.001.DNZ00XG-P4-D3 )

1. Information
2. Normal Mode Boot
3. Service Mode Boot
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--------------------------------------------------------------------------
Navigation keys:
M = return to Main Menu
ESC key = return to previous screen X = eXit System Management Services
--------------------------------------------------------------------------
Type the number of the menu item and press Enter or select Navigation Key:

Choose 2. Normal Mode Boot to install from this device. On the next screen, confirm
with 1. Yes to exit System Management Services and boot from the device.

The system reads from the CD-ROM drive and the yaboot utility starts:

Welcome to SuSE:SLE-11:GA!

Type "install" to start the YaST installer on this CD/DVD
Type "slp" to start the YaST install via network
Type "rescue" to start the rescue system on this CD/DVD

Welcome to yaboot version 1.3.11.SuSE
Enter "help" to get some basic usage information
boot:

Type install and press Enter.

To read the installation data from a network install source rather than continuing the
installation from the CD-ROM (see Section 3.2.1.3, “Assigning an Installation Device
to an LPAR” (page 25)), append the option manual to the name of the kernel
(install).

For an installation over VNC, append the parameters vnc=1 and
vncpassword=password to the name of the kernel (install). Read more about
VNC in Section 14.1.1, “Simple Remote Installation via VNC—Static Network Confi-
guration” (page 216).

3.2.1.6 Booting from the Network Source
Select an ethernet device that has access to the installation source (2 in this example).
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3.2.1.7 Additional Steps
Proceed as described in Chapter 6, Installation with YaST (page 89) to begin installing
the software with linuxrc and YaST.

3.2.2 Preparing for Installation on IBM
pSeries Models

This section covers the preparatory steps for installing SUSE®Linux Enterprise Server
on pSeries systems. It explains the installation from a built-in CD-ROM drive or a
network source.

3.2.2.1 Special Features of IBM pSeries p630, p655,
p670, and p690

IBM p630, p655, p670, and p690 systems offer the possibility of statically partitioning
the system similarly to eServer p5/System p5 (which is described in Section 3.2.1,
“Preparing for Installation on IBM eServer p5, System p, and OpenPower Mod-
els” (page 25)). This enables the concurrent operation of up to 16 operating systems
on one machine. These operating systems are installed in LPARs (logical partitions).
One or several of these partitions can contain a SUSE Linux Enterprise Server environ-
ment.

To prepare an LPAR for SUSE Linux Enterprise Server, first configure the system over
the HMC. Refer to the Redbook IBM eServer pSeries 690 System Handbook (SG24-
7040-00) for details (http://www.redbooks.ibm.com/redbooks/
SG247040/).

Important notes regarding the configuration:

• The recommended maximum number of processors for a SUSE Linux Enterprise
Server LPAR is eight, because the kernel can onlymanage eight processors effectively.

• For the installation, select SMS as the boot mode for the respective partition.
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• The HMC terminal used for the input during the installation is a VT320 emulation.
This emulation can lead to strange results with some applications. If possible, use an
XTerm for communicating with the LPAR.

3.2.2.2 Hard Disk Space
Make sure that you have sufficient hard disk space for installing SUSE Linux Enterprise
Server. The use of a separate hard disk is recommended.

SUSELinux also supports installing to Fibre Channel–attached storage. Before beginning
installation, the Fibre Channel Host Bus Adapter (FCHBA), SAN fabric, and storage
system must each be configured to provide access from the FCHBA through the SAN
Fabric to target logical units (LUNs) on the storage system.

SAN storage devices, if properly configured, are listed among existing hard disks on
your system. Create Custom Partitioning Setup opens the dialog, as described in Sec-
tion 15.1, “Using the YaST Partitioner” (page 251).

3.2.2.3 Setting Up the Installation Source
If you plan to install from CD-ROM, insert CD1 in the drive. In LPAR mode, the par-
tition to install must have the CD-ROM in its partition profile. Create a network instal-
lation source if SUSE Linux Enterprise Server needs to be installed over a number of
partitions. This eliminates the need to change CDs during installation. The same source
can also be used for concurrent installation of various systems. The configuration of
the network installation source is described in Section 14.2.1, “Setting Up an Installation
Server Using YaST” (page 224).

3.2.2.4 Starting the Installation
To start the installation, reboot the system. Then enter the system firmware by pressing
F1 or 1 when using the serial console during the system check when the system is re-
booted. See Figure 3.3, “Entering the System Firmware” (page 32).

Figure 3.3 Entering the System Firmware
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Press F1 or 1 while the SCSI devices are checked. Select 6 MultiBoot to enter the
Multiboot dialog. See Figure 3.4, “Multiboot Dialog” (page 33)

Figure 3.4 Multiboot Dialog

Select 3 to set the install device. A list of available devices is displayed. See Figure 3.5,
“Installing the Operating System” (page 33).

Figure 3.5 Installing the Operating System

3.2.2.5 Booting from the CD-ROM Drive
Select the respective CD-ROM drive (3 in this example). The system reads from the
CD-ROM drive and displays the identstring.

->1 SuSE:SLE-11:GA<-

After you select 1, the yaboot utility is started.

Welcome to SuSE:SLE-11:GA!

Type "install" to start the YaST installer on this CD/DVD
Type "slp" to start the YaST install via network
Type "rescue" to start the rescue system on this CD/DVD

Type install and press Enter. Alternatively, just press Enter to start the installer, the
default option.

To install from a network source (see Section 3.2.2.3, “Setting Up the Installation
Source” (page 32)), append manual to the kernel to install. For an installation
over VNC, append the parameters vnc=1 and vncpassword=password to
install. Read more about VNC in Section 14.1.1, “Simple Remote Installation via
VNC—Static Network Configuration” (page 216).

In LPAR mode, the partition to install must have the CD-ROM in its partition profile.
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3.2.2.6 Booting from the Network Source
Select an ethernet device that has access to the installation source (6 in this example).

3.2.2.7 Additional Steps
Proceed as described in Chapter 6, Installation with YaST (page 89) to begin installing
the software with linuxrc and YaST.

3.2.3 Preparing an Installation on IBM JSxx
BladeCenter

This section describes the preparatory steps for the installation of SUSE® Linux Enter-
prise Server on JSxx Blades. It covers installation using the CD-ROM drive of the
BladeCenter and using the network.

3.2.3.1 Creating a Network Installation Source
Create a network installation source if SUSE Linux Enterprise Server needs to be in-
stalled over a number of partitions. This provides the advantage of no CDs needing to
be changed during installation. The same source can also be used for the concurrent
installation of various systems. Configuration of a network installation source is de-
scribed in Section 14.2.1, “Setting Up an Installation Server Using YaST” (page 224).

3.2.3.2 Hard Disk Storage Space
Ensure that enough hard disk storage space is available for the installation of SUSE
Linux Enterprise Server. It is recommended you use a dedicated hard disk.

3.2.3.3 Notes and Information
Introductory Information:

• JSxx Blades Site: https://www-304.ibm.com/systems/support/
supportsite.wss/brandmain?brandind=5000020
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3.2.3.4 Preparing the System for Boot

Preparing to Boot from the CD-ROM Drive

Perform the steps described in this section if an installation from CD-ROM is desired.

Assign the CD-ROM drive to the Blade chosen for installation by connecting (with a
web browser) to a BladeCenterManagementModule, then logging in. After login, select
the functionRemote Control in themenuBlade Tasks then activate Start Remote Control.
Assign the CD-ROM drive to the desired blade in the menuChangeMedia Tray Owner
of the new window.

Set up the CD-ROM drive as a boot device. Do this by selecting Blade Tasks then
Configuration while in the BladeCenter Management Module. Select the JSxx Blade
in the section Boot Sequence. Set the entry for 1st Device on the page for Blade Boot
Sequence to CDROM.

Put CD 1 in the CD-ROM drive and restart the blade.

Preparing to Boot from the Network

Perform the steps as described in this section if an installation over the network is de-
sired.

Connect to the BladeCenter Management Module using a Web browser and log in. Set
the boot device to the network by accessing the Configuration menu from the Blade
Tasks page. Select the JSxx Blade in the section Boot Sequence and set 1st Boot Device
to Network — BOOTP on Blade Boot Sequence.

Rebooting and Connecting to the Console of the JSxx Blade

Reboot the JSxx Blade from the item Power/Restart of the Blade Tasks menu in the
BladeCenter Management Module. A table appears, showing the power status of the
blades in the Pwr column. Mark the check box of the desired blade and restart it with
Power On Blade.

Connect to the BladeCenter with the command telnet bladecenter and log in.

username: user
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password: ********
system>

The command env -T system:blade[bay number] determines for which
JSxx Blade the subsequent commands are intended. The blades installed in the Blade-
Center are listed by calling list -l 3.

system> list -l 3
system

mm[1] primary
power[1]
power[2]
power[3]
power[4]
blower[1]
blower[2]
switch[1]
switch[3]
blade[1]

sp
cpu[1]
cpu[2]

blade[3]
sp

blade[4]
sp

blade[6]
sp

blade[8]
sp
cpu[1]
cpu[2]

blade[9]
sp
cpu[1]
cpu[2]

blade[10]
sp

blade[11]
sp

blade[13]
sp

mt
system>

The command target is then determined. To work, for example, with blade number 9,
enter env -T system:blade[9]. Connect with the console of the JSxx Blade
over Serial over LAN (SOL) with the command console.
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system> env -T system:blade[9]
OK
system:blade[9]> console

Starting the Installation

The SUSE Linux Enterprise Server boot loader starts after the system check has com-
pleted.

Welcome to SuSE:SLE-11:GA!

Type "install" to start the YaST installer on this CD/DVD
Type "slp" to start the YaST install via network
Type "rescue" to start the rescue system on this CD/DVD

Welcome to yaboot version 1.3.11.SuSE
Enter "help" to get some basic usage information
boot:

Select install from the menu and press Enter.

In the case of an installation over VNC, append the parameters vnc=1 and
vncpassword=password to the command line for the kernel (install).

Additional Steps

Proceed as described in Chapter 6, Installation with YaST (page 89) to begin installing
the software with linuxrc and YaST.
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4Installation on IBM System z
This chapter describes the procedure for preparing the installation of SUSE® Linux
Enterprise Server on IBM System z systems. It provides all information needed to
prepare the installation on the LPAR and z/VM side.

4.1 General Information and
Requirements

This section gives basic information about the system requirements (like supported
hardware), level of MicroCode, and software. It also covers the different installation
types, how to do an IPL for the first installation, and information about the IOCDS.

4.1.1 System Requirements
This section provides a list of hardware for IBM System z supported by SUSE Linux
Enterprise Server. Next, the level of the MicroCode (MCL) used in your IBM System
z system, which is very important for the installation, is covered. Additional software
to install and use for installation is mentioned at the end of this section.

4.1.1.1 Hardware
SUSE Linux Enterprise Server has run successfully on the following platforms:

• IBM Series z9 (z9-EC) 2094
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• IBM Series z9 (z9-BC) 2096

• IBM Series z10 (z10-EC) 2097

• IBM Series z10 (z10-BC) 2098

Memory Requirements

Different installation methods have different memory requirements during installation.
After installation is completed, the system administrator may reduce memory to the
desired size. SUSE recommends using:

For installation under z/VM.768 MB

For installation under LPAR.1 GB

NOTE: Memory Requirements with Remote Installation Sources

For installation from NFS, FTP, or SMB installation sources or whenever VNC
is used, 512MB of memory is required as a minimum. Otherwise, the installation
attempt is likely to fail. Further note that the number of devices visible to the
z/VM guest or LPAR image affects memory requirements. Installation with liter-
ally hundreds of accessible devices (even if unused for the installation) may
require more memory.

Disk Space Requirements

The disk requirements depend largely on the installation. Commonly, you need more
space than the installation software itself needs to have a system that works properly.
Minimal requirements for different selections are:

Default Installation2.6 GB

Recommended (this is with graphical desktop, develop-
ment packages and java).

3.6 GB+

40 Deployment Guide



Network Connection

A network connection is needed to communicate with your SUSE Linux Enterprise
Server system. This can be one or more of the following connections or network cards:

• OSA Express Ethernet (including Fast and Gigabit Ethernet)

• HiperSockets or Guest LAN

• 10 GBE, VSWITCH

The following interfaces are still included, but no longer supported:

• CTC (or virtual CTC)

• ESCON

• IP network interface for IUCV

IPL Options

For an LPAR installation, the Load from CD-ROM or Server option is the preferred
way to IPL the installation kernel and initrd (initial RAM disk). If this option is not
available and you cannot use z/VM for installing the system, you need to IPL from a
channel attached tape with the tapeipl kernel, the parmfile, and the initrd. Thus, you
need access to a tape unit (3480, 3490, or 3590, for example).

4.1.1.2 MicroCode Level, APARs, and Fixes
This release of SUSE Linux Enterprise Server is based on the May 2008 update of the
development stream from IBM developerWorks (http://www.ibm.com/
developerworks/linux/linux390/development_recommended.html).
The restrictions and requirements listed at the Web site also apply for this release of
SUSE Linux Enterprise Server, except where stated differently in this manual. It is
recommended always to use the highest service level available. Contact your IBM
support for minimum requirements.
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z/VM

z/VM 5.2

z/VM 5.3

z/VM 5.4

Negotiate the order of installation with your IBM support, because it might be necessary
to activate the VM APARs before installing the new MicroCode levels.

4.1.1.3 Software
To install SUSE Linux Enterprise Server via non-Linux–based NFS or FTP, you might
experience problems with NFS or FTP server software. The Windows standard FTP
server can cause errors, so installing via SMB on these machines is generally recom-
mended.

To connect to the SUSELinux Enterprise Server installation system, one of the following
methods is required:

SSH with Terminal Emulation (xterm compatible)
SSH is a standard Unix tool that should be present on any Unix or Linux system.
For Windows, there is an SSH client called Putty. It is free to use and is available
from http://www.chiark.greenend.org.uk/~sgtatham/putty/.

VNC Client
For Linux, a VNC client called vncviewer is included in SUSE Linux Enterprise
Server as part of the tightvnc package. ForWindows, tightvnc is also available.
Download it from http://www.tightvnc.com/. Alternatively, use the VNC
Java client and a Java-enabled Web browser.

X Server
Find a suitable X server implementation on any Linux or Unix workstation. There
aremany commercial XWindowSystem environments forWindows andMacintosh.
Some of them can be downloaded as free trial versions. A trial version of theMocha
X Server from MochaSoft can be obtained at http://www.mochasoft.dk/
freeware/x11.htm.
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TIP: Additional Information

Consult the README located in the root directory of DVD 1 of your SUSE Linux
Enterprise Server before installing SUSE Linux Enterprise Server on IBM System
z. This file completes the documentation presented in this book.

4.1.2 Installation Types
This section gives an overview of the different types of installation possible with SUSE
Linux Enterprise Server for IBM System z. Basically, these two types are given:

LPAR
Installation of SUSE Linux Enterprise Server using a logical partition (LPAR).

VM (z/VM)
Installation of SUSE Linux Enterprise Server as as a guest operating systemwithin
z/VM.

Depending on the mode of installation (LPAR or VM), there are different possibilities
for starting the installation process and IPLing the installed system.

4.1.2.1 LPAR
If you install SUSE Linux Enterprise Server for IBM System z into a separate logical
partition (LPAR), allow SUSE Linux Enterprise Server to use a special part of the
physical memory in your system. Also decide how many processors are used by SUSE
Linux Enterprise Server. In this mode, you can run different operating systems simulta-
neously on your IBM System z system.

4.1.2.2 z/VM
Running SUSE Linux Enterprise Server for IBM System z in z/VM means that SUSE
Linux Enterprise Server is a guest system within z/VM. An advantage of this mode is
that you have full control over SUSE Linux Enterprise Server from z/VM. This is very
helpful for kernel development or kernel-based debugging. It is also very easy to add
or remove hardware to and from Linux guests. Creating additional SUSE Linux Enter-
prise Server guests is simple and you are able to run hundreds of Linux instances simul-
taneously.
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4.1.3 IPL Options
This section provides the information needed to do an IPL for the first installation.
Depending on the type of installation, different options need to be used. The channel-
attached tape, VM reader, and load from CD-ROM or server options are discussed.
Installing the software packages, which is done over the network, does not require the
IPL medium.

4.1.3.1 ESCON or FICON Attached Tape
IPLing from a channel-attached tape is possible on all systems connected to a tape li-
brary. The only prerequisite is that the LPAR in which to install (or allowing z/VM to
run) is allowed to access the tape unit. For this, the IODEVICE statement in the IOCDS
must have the attribute SHARED or PART=<LPARName>.

4.1.3.2 VM Reader
To IPL from a VM reader, transfer the necessary files into the reader first. Then multiple
IPLs are easily done. This is the preferred way on z/VM. For convenience of adminis-
tration, it is recommended to create a user linuxmnt that owns a minidisk with the
files and scripts needed for IPL. This minidisk is then accessed read-only by the Linux
guests.

4.1.3.3 Load from CD/DVD-ROM or Server
For IPLing into an LPAR, it is possible to either load the kernel image directly from
the SE's or the HMC's CD/DVD-ROM device or from any remote system accessible
through FTP. This function can be performed from the HMC. The installation process
requires a file with a mapping of the location of the installation data in the file system
and the memory locations where the data is to be copied. For SUSE Linux Enterprise
Server this file is called suse.ins and located in the root directory of the file system
on the DVD 1.

In the left navigation pane of the HMC expand Systems Management and Servers and
select the mainframe system you want to work with. Choose the LPARwhere you want
to boot SUSE Linux Enterprise Server from the table of LPARs displayed in the upper
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content area on the right. In the Tasks area, expand Recovery and click Load from CD-
ROM, DVD, or Server.

Now either choose Hardware Management Console CD-ROM/DVD or FTP Source.
If having chosen the latter option, provide the servers address or name and your creden-
tials. In case the suse.ins file is not located in the root directory of the server, provide
the path to this file. Continue to the Select the software to load menu and select the
suse.ins entry. Start the installation with OK.

4.1.3.4 Load from SCSI-Attached DVD
To IPL from a SCSI DVD, you need access to an FCP adapter connected to a DVD
drive. You need values like the WWPN and LUN from the SCSI drive. For details, see
Section “IPL from FCP-Attached SCSI DVD” (page 54).

4.1.4 The IOCDS
This section provides some necessary information about the IOCDS and how to cus-
tomize some settings for sharing network cards or DASDs among several LPARs. In
the IOCDS, the chpid and types of the devices connected to the IBM System z are
defined. The resources can be dedicated or shared among LPARs.

WARNING: Sharing Devices (DASD)

Do not share writable DASD among LPARs because this might result in data
loss. Consider the definition of the necessary resources in advance when plan-
ning the setup for SUSE Linux Enterprise Server on IBM System z.

This example shows how to dedicate a DASD to one specific LPAR. This LPAR is
referred to as LPAR1.

Example 4.1 Dedicating DASD to One LPAR
CHPID PATH=FD,TYPE=DSD,SHARED
CNTLUNIT CUNUMBR=FD00,PATH=FD,UNITADD=((00,256)),UNIT=3990-2
IODEVICE ADDRESS=(FD03,1),CUNUMBR=FD00,UNIT=3390,PART=LPAR1

To share a DASD among LPARs, delete thePART=LPAR1 part in the IOCDS definition.
This might be useful for high availability reasons or for sharing data among LPARs
read-only.
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Several Linux systems can use the same network device if you share it among LPARs
or z/VM guests. This reduces the number of network devices that must be provided to
the Linux system. On the other hand, you might provide more than one network device
to one Linux system to make it more available in case one connection fails.

Network cards like OSA-Express can be used in two different modes. These modes are
known as QDIO and non-QDIO mode. Define these modes in the IOCDS by using the
TYPE statement. QDIOmode is much faster than non-QDIOmode, but uses three device
addresses instead of two in non-QDIO. Consider the limited number of device addresses
when planning the setup of your IBM System z Linux environment.

Example 4.2 Sharing OSA Express Card among LPARs (non-qdio) on z9
CHPID PATH=(FE),SHARED,PARTITION=((LPAR1,LPAR2)),TYPE=OSE
CNTLUNIT CUNUMBR=FE00,PATH=(FE),UNIT=OSA
IODEVICE ADDRESS=(FE00,016),CUNUMBR=(FE00),UNIT=OSA
IODEVICE ADDRESS=(FEFE,001),CUNUMBR=(FE00),UNIT=OSAD

Example 4.3 Sharing OSA Express Card among LPARs (qdio) on z9
CHPID PATH=(FE),SHARED,PARTITION=((LPAR1,LPAR2)),TYPE=OSD
CNTLUNIT CUNUMBER=FE00,PATH=(FE),UNIT=OSA
IODEVICE ADDRESS=(FE00,016),CUNUMBR=(FE00),UNIT=OSA
IODEVICE ADDRESS=(FEFE,001),CUNUMBR=(FE00),UNIT=OSAD

4.2 Preparing for Installation
In this section, learn how to make the data accessible for installation, install SUSE
Linux Enterprise Server using different methods, and prepare and use the IPL of the
SUSE Linux Enterprise Server installation system. Also find out about network confi-
guration and network installation.

4.2.1 Making the Installation Data Available
This section provides detailed information about making the SUSE Linux Enterprise
Server IBM System z installation data accessible for installation. Depending on your
computer and system environment, choose between NFS or FTP installation. If you are
running Microsoft Windows workstations in your environment, you can also use the
Windows network (including the SMB protocol) to install SUSE Linux Enterprise
Server on your IBM System z system.
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TIP: IPL from DVD

Since Service Pack 1 of SUSE Linux Enterprise Server Version 10, it is possible
to IPL from DVD and use the DVD as the installation medium. This is very
convenient if you have restrictions setting up an installation server providing
installation media over your network. The prerequisite is an FCP-attached SCSI
DVD Drive.

NOTE: No Installation “From Hard Disk”

It is not possible to install from hard disk by putting the content of the DVD
to a partition on a DASD.

4.2.1.1 Using a Linux Workstation or SUSE Linux
Enterprise Server DVD

If you have a Linux workstation running in your computer environment, use the work-
station to provide the installation data to the IBM System z installation process by NFS
or FTP. If the Linux workstation runs under SUSE Linux Enterprise Server, you can
set up an installation server (NFS or FTP) using the YaST Installation Server module
as described in Section 14.2.1, “Setting Up an Installation Server Using
YaST” (page 224).

Over NFS

Use NFS (network file system) to make the installation media available.

IMPORTANT: Exporting Mounted Devices with NFS

Exporting the file system root (/) does not imply the export of mounted devices,
such as DVD. Explicitly name the mount point in /etc/exports:
/media/dvd *(ro)

After changing this file, restart the NFS server with the command
rcnfsserver restart.
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Over FTP

Setting up an FTP server on a Linux system involves the installation of the server
software itself, such as wuftpd or proftpd, as well as other possible configuration tasks.
Using YaST, the installation step is straightforward: select the package to install and
start the installation. Skip the configuration of the FTP server if no anonymous FTP
should be used for the installation. Instead, use an FTP login with a valid username and
password. You might want to create a user account for this task only. The FTP daemon
does not need to be started by hand. It can be started by inetd if an FTP connection is
requested. To activate the new settings, enter rcinetd restart or
rcxinetd restart.

SUSE Linux Enterprise Server on DVD

DVD1 of the SUSE Linux Enterprise Server for IBM System z contains a bootable
Linux image for Intel-based workstations as well as an image for System z.

For Intel-based workstations, boot from this DVD, answer the questions regarding your
language and keyboard layout, and select Start rescue system. You need at least 64 MB
RAM for this. No disk space is needed because the entire rescue system resides in the
workstation's RAM. This approach takes some Linux and networking experience, be-
cause you need to set up the networking of the workstation manually.

For System z, IPL your LPAR/VM guest from this DVD as described in Section “IPL
from FCP-Attached SCSI DVD” (page 54). After entering your network parameters,
the installation system treats the DVD as the source of installation data. Because System
z cannot have an X11-capable terminal attached directly, choose between VNC or SSH
installation. SSH also provides a graphical installation by tunneling the X connection
through SSH with ssh -X.

4.2.1.2 Using a Microsoft Windows Workstation
If there is a Microsoft Windows workstation available in your network, use this com-
puter to make the installation media available. The easiest way to do this is to use the
SMB protocol, already included in the Windows operating system. Be sure to activate
SMB over TCP/IP as this enables the encapsulation of SMB packages into TCP/IP
packages. Find details in theWindows online help or otherWindows-related documen-
tation that covers networking. Another option is to use FTP. This also requires some
third-party software for Windows.
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With SMB

To make the installation media available with SMB, just insert the SUSE Linux Enter-
prise Server DVD 1 into the DVD drive of the Windows workstation. Then create a
new share using the DVD-ROM drive's letter and make it available for everyone in the
network.

TIP: SMB Installation Path for YaST

Consult the README from the highest directory of DVD 1 for detailed informa-
tion about the syntax of the installation path for YaST.

With NFS

Refer to the documentation provided with the third party product that enables NFS
server services for your Windows workstation. The DVD-ROM drive containing the
SUSE Linux Enterprise Server DVDs must be in the available NFS path.

With FTP

Refer to the documentation provided with the third party product that is enabling FTP
server services on your Windows workstation. The DVD-ROM drive containing the
SUSE Linux Enterprise Server DVDs must be in the available FTP path.

The FTP server that is bundled with some Microsoft Windows releases implements
only a subset of the FTP command set and is not suitable for providing the installation
data. However, other products (such as the FTP server that is part of Hummingbird
Exceed or WAR-FTPD) have been reported as functional.

Using an FCP-Attached SCSI DVD Drive

After you IPLed from the SCSI DVD as described in Section 4.1.3.4, “Load from SCSI-
Attached DVD” (page 45), the installation system uses the DVD as the installation
medium. In that case, you do not need the installation media on an FTP, NFS, or SMB
server. However, you need the network configuration data for your SUSE Linux Enter-
prise Server, because you must set up the network during the installation to perform a
graphical installation by VNC or by X tunneled through SSH.
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4.2.2 Installation Types
This section provides information about which steps must be performed to install SUSE
Linux Enterprise Server for each of the installation modes and where to find the appro-
priate information. After the preparationsmentioned in the previous chapters have been
accomplished, follow the installation overview of the desired installation mode to install
SUSE Linux Enterprise Server on your system.

As described in Section 4.2.1, “Making the Installation Data Available” (page 46),
there are two different installation modes for Linux on IBM System z:

• LPAR Installation

• z/VM Installation

Procedure 4.1 Overview of LPAR Installation

1 Prepare the devices needed for installation. See Section 4.2.3.1, “LPAR Installa-
tion” (page 51).

2 IPL the installation system. See Section 4.2.4.1, “LPAR Installation” (page 54).

3 Configure the network. See Section 4.2.5, “Network Configuration” (page 59).

4 Connect to the SUSE Linux Enterprise Server installation system. See Section 4.2.6,
“Connecting to the SUSE Linux Enterprise Server Installation System” (page 61).

5 Start the installation using YaST and IPL the installed system. See Chapter 6, Instal-
lation with YaST (page 89).

Procedure 4.2 Installation Overview of z/VM Installation

1 Prepare the devices needed for installation. See Section 4.2.3.2, “z/VM Installa-
tion” (page 52).

2 IPL the installation system. See Section 4.2.4.2, “z/VM Installation” (page 55).

3 Configure the network. See Section 4.2.5.1, “z/VM Installation” (page 60).

4 Connect to the SUSE Linux Enterprise Server installation system. See Section 4.2.6,
“Connecting to the SUSE Linux Enterprise Server Installation System” (page 61).
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5 Start the installation using YaST and IPL the installed system. See Chapter 6, Instal-
lation with YaST (page 89).

4.2.3 Preparing the IPL of the SUSE Linux
Enterprise Server Installation System

4.2.3.1 LPAR Installation
Configure your IBM System z system to start in ESA/S390 or LINUX-only mode with
an appropriate activation profile and IOCDS. Consult IBM documentation for more on
how to achieve this.

IOCDS: Attaching and Configuring Devices

A SUSE Linux Enterprise Server installation needs at least two devices: a DASD and
a network connection device. For an IPL from tape, a tape device should also be acces-
sible. Devices are configured and attached to an LPAR in the IOCDS (input output
configuration data set). This example defines one DASD, one OSA-2 network device,
and a tape device for LPAR Z1. For further information about how to set up the IOCDS
for Linux, refer to your machine's IBM hardware documentation.

Example 4.4 An Example IOCDS
CHPID PATH=(CSS(0),FD),PCHID=120,TYPE=FC
CHPID PATH=(CSS(0),FE),PCHID=320,TYPE=OSD
CHPID PATH=(CSS(0),10),PCHID=3A0,TYPE=CNC

CNTLUNIT CUNUMBR=FD00,PATH=((CSS(0),FD)),UNITADD=((00,1)),UNIT=2105
IODEVICE ADDRESS=(FD00,1),CUNUMBR=(FD00),UNIT=3390B,UNITADD=00

CNTLUNIT CUNUMBR=FE20,PATH=((CSS(0),FE)),UNIT=OSA
IODEVICE ADDRESS=(FE20,1),CUNUMBR=(FE20),UNIT=OSA
IODEVICE ADDRESS=(FEFE,1),CUNUMBR=(FE20),UNIT=OSAD

CNTLUNIT CUNUMBR=100A,PATH=((CSS(0),10)),UNIT=3480,UNITADD=((0A,1))
IODEVICE ADDRESS=(100A,1),CUNUMBR=(100A),UNIT=3480,UNITADD=00

Proceed with Section 4.2.4.1, “LPAR Installation” (page 54).
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4.2.3.2 z/VM Installation

Adding a Linux Guest

The first step is to attach and format one or multiple DASDs in the system to be used
by the Linux guest in z/VM. Next, create a new user in z/VM. The example shows the
directory for a user LINUX1with the password LINPWD, 256MB of memory (extend-
able up to 1024MB), 32MBof expanded RAM (XSTORE), someminidisks (MDISK),
two CPUs and an OSA QDIO device.

TIP: Assigning Memory to z/VM guests

When assigning memory to a z/VM guest, make sure that the memory size suits
the needs of your preferred installation type. See Section “Memory Require-
ments” (page 40). To set the memory size to 512 MB, use the command CP
DEFINE STORAGE 512M. After the installation has finished, reset the memory
size to the desired value.
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Example 4.5 Configuration of a z/VM Directory
USER LINUX1 LINPWD 256M 1024M G
*____________________________________________
* LINUX1
*____________________________________________
* This VM Linux guest has two CPUs defined.

CPU 01 CPUID 111111
CPU 02 CPUID 111222
IPL CMS PARM AUTOCR
IUCV ANY
IUCV ALLOW
MACH ESA 10
OPTION MAINTCCW RMCHINFO
SHARE RELATIVE 2000
XSTORE 32M
CONSOLE 01C0 3270 A
SPOOL 000C 2540 READER *
SPOOL 000D 2540 PUNCH A
SPOOL 000E 3203 A
* OSA QDIO DEVICE DEFINITIONS
DEDICATE 9A0 9A0
DEDICATE 9A1 9A1
DEDICATE 9A2 9A2
*
LINK MAINT 0190 0190 RR
LINK MAINT 019E 019E RR
LINK MAINT 019D 019D RR
* MINIDISK DEFINITIONS
MDISK 201 3390 0001 0050 DASD40 MR ONE4ME TWO4ME THR4ME
MDISK 150 3390 0052 0200 DASD40 MR ONE4ME TWO4ME THR4ME
MDISK 151 3390 0253 2800 DASD40 MR ONE4ME TWO4ME THR4ME

This example uses minidisk 201 as the guest's home disk. Minidisk 150 with 200
cylinders is the Linux swap device. Disk 151 with 2800 cylinders holds the Linux in-
stallation.

Now add (as the user MAINT) the guest to the user directory with DIRM FOR LINUX1
ADD. Enter the name of the guest (LINUX1) and press F5. Set up the environment of
the user with:
DIRM DIRECT
DIRM USER WITHPASS

The last command returns a reader file number. This number is needed for the next
command:
RECEIVE <number> USER DIRECT A (REPL)
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Assign the directories to the guest with DISKMAP USER DIRECT A. You can now
log in on the guest as user LINUX1.

If you do not have the dirmaint option available, refer to the IBM documentation
to set up this user.

Proceed with Section 4.2.4.2, “z/VM Installation” (page 55).

4.2.4 IPLing the SUSE Linux Enterprise
Server Installation System

4.2.4.1 LPAR Installation
There are different ways to IPL SUSE Linux Enterprise Server into an LPAR. The
preferred way is to use the Load from CD-ROM or server feature of the SE or HMC.

IPL from DVD-ROM

Mark the LPAR to install and select Load from CD-ROM or server. Leave the field for
the file location blank or enter the path to the root directory of the first DVD-ROM and
select continue. In the list of options that appears, choose the default selection.Operating
system messages should now show the kernel boot messages.

IPL from FCP-Attached SCSI DVD

You can use the Load procedure by selecting SCSI as Load type to IPL from SCSI.
Enter the WWPN (Worldwide port name) and LUN Logical unit number) provided by
your SCSI bridge or storage (16 digits—do not omit the trailing 0s). The boot program
selector must be 2. Use your FCP adapter as Load address and perform an IPL.

IPL from ESCON or FICON Attached Tape

If you cannot IPL from DVD, create a channel attached tape from which to IPL the
SUSE Linux Enterprise Server installation image. Use the LOAD button in the SE or
HMCwith the tape device address as the load address to IPL the SUSE Linux Enterprise
Server installation system.
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There are many ways to create an IPLable tape. One is to copy the files:
/boot/s390x/tapeipl.ikr
/boot/s390x/parmfile
/boot/s390x/initrd

as binary files from DVD 1 (for example, using FTP from a Linux workstation).

Name them
SLES11 IMAGE
SLES11 PARM
SLES11 INITRD

and write them onto a tape with the REXX from the example.

IMPORTANT: Transferring Binaries using FTP

Do not upload the files as fixed 80. Store them as fixed 1024. Use the
FTP command locsite fix 1024.

Example 4.6 REXX Script to Create an IPLable Tape
'REWIND 181'
'FILEDEF IN1 DISK' SLES11 IMAGE A
'FILEDEF IN2 DISK' SLES11 PARM A
'FILEDEF IN3 DISK' SLES11 INITRD A
'FILEDEF OUT TAP1 (RECFM F BLOCK 1024 LRECL 1024 PERM'
say 'Writing: ' left(file1,23)
'MOVEFILE IN1 OUT'
say 'Writing: ' left(file2,23)
'MOVEFILE IN2 OUT'
say 'Writing: ' left(file3,23)
'MOVEFILE IN3 OUT'
say 'Done.'
'REWIND 181'
exit

The tape in this script is attached as 181. Adjust the script to your needs.

4.2.4.2 z/VM Installation
This section is about IPLing the installation system to install SUSE Linux Enterprise
Server for IBM System z on a z/VM system.
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IPL from the z/VM Reader

You need a working TCP/IP connection and an FTP client program within your newly
defined z/VM guest to transfer the installation system via FTP. Setting up TCP/IP for
z/VM is beyond the scope of this manual. Refer to the appropriate IBM documentation.

Log in as the z/VM Linux guest to IPL. Make the content of the directory /boot/
s390x on DVD 1 of the SUSE Linux Enterprise Server for IBM System z available
by FTP within your network. From this directory, get the files vmrdr.ikr, initrd,
parmfile, and sles11.exec. Transfer the files with a fixed block size of 80
characters. Specify it with the FTP command locsite fix 80. It is important to
copy vmrdr.ikr (the Linux kernel) and initrd (the installation image) as binary
files, so use the binary transfer mode. parmfile and sles11.exec need to be
transferred in ASCII mode.

The example shows the steps necessary. In this example, the required files are accessible
from an FTP server at the IP address 192.168.0.3 and the login is lininst. It
may differ for your network.
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Example 4.7 Transferring the Binaries via FTP
FTP 192.168.0.3
VM TCP/IP FTP Level 530
Connecting to 192.168.0.3, port 21
220 ftpserver FTP server (Version wu-2.4.2-academ[BETA-18](1)
Thu Feb 11 16:09:02 GMT 2010) ready.
USER
lininst
331 Password required for lininst
PASS
******
230 User lininst logged in.
Command:
binary
200 Type set to I
Command:
locsite fix 80
Command:
get /media/dvd1/boot/s390x/vmrdr.ikr sles11.image
200 PORT Command successful
150 Opening BINARY mode data connection for /media/dvd1/boot/s390x/vmrdr.ikr
(6757376 bytes)
226 Transfer complete.
6757376 bytes transferred in 8.826 seconds.
Transfer rate 766.70 Kbytes/sec.
Command:
get /media/dvd1/boot/s390x/initrd sles11.initrd
200 PORT Command successful
150 Opening BINARY mode data connection for /media/dvd1/boot/s390x/initrd
(12654815 bytes)
226 Transfer complete.
12194534 bytes transferred in 16.520 seconds.
Transfer rate 766.70 Kbytes/sec.
Command:
ascii
200 Type set to A
Command:
get /media/dvd1/boot/s390x/parmfile sles11.parmfile
150 Opening ASCII mode data connection for /media/dvd1/boot/s390x/parmfile
(71 bytes)
226 Transfer complete.
71 bytes transferred in 0.092 seconds.
Transfer rate 0.71 Kbytes/sec.
Command:
get /media/dvd1/boot/s390x/sles11.exec sles11.exec
150 Opening ASCII mode data connection for /media/dvd1/boot/s390x/sles11.exec
(891 bytes)
226 Transfer complete.
891 bytes transferred in 0.097 seconds.
Transfer rate 0.89 Kbytes/sec.
Command:
quit

Installation on IBM System z 57



Use the REXX script sles11.exec you just downloaded to IPL the Linux installation
system. This script loads the kernel, parmfile, and the initial RAM disk into the reader
for IPL.

Example 4.8 SLES11 EXEC
/* REXX LOAD EXEC FOR SUSE LINUX S/390 VM GUESTS */
/* LOADS SUSE LINUX S/390 FILES INTO READER */
SAY ''
SAY 'LOADING SLES11 FILES INTO READER...'
'CP CLOSE RDR'
'PURGE RDR ALL'
'SPOOL PUNCH * RDR'
'PUNCH SLES11 IMAGE A (NOH'
'PUNCH SLES11 PARMFILE A (NOH'
'PUNCH SLES11 INITRD A (NOH'
'I 00C'

With this script you can IPL the SUSE Linux Enterprise Server installation systemwith
the command sles11. The Linux kernel then starts and prints its boot messages.

To continue the installation, proceed to Section 4.2.5.1, “z/VM Installation” (page 60).

IPL from FCP-Attached SCSI DVD

To IPL in z/VM, prepare the SCSI IPL process by using the SET LOADDEV parameter:
SET LOADDEV PORTNAME 200400E8 00D74E00 LUN 00020000 00000000 BOOT 2

After setting the LOADDEV parameter with the appropriate values, IPL your FCP
adapter, for example:
IPL FC00

To continue the installation, proceed with Section 4.2.5.1, “z/VM Installation” (page 60).

IPL from ESCON or FICON Attached tape

If you cannot IPL from a z/VM reader, create a channel attached tape from which to
IPL the SUSE Linux Enterprise Server installation image. For instructions, refer to
Section “IPL from ESCON or FICON Attached Tape” (page 54).

To continue the installation, proceed with Section 4.2.5.1, “z/VM Installation” (page 60).
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4.2.5 Network Configuration
Wait until the kernel has completed its start-up routines. If you are installing in basic
mode or in an LPAR, open the Operating System Messages on the HMC or SE.

First, choose Start Installation or System in the linuxrc main menu then Start Installation
or Update to start the installation process. Select Network as your installation medium
then select the type of network protocol you will be utilizing for the installation. Sec-
tion 4.2.1, “Making the Installation Data Available” (page 46) describes how to make
the installation data available for the various types of network connections. Currently,
FTP, HTTP, NFS, and SMB/CIFS (Windows file sharing) are supported.

Now set up the network device over which to receive the installation data: OSA-2 or
OSA Express or HiperSockets. The following network adapters are still available and
usable, but no longer supported: CTC, ESCON, IUCV. Next, choose the CCW bus in-
terface and the physical medium (Ethernet). As a result, the respective driver is installed
and you see the corresponding kernel messages.

Proceeding with the installation, linuxrc displays a list of potential usable read, write,
and, if applicable, data channels. After entering the addresses for each channel, you
may also need to enter additional information, such as the port name for OSA ethernet
cards.

Next, decide whether to use DHCP autoconfiguration for setting up the network interface
parameters. Because DHCP only works on a few devices and requires special hardware
configuration settings, you probably want to say NO here. When you do so, you are
prompted for the networking parameters of your installation network device:

• The IP address of the system to install

• The corresponding netmask

• The IP address of a gateway to reach the server

• The IP address of your domain name server (DNS)

When using an OSA Express Network Card you are now prompted for a relative port
number. This was added to support the new 2 port OSA Express 3 Network devices. If
you are not using an OSA Express 3 device, please enter 0. OSA Express cards also
have the option of running in an “OSI layer 2 support” mode or using the older more
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common “layer 3” mode. The card mode affects all systems that share the device includ-
ing systems on other LPARs. If in doubt, please specify 2 for compatibility with the
default mode used by other operating systems such as z/VM and z/OS. Consult with
your hardware administrator for further information on these options.

4.2.5.1 z/VM Installation
After the kernel has completed its start-up routines, answer a few questions regarding
the network setup. First, select the type of network connection to use: OSA Express or
HiperSockets. In this example installation, OSA Express is used.

The system now displays a possible OSA configuration. Choose first whether to use
QDIO or LCS OSA. Next, choose the physical medium to use and enter the device ad-
dresses. If you prefer another setup, enter the device address of the OSA read channel
(0.0.0700 in this example) then the one of the OSA write channel (0.0.0701) and the
OSA control channel (0.0.0702). After entering the channels, insert the name of the
port to which the OSA card is connected.

SUSE Linux Enterprise Server now tries to load the network module by building a pa-
rameter line with the information provided and displaying all loaded modules. Loading
was successful if you get an output like:

Example 4.9 Network Device Driver Parameters
(portname YSW2)
(Port 0)
qdio: 0.0.0702 OSA on SC 3 using AI:1 QEBSM:0 PCI:1 TDD:1 SIGA:RW AO
qeth.736dae: 0.0.0700: Device is a Guest LAN QDIO card (level: V540)
with link type GuestLAN QDIO (portname: YSW2)
qeth.47953b: 0.0.0700: Hardware IP fragmentation not supported on eth0
qeth.066069: 0.0.0700: Inbound source MAC-address not supported on eth0
qeth.d7fdb4: 0.0.0700: VLAN enabled
qeth.e90c78: 0.0.0700: Multicast enabled
qeth.5a9d02: 0.0.0700: IPV6 enabled
qeth.184d8a: 0.0.0700: Broadcast enabled
qeth.dac2aa: 0.0.0700: Using SW checksumming on eth0.
qeth.9c4c89: 0.0.0700: Outbound TSO not supported on eth0

Next, enter your IP address, netmask, and default gateway. To install over iucv or ctc,
enter additional information, like the the peer address (for a point-to-point adapter) or
the port name.

Finally, the IP address of the DNS server and the MTU size are requested. The MTU
size should always match the one used by the network to which you are connecting.
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Now a summary is displayed. Confirm if your input is correct. Before the network is
started, enter a password that is valid only during the installation. After having IPLed
the installed system, enter the real root password.

With all basic parameters set up, the network is started. Check the output of ifconfig,
which should contain two entries: a loopback (lo) connection and one connection (eth0,
ctc0, escon0, iucv0, or hsi0) with correct settings.

Example 4.10 Example ifconfig
/sbin/ifconfig eth0 :
Link encap:Ethernet HWaddr 02:00:01:00:00:27

inet addr:192.168.0.1 Bcast:192.168.0.255 Mask:255.255.255.0
inet6 addr: fe80::200:100:100:27/64 Scope:Link
UP BROADCAST RUNNING MULTICAST MTU:1492 Metric:1
RX packets:0 errors:0 dropped:0 overruns:0 frame:0
TX packets:0 errors:0 dropped:0 overruns:0 carrier:0
collisions:0 txqueuelen:1000
RX bytes:0 (0.0 Mb) TX bytes:0 (0.0 Mb)

4.2.6 Connecting to the SUSE Linux
Enterprise Server Installation System

After setting up your network connection, linuxrc prompts for the details of the instal-
lation source chosen earlier in the process, for example, the server IP address and the
directory in which the data is located.

Finally, linuxrc wants to know what type of display you want to use to control the in-
stallation procedure. Possible choices are X11 (X Window System), VNC (Virtual
Network Computing protocol), SSH (text mode or X11 installation via Secure Shell),
or ASCII Console.

When choosing the latter (ASCII Console), YaST will be started in text mode and
you can perform the installation directly within your terminal. See Chapter 3, YaST in
Text Mode (↑Administration Guide) for usage instructions.

NOTE: Terminal Emulation for ASCII Console

In order to be able to work with YaST in text mode, it needs to run in a terminal
with VT220/Linux emulation (also referred to as ASCII console). You will
not be able to use YaST in a 3270 terminal, for example.
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4.2.6.1 Initiating the Installation for VNC
1 After the installation option VNC has been chosen, the VNC server starts. A short

note displayed in the console provides information about which IP address and display
number is needed for a connection with vncviewer. Alternatively, a URL is given
here for entry into your Java-enabled browser to connect to the installation system.

2 Start a VNC client application on your client system. Either use vncviewer or the
VNC Java client and a Java-enabled Web browser.

3 Enter the IP address and the display number of the SUSE Linux Enterprise Server
installation system when prompted to do so.

If you connect via a Java-enabled browser, enter a URL containing the IP address
of the installation system and the appropriate port number in the format:
http://<IP address of installation system>:5801/

4 After the connection has been established, start installing SUSE Linux Enterprise
Server with YaST.

4.2.6.2 Initiating the Installation for the X Window
System

IMPORTANT: X Authentication Mechanism

The direct installation with the X Window System relies on a primitive authen-
tication mechanism based on hostnames. This mechanism is disabled on current
SUSE Linux Enterprise Server versions. Installation with SSH or VNC is preferred.

1 Make sure that the X server allows the client (the system that is installed) to connect.
Set the variableDISPLAYMANAGER_XSERVER_TCP_PORT_6000_OPEN="yes"
in the file /etc/sysconfig/displaymanager. Then restart the X server and
allow client binding to the server using xhost <client IP address>.

2 When prompted at the installation system, enter the IP address of the machine running
the X server.

3 Wait until YaST opens then start the installation.
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4.2.6.3 Initiating the Installation for SSH
To connect to an installation system with the name earth using SSH, execute ssh -X
earth. If your workstation runs on Microsoft Windows, use the ssh and telnet client
and terminal emulator putty, which is available from http://www.chiark
.greenend.org.uk/~sgtatham/putty/. Set Enable X11 forwarding in putty
under Connection > SSH > X11.

A login prompt appears. Enter root and log in with your password. Enter yast2 to
start YaST.

Proceed with the detailed description of the installation procedure that can be found in
Chapter 6, Installation with YaST (page 89).

4.3 Network Connection Types
SUSE Linux Enterprise Server for IBM System z includes network drivers for OSA
devices (ethernet, and gigabit ethernet) and HiperSockets. This chapter describes the
configuration within the SUSE Linux Enterprise Server installation system.

WARNING: CTC, ESCON, and IUCV Interfaces No Longer Supported

CTC, ESCON, and IUCV interfaces are no longer officially supported. For com-
patibility reasons, they are still usable, but with the next release of SUSE Linux
Enterprise Server the support of these interfaces will be dropped completely.

4.3.1 HiperSockets
Select your device from the list of network devices. Then enter the network device read
channel number (such as 0.0.700), the write channel number (like 0.0.701) and the data
channel number (like 0.0.702).
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Example 4.11 Supported Network Connection Types and Driver Parameters
Choose the network device.

1) IBM parallel CTC Adapter (0.0.0600)
2) IBM parallel CTC Adapter (0.0.0602)
3) IBM parallel CTC Adapter (0.0.0604)
4) IBM Hipersocket (0.0.0700)
5) IBM Hipersocket (0.0.0701)
6) IBM Hipersocket (0.0.0702)
7) IBM OSA Express Network card (0.0.050c)
8) IBM OSA Express Network card (0.0.050d)
9) IBM OSA Express Network card (0.0.050e)
10) IBM OSA Express Network card (0.0.f401)
11) IBM OSA Express Network card (0.0.f400)
12) IBM OSA Express Network card (0.0.f402)
13) IBM IUCV

> 4

Device address for read channel [0.0.700]
[0.0.700]> 0.0.700

Device address for write channel
> 0.0.701

Device address for data channel
> 0.0.702

Next, choosemanual configuration then enter the IP address, netmask, broadcast address,
IP address of the gateway, and the searchlist of the DNS server.

Example 4.12 Network Device Name
Automatic configuration via DHCP?

1) Yes
2) No

> 2

Enter your IP address
> 192.168.0.20

Enter your netmask. For a normal class C network, this is usually
255.255.255.0 [255.255.255.0]
> 255.255.255.0

Enter the IP address of the gateway. Leave empty if you don't need one
> 192.168.0.1

Enter your search domains, separated by a space:
> example.com

64 Deployment Guide



4.3.2 Gigabit Ethernet with the qeth Module
Select an IBM OSA Express Network card from the list of network devices,
and then 1 for ethernet. When prompted, enter the network device's read, write, and
data channel numbers (for example, 0.0.0600, 0.0.0601, and 0.0.0602) and
the port name, if applicable. Choose whether to enable OSI Layer 2 support.

Example 4.13 Network Device Driver Parameters
Detecting and loading network drivers
netiucv.8db02b: driver initialized

Choose the network device.
1) IBM OSA Express Network card (0.0.09a0)
2) IBM OSA Express Network card (0.0.09a1)
3) IBM OSA Express Network card (0.0.09a2)
4) IBM OSA Express Network card (0.0.0600)
5) IBM OSA Express Network card (0.0.0601)
6) IBM OSA Express Network card (0.0.0602)
7) IBM IUCV

> 4

Please choose the physical medium.
1) Ethernet
2) Token Ring

> 1

Enter the relative port number
> 0

Device address for read channel
[0.0.0600]> 0.0.0600

Device address for write channel
> 0.0.0601

Device address for data channel
> 0.0.0602

Portname to use
> DT70

Enable OSI Layer 2 support?
1) Yes
2) No

> 2
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Next, deny the DHCP configuration and enter the IP address and netmask. Now enter
the IP address of the gateway (if applicable), the search domain(s) and the IP address
of the DNS server.

Example 4.14 Network configuration
Automatic configuration via DHCP?

1) Yes
2) No

> 2

Enter your IPv4 address.
Example: 192.168.5.77/24
> 192.168.0.20

Enter your netmask. For a normal class C network, this is usually
255.255.255.0
[255.255.255.0]> 255.255.255.0

Enter the IP address of the gateway. Leave empty if you don't need one
> 192.168.0.2

Enter your search domains, separated by a space:
> example.net

Enter the IP address of your name server. Leave empty or enter "+++" if you
don't need one
> 192.168.0.1

4.4 The parmfile—Automating the
System Configuration

The installation process can be partly automated by specifying the crucial parameters
in the parmfile. The parmfile contains all the data required for network setup
and DASD configuration. In addition to that, it can be used to set up the connection
method to the SUSE Linux Enterprise Server installation system and the YaST instance
running there. User interaction is thus limited to the actual YaST installation controlled
by YaST dialogs.

The following parameters can be passed to the installation routine, which takes them
as default values for installation. All IP addresses, server names, and numerical values
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are just examples. Replace these values with the ones needed in your installation sce-
nario.

The number of lines in the parmfile is limited to 10. Specify more than one parameter
on a line. Parameter names are not case-sensitive. Separate the parameters by spaces.
You may specify the parameters in any order. Always keep the PARAMETER=value
string together in one line. For example:
Hostname=s390zvm01.suse.de HostIP=10.11.134.65

TIP: Using IPv6 during the Installation

By default you can only assign IPv4 network addresses to your machine. To
enable IPv6 during installation, enter one of the following parameters at the
bootprompt: ipv6=1 (accept IPv4 and IPv6) or ipv6only=1 (accept IPv6
only).

Some of the following parameters are required. If they are missing, the automatic process
pauses and asks you to enter the value manually.

4.4.1 General Parameters
AutoYaST=<URL> Manual=0

The AutoYaST parameter specifies the location of the autoinst.xml control
file for automatic installation. The Manual parameter controls if the other param-
eters are only default values that still must be acknowledged by the user. Set this
parameter to 0 if all values should be accepted and no questions asked. Setting
AutoYaST implies setting Manual to 0.

Info=<URL>
Specifies a location for a file from which to read additional options. This helps to
overcome the limitations of 10 lines (and 80 characters per line under z/VM) for
the parmfile. More documentation on the Info file can be found in Section 21.1.5,
“Creating the info File” (page 321). Since the Info file can typically only be ac-
cessed through the network on System z, you cannot use it to specify options re-
quired to setup the network, i.e. options described in Section 4.4.2, “Configuring
the Network Interface” (page 68). Also other linuxrc specific options such as for
debugging have to be specified in the parmfile to be effective.
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TIP: Creating a File with Autoinstallation Information

At the very end of the installation of a system you can check Clone This System
for Autoyast. This creates a ready-to-use profile as /root/autoinst.xml
that can be used to create clones of this particular installation. To create an
autoinstallation file from scratch or to edit an existing one, use the YaST module
Autoinstallation. For more information about AutoYaST, refer to Chapter 21,
Automated Installation (page 313).

4.4.2 Configuring the Network Interface
IMPORTANT: Configuring the Network Interface

The settings discussed in this section apply only to the network interface used
during installation. Configure additional network interfaces in the installed
system by following the instructions given in Section “Configuring a Network
Connection Manually” (Chapter 20, Basic Networking, ↑Administration Guide).

Hostname=zseries.example.com
Enter the fully qualified hostname.

Domain=example.com
Domain search path for DNS. Allows you to use short host names instead of fully
qualified ones.

HostIP=192.168.1.2
Enter the IP address of the interface to configure.

Gateway=192.168.1.3
Specify the gateway to use.

Nameserver=192.168.1.4
Specify the DNS server in charge.

InstNetDev=osa
Enter the type of interface to configure. Possible values areosa,hsi.ctc,escon,
and iucv. (CTC, ESCON, and IUCV are no longer officially supported).
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For the interfaces of type hsi and osa, specify an appropriate netmask and an
optional broadcast address:
Netmask=255.255.255.0
Broadcast=192.168.255.255

For the interfaces of type ctc, escon, and iucv (CTC, ESCON, and IUCV are
no longer officially supported), enter the IP address of the peer:
Pointopoint=192.168.55.20

OsaInterface=<lcs|qdio> OsaMedium=<eth|tr>
For osa network devices, specify the host interface (qdio or lcs) and the phys-
ical medium (eth for ethernet or tr for token ring).

Layer2=<0|1>
For osa QDIO ethernet and hsi devices, specify whether to enable OSI Layer 2
support.

OSAHWAddr=02:00:65:00:01:09
For Layer 2-enabledosaQDIO ethernet devices, specify themanualMAC address.
Note that this is distinct from HWAddr, which contains the default MAC address
as detected by linuxrc.

PortNo=<0|1>
For osa network devices, specify the port number (provided the device supports
this feature). The default value is 0.

Each of the interfaces requires certain setup options:

• Interfaces ctc and escon (CTC and ESCON are no longer officially supported):
ReadChannel=0.0.0424
WriteChannel=0.0.0425

ReadChannel specifies the READ channel to use. WriteChannel specifies the
WRITE channel.

• For the ctc interface (no longer officially supported), specify the protocol that should
be used for this interface:
CTCProtocol=<0/1/2>

Valid entries would be:
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Compatibility mode, also for non-Linux peers other than
OS/390 and z/OS (this is the default mode)

0

Extended mode1

Compatibility mode with OS/390 and z/OS2

• Network device type osa with interface lcs:
ReadChannel=0.0.0124
Portname=1

ReadChannel stands for the channel number used in this setup. A second port
number can be derived from this by adding one to ReadChannel. Portnumber
is used to specify the relative port.

• Interface iucv:
IUCVPeer=PARTNER

Enter the name of the peer machine.

• Network device type osa with interface qdio for OSA-Express Gigabit Ethernet
and OSA-Express High-speed Token Ring:
ReadChannel=0.0.0524
WriteChannel=0.0.0525
DataChannel=0.0.0526
Portname=FEF400

For ReadChannel, enter the number of the READ channel. For WriteChannel,
enter the number of the WRITE channel. DataChannel specifies the DATA
channel. For Portname, enter an appropriate port name. Make sure that the READ
channel carries an even device number.

• Interface hsi for HiperSockets and VM guest LANs:
ReadChannel=0.0.0624
WriteChannel=0.0.0625
DataChannel=0.0.0626
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For ReadChannel, enter the appropriate number for the READ channel. For
WriteChannel and DataChannel, enter the WRITE and DATA channel num-
bers.

4.4.3 Specifying the Installation Source and
YaST Interface

Install=nfs://server/directory/DVD1/
Specify the location of the installation source to use. Possible protocols are nfs,
smb (Samba/CIFS), ftp, and http.

If an ftp or smbURL is given, specify the username and password with the URL.
These parameters are optional and anonymous or guest login is assumed if they
are not given.
Install=ftp://user:password@server/directory/DVD1/

In case of a Samba or CIFS installation, you can also specify the domain that should
be used:
Install=smb://workdomain;user:password@server/directory/DVD1/

UseSSH=1 UseVNC=1 Display_IP=192.168.42.42
Depending on which parameter you give, a remote X server, SSH, or VNC will be
used for installation. UseSSH enables SSH installation, UseVNC starts a VNC
server on the installing machine, and Display_IP causes the installing system
to try to connect to an X server at the given address. Only one of these parameters
should be set at any time.

IMPORTANT: X Authentication Mechanism

The direct installation with the X Window System relies on a primitive au-
thentication mechanism based on hostnames. This mechanism is disabled
on current SUSE Linux Enterprise Server versions. Installation with SSH or
VNC is preferred.

To allow a connection between YaST and the remote X server, run xhost <IP
address> with the address of the installing machine on the remote machine.
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For VNC, specify a password of six to eight characters to use for installation:
VNCPassword=<a password>

For SSH, specify a password of six to eight characters to use for installation:
SSHPassword=<a password>

4.4.4 Example Parmfiles
For an automatic installation with AutoYaST in an LPAR, it is preferable that the
parmfile has just one long line. If multiple lines are desired for readability, use blank
characters at the beginning and end of each line. The maximum number of lines in a
parmfile is 10.

To receive potential error messages on the console, use
linuxrclog=/dev/console

Example 4.15 Parmfile for Installation with NFS, VNC, and IUCV and AutoYaST
with HTTP

ramdisk_size=131072 root=/dev/ram1 ro init=/linuxrc TERM=dumb
instnetdev=iucv iucvpeer=ROUTER01 pointopoint=192.168.0.1
hostip=192.168.0.2
nameserver=192.168.0.3
install=nfs://192.168.0.4/SLES/SLES-11-s390x/DVD1
autoyast=http://192.168.0.5/autoinst.xml
linuxrclog=/dev/console usevnc=1
vncpassword=testin

Example 4.16 Parmfile for Installation with NFS, SSH, and HSI and AutoYaST with
NFS

ramdisk_size=131072 root=/dev/ram1 ro init=/linuxrc TERM=dumb
AutoYast=nfs://192.168.1.1/autoinst/s390.xml
Hostname=zseries.example.com HostIP=192.168.1.2
Gateway=192.168.1.3 Nameserver=192.168.1.4
InstNetDev=hsi layer2=0
Netmask=255.255.255.128 Broadcast=192.168.1.255
readchannel=0.0.702c writechannel=0.0.702d datachannel=0.0.702e
install=nfs://192.168.1.5/SLES-11-s390x/DVD1/
UseSSH=1 SSHPassword=testing linuxrclog=/dev/console
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4.5 Using the vt220 Terminal
Emulator

Recent MicroCode Levels allow the use of an integrated vt220 terminal emulator in
addition to the standard line mode terminal. The vt220 terminal is connected to /dev/
ttyS1. The line mode terminal is connected to /dev/ttyS0. If the vt220 emulation
is available, an icon for an integrated vt220 ASCII console appears next to the icon for
the 3215 console on the HMC/SE.

To activate vt220 support on your machine, edit /etc/inittab as user root. Look
for the following line and delete the leading # sign:
#2:2345:respawn:/sbin/mingetty --noclear /dev/ttyS1 xterm

Save the file and run telinit q to pass the changes in /etc/inittab to init. The
vt220 terminal should then be ready to use. If not, try hitting Enter at the terminal until
the login prompt appears.

Make sure that you do not apply the changes as described above to a system that does
not support vt220 terminal emulators. Otherwise, login might become impossible on
this system and you will be shown the following message:
INIT respawning too fast, disabled for 5 minutes.

To redirect the kernel messages at boot time from the system console to the vt220 ter-
minal, add the following entries to the parameters line in /etc/zipl.conf:
console=ttyS0 console=ttyS1

The resulting parameters line would look like the following example:
parameters = "root=/dev/dasda2 TERM=dumb console=ttyS0 console=ttyS1"

Save the changes in /etc/zipl.conf, run zipl, and reboot the system.
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4.6 Further In-Depth Information
about IBM System z

IBM has published a number of very interesting documents about their System z plat-
form. Find them at http://www.redbooks.ibm.com.

4.6.1 IBM System z with SUSE Linux
Enterprise Server

Find additional in-depth technical documentation about the kernel and application topics
on IBM System z with SUSE Linux Enterprise Server at the following location:

• http://www.ibm.com/developerworks/linux/linux390/
documentation_novell_suse.html

4.6.2 Hardware
For a first glance at the technical details of some systems, refer to:

• IBM System z10 Enterprise Class Technical Introduction (SG24-7515)

• IBM System z9 Business Class Technical Introduction (SG24-7241)

• Linux on zSeries Fibre Channel Protocol Implementation Guide (SG24-6344)

4.6.3 General Documents about Linux on
IBM System z

A general coverage of Linux on IBMSystem z can be found in the following documents:

• Linux on IBM eServer zSeries and S/390: ISP and ASP Solutions (SG24-6299)

These documents might not reflect the current state of Linux, but the principles of
Linux deployment outlined there remain accurate.
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4.6.4 Technical Issues of Linux on IBM
System z

Refer to the following documents to get in-depth technical information about the Linux
kernel and application topics. Refer to the Internet for up-to-date versions of these
documents for the most recent code drop (http://www.ibm.com/
developerworks/linux/linux390/index.html).

• Linux on System z Device Drivers, Features, and Commands

• zSeries ELF Application Binary Interface Supplement

• Linux on System z Device Drivers, Using the Dump Tools

• IBM System z9-109 Technical Introduction (SG26-6669)

• IBM System z10 Enterprise Class Technical Guide (SG24-7516)

There also is a Redbook for Linux application development on http://www
.redbooks.ibm.com:

• Linux on IBM eServer zSeries and S/390: Application Development (SG24-6807)

4.6.5 Advanced Configurations for Linux on
IBM System z

Refer to the following Redbooks, Redpapers, and links for some more complex IBM
System z scenarios:

• Linux on IBM eServer zSeries and S/390: Large Scale Deployment (SG24-6824)

• Linux on IBM eServer zSeries and S/390: PerformanceMeasuring and Tuning (SG24-
6926)

• Linux with zSeries and ESS: Essentials (SG24-7025)

• IBM TotalStorage Enterprise Storage Server Implementing ESS Copy Services with
IBM eServer zSeries (SG24-5680)
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• Linux on IBM zSeries and S/390: High Availability for z/VM and Linux (REDP-
0220)

• Saved Segments Planning and Administration

http://publibz.boulder.ibm.com/epubs/pdf/hcsg4a00.pdf

• Linux on System z documentation for "Development stream"

http://www.ibm.com/developerworks/linux/linux390/
development_documentation.html
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Part II. Manual Deployment





5Deployment Strategies
There are several different ways to deploy SUSE Linux Enterprise Server. Choose from
various approaches ranging from a local installation using physical media or a network
installation server to a mass deployment using a remote-controlled, highly-customized,
and automated installation technique. Select the method that best matches your require-
ments.

5.1 Deploying up to 10 Workstations
If your deployment of SUSE Linux Enterprise Server only involves 1 to 10 workstations,
the easiest and least complex way of deploying SUSE Linux Enterprise Server is a plain
manual installation as featured in Chapter 6, Installation with YaST (page 89). Manual
installation can be done in several different ways, depending on your requirements:

Installing from the SUSE Linux Enterprise Server Media (page 80)
Consider this approach if you want to install a single, disconnected workstation.

Installing from a Network Server Using SLP (page 80)
Consider this approach if you have a single workstation or a small number of
workstations and if a network installation server announced via SLP is available.

Installing from a Network Server (page 81)
Consider this approach if you have a single workstation or a small number of
workstations and if a network installation server is available.
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Table 5.1 Installing from the SUSE Linux Enterprise Server Media

SUSE Linux Enterprise Server media kitInstallation Source

Tasks Requiring Manual
Interaction

• Inserting the installation media

• Booting the installation target

• Changing media

• Determining the YaST installation scope

• Configuring the system with YaST system

NoneRemotely Controlled Tasks

Installing from the SUSE Linux Enterprise Server
Media (page 89)

Details

Table 5.2 Installing from a Network Server Using SLP

Network installation server holding the SUSE Linux
Enterprise Server installation media

Installation Source

Tasks Requiring Manual
Interaction

• Inserting the boot disk

• Booting installation target

• Determining the YaST installation scope

• Configuring the system with YaST

None, but this method can be combined with VNCRemotely Controlled
Tasks

Section 6.1.1, “Installing from a Network Server
Using SLP” (page 91)

Details
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Table 5.3 Installing from a Network Server

Network installation server holding the SUSE Linux
Enterprise Server installation media

Installation Source

Tasks RequiringManual
Interaction

• Inserting the boot disk

• Providing boot options

• Booting the installation target

• Determining the YaST installation scope

• Configuring the system with YaST

None, but method can be combined with VNCRemotely Controlled
Tasks

Section 6.1.2, “Installing from a Network Source
without SLP” (page 91)

Details

5.2 Deploying up to 100 Workstations
With a growing number of workstations to install, you certainly do not want to install
and configure each one of themmanually. There are many automated or semiautomated
approaches as well as several options for performing an installation with minimal to
no physical user interaction.

Before considering a fully-automated approach, take into account that the more complex
the scenario gets the longer it takes to set up. If a time limit is associated with your de-
ployment, it might be a good idea to select a less complex approach that can be carried
out much more quickly. Automation makes sense for huge deployments and those that
need to be carried out remotely.

Choose from the following options:
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Simple Remote Installation via VNC—Static Network Configuration (page 83)
Consider this approach in a small to medium scenario with a static network setup.
A network, network installation server, and VNC viewer application are required.

Simple Remote Installation via VNC—Dynamic Network Configuration (page 83)
Consider this approach in a small to medium scenario with dynamic network setup
throughDHCP. A network, network installation server, and VNC viewer application
are required.

Remote Installation via VNC—PXE Boot and Wake on LAN (page 84)
Consider this approach in a small to medium scenario that needs to be installed via
the network and without physical interaction with the installation targets. A network,
a network installation server, network boot images, network bootable target hard-
ware, and a VNC viewer application are required.

Simple Remote Installation via SSH—Static Network Configuration (page 84)
Consider this approach in a small to medium scenario with static network setup.
A network, network installation server, and SSH client application are required.

Remote Installation via SSH—Dynamic Network Configuration (page 85)
Consider this approach in a small to medium scenario with dynamic network setup
through DHCP. A network, network installation server, and SSH client application
are required.

Remote Installation via SSH—PXE Boot and Wake on LAN (page 85)
Consider this approach in a small to medium scenario that needs to be installed via
the network and without physical interaction with the installation targets. A network,
a network installation server, network boot images, network bootable target hard-
ware, and an SSH client application are required.

Simple Mass Installation (page 86)
Consider this approach for large deployments to identical machines. If configured
to use network booting, physical interaction with the target systems is not needed
at all. A network, a network installation server, a remote controlling application
(such as a VNC viewer or an SSH client), and an AutoYaST configuration profile
are required. If using network boot, a network boot image and network bootable
hardware are required, as well.

Rule-Based Autoinstallation (page 87)
Consider this approach for large deployments to various types of hardware. If
configured to use network booting, physical interaction with the target systems is
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not needed at all. A network, a network installation server, a remote controlling
application (such as a VNC viewer or an SSH client), and several AutoYaST con-
figuration profiles as well (as a rule setup for AutoYaST) are required. If using
network boot, a network boot image and network bootable hardware are required,
as well.

Table 5.4 Simple Remote Installation via VNC—Static Network Configuration

NetworkInstallation Source

Preparations • Setting up an installation source

• Booting from the installation media

Remote: VNCControl and Monitoring

small to medium scenarios with varying hardwareBest Suited For

Drawbacks • Each machine must be set up individually

• Physical access is needed for booting

Section 14.1.1, “Simple Remote Installation via
VNC—Static Network Configuration” (page 216)

Details

Table 5.5 Simple Remote Installation via VNC—Dynamic Network Configuration

NetworkInstallation Source

Preparations • Setting up the installation source

• Booting from the installation media

Remote: VNCControl and Monitoring

Small to medium scenarios with varying hardwareBest Suited For

Drawbacks • Each machine must be set up individually
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• Physical access is needed for booting

Section 14.1.2, “Simple Remote Installation via
VNC—DynamicNetworkConfiguration” (page 217)

Details

Table 5.6 Remote Installation via VNC—PXE Boot and Wake on LAN

NetworkInstallation Source

Preparations • Setting up the installation source

• Configuring DHCP, TFTP, PXE boot, and WOL

• Booting from the network

Remote: VNCControl and Monitoring

Best Suited For • Small to medium scenarios with varying hardware

• Completely remote installs; cross-site deployment

Each machine must be set up manuallyDrawbacks

Section 14.1.3, “Remote Installation via VNC—PXE
Boot and Wake on LAN” (page 218)

Details

Table 5.7 Simple Remote Installation via SSH—Static Network Configuration

NetworkInstallation Source

Preparations • Setting up the installation source

• Booting from the installation media

Remote: SSHControl and Monitoring
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Best Suited For • Small to medium scenarios with varying hardware

• Low bandwidth connections to target

Drawbacks • Each machine must be set up individually

• Physical access is needed for booting

Section 14.1.4, “Simple Remote Installation via
SSH—Static Network Configuration” (page 220)

Details

Table 5.8 Remote Installation via SSH—Dynamic Network Configuration

NetworkInstallation Source

Preparations • Setting up the installation source

• Booting from installation media

Remote: SSHControl and Monitoring

Best Suited For • Small to medium scenarios with varying hardware

• Low bandwidth connections to target

Drawbacks • Each machine must be set up individually

• Physical access is needed for booting

Section 14.1.5, “Simple Remote Installation via
SSH—DynamicNetwork Configuration” (page 221)

Details

Table 5.9 Remote Installation via SSH—PXE Boot and Wake on LAN

NetworkInstallation Source
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Preparations • Setting up the installation source

• Configuring DHCP, TFTP, PXE boot, and WOL

• Booting from the network

Remote: SSHControl andMonitoring

Best Suited For • Small to medium scenarios with varying hardware

• Completely remote installs; cross-site deployment

• Low bandwidth connections to target

Each machine must be set up individuallyDrawbacks

Section 14.1.6, “Remote Installation via SSH—PXE
Boot and Wake on LAN” (page 222)

Details

Table 5.10 Simple Mass Installation

Preferably networkInstallation Source

Preparations • Gathering hardware information

• Creating AutoYaST profile

• Setting up the installation server

• Distributing the profile

• Setting up network boot (DHCP, TFTP, PXE,WOL)

or

Booting the target from installation media
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Local or remote through VNC or SSHControl and Monitor-
ing

Best Suited For • Large scenarios

• Identical hardware

• No access to system (network boot)

Applies only to machines with identical hardwareDrawbacks

Section 21.1, “Simple Mass Installation” (page 313)Details

Table 5.11 Rule-Based Autoinstallation

Preferably networkInstallation Source

Preparations • Gathering hardware information

• Creating AutoYaST profiles

• Creating AutoYaST rules

• Setting up the installation server

• Distributing the profile

• Setting up network boot (DHCP, TFTP, PXE,WOL)

or

Booting the target from installation media

Local or remote through SSH or VNCControl andMonitoring

Best Suited For • Varying hardware

• Cross-site deployments
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Complex rule setupDrawbacks

Section 21.2, “Rule-BasedAutoinstallation” (page 325)Details

5.3 Deploying More than 100
Workstations

Most of the considerations brought up for medium installation scenarios in Section 5.1,
“Deploying up to 10Workstations” (page 79) still hold true for large scale deployments.
However, with a growing number of installation targets, the benefits of a fully automated
installation method outweigh its drawbacks.

It pays off to invest a considerable amount of time to create a sophisticated rule and
class framework in AutoYaST to match the requirements of a huge deployment site.
Not having to touch each target separately can save you a tremendous amount of time
depending on the scope of your installation project.

As an alternative, and if user settings should be done during the first bootup, create
preload images with kiwi and firstboot. Deploying such images could even be done by
a PXE boot server specialized for this task. For more details, see Chapter 17, KI-
WI (page 283), Chapter 21,Automated Installation (page 313), and Chapter 20,Deploying
Customized Preinstallations (page 299).
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6Installation with YaST
After your hardware has been prepared for the installation of SUSE® Linux Enterprise
Server as described in Part I, “Architecture Specific Installation Considera-
tions” (page 5) and after the connection with the installation system has been estab-
lished, you are presented with the interface of SUSE Linux Enterprise Server's system
assistant YaST. YaST guides you through the entire installation and configuration
procedure.

6.1 Choosing the Installation Method
After having selected the installationmedium, determine the suitable installationmethod
and boot option that best matches your needs:

Installing from the SUSE Linux Enterprise Server Media
Choose this option if you want to perform a stand-alone installation and do not
want to rely on a network to provide the installation data or the boot infrastructure.
The installation proceeds exactly as outlined in Section 6.2, “The Installation
Workflow” (page 91).

Installing from a Network Server
Choose this option if you have an installation server available in your network or
want to use an external server as the source of your installation data. This setup
can be configured to boot from physical media (Floppy, CD/DVD, or hard disk)
or configured to boot via network using PXE/BOOTP. Refer to Section 6.1.1,
“Installing from aNetwork Server Using SLP” (page 91), Section 6.1.2, “Installing
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from a Network Source without SLP” (page 91), or Chapter 14, Remote Installa-
tion (page 215) for details.

SUSE Linux Enterprise Server supports several different boot options from which you
can choose, depending on the hardware available and on the installation scenario you
prefer. Booting from the SUSELinux Enterprise Servermedia is themost straightforward
option, but special requirements might call for special setups:

Table 6.1 Boot Options

DescriptionBoot Option

This is the easiest boot option. This option can be used if the
system has a local DVD-ROM drive that is supported by Linux.

DVD

Booting over the network must be supported by the system's
BIOS or firmware, and a boot server must be available in the

PXE or
BOOTP

network. This task can also be handled by another SUSE Linux
Enterprise Server system. Refer to Chapter 14, Remote Installa-
tion (page 215) for more information.

SUSE Linux Enterprise Server installation can also be booted
from the hard disk. To do this, copy the kernel (linux) and the

Hard Disk

installation system (initrd) from the directory
/boot/architecture/ on the installationmedia to the hard
disk and add an appropriate entry to the existing boot loader of
a previous SUSE Linux Enterprise Server installation.

TIP: Booting from DVD on UEFI machines

►amd64 em64t: DVD1 can be used as a boot medium for machines equipped
with UEFI (Unified Extensible Firmware Interface). Refer to your vendor's doc-
umentation for specific information. If booting fails, try to enable CSM (Com-
patibility Support Module) in your firmware. ◄
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6.1.1 Installing from a Network Server Using
SLP

If your network setup supports OpenSLP and your network installation source has been
configured to announce itself via SLP (described in Section 14.2, “Setting Up the
Server Holding the Installation Sources” (page 223)), boot the system, press F4 in the
boot screen and select SLP from the menu.

The installation program configures the network connection with DHCP and retrieves
the location of the network installation source from the OpenSLP server. If the automatic
DHCP network configuration fails, you are prompted to enter the appropriate parameters
manually. The installation then proceeds as described below with the exception of the
network configuration step that is needed prior to adding additional repositories. This
step is not needed as the network is already configured and active at this point.

6.1.2 Installing from a Network Source
without SLP

If your network setup does not support OpenSLP for the retrieval of network installation
sources, boot the system and press F4 in the boot screen to select the desired network
protocol (NFS, HTTP, FTP, or SMB/CIFS). Provide the server's address and the path
to the installation media.

The installation program automatically configures the network connection with DHCP.
If this configuration fails, you are prompted to enter the appropriate parameters manu-
ally. The installation retrieves the installation data from the source specified. The instal-
lation then proceeds as described belowwith the exception of the network configuration
step needed prior to adding additional repositories. This step is not needed as the network
is already configured and active at this point.

6.2 The Installation Workflow
The SUSE Linux Enterprise Server installation is split into three main parts: preparation,
installation, and configuration. During the preparation phase you configure some basic
parameters such as language, time, hard disk setup and installation scope. In the non-
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interactive installation phase the software is installed and the system is prepared for the
first boot. Upon finishing the installation the machine reboots into the newly installed
system and starts the final system configuration. In this stage, network and Internet
access, as well as hardware components such as printers, are set up.

6.3 IBM POWER: System Start-Up for
Network Installation

For IBM POWER platforms, the system is booted (IPL, Initial Program Load) as de-
scribed in Section 3.2, “Preparation” (page 23). For a network installation, SUSE Linux
Enterprise Server does not show a splash screen or a boot loader command line on these
systems. During the installation load the kernel manually. YaST starts with its installation
screen as soon as a connection has been established to the installation system via VNC,
X, or SSH. Because there is no splash screen or boot loader command line, kernel or
boot parameters cannot be entered on the screen, but must be included in the kernel
image using the mkzimage_cmdline utility.

TIP: IBM POWER: The Next Steps

To install, follow the description of the installation procedure with YaST starting
from Section 6.7, “Welcome” (page 98).

6.4 IBM System z: System Start-Up for
Installation

For IBM System z platforms, the system is booted (IPL, Initial Program Load) as de-
scribed in Section 4.2.4, “IPLing the SUSE Linux Enterprise Server Installation Sys-
tem” (page 54). SUSE Linux Enterprise Server does not show a splash screen on these
systems. During the installation, load the kernel, initrd, and parmfile manually. YaST
starts with its installation screen as soon as a connection has been established to the
installation system via VNC, X, or SSH. Because there is no splash screen, kernel or
boot parameters cannot be entered on screen, but must be specified in a parmfile (see
Section 4.4, “The parmfile—Automating the System Configuration” (page 66)).
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TIP: IBM System z: The Next Steps

To install, follow the description of the installation procedure with YaST starting
from Section 6.7, “Welcome” (page 98).

6.5 System Start-Up for Installation
You can install SUSE Linux Enterprise Server from local installation sources, such as
the SUSE Linux Enterprise Server CDs or DVD, or from network source of an FTP,
HTTP, NFS, or SMB server. Any of these approaches requires physical access to the
system to install as well as user interaction during the installation. The installation
procedure is basically the same regardless of the installation source. Any exceptions
are sufficiently highlighted in the following workflow description. For a description
on how to perform non-interactive, automated installations, refer to Part IV, “Automated
Installations” (page 311).

6.6 The Boot Screen
The boot screen displays a number of options for the installation procedure. Boot from
Hard Disk boots the installed system and is selected by default, because the CD is often
left in the drive. Select one of the other options with the arrow keys and press Enter to
boot it. The relevant options are:

Installation
The normal installation mode. All modern hardware functions are enabled. In case
the installation fails, see F5 Kernel (page 95) for boot options that disable poten-
tially problematic functions.

Repair Installed System
Boots into the graphical repair system. More information on repairing an installed
system is available in Section “Recovering a Corrupted System” (Chapter 34,
Common Problems and Their Solutions, ↑Administration Guide).

Rescue System
Starts a minimal Linux system without a graphical user interface. For more infor-
mation, see Section “Using the Rescue System” (Chapter 34, Common Problems
and Their Solutions, ↑Administration Guide).
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Check Installation Media
This option is only available when you install frommedia created from downloaded
ISOs. In this case it is recommended to check the integrity of the installation
medium. This option starts the installation system before automatically checking
the media. In case the check was successful, the normal installation routine starts.
If a corrupt media is detected, the installation routine aborts.

Firmware Test
Starts a BIOS checker that validates ACPI and other parts of your BIOS.

Memory Test
Tests your system RAM using repeated read and write cycles. Terminate the test
by rebooting. For more information, see Section “Fails to Boot” (Chapter 34,
Common Problems and Their Solutions, ↑Administration Guide).

Figure 6.1 The Boot Screen

Use the function keys indicated in the bar at the bottom of the screen to change the
language, screen resolution, installation source or to add an additional driver from your
hardware vendor:

F1 Help
Get context-sensitive help for the active element of the boot screen. Use the arrow
keys to navigate, Enter to follow a link, and Esc to leave the help screen.
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F2 Language
Select the display language and a corresponding keyboard layout for the installation.
The default language is English (US).

F3 Video Mode
Select various graphical display modes for the installation. Select Text Mode if the
graphical installation causes problems.

F4 Source
Normally, the installation is performed from the inserted installationmedium. Here,
select other sources, like FTP or NFS servers. If the installation is deployed on a
network with an SLP server, select an installation source available on the server
with this option. Find information about SLP in Chapter 21, SLP Services in the
Network (↑Administration Guide).

F5 Kernel
If you encounter problems with the regular installation, this menu offers to disable
a few potentially problematic functions. If your hardware does not support ACPI
(advanced configuration and power interface) select No ACPI to install without
ACPI support.No local APIC disables support for APIC (Advanced Programmable
Interrupt Controllers) whichmay cause problems with some hardware. Safe Settings
boots the system with the DMA mode (for CD/DVD-ROM drives) and power
management functions disabled.

If you are not sure, try the following options first: Installation—ACPI Disabled or
Installation—Safe Settings. Experts can also use the command line (Boot Options)
to enter or change kernel parameters.

F6 Driver
Press this key to notify the system that you have an optional driver update for SUSE
Linux Enterprise Server. With File or URL, load drivers directly before the instal-
lation starts. If you select Yes, you are prompted to insert the update disk at the
appropriate point in the installation process.

TIP: Using IPv6 during the Installation

By default you can only assign IPv4 network addresses to your machine. To
enable IPv6 during installation, enter one of the following parameters at the
bootprompt: ipv6=1 (accept IPv4 and IPv6) or ipv6only=1 (accept IPv6
only).
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After starting the installation, SUSE Linux Enterprise Server loads and configures a
minimal Linux system to run the installation procedure. To view the boot messages
and copyright notices during this process, press Esc. On completion of this process, the
YaST installation program starts and displays the graphical installer.

TIP: Installation without a Mouse

If the installer does not detect your mouse correctly, use Tab for navigation,
arrow keys to scroll, and Enter to confirm a selection. Various buttons or selec-
tion fields contain a letter with an underscore. Use Alt + Letter to select a button
or a selection directly instead of navigating there with the Tab button.

6.6.1 Providing Data to Access an SMT
Server

By default, updates for SUSE Linux Enterprise Server are delivered by the Novell
Customer Center. If your network provides a so called SMT server to provide a local
update source, you need to equip the client with the server's URL. Client and server
communicate solely via HTTPS protocol, therefore you also need to enter a path to the
server's certificate if the certificate was not issued by a certificate authority. This infor-
mation can either be entered at the boot prompt (as described here) or during the regis-
tration process as described in Section “Local Registration Server” (page 119).

smturl
URL of the SMT server. This URL has a fixed format
https://FQN/center/regsvc/ FQN has to be a fully qualified hostname
of the SMT server. Example:
smturl=https://smt.example.com/center/regsvc/

smtcert
Location of the SMT server's certificate. Specify one of the following locations:

URL
Remote location (http, https or ftp) fromwhich the certificate can be download-
ed. Example:
smtcert=http://smt.example.com/smt-ca.crt
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Floppy
Specifies a location on a floppy. The floppy has to be inserted at boot time, as
you will not be prompted to insert it if it is missing. The value has to start with
the string floppy followed by the path to the certificate. Example:
smtcert=floppy/smt/smt-ca.crt

local path
Absolute path to the certificate on the local machine. Example:
smtcert=/data/inst/smt/smt-ca.cert

Interactive
Use ask to open a pop-up menu during the installation where you can specify
the path to the certificate. Do not use this option with AutoYaST. Example
smtcert=ask

Deactivate certificate installation
Use done if either the certificate will be installed by an add-on product, or if
you are using a certificate issued by an official certificate authority. Example:
smtcert=done

WARNING: Beware of typing errors

Make sure the values you enter are correct. If smturl has not been specified
correctly, the registration of the update source will fail. If a wrong value for
smtcert has been entered, you will be prompted for a local path to the certifi-
cate.

In case smtcert is not specified, it will default to http://FQN/smt.crt with
FQN being the name of the SMT server.

6.6.2 Configuring an Alternative Data Server
for supportconfig

The data that supportconfig (see Chapter 2, Gathering System Information for Support
(↑Administration Guide) for more information) gathers is sent to the Novell Customer
Center by default. It is also possible to set up a local server to collect this data. If such
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a server is available on your network, you need to set the server's URL on the client.
This information has to be entered at the boot prompt.

supporturl
URL of the server. The URL has the format http://FQN/Path/ FQN has to
be full qualified hostname of the server, Path has to be replaced with the location
on the server. Example:
supporturl=http://support.example.com/supportconfig/data/

6.7 Welcome
Start the installation of SUSE Linux Enterprise Server by choosing your language.
Changing the language will automatically preselect a corresponding keyboard layout.
Override this proposal by selecting a different keyboard layout from the drop-down
menu. The language selected here is also used to assume a time zone for the system
clock. This setting—along with the selection of secondary languages to install on your
system—can be modified later in the Installation Summary, described in Section 6.13,
“Installation Settings” (page 106). For information about language settings in the installed
system, see Chapter 13,Changing Language and Country Settings with YaST (page 207).

Read the license agreement that is displayed beneath the language and keyboard selection
thoroughly. Use License Translations... to access translations. If you agree to the terms,
check I Agree to the License Terms and click Next to proceed with the installation. If
you do not agree to the license agreement, you cannot install SUSE Linux Enterprise
Server; click Abort to terminate the installation.
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Figure 6.2 Welcome

6.8 IBM System z: Hard Disk
Configuration

When installing on IBM System z platforms, the language selection dialog is followed
by a dialog to configure the attached hard disks. Select DASD, Fibre Channel Attached
SCSI Disks (ZFCP), or iSCSI for installation of SUSE Linux Enterprise Server.

TIP: Adding DASD or zFCP Disks at a Later Stage

Adding DASD or zFCP disks is not only possible during the installation workflow,
but also when the installation proposal is shown. To add disks at that stage,
click Expert and scroll down. The DASD and zFCP entries are shown at the very
bottom.

After adding the disks, reread the partition table. Return to the installation
proposal screen and choose Partitioning then select Reread Partition Table.
This updates the new partition table.
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6.8.1 Configuring DASD Disks
After selecting Configure DASD Disks, an overview lists all available DASDs. To get
a clearer picture of the available devices, use the entry field located above the list to
specify a range of channels to display. To filter the list according to such a range, select
Filter.

Figure 6.3 IBM System z: Selecting a DASD

Specify the DASDs to use for the installation by selecting the corresponding entries in
the list. Click Select or Deselect. Activate and make the DASDs available for the instal-
lation by selecting Perform Action > Activate. To format the DASDs, select Perform
Action >Format right away or use the YaST partitioner later as described in Section 15.1,
“Using the YaST Partitioner” (page 251).

6.8.2 Configuring zFCP Disks
To use zFCP disks for the SUSE Linux Enterprise Server installation, select Configure
zFCP Disks in the selection dialog. This opens a dialog with a list of the zFCP disks
available on the system. In this dialog, select Add to open another dialog in which to
enter zFCP parameters.
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To make a zFCP disk available for the SUSE Linux Enterprise Server installation,
choose an available Channel Number from the drop-down list. Get WWPNs (World
Wide Port Number) and Get LUNs (Logical Unit Number) return lists with available
WWPNs and FCP-LUNs, respectively, to choose from.When completed, exit the zFCP
dialog with Next and the general hard disk configuration dialog with Finish to continue
with the rest of the configuration.

6.9 Media Check
Themedia check dialog only appears if you install frommedia created from downloaded
ISOs. If you install from the original media kit, the dialog is skipped.

The media check examines the integrity of a medium. To start it, select the drive that
contains the installation medium and click Start Check. The check can take some time.

To test multiple media, wait until a result message appears in the dialog before changing
the medium. If the last medium checked is not the one you started the installation with,
YaST prompts for the appropriate medium before continuing with the installation.

If using ISO images (for example, for installing add-on products), clickCheck ISO File
and choose the image via the file dialog.

WARNING: Failure of Media Check

If the media check fails, your medium is damaged. Do not continue the instal-
lation because installation may fail or you may loose your data. Replace the
broken medium and restart the installation process.

If the media check turns out positive, click Next to continue the installation.

6.10 Installation Mode
After a system analysis (where YaST probes for storage devices and tries to find other
installed systems on your machine) the available installation modes are displayed.

New installation
Select this option to start a new installation from scratch.
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Update
Select this option to update an existing installation to a newer version. For more
information about system update, see Chapter 7, Updating SUSE Linux Enter-
prise (page 127).

Repair Installed System
Choose this option to repair a damaged system that is already installed. More infor-
mation is available in Section “Recovering a Corrupted System” (Chapter 34,
Common Problems and Their Solutions, ↑Administration Guide).

Figure 6.4 Installation Mode

Check Include Add-On Products from Separate Media to include add-on products
during the installation. An add-on product can include extensions, third-party products
and drivers or additional software for your system.

TIP: Installing Product Patches from an SMT Server on Installation

In case your organization provides the update channel for SUSE Linux Enterprise
Server via an SMT server, it is possible to specify this channel as an Add-On
product by entering its HTTP address. As a consequence, the system will be
installed with the most current packages without having to apply the updates
at the end of the installation.
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Click Next to proceed. If you selected to include an add-on product, proceed with Sec-
tion 6.10.1, “Add-On Products” (page 103), otherwise skip the next section and advance
to Section 6.11, “Clock and Time Zone” (page 104).

6.10.1 Add-On Products
Add-on products can be installed either from a local source (CD, DVD, or directory)
or from a network source (HTTP, FTP, NFS, CIFS,...). When installing from a network
source, you need to configure the network first (unless you are performing a network
installation— in this case the existing network configuration is used). Choose Yes, Run
the Network Setup and proceed as described in Section 6.10.1.1, “Network Set-
up” (page 103). If the add-on product is available locally, select No, Skip the Network
Setup.

Click Next and specify the product source. Source types available are CD, DVD, Hard
Disk, USB Mass Storage, a Local Directory or a Local ISO Image (if no network was
configured). If the add-on product is available on removable media, the system automat-
ically mounts the media and reads its contents. If the add-on product is available on
hard disk, choose Hard Disk to install from an unmounted hard drive, or Local Direc-
tory/Local ISO Image to install from the local file system. Add-on products may be
delivered as a repository or as a set of rpm files. In the latter case, check Plain RPM
Directory. Whenever a network is available, you can choose from additional remote
sources such as HTTP, SLP, FTP, etc. It is also possible to specify a URL directly.

Check Download Repository Description Files to download the files describing the
repository now. If unchecked, they will be downloaded once the installation starts.
Proceed with Next and insert a CD or DVD if required. Depending on the product's
content it may be necessary to accept additional license agreements.

It is also possible to configure add-on products later. Using add-on products on the in-
stalled system is described in Chapter 10, Installing Add-On Products (page 183).

6.10.1.1 Network Setup
When invoking the network setup, YaST scans for available network cards. If more
than one network card is found, you must choose the card to configure from the list.

If an ethernet network adapter is not already connected, a warning will open. Make
sure the network cable is plugged in and choose Yes, Use It. If your network is equipped
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with a DHCP server, choose Automatic Address Setup (via DHCP). To manually set
up the network choose Static Address Setup and specify IP Address, Netmask, Default
Gateway IP, and the DNS Server IP.

Some networks require the use of a proxy server to access the Internet. Tick the check
boxUse Proxy for Accessing the Internet and enter the appropriate specifications. Click
Accept to perform the network setup. The installation procedure will continue with the
add-on products or repositories setup as described in Section 6.10.1, “Add-On Prod-
ucts” (page 103).

6.11 Clock and Time Zone
In this dialog, select your region and time zone. Both are preselected according to the
selected installation language. To change the preselected values, either use the map or
the drop down lists for Region and Time Zone. When using the map, point the cursor
at the rough direction of your region and left-click to zoom. Now choose your country
or region by left-clicking. Right-click to return to the world map.

Figure 6.5 Clock and Time Zone

To set up the clock, choose whether the Hardware Clock is Set to UTC. If you run an-
other operating system on your machine, such as Microsoft Windows, it is likely your
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system uses local time instead. If you only run Linux on your machine, set the hardware
clock to UTC and have the switch from standard time to daylight saving time performed
automatically.

If a network is already configured, you can configure time synchronization with an
NTP server. Click Change to either alter the NTP settings or toManually set the time.
See Chapter 22, Time Synchronization with NTP (↑Administration Guide) for more in-
formation on configuring the NTP service. When finished, click Accept to continue the
installation.

NOTE: Time Cannot be Changed on IBM System z

Since the operating system is not allowed to change time and date directly,
the Change option is not available on IBM System z.

6.12 Server Base Scenario
In SUSE Linux Enterprise Server, you can choose from three base scenarios. The se-
lected scenario affects the package selection.

Physical Machine
Choose this scenario when installing on a “real” machine or a fully virtualized
guest.

Virtual Machine
Choose this scenario when installing a para-virtualized guest.

XEN Virtualization Host
Choose this scenario when installing on amachine that should serve as a XEN host.
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Figure 6.6 Server Base Scenario

6.13 Installation Settings
On the last step before the real installation takes place, you can alter installation settings
suggested by YaST and also review the settings you made so far. Basic settings can be
changed in the Overview tab, advanced options are available on the Experts tab. To
modify the suggestions, either click Change and select the category to change or click
on one of the headlines. After configuring any of the items presented in these dialogs,
you are always returned to the Installation Settings window, which is updated accord-
ingly.
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Figure 6.7 Installation Settings

TIP: Restoring the Default Settings

You can reset all changes to the defaults by clicking Change > Reset to Defaults.
YaST then shows the original proposal again.

6.13.1 Partitioning (Overview)
Review and, if necessary, change the partition setup proposed by the system. Changing
the partition setup either lets you partition a specific disk or, when choosing Custom
Partitioning, apply your own partitioning scheme. Modifying the partition setup opens
the Expert Partitioner described in Section 15.1, “Using the YaST Partitioner” (page 251).

TIP: Btrfs as a default filesystem

The default partitioning scheme is based on Ext3 filesystem. To use Btrfs as a
default filesystem instead, click Partitioning in the Overview tab and check Use
Btrfs as Default Filesystem
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NOTE: Using Minidisks in z/VM

If SUSE Linux Enterprise Server is installed on minidisks in z/VM, which reside
on the same physical disk, the access path of the minidisks (/dev/disk/by-id/)
is not unique but rather the ID of the physical disk. So if two or more minidisks
are on the same physical disk, they all have the same ID.

To avoid problems when mounting the minidisks, always mount them either
"by path" or "by UUID".

6.13.2 Booting (Expert)
►System z: This module cannot be used to configure the boot loader (zipl) on the
IBM System z platforms. ◄

YaST proposes a boot configuration for your system. Other operating systems found
on your computer, such as Microsoft Windows or other Linux installations, will auto-
matically be detected and added to the boot loader. However, SUSE Linux Enterprise
Server will be booted by default. Normally, you can leave these settings unchanged. If
you need a custom setup, modify the proposal for your system. For information, see
Section “Configuring the Boot Loader with YaST” (Chapter 10, The Boot Loader
GRUB, ↑Administration Guide).

6.13.3 Software (Overview)
SUSE Linux Enterprise Server contains a number of software patterns for various ap-
plication purposes. Click Software to start the pattern selection and modify the installa-
tion scope according to your needs. Select your pattern from the list and see a pattern
description in the right part of the window. Each pattern contains a number of software
packages needed for specific functions (e.g. Web and LAMP server or a print server).
For a more detailed selection based on software packages to install, select Details to
switch to the YaST Software Manager.

You can also install additional software packages or remove software packages from
your system at any later time with the YaST Software Manager. For more information,
refer to Chapter 9, Installing or Removing Software (page 165).
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Figure 6.8 Software Selection and System Tasks

NOTE: Default Desktop

The default desktop of SUSE Linux Enterprise Server is GNOME. To install KDE,
click Software and select KDEDesktop Environment from Graphical Environment.

6.13.4 Language (Overview)
Here you can change the system Language you defined in the first step of the installation.
It is also possible to add additional languages. To adjust the system language settings,
select Language. Select a language from the list. The primary language is used as the
system language. You can also adapt keyboard layout and time zone to the primary
language if the current settings differ. Details lets you modify language settings for the
user root, set UTF-8 support, or further specify the language (e.g. select South African
English).

Choose secondary languages to be able to switch to one of these languages at any time
without having to install additional packages. For more information, see Chapter 13,
Changing Language and Country Settings with YaST (page 207).
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6.13.5 Add-On Products (Expert)
If you added a source for an add-on media earlier, it appears here. Add, remove, or
modify add-on products here, if needed.This is the same configuration dialog as dis-
cussed earlier in Section 6.10.1, “Add-On Products” (page 103).

6.13.6 Keyboard Layout (Expert)
To change the keyboard layout, select Keyboard Layout. By default, the layout corre-
sponds to the language chosen for installation. Select the keyboard layout from the list.
Use the Test field at the bottom of the dialog to check if you can enter special characters
of that layout correctly. Options to fine-tune various settings are available under Expert
Mode. When finished, click Accept to return to the installation summary.

6.13.7 Time Zone (Expert)
Adjust time zone and clock settings here. Provided a network is configured, you can
also set up a Network Time Protocol (NTP) client that automatically synchronizes your
computer with a time server. This is the same configuration as shown earlier in Sec-
tion 6.11, “Clock and Time Zone” (page 104).

6.13.8 Default Runlevel (Expert)
SUSE Linux Enterprise Server can boot to different runlevels. Normally, there should
be no need to change anything here, but if necessary set the default runlevel with this
dialog. Refer to Section “Configuring System Services (Runlevel) with YaST” (Chap-
ter 9, Booting and Configuring a Linux System, ↑Administration Guide) for more infor-
mation about runlevel configuration.

6.13.9 System (Expert)
This dialog presents all the hardware information YaST could obtain about your com-
puter.When called, the hardware detection routine is started. Depending on your system,
this may take some time. Select any item in the list and click Details to see detailed
information about the selected item. Use Save to File to save a detailed list to either the
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local file system or a floppy. Advanced users can also change the PCI ID setup and
Kernel Settings by choosing Kernel Settings.

6.13.10 Kdump (Expert)
Using kdump, you can save a dump of the kernel (in case of a crash) to analyze what
went wrong. Use this dialog to enable and configure kdump. Find detailed information
at Chapter 18, kexec and kdump (↑System Analysis and Tuning Guide).

6.14 Performing the Installation
After configuring all installation settings, click Install in the Installation Settings window
to start the installation. Some software may require a license confirmation. If your
software selection includes such software, license confirmation dialogs are displayed.
Click Accept to install the software package. When not agreeing to the license, click I
Disagree and the software package will not be installed. In the dialog that follows,
confirm with Install again.

The installation usually takes between 15 and 30 minutes, depending on the system
performance and the selected software scope. After having prepared the hard disk and
having saved and restored the user settings, the software installation starts.

After the software installation has completed, the basic system is set up. Among others,
“Finishing the Basic Installation” includes installing the boot manager, initializing fonts
and more. Next YaST boots into the new Linux system to start the system configuration.

TIP: Existing SSH Host Keys

If you install SUSE Linux Enterprise Server on a machine with existing Linux in-
stallations, the installation routine automatically imports the SSH host key with
the most recent access time from an existing installation.

Installation with YaST 111



6.14.1 IBM System z: IPLing the Installed
System

In most cases, YaST automatically reboots into the installed system on the IBM System
z platform. Known exceptions to this are installations wherein the bootloader resides
on an FCP device in environments with LPAR on amachine older than z9 or with z/VM
older than release 5.3. The bootloader gets written to the device that holds the /boot
directory. If /boot is not on a separate partition, it is on the same partition as the root
file system /.

In cases where an automatic reboot is not possible, YaST will show a dialog box con-
taining information about from which device to do an IPL. Accept the shutdown option
and perform an IPL after the shutdown. The procedure varies according to the type of
installation:

LPAR Installation
In the IBMSystem z HMC, select Load, selectClear, then enter the loading address
(the device address of the device holding the /boot directory with the bootloader).
If using a ZFCP disk as the boot device, choose Load from SCSI and specify the
load address of your FCP adapter as well as WWPN and LUN of the boot device.
Now start the loading process.

z/VM Installation
Log in to the VM guest (see Example 4.5, “Configuration of a z/VM Directo-
ry” (page 53) for the configuration) as LINUX1 and proceed to IPL the installed
system:
IPL 151 CLEAR

151 is an example address of the DASD boot device, replace this value with the
correct address.

If using a ZFCP disk as the boot device, specify both the ZFCP WWPN and LUN
of the boot device before initiating the IPL. The parameter length is limited to eight
characters. Longer numbers must be separated by spaces:
SET LOADDEV PORT 50050763 00C590A9 LUN 50010000 00000000

Finally, initiate the IPL:
IPL FC00
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FC00 is an example address of the ZFCP adapter, replace this value with the correct
address.

6.14.2 IBM System z: Connecting to the
Installed System

After IPLing the installed system, establish a connection with it to complete the instal-
lation. The steps involved in this vary depending on the type of connection used at the
outset.

6.14.2.1 Using VNC to Connect
A message in the 3270 terminal asks you to connect to the Linux system using a VNC
client. This message is easily missed, however, because it is mixed with kernel messages
and the terminal process might quit before you become aware of the message. If nothing
happens for five minutes, try to initiate a connection to the Linux system using a VNC
viewer.

If you connect using a Java-capable browser, enter the complete URL, consisting of
the IP address of the installed system along with the port number, in the following
fashion:
http://<IP of installed system>:5801/

6.14.2.2 Using X to Connect
When IPLing the installed system, make sure that the X server used for the first phase
of the installation is up and still available before booting from the DASD. YaST opens
on this X server to finish the installation. Complications may arise if the system is
booted up but unable to connect to the X server in a timely fashion.

6.14.2.3 Using SSH to Connect

IMPORTANT: IBM System z: Connecting from a Linux or UNIX System

Start SSH in an xterm. Other terminal emulators lack complete support for the
text-based interface of YaST.
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A message in the 3270 terminal asks you to connect to the Linux system with an SSH
client. This message is easily missed, however, because it is mixed with kernel messages
and the terminal process might quit before you become aware of the message.

Once the message appears, use SSH to log in to the Linux system as root. If the con-
nection is denied or times out, wait for the login timeout to expire, then try again (this
time may vary depending on server settings).

When the connection is established, execute the command
/usr/lib/YaST2/startup/YaST2.ssh. Just executing the command yast
does not suffice in this case.

YaST then begins completing the installation of the remaining packages and creating
an initial system configuration.

6.15 Configuration of the Installed
System

The system is now installed, but not yet configured for use. The hardware, the network
and other services are not yet set up.

6.15.1 System Configuration
Having rebooted, the system starts the manual configuration. If the configuration fails
at one of the steps of this stage, it restarts and continues from the last successful step.

6.15.1.1 Password for the System Administrator
“root”

root is the name of the superuser, the administrator of the system. Unlike regular
users, who may or may not have permission to execute administrative commands on
the system, root has unlimited command capacity, for instance changing the system
configuration, installing programs, and setting up new hardware. If users forget their
passwords or have other problems with the system, root can help. The root account
should only be used for system administration, maintenance, and repair. Logging in as
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root for daily work is rather risky: a single mistake could lead to the irretrievable loss
of system files.

For verification purposes, the password for rootmust be entered twice. Do not forget
the root password. Once entered, this password cannot be retrieved.

When typing passwords, the characters are replaced by dots, so you do not see the string
you are typing. If you are unsure whether you have typed the correct string, use the
Test Keyboard Layout field for testing purposes.

SUSE Linux Enterprise Server can use the DES, MD5, or Blowfish encryption algo-
rithms for passwords. The default encryption type is Blowfish. To change the encryption
type, click Expert Options > Encryption Type and select the new type.

The root can be changed any time later in the installed system. To do so run YaST
and start Security and Users > User and Group Management.

6.15.1.2 Hostname and Domain Name
The hostname is the computer's name in the network. The domain name is the name of
the network. A hostname and domain are proposed by default. If your system is part
of a network, the hostname has to be unique in this network, whereas the domain name
has to be common to all hosts on the network.

In many networks, the system receives its name over DHCP. In this case it is not nec-
essary to modify the proposed hostname and domain name. Select Change Hostname
via DHCP instead. To be able to access your system using this hostname, even when
it is not connected to the network, selectAssign Hostname to Loopback IP. Do not enable
this option when your machine provides network services. If you often change networks
without restarting the desktop environment (e.g. when switching between different
WLANs), do not enable this option either, because the desktop systemmay get confused
when the hostname in /etc/hosts changes.

To change hostname settings at any time after installation, use YaST Network Devices
> Network Settings. For more information, see Section “Configuring the Network Card
with YaST” (Chapter 20, Basic Networking, ↑Administration Guide).
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6.15.1.3 Network Configuration

TIP: IBM System z: Network Configuration

For the IBM System z platforms, a working network connection is needed at
installation time to connect to the target system, the installation source, and
the YaST terminal controlling the process. The steps to set up the network are
discussed in Section 4.2.5, “Network Configuration” (page 59). The IBM System
z platforms only support the types of network interfaces mentioned there (OSA
Ethernet, OSA Gigabit Ethernet, OSA Express Fast Ethernet, Escon, and IUCV).
The YaST dialog simply displays the interface with its settings as already config-
ured. Just confirm this dialog to continue.

By default, Traditional Method without NetworkManager Applet is enabled. If desired,
you can also use NetworkManager to manage all your network devices. However, the
traditional method is the preferred option for server solutions. Find detailed information
about NetworkManager in Chapter 25,UsingNetworkManager (↑AdministrationGuide).

The network can also be configured after the system installation has been completed.
If you skip it now, your system is left offline unable to retrieve any available updates.
To configure your network connection later, select Skip Configuration and click Next.

The following network settings can be configured in this step:

General Network Settings
Enable or disable the use of NetworkManager as described above. Also change the
IPv6 support here. By default the IPv6 support is enabled. To disable it, click Dis-
able IPv6. For more information about IPv6, see Section “IPv6—The Next Gener-
ation Internet” (Chapter 20, Basic Networking, ↑Administration Guide).

Firewall
By default SuSEFirewall2 is enabled on all configured network interfaces. To
globally disable the firewall for this computer, click on Disable. If the firewall is
enabled, youmayOpen the SSH port in order to allow remote connections via secure
shell. To open the detailed firewall configuration dialog, click on Firewall. See
Section “Configuring the Firewall with YaST” (Chapter 15, Masquerading and
Firewalls, ↑Security Guide) for detailed information.
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Network Interfaces
All network cards detected by YaST are listed here. If you have already set up a
network connection during the installation (as described in Section 6.10.1.1,
“Network Setup” (page 103)) the card used for this connection is listed as Config-
ured. A click on Network Interfaces opens the Network Settings dialog, where you
can change existing configurations, set up networks cards not configured yet, or
add and configure additional cards.

DSL Connections, ISDN Adapters, andModems
If your computer is equipped with an internal DSLmodem, an internal ADSL Fritz
Card, an ISDN card or a modem, clicking on the respective headline opens the
configuration dialog. Refer to Chapter 11, Accessing the Internet (page 187) for
further information.

VNC Remote Administration
To enable remote administration of your machine via VNC, click VNC Remote
Administration. Choose Allow Remote Administration in the following dialog and
adjust your firewall settings accordingly.

Proxy
If you have a proxy server controlling the Internet access in your network, configure
the proxy URLs and authentication details in this dialog.

TIP: Resetting the Network Configuration to the Default Values

Reset the network settings to the original proposed values by clicking Change
> Reset to Defaults. This discards any changes made.

Test Internet Connection

After having configured a network connection, you can test it. For this purpose, YaST
establishes a connection to the SUSE Linux Enterprise Server server and downloads
the latest release notes. Read them at the end of the installation process. A successful
test is also a prerequisite for the automatic addition of the default repositories and for
updating online.

If you have multiple network interfaces, verify that the desired card is used to connect
to the Internet. If not, click Change Device.
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To start the test, select Yes, Test Connection to the Internet and click Next. In the fol-
lowing dialog, view the progress of the test and the results. Detailed information about
the test process is available via View Logs. If the test fails, click Back to return to the
network configuration to correct your entries.

Proceed withNext. If the test was successful, the official software repositories for SUSE
Linux Enterprise Server and the update repository will be configured. Downloading
the repository data for the first time may take some time.

If you do not want to test the connection at this point, select No, Skip This Test then
Next. This also skips downloading the release notes, configuring the customer center
and updating online. These steps can be performed any time after the system has been
initially configured.

6.15.1.4 Novell Customer Center Configuration
To get technical support and product updates, you need to register and activate your
product with the Novell Customer Center. The Novell Customer Center Configuration
provides assistance for doing so. Find detailed information about Novell Customer
Center at http://www.novell.com/documentation/ncc/.

If you are offline or want to skip this step, selectConfigure Later. This also skips SUSE
Linux Enterprise Server's online update.

In Include for Convenience, select whether to send unsolicited additional information,
such as yourHardware Profile orOptional Informationwhen registering. This simplifies
the registration process. Click on Details to get in-depth information about how the
data will be collected. In order to obtain information about which data will be sent for
your specific product, the Novell server will be connected. Upon this initial connect no
data other than the ID of your product will be sent to the Novell servers.

In order to become entitled for support, make sure to check Registration Code. You
will be prompted to enter the code when proceeding with Next. Find more information
about the technical support at http://www.novell.com/products/server/
services_support.html.
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NOTE: Data Privacy

No information is passed to anyone outside Novell. The data is used for statis-
tical purposes and to enhance your convenience regarding driver support and
your Web account. Find a link to the detailed privacy policy by clicking on De-
tails. View the information transmitted in the log file at /root/.suse
_register.log.

Apart from activating and registering your product, this module also adds the official
update repositories to your configuration. These repositories provide fixes for known
bugs or security issues which can be installed via an online update.

To keep your repositories valid, select Regularly Synchronize with Customer Center.
This option checks your repositories and adds newly available catalogs or removes
obsolete ones. It does not affect manually-added repositories.

Proceed with Next. A connection with the Novell server is established. Follow the on-
screen instructions to finish the registration.

Local Registration Server

If your organization provides a local registration server instead of using the Novell
Customer Center, you need to specify the server's URL. Client and server communicate
solely via HTTPS protocol, therefore you also need to enter a path to the server's cer-
tificate if the certificate was not issued by a certificate authority. Open the dialog with
Advanced > Local Registration Server

Registration Server
URL of the registration server. The URL has a fixed format
https://FQN/center/regsvc/ FQN has to be full qualified hostname of
the registration server. Example:
https://smt.example.com/center/regsvc/

Server CA certificate location
Location of the registration server's certificate. Specify one of the following loca-
tions:

URL
Remote location (http, https or ftp) fromwhich the certificate can be download-
ed. Example:
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http://smt.example.com/smt-ca.crt

Floppy
Specifies a location on a floppy. The floppy has to be inserted before proceed-
ing. The value has to start with the string floppy followed by the path to the
certificate. Example:
floppy/smt/smt-ca.crt

local path
Absolute path to the certificate on the local machine. Example:
/data/inst/smt/smt-ca.cert

Interactive
Use ask to open a pop-up menu where you can specify the path to the certifi-
cate. Do not use this option with AutoYaST. Example
ask

Deactivate certificate installation
Use done if either the certificate will be installed by an add-on product, or if
you are using a certificate issued by an official certificate authority. Example:
done

6.15.1.5 Online Update
If an Internet connection has been established, and updates are available, select whether
to perform a YaST online update. If there are any patched packages available on the
servers, download and install them now to fix known bugs or security issues. For detailed
instructions see Chapter 1, YaST Online Update (↑Administration Guide). Directives
on how to perform an online update in the installed system are available at Section 9.4,
“Keeping the System Up-to-date” (page 177) or Chapter 1, YaST Online Update (↑Ad-
ministration Guide). This step is skipped if no updates are available or no Internet
connection has been established. Patches fixing security issues and recommended
patches applying to your installation are automatically preselected. ClickAccept to install
them and Next to proceed with the system configuration.

IMPORTANT: Downloading Software Updates

The download of updates might take quite some time, depending on the
bandwidth of the Internet connection and the size of the update files. In case
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the patch system itself is updated, the online update will restart and download
more patches after the restart. If the kernel was updated, the system will reboot
before completing the configuration.

6.15.1.6 Services Configuration
After testing the Internet connection and downloading the first updates, a dialog opens
in which to enable and configure three network services.

CA Management
The purpose of a CA (certificate authority) is to guarantee a trust relationship among
all network services communicating with each other.Without a CA, you can secure
server communications with SSL and TLS separately for each individual service.
By default, a CA is created and enabled during the installation. Find details about
the creation of a CA with YaST in Chapter 17, Managing X.509 Certification
(↑Security Guide).

OpenLDAP Server
You can run an LDAP service on your host to have a central facility manage a
range of configuration files. Typically, an LDAP server handles user account data,
but with SUSE Linux Enterprise Server it can also be used for mail, DHCP, and
DNS data. By default, an LDAP server is set up during the installation. If you decide
against the use of an LDAP server, the YaST mail server module does not work
because it depends on LDAP functionality. However, you can still set up a mail
server on your systemwith the help of theMail Transfer Agentmodule. Find details
about LDAP and its configuration with YaST in Chapter 4, LDAP—A Directory
Service (↑Security Guide).

Services
The CIM (Common InformationModel) Server is started by default. ClickDisable
to prevent the server automatically stating at boot time. For more information on
CIM services refer to Chapter 32,Web Based Enterprise Management using SFCB
(↑Administration Guide).

If preferred, you can skip this configuration proposal for now. After the installation is
finished, configure and start the same services with the help of YaST.
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TIP: Resetting the Service Configuration to Defaults

Restore the defaults by clicking Change > Reset to Defaults. This discards any
changes made.

6.15.1.7 User Authentication Method
If network access was configured successfully during the previous steps of the installa-
tion, you can now choose from several user management options. If a network connection
has not been configured, create local user accounts. You may also, if present, import
users from a previous installation. Also change the password encryption type in this
dialog.

You can also add additional user accounts or change the user authentication method in
the installed system. For detailed information about user management, see Chapter 12,
Managing Users with YaST (page 191).

The default authentication method is Local (/etc/passwd). If a former version of SUSE
Linux Enterprise Server or another system using /etc/passwd is detected, you may
import local users. To do so, check Read User Data from a Previous Installation and
click Choose. In the next dialog, select the users to import and finish with OK.

Manually enter local users by clicking Next. The New Local User dialog opens. After
entering the first name and last name, either accept the proposal or specify a new
Username that will be used to log in. Finally, enter a password for the user. Reenter it
for confirmation (to ensure that you did not type something else by mistake). To provide
effective security, a password should be between five and eight characters long. The
maximum length for a password is 72 characters. However, if no special security
modules are loaded, only the first eight characters are used to discern the password.
Passwords are case-sensitive. Special characters (7-bit ASCII) and the digits 0 to 9 are
allowed. Other special characters like umlauts or accented characters are not allowed.

Passwords you enter are checked for weakness. When entering a password that is easy
to guess, such as a dictionary word or a name, you will see a warning. It is a good secu-
rity practice to use strong passwords.

Two additional options are available:

122 Deployment Guide



Receive System Mail
Checking this box sends messages created by the system services to the user. These
are usually only sent to root, the system administrator. This option is useful for
the most frequently used account, because it is highly recommended to log in as
root only in special cases.

The mails sent by system services are stored in the local mailbox /var/spool/
mail/username, where username is the login name of the selected user. To
read e-mails after installation, you can use any e-mail client, for example KMail
or Evolution.

Automatic Login
This option automatically logs the current user in to the system on startup. This is
mainly useful if the computer is operated by only one user. For automatic login to
work, the option must be explicitly enabled.

WARNING: Automatic Login

With automatic login enabled, the system boots straight to your desktop with
no authentication at all. If you store sensitive data on your system, you should
not enable this option if the computer can also be accessed by others.

Enter more users by calling the User Management module described in Chapter 12,
Managing Users with YaST (page 191).

When using a network server for user authentication, access to the following services
can be configured:

LDAP
Users are administered centrally on an LDAP server for all systems in the network.
More information is available in Section “Configuring an LDAPClient with YaST”
(Chapter 4, LDAP—A Directory Service, ↑Security Guide).

NIS
Users are administered centrally on a NIS server for all systems in the network.
See Section “Configuring NIS Clients” (Chapter 3, Using NIS, ↑Security Guide)
for more information.
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Windows Domain
SMB authentication is often used in mixed Linux andWindows networks. Detailed
information is available in Section “Samba Server in the Network with Active Di-
rectory” (Chapter 26, Samba, ↑Administration Guide) and Section “Configuring a
Linux Client for Active Directory” (Chapter 5, Active Directory Support, ↑Security
Guide).

Along with user administration via LDAP andNIS, you can use Kerberos authentication.
To use it, select Set Up Kerberos Authentication. For more information on Kerberos,
refer to Chapter 6, Network Authentication with Kerberos (↑Security Guide).

6.15.1.8 Release Notes
After completing the user authentication setup, YaST displays the release notes. Reading
them is recommended, because they contain important up-to-date information which
was not available when the manuals were printed. If you successfully tested the Internet
connection, read the most recent version of the release notes, as fetched from SUSE
Linux Enterprise Server's servers. UseMiscellaneous > Release Notes in YaST or start
the SUSE Help Center to view the release notes after installation.

6.15.1.9 Hardware Configuration
At the end of the installation, YaST opens a dialog for the configuration of Graphics
Cards Printer and Sound. Click the individual components to start the hardware confi-
guration. For the most part, YaST detects and configures the devices automatically.

TIP: IBM System z: Hardware Configuration

On the IBM System z, there is no display that would be supported by XFree.
Accordingly, you do not find a Graphics Cards entry on these systems.

You can skip any peripheral devices and configure them later, as described in Chapter 8,
Setting Up Hardware Components with YaST (page 147). To skip the configuration,
select Skip Configuration and click Next.

However, when setting up a desktop system you should configure the graphics card
right away. Although the display settings as configured by YaST should be generally
acceptable, most users have very strong preferences as far as resolution, color depth,
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and other graphics features are concerned. To change these settings, select the respective
item and set the values as desired.

TIP: Resetting Hardware Configuration to the Default Values

You can cancel any changes to the hardware configuration by clicking Change
> Reset to Defaults. YaST then shows the original proposal again.

6.15.1.10 Installation Completed
After a successful installation, YaST shows the Installation Completed dialog. In this
dialog, select whether to clone your newly installed system for AutoYaST. To clone
your system, select Clone This System for AutoYaST. The profile of the current system
is stored in /root/autoyast.xml. Cloning is selected by default.

AutoYaST is a system for installing one or more SUSE Linux Enterprise Server systems
automatically without user intervention. AutoYaST installations are performed using
a control file with installation and configuration data.For detailed information, refer to
Chapter 21, Automated Installation (page 313). Finish the installation of SUSE Linux
Enterprise Server with Finish in the final dialog.

6.16 Graphical Login
TIP: IBM System z: No Graphical Login

The graphical login is not available on IBM System z platforms.

SUSE Linux Enterprise Server is now fully installed and configured. Unless you enabled
the automatic login function or customized the default runlevel, you should see the
graphical login on your screen in which to enter a username and password to log into
the system. On single user systems with automatic login enabled, the desktop starts
automatically.
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7Updating SUSE Linux
Enterprise
SUSE® Linux Enterprise (SLE) provides the option of updating an existing system to
the new version without completely reinstalling it. No new installation is needed. Exist-
ing data, such as home directories and system configuration, is kept intact. During the
life-cycle of the product, you can apply Service Packs to increase system security,
correct software defects and get access to new features. Install from a local CD or DVD
drive or from a central network installation source.

7.1 Terminology
This chapter uses several terms. In order to understand the information, read the defini-
tions below:

Deltarpm
A deltarpm consists only of the binary diff between two defined versions of a
package, and therefore has the smallest download size. Before being installed, the
full RPM package is rebuilt on the local machine.

Patch
A patch consists of one or more packages and may be applied by means of
deltarpms. It may also introduce dependencies to packages that are not installed
yet.

Package
A package is a compressed file in rpm format that contains the files for a particular
program.
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Service Packs (SP)
Combines several patches into a form which is easy to install or deploy. Service
packs are numbered and usually contain security fixes, updates, upgrades, or en-
hancements of programs.

Update
Installation of a newer minor version of a package.

Upgrade
Installation of a newer major version of a package or distribution, which brings
new features.

Online Migration
Updating to a Service Pack (SP) by using the online update tools (rather than the
installationmedia) to install the respective patches. There are two possible migration
paths. In the following, SPx+1 refers to the new Service Pack that is going to be
installed, whereas SPx refers to the currently installed Service Pack.

Full Migration
Updates all Packages of the installed system to the latest state—including up-
dates—of SPx+1 plus SPx updates.

Minimal Migration
Updates all Packages of the installed system to the latest state of SPx+1 Core
packages, SPx+1 Updates and few SPx updates.

7.2 The SUSE Linux Enterprise 11
Maintenance Model

The SUSE Linux Enterprise 11 Maintenance Model combines flexibility and control
of your service packs. It offers the following benefits:

• Makes service packs more lightweight and easier to test and deploy.

• Allows staying with older versions, but with support for the full system.
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• Answersmarket needs in between service packs by selective enhancements and allows
more updates in the general update repository. By selecting the enhancements, it
mitigates longer periods between service packs.

Figure 7.1, “MaintenanceDelivery Evolution (also applies to SLED)” (page 129) depicts
some of the mentioned aspects above.

Figure 7.1 Maintenance Delivery Evolution (also applies to SLED)

Our products have a 10-year life-cycle: 7 years general support and 3 years extended
support. Major releases are made every 4 years and service packs every 18 months.
The Long Term Service Pack Support is an extended window or extendedmajor release
life-cycle (see Figure 7.2, “Long Term Service Pack Support” (page 129)).

Figure 7.2 Long Term Service Pack Support

The Long Term Service Pack Support requires active subscription, either standard or
priority. It does not affect L1 or L2 subscription terms. Security updates are handled
“proactively”: these are any non-user driven critical vulnerabilities, local root exploits
in Kernel or other root exploits directly executable without user interaction.

The range for extended support levels starts from year 8 and ends in year 10. These
contain continued L3 engineering level diagnosis and reactive critical bug fixes. These
support levels proactively update trivial local root exploits in Kernel or other root exploits
directly executable without user interaction. Furthermore they support existing work-
loads, software stacks, and hardware with limited package exclusion list. Find an
overview in Table 7.1, “Security Updates and Bug Fixes” (page 130).
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Table 7.1 Security Updates and Bug Fixes

Extend-
ed Sup-
port

— General Support —

Year 8,
9, 10
with
LTSS

Year 6
& 7
with
LTSS

SP (n-
1) with
LTSS

SP (n-
1) 6
months

Cur-
rent
SP

Topic

✓✓✓✓✓L1/L2 Technical
Services

✓✓✓ProactiveMainte-
nance

✓✓✓Driver Updates
via PLDP

✓✓✓✓Proactive Security
Updates

✓✓✓✓✓L3 Engineering
Support

✓✓✓✓Back-ports avail-
able

7.2.1 Channel Model
With the former maintenance model, SUSE Linux Enterprise Server, had two channels
assigned: SLES11-SPx-pool and SLES11-SPx-Updates. During an online mi-
gration to SPx+1 these channels were temporary replaced bySLES11-SPx-Online.

With SUSE Linux Enterprise SP 2 the channel layout has changed to support the benefits
of the new maintenance model. The following channels are assigned to a product:

• SLES11-SPx-Updates
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• SLES11-SPx-Core

• SLES11-SPx-LTSS-Updates (optional)

• SLES11-SPx-Extension-Store (optional)

• SLES11-SP(x-1)-Updates

• SLES11-SP(x-1)-Core

• SLES11-SP(x-2)-Updates

• SLES11-SP(x-2)-Core

• ...

• SLES11-SP1-Updates

• SLES11-SP1-Pool

Each repository type contains a different set of packages:

Core
A subset of the unpacked installation media, it only contains those packages that
are considered to be the "core" of SPx (approximately 30% of the package total).
The SP repositories only contain packages specific to a SP and its themes (e.g.
hardware enablement)

Updates
Maintenance updates to packages in the corresponding Core or Pool repository.

LTSS-Updates
Maintenance updates to packages in the corresponding Core repository for instal-
lations with Long Term Support Service.

Extension-Store
Not yet in use, yet. Supposed to contain packages for (future) add-on products.
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Pool
The unpacked SP1 installation media, containing all binary RPMs from the instal-
lation media, plus pattern information and support status metadata. This repository
is only available for SP1.

7.2.1.1 Origin of Packages
The base channel for SUSE Linux Enterprise 11 is SLES11-SP1-Pool. It's the only
channel containing all packages. This channel and it's content will not change
throughout the entire life cycle of SUSE Linux Enterprise 11. A package will be served
from this channel as long as no update for this package is available.

Once a package gets updated, the update is served from SLES11-SP1-Updates.
This channel contains all packages having been updated since the release of SP1.

Once Service Pack 2 is installed, two additional channels will be added:
SLES11-SP2-Core and SLES11-SP2-Updates. SP2-Core contains a subset
of packages from SP1-Pool. These packages are newer than the versions in both SP1
channels. Once an SP2-Core package gets updated, the update is served from
SLES11-SP2-Updates. This channel contains all packages having been updated
since the release of SP2.

Starting with the installation of SP2 the following rules on the origin of packages apply:

1. Non-core-packages will be served from SP1-Pool or SP1-Updates throughout
the entire life cycle of SUSE Linux Enterprise 11.

2. Core packages will always be served from SPx-Core or SPx-Update. In case a
package gets dropped from the Core in SPx, it will be served from SPx-1 for the entire
rest of the life cycle of SUSE Linux Enterprise 11.

7.3 Supported Upgrade Paths to SLE
SP2

Upgrading SLES 8, SLES 9 and NLD 9
There is no supported direct upgrade path from these versions. Instead it is recom-
mended to perform a new installation.
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Upgrading from SUSE Linux Enterprise 10 Prior to Service Pack 4
There is no supported direct migration path to SUSE Linux Enterprise 11. An update
has to be performed from SUSE Linux Enterprise 10 GA to SP 1, then to SP 2,
further to SP 3, and then to SP4 by using the respective boot media. SP4 can be
updated to SUSE Linux Enterprise 11 SP2 following the procedure outlined in
Section 7.6, “Updating SLE 10 SP4 to SLE 11 SP2” (page 143).

Upgrading from SUSE Linux Enterprise 10 Service Pack 4
The supported migration path from SUSE Linux Enterprise 10 SP4 to SUSE Linux
Enterprise 11 Service Pack 2 is by using the SUSE Linux Enterprise 11 SP 2 boot
media. See Section 7.6, “Updating SLE 10 SP4 to SLE 11 SP2” (page 143) for de-
tails.

Upgrading from SUSE Linux Enterprise 11 GA
There is no supported direct migration path to SUSE Linux Enterprise 11 SP2. An
update hast to be performed from SUSE Linux Enterprise 11 GA to SP1 first.
Proceed with Section 7.5, “Updating SLE 11 SP1 to SLE 11 SP2” (page 135) after-
wards.

Upgrading from SUSE Linux Enterprise SP1
Refer to Section 7.5, “Updating SLE 11 SP1 to SLE 11 SP2” (page 135) for details.

7.4 General Preparations for Updating
Before starting the update procedure, make sure your system is properly prepared.
Among others, preparation involves backing up data and checking the release notes.

7.4.1 Make a Backup
Before updating, copy existing configuration files to a separate medium (such as tape
device, removable hard disk, etc.) to back up the data. This primarily applies to files
stored in /etc as well as some of the directories and files in /var and /opt. You
may also want to write the user data in /home (the HOME directories) to a backup
medium. Back up this data as root. Only root has read permissions for all local files.
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7.4.2 Partitioning and Disk Space
Before starting your update, make note of the root partition. The command df / lists
the device name of the root partition. In Example 7.1, “List with df -h” (page 134),
the root partition to write down is /dev/sda3 (mounted as /).

Example 7.1 List with df -h
Filesystem Size Used Avail Use% Mounted on

/dev/sda3 74G 22G 53G 29% /
tmpfs 506M 0 506M 0% /dev/shm
/dev/sda5 116G 5.8G 111G 5% /home
/dev/sda1 44G 4G 40G 9% /data

Software tends to “grow” from version to version. Therefore, take a look at the available
partition space with df before updating. If you suspect you are running short of disk
space, secure your data before updating and repartitioning your system. There is no
general rule regarding howmuch space each partition should have. Space requirements
depend on your particular partitioning profile and the software selected.

7.4.3 Shut Down Virtual Machines
If your machine serves as a VM Host Server for KVM or Xen, make sure to properly
shut down all running VM Guests prior to the update. Otherwise you may not be able
to acces the guests after the update.

7.4.4 Version Specific Requirements
For version specific requirements, refer to the release notes coming with the update
product. In the release notes you can find additional information about upgrade proce-
dures.

The current version of the release notes document containing the latest information on
SUSE Linux Enterprise Server can be read online at http://www.suse.com/
documentation/sles11/#additional.
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7.5 Updating SLE 11 SP1 to SLE 11 SP2
There are different supported ways for updating a SUSE Linux Enterprise 11 SP1 system
to a Service Pack 2. You may either update by using the online update tools to install
the respective patches (“Online Migration”) or update via the Service Pack installation
media. Furthermore, updates can be performed via servers hosting Subscription Man-
agement Tool or SUSE Manager.

An Online Migration is supported by the following tools:

• YaST wagon (graphical user interface)

• zypper (command line)

Alternatively, the full Service Pack media (DVD ISO image) can be downloaded. Start
the update process by booting from the physical Service Pack media or a network in-
stallation source.

7.5.1 Online Migration
Updating your system via online migration is done from within the running system.
You only need to reboot once, after the update is completed.

7.5.1.1 Requirements
In order to do an online update, the following requirements must be met. Make sure to
also read Section 7.4, “General Preparations for Updating” (page 133).

Product Registration
In order to be able to connect to the update channels, your product has to be regis-
tered. If this is not the case, either run the Novell Customer Center Configuration
module in YaST or the suse_register commandline tool to start the registra-
tion.

Run an Online Update
Make sure the currently installed version has the latest patches installed. Run an
Online Update prior to the Online Migration. When using a graphical interface,
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start the YaST Online Update or the updater applet. On the command line, run the
following commands (the last command needs to be run twice):
zypper ref -s

zypper update -t patch
zypper update -t patch

Reboot the system if needed.

See Chapter 1, YaSTOnlineUpdate (↑AdministrationGuide) or at Section “Updating
Software with Zypper” (Chapter 6,Managing Software with Command Line Tools,
↑Administration Guide). for more information. on the online update tools.

3rd Party Software
If your setup involves third-party software or add-on software, test this procedure
on another machine to make sure that the dependencies are not broken by the update.

IMPORTANT: Always Run a Complete Online Migration

The online migration always has to be completed from beginning to end. If an
online migration is interrupted in between, the system is corrupted beyond
recovery.

7.5.1.2 Online Migration with YaST Wagon
1 When all requirements are met (see Section 7.5.1.1, “Requirements” (page 135)),

the update applet in the tray will display a message that a distribution upgrade is
available. Click it to start YaSTWagon. Alternatively run /usr/sbin/wagon
as root from the command line.

2 Confirm theWelcome dialog with Next.

3 If Wagon finds that the requirements are not met (needed maintenance updates
available but not yet installed) it will do an automatic self update that may require
to reboot. Follow the on-screen instructions.

4 Choose the update method in the following dialog. Choose Customer Center to
use the default setup (recommended).

Click Custom URL to manually choose the software channels used for the online
migration. A list of channels will be displayed, providing the opportunity to
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manually enable, disable, add, or delete channels. Add the SP2 update source(s).
This can either be the SP2 installation media or the SP2-Core and
SP2-Updates channels.Click OK to return to the Update Method dialog.

If you want to review changes to the channel setup caused by the update process,
select Check Automatic Repository Changes.

Proceed with Next.

5 The system will be re-registered. During this process the SP2-Core and
SP2-Updates channels will be added to the system (see Section 7.2.1, “Channel
Model” (page 130) for more information). Confirm the addition of the channels.

6 If you have selected Check Automatic Repository Changes in theUpdate Method
dialog, the list of repositories will be displayed, providing the opportunity to
manually enable, disable, add, or delete channels. Proceed withOKwhen finished.

7 Choose the migration type. See Section 7.1, “Terminology” (page 127) for details.

Full migration
Updates all packages to the latest SP2 level.

Minimal Migration
Updates a minimal set of packages to the latest SP2 level.

Click Advanced to manually select the repositories used for upgrading.

Confirm your selection.

8 The Distribution Upgrade Settings screen opens presenting a summary of the
update configuration. the following sections are available:

Add-On Products
You may add add SUSE Linux Enterprise Server add-on products or 3rd
party products here.

Update Options
Lists the actions that will be performed during the update. You can choose
whether to download all packages before installing them (default, recommend-
ed), or whether to download and install packages one by one.
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Packages
Statistical overview of the update.

Backup
Set backup options.

Click Next and Start The Update to proceed.

IMPORTANT: Aborting the Online Migration

It is safe to abort the online migration on this screen prior to clicking Start
The Update and on all previous screens. Click Abort to leave the update
procedure and restore the system to the state it was in prior to starting
YaST wagon. Follow the instructions on screen and perform a re-registra-
tion before leaving Wagon to remove the SP2 channels from your system.

9 During the update procedure the following steps are executed:

9a Packages will be updated.

9b SuSEconfig will be run.

9c The system will be rebooted (press OK).

9d The newly updated system will be re-registered.

10 Your system has been successfully updated to Service Pack 2.

7.5.1.3 Online Migration with zypper
1 When all requirements are met (see Section 7.5.1.1, “Requirements” (page 135)),

the “products” needed for the online migration have been added to /etc/
products.d. Get a list of these products by running the following command:
zypper se -t product | grep -h -- "-migration" | cut -d'|' -f2

This command should at least returnSUSE_SLES-SP2-migration. Depending
on the scope of your installation, more products may be listed.
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2 Install the migration products retrieved on the previous step with the command
zypper in -t product LIST_OF_PRODUCTS, for example
zypper in -t product SUSE_SLES-SP2-migration

3 Register the products installed in the previous step in order to get the respective
update channels:
suse_register -d 2 -L /root/.suse_register.log'

4 Refresh repositories and services again:
zypper ref -s

5 Check the list of repositories you can retrieve with zypper lr. At least the
following repositories need to be Enabled:

• SLES11-SP1-Pool

• SLES11-SP1-Updates

• SLES11-SP2-Core

• SLES11-SP2-Updates

Depending on the scope of your installation, further repositories for add-on
products or extensions need to be enabled.

If one of these repositories is not enabled (the SP2 ones are not enabled by default
when following this workflow), enable them with zypper modifyrepo
--enable REPOSITORY ALIAS, for example:
zypper modifyrepo --enable SLES11-SP2-Core SLES11-SP2-Updates

If your setup contains 3rd party repositories that may not be compatible with SP2,
disable them with zypper modifyrepo --disable REPOSITORY
ALIAS.

6 Now everything is in place to perform the distribution upgrade with zypper
dup --from REPO 1 --from REPO 2 .... Make sure to list all needed
repositories with --from, for example:
zypper dup --from SLES11-SP2-Core --from SLES11-SP2-Updates
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Confirm with y to start the upgrade.

7 Upon completion of the distribution upgrade from the previous step, a Minimal
Migration has been performed (a minimal set of packages has been updated to
the latest SP2 level). Skip this step if you do not intend to do a Full Migration.

In order to do a Full Migration (updates all packages to the latest SP2 level), run
the following command:
zypper update -t patch

8 Now that the upgrade to SP2 has been completed, you need to re-register your
product:
suse_register -d 2 -L /root/.suse_register.log

9 Last, reboot your system.

10 Your system has been successfully updated to Service Pack 2.

7.5.2 Updating by Booting from an
Installation Source

As an alternative to the Online Migration (see Section 7.5.1, “Online Migra-
tion” (page 135) for details) you may also update your system by booting from an instal-
lation source—either a DVD or a network installation source. The update will start like
a normal installation.

Service Pack 2 ISO images can be obtained from http://download.novell
.com/. Either burn it to a DVD or prepare a network installation source as described
in Section 14.2, “Setting Up the Server Holding the Installation Sources” (page 223).

7.5.2.1 Updating from a Local DVD Drive
Before starting a new installation of a SUSE Linux Enterprise SP, ensure that all the
Service Pack installation media (DVDs) are available.
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Procedure 7.1 Booting from the Service Pack Medium

1 Insert the first SUSE Linux Enterprise SP medium and boot your machine. A boot
screen similar to the original installation of SUSE Linux Enterprise 11 is displayed.

2 Select Installation and continue as outlined in the YaST installation instructions in
Chapter 6, Installation with YaST (page 89).

7.5.2.2 Updating from a Network Installation Source
Before starting an update of a SUSE Linux Enterprise SP from a network installation
source, make sure that the following requirements are met:

• A network installation source is setup according to Section 14.2, “Setting Up the
Server Holding the Installation Sources” (page 223).

• A working network connection on both the installation server and the target machine
that includes a name service, DHCP (optional, but needed for PXE boot), and
OpenSLP (optional) exists.

• The SUSE Linux Enterprise SP DVD 1 to boot the target system or a target system
set up for PXE boot according to Section 14.3.5, “Preparing the Target System for
PXE Boot” (page 242) exist.

Please refer to Chapter 14, Remote Installation (page 215) for in-depth information on
starting the upgrade from a remote server.

Network Installation—Boot from DVD

To perform a network installation using the SP DVD as the boot medium, proceed as
follows:

1 Insert the SUSE Linux Enterprise SP DVD 1 and boot your machine. A boot screen
similar to the original installation of SUSE Linux Enterprise 11 is displayed.

2 Select Installation to boot the SP Kernel then use F4 to select the type of network
installation source (FTP, HTTP, NFS, or SMB).

3 Provide the appropriate path information or select SLP as the installation source.
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4 Select the appropriate installation server from those offered or use the boot options
prompt to provide the type of installation source and its actual location as in Sec-
tion 6.1.2, “Installing from a Network Source without SLP” (page 91). YaST starts.

Finish the installation as outlined in Section 7.5.2.3, “The Update Proce-
dure” (page 142).

Network Installation—PXE Boot

To perform a network installation of a SUSE Linux Enterprise Service Pack via network,
proceed as follows:

1 Adjust the setup of your DHCP server to provide the address information needed
for PXE boot according to Section 14.3.5, “Preparing the Target System for PXE
Boot” (page 242).

2 Set up a TFTP server to hold the boot image needed for PXE boot.

Use the first CD or DVD of your SUSE Linux Enterprise Service Pack for this or
follow the instructions in Section 14.3.2, “Setting Up a TFTP Server” (page 236).

3 Prepare PXE boot and Wake-on-LAN on the target machine.

4 Initiate the boot of the target system and use VNC to remotely connect to the instal-
lation routine running on this machine. See Section 14.5.1, “VNC Installa-
tion” (page 247) for more information.

5 Finish the installation as outlined in Section 7.5.2.3, “The Update Proce-
dure” (page 142).

7.5.2.3 The Update Procedure
Once you have successfully booted from installation medium or the network, proceed
as follows to start the update:

1 On theWelcome screen choose Language and Keyboard and Accept the license
agreement. Proceed with Next.
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2 In case you have booted from a physical medium, perform aMedia Check to verify
the integrity of the medium. Only skip this step if you have checked the medium
before.

3 On the InstallationMode screen, chooseUpdate. Clicking onNextwill start the update
procedure.

7.5.3 Updating via Subscription
Management Tool

As an alternative to downloading the updates for each single client system from the
Novell update server, it is possible to use the Subscription Management Tool (SMT)
for SUSE Linux Enterprise to mirror the updates to a local server.

This tool acts as Novell Customer Center proxy both for client registrations and as
software update repository. The SMT documentation at http://www.suse.com/
documentation/smt11/ gives an overview of its features as well as instructions
on how to implement it.

7.5.4 Updating via SUSE Manager
SUSE Manager is a server solution for providing updates, patches, and security fixes
for SUSE Linux Enterprise clients. It comes with a set of tools and a Web-based user
interface for management tasks.

TheSUSEManager documentation athttp://www.suse.com/documentation/
suse_manager/ gives an overview of its features as well as instructions on how to
set up server and clients.

7.6 Updating SLE 10 SP4 to SLE 11 SP2
The supported migration path from SUSE Linux Enterprise 10 SP4 to SUSE Linux
Enterprise 11 SP2 is by using the SUSE Linux Enterprise 11 SP 2 boot media. Please
refer to the instructions at Section 7.5.2, “Updating by Booting from an Installation
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Source” (page 140). Make sure to update your SUSE Linux Enterprise 10 system to the
latest patch level by running an online update prior to starting the update to SP2.

7.6.1 Possible Problems
If you update a default system from the previous version to the current version, YaST
works out necessary changes and performs them. Depending on your customizations,
some steps or the entire update procedure may fail and you must resort to copying back
your backup data. Check the following issues before starting the system update.

7.6.1.1 Checking passwd and group in /etc
Before updating the system, make sure that /etc/passwd and /etc/group do not
contain any syntax errors. For this purpose, start the verification utilities pwck and
grpck as root and eliminate any reported errors.

7.6.1.2 PostgreSQL
Before updating PostgreSQL (postgres), dump the databases. See the manual page
of pg_dump. This is only necessary if you actually used PostgreSQL prior to your
update.

7.7 The Atomic Update
The Atomic Update is based on tools that manage two copies of the system and allow
easy recovery after an update failure. The delivered tools require a special disk partition
setup. Every copy of the system resides on a primary partition of its own. If an update
fails, you can always switch back to the previous state of the system, which is available
on the other partition.

144 Deployment Guide



7.7.1 Setup
WARNING: Strict Partitioning Requirements

The implementation has strict requirements on disk partitioning: the first root
partition is /dev/sda1 and must not occupy more than half of the entire disk
size. Then the tools will create /dev/sda2 for the system's second root parti-
tion. Further partitions if available are shared on both root partitions—take
their size into account, and reduce the size of the first partition accordingly;
this is a rough calculation:

The size of the complete disk minus size of sda1minus sda2 is the free space
of additional partitions.

1 Install the system with /dev/sda1 as the single root partition and with less than
half of the entire disk size.

2 Customize the installed system as needed. Make sure to have the
multi-update-tools package installed.

3 Runmulti-update-setup --partition, which creates the system's second
root partition (/dev/sda2) of the similar size.

4 Partition the rest of the disk as needed and continue with customizations(*).

5 Run multi-update-setup --clone to copy the system to the other partition.
With this command you also change the / (root) entry in /etc/fstab of the target
system.

6 If needed, do further customizations(*).

7 Run multi-update-setup --bootloader to initialize the bootloader setup.
The bootloader menu will then contain an entry to boot the other system.

WARNING: GRUB Bootloader Mandatory

Installation of the GRUB bootloader is mandatory. The tools are not compat-
ible with other bootloaders.
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8 If there are no customizations to be done as marked with (*), run
multi-update-setup --complete which performs all the three steps.

7.7.2 Updating the Other System
Run multi-update. This command runs zypper in a chroot environment and
updates the other system— it does not matter which one is active. Its boot menu will
be offered as the default at boot time.

7.7.3 Troubleshooting
If the updated system has a damaged bootloader after the update, you must change the
“Active” flag and set it for the root partition of the other system in order to boot it.

If the updated system does not boot at all, you need access to the bootloader menu to
select the other system.

For more information about GRUB, see Chapter 10, The Boot Loader GRUB (↑Admin-
istration Guide).

7.7.4 For More Information
For more information, see /usr/share/doc/packages/multi-update
-tools/README coming with the multi-update-tools package.
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8Setting Up Hardware
Components with YaST
YaST allows you to configure hardware items at installation time as well as on an al-
ready-installed system. Configure audio hardware, printers or scanner support or learn
which hardware components are connected to your computer by using the YaST
Hardware Information module.

TIP: Graphics card, monitor, mouse and keyboard settings

Graphics card, monitor, mouse and keyboard can be configured with either
KDE or GNOME tools.

8.1 Hardware Information
Use the YaST hardware information module if you want to know more about your
hardware or if you need to find out details like vendor and model of a certain piece of
hardware to be able to properly configure it.

1 Start YaST and click Hardware > Hardware Information. Hardware probing starts
immediately and it will take some time until you see the hardware information tree
in a separate window.

2 In the hardware information tree recursively click on the plus icons to expand the
information about a specific device.

3 Click Save to File... to save the output to a file.
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4 Click Close to leave the hardware information overview.

8.2 Setting Up Graphics Card and
Monitor

After the installation you can change the configuration of your graphics system
(graphics card and monitor) according to your needs. Such a change may be necessary
because of accessibility issues or hardware upgrades.

WARNING: Changing Monitor Frequencies

Although there are safety mechanisms, you should still be very careful when
manually changing the allowed monitor frequencies. Incorrect values can
damage your monitor. Always refer to the monitor's manual before changing
frequencies.

Change the resolution, if fonts are too small or if circles appear misshapen. Proceed as
follows:

1 In YaST, click Hardware > Graphics Card and Monitor. SaX2 checks the system
resources and displays a window.

2 Make sure the monitor is properly detected. If not, use Change to select the appro-
priate model from the list.

3 Select an appropriate Resolution and Colors, if necessary.
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4 Test the new configuration before it is applied to the system. Click Ok to decide
what to do with your configuration (Test, Save, or Cancel.)

To activate a second monitor, proceed as follows:

1 In YaST, click Hardware > Graphics Card and Monitor. SaX2 checks the system
resources and displays the Card and Monitor Properties dialog.

2 Make sure the monitor is properly detected. If not, use Change to select the appro-
priate model from the list.

3 Enable Activate Dual Head Mode and click Configure for further fine-tuning.

4 Make sure the second monitor is properly detected. If not, use Change to select the
appropriate model from the list.

5 Decide whether you want to use the second monitor in Cloned Multihead or in Xin-
erama Multihead mode and click Ok.

6 Test the new configuration before it is applied to the system. Click Ok to decide
what to do with your configuration (Test, Save, or Cancel.)
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NOTE: Restarting the X Server

Any changes you make here take effect only after you restart the X server. If
you want to restart the X server now, log out of the graphical system and log
in again.

8.3 Setting Up Keyboard and Mouse
Reconfigure input devices such as the keyboard or the mouse, or add more than one of
these devices using the YaST Keyboard and Mouse modules.

8.3.1 Keyboard Layout
In case you want to replace a standard 104-key keyboard with a multimedia keyboard
or use a different language or country layout, proceed as follows:
1 In YaST, click Hardware > Keyboard Layout. The SaX2 configuration tool reads

the system resources and displays the Keyboard Properties dialog.
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2 Select your keyboard model from the Type list.

3 Select the country in the Layout list.

4 Depending on the country layout, you can choose a certain Variant. The selections
are applied immediately for testing.

5 As an option you can enable Additional Layouts. Check one or more boxes in the
list. This feature is handy if you want to switch between different languages or scripts
in the running system without the need for reconfiguration.

6 Before saving the configuration, use the Test field at the bottom of the dialog to
check if special characters like umlauts and accented characters can be entered and
displayed correctly.

7 Click OK to leave the configuration dialog and in the following message click Save
to apply your changes.

NOTE: Configuring Console Keyboard Layout

By clicking the Save button as described in Step 7 (page 151) the setup of the
console keyboard layout takes place at the same time. If you want to change
the console keyboard layout, either call yast keyboard (the text mode in-
terface) or check the KEYTABLE and YAST_KEYBOARD settings in /etc/
sysconfig/keyboard.

8.3.2 Mouse Model
The mouse is usually detected automatically, but you can set up your mouse model
manually if the automatic detection fails. Refer to the documentation of your mouse
for a description of the model. If you want to modify your mouse configuration, proceed
as follows:

1 In YaST, click Hardware >Mouse Model. The SaX2 configuration tool reads the
system resources and displays theMouse Properties dialog.

2 Click Change and select your mouse model from the list displayed.

3 Click OK to leave the configuration dialog and apply your changes with Save.
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In the Options part of the dialog, set various options for operating your mouse.

Activate 3-Button Emulation
If your mouse has only two buttons, a third button is emulated whenever you click
both buttons simultaneously.

Activate Mouse Wheel
Check this box to use a scroll wheel.

Invert X-Axis / Invert Y-Axis
Check these options if you want to change the direction in which the mouse
pointer moves.

Activate Left-Hand Button Mapping
Check this box to make the button mapping suitable for left-hand usage.

Emulate Wheel with Mouse Button
If your mouse does not have a scroll wheel but you would like to use a similar
functionality, you can assign an additional button for this. Select the button to use.
While pressing this button, any movement of the mouse is translated into scroll
wheel commands. This feature is especially useful with trackballs.

8.4 Setting Up Sound Cards
YaST detects most sound cards automatically and configures themwith the appropriate
values. If you want to change the default settings, or need to set up a sound card that
could not be configured automatically, use the YaST sound module. There, you can
also set up additional sound cards or switch their order.

To start the sound module, start YaST and clickHardware > Sound. Alternatively, start
the Sound Configuration dialog directly by running yast2 sound & as user root
from a command line.
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The dialog shows all sound cards that could be detected.

Procedure 8.1 Configuring Sound Cards

If you have added a new sound card or YaST could not automatically configure an ex-
isting sound card, follow the steps below. For configuring a new sound card, you need
to know your sound card vendor and model. If in doubt, refer to your sound card docu-
mentation for the required information. For a reference list of sound cards supported
by ALSA with their corresponding sound modules, see http://www.alsa
-project.org/main/index.php/Matrix:Main.

During configuration, you can choose between the following setup options:

Quick Automatic Setup
You are not required to go through any of the further configuration steps—the
sound card is configured automatically. You can set the volume or any options you
want to change later.
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Normal Setup
Allows you to adjust the output volume and play a test sound during the configura-
tion.

Advanced setup with possibility to change options
For experts only. Allows you to customize all parameters of the sound card.

IMPORTANT: Advanced Configuration

Only use this option if you know exactly what your are doing. Otherwise
leave the parameters untouched and use the normal or the automatic
setup options.

1 Start the YaST sound module.

2 To configure a detected, but Not Configured sound card, select the respective entry
from the list and click Edit.

To configure a new sound card, click Add. Select your sound card vendor and model
and click Next.

3 Choose one of the setup options and click Next.

4 If you have chosen Normal Setup, you can now Test your sound configuration and
make adjustments to the volume. You should start at about ten percent volume to
avoid damage to your hearing or the speakers.

5 If all options are set according to your wishes, click Next.

The Sound Configuration dialog shows the newly configured or modified sound
card.

6 To remove a sound card configuration that you no longer need, select the respective
entry and click Delete.

7 Click OK to save the changes and leave the YaST sound module.

Procedure 8.2 Modifying Sound Card Configurations

1 To change the configuration of an individual sound card (for experts only!), select
the sound card entry in the Sound Configuration dialog and click Edit.
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This takes you to the Sound Card Advanced Options where you can fine-tune a
number of parameters. For more information, click Help.

2 To adjust the volume of an already configured sound card or to test the sound card,
select the sound card entry in the Sound Configuration dialog and clickOther. Select
the respective menu item.

NOTE: YaST Mixer

The YaST mixer settings provide only basic options. They are intended for
troubleshooting (for example, if the test sound is not audible). Access the
YaST mixer settings from Other > Volume. For everyday use and fine-tuning
of sound options, use the mixer applet provided by your desktop or the
alsasound command line tool.

3 For playback of MIDI files, select Other > Start Sequencer.

4 When a supported sound card is detected (like a Creative Soundblaster Live,
Audigy or AWE sound card), you can also install SoundFonts for playback of MIDI
files:

4a Insert the original driver CD-ROM into your CD or DVD drive.

4b Select Other > Install SoundFonts to copy SF2 SoundFonts™ to your hard
disk. The SoundFonts are saved in the directory /usr/share/sfbank/
creative/.

5 If you have configured more than one sound card in your system you can adjust the
order of your sound cards. To set a sound card as primary device, select the sound
card in the Sound Configuration and click Other > Set as the Primary Card. The
sound device with index 0 is the default device and thus used by the system and the
applications.

6 Per default, SUSE Linux Enterprise Server uses the PulseAudio sound system. It is
an abstraction layer that helps to mix multiple audio streams, bypassing any restric-
tions the hardware may have. To enable or disable the PulseAudio sound system,
click Other > PulseAudio Configuration. If enabled, PulseAudio daemon is used to
play sounds. Disable PulseAudio Support in case you want to use something else
system-wide.
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The volume and configuration of all sound cards are saved when you click OK and
leave the YaST sound module. The mixer settings are saved to the file /etc/asound
.state. The ALSA configuration data is appended to the end of the file /etc/
modprobe.d/sound and written to /etc/sysconfig/sound.

8.5 Setting Up a Printer
YaST can be used to configure a local printer that is directly connected to your machine
(normally with USB or parallel port) and to set up printing with network printers. It is
also possible to share printers over the network. Further information about printing
(general information, technical details, and troubleshooting) is available in Chapter 12,
Printer Operation (↑Administration Guide).

In YaST, click Hardware > Printer to start the printer module. By default it opens in
the Printer Configurations view, displaying a list of all printers that are available and
configured. This is especially useful when having access to a lot of printers via the
network. From here you can also Print a Test Page and configure local printers.

8.5.1 Configuring Local Printers
Usually a local USB printer is automatically detected. There are two possible reasons
why a USB printer is not automatically detected:

• The USB printer is switched off.

• The communication between printer and computer is not possible. Check the cable
and the plugs to make sure that the printer is properly connected. If this is the case,
the problem may not be printer-related, but rather a USB related problem.

Configuring a printer is basically a three-step process. First specify the connection type,
then choose a driver, and name the printing queue for this setup.

For many printer models, several drivers are available. When configuring the printer,
YaST defaults to the one marked recommended as a general rule. Normally it is not
necessary to change the driver—therecommended one should produce the best results.
However, if you want a color printer to print only in black and white, it is most conve-
nient to use a driver that does not support color printing, for example. If you experience

156 Deployment Guide



performance problems with a PostScript printer when printing graphics, it may help to
switch from a PostScript driver to a PCL driver (provided your printer understands
PCL).

If no driver for your printer is listed, you can try to select a generic driver with an ap-
propriate standard language from the list. Refer to your printer's documentation to find
out which language (the set of commands controlling the printer) your printer under-
stands. If this does not work, refer to Section 8.5.1.1, “Adding Drivers with
YaST” (page 158) for another possible solution.

A printer is never used directly, but always through a print queue. This ensures that si-
multaneous jobs can be queued and processed one after the other. Each printer queue
is assigned to a specific driver, and a printer can have multiple queues. This makes it
possible to set up a second queue on a color printer that prints black and white only,
for example. Refer to Section “The Workflow of the Printing System” (Chapter 12,
Printer Operation, ↑Administration Guide) for more information about print queues.

Procedure 8.3 Adding a New Local Printer

1 Start the YaST printer module with Hardware > Printer

2 Click Add in the Printer Configurations screen

3 If your printer is already listed under Specify the Connection, proceed with
the next step. Otherwise, try to Detect More or start the Connection Wizard.

4 Enter the vendor name and the model name into the input box under Find and
Assign a Driver and click Search for.

5 Choose the driver marked as recommended that best matches your printer. If no
suitable drivers is displayed

5a check your search term

5b broaden your search by clicking Find More

5c add a driver as described in Section 8.5.1.1, “Adding Drivers with
YaST” (page 158)

6 Specify the Default paper size
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7 Enter a unique name for the printer queue in the Set Arbitrary Name field.

8 The printer is now configured with the default settings and ready to use. Click OK
to return to the Printer Configurations view. The newly configured printer is now
visible in the printers list.

8.5.1.1 Adding Drivers with YaST
If no suitable driver is available in the Assign Drivers dialog when adding a new printer,
no PPD (PostScript Printer Description, commonly referred to as “printer driver”) file
for your model is available. For more information about PPD files, refer to Section “In-
stalling the Software” (Chapter 12, Printer Operation, ↑Administration Guide).

Get PPD files directly from your printer vendor or from the driver CD of a PostScript
printer. For details, see Section “No Suitable PPD File Available for a PostScript
Printer” (Chapter 12, Printer Operation, ↑Administration Guide). Conversely, you can
also find PPD files at http://www.linuxfoundation.org/en/
OpenPrinting/, the “OpenPrinting.org printer database”. When downloading PPD
files from OpenPrinting.org, keep in mind that it always shows the latest Linux support
status, which is not necessarily met by SUSE Linux Enterprise Server.

Procedure 8.4 Adding a PPD file

1 Start the YaST printer module with Hardware > Printer

2 Click Add in the Printer Configurations screen

3 Click Add Driver in the Assign Driver section

4 Enter the full path to the PPD file into the input box under Make a Printer
Description File Available or choose the file from a dialog box by
clicking on Browse

5 Click OK to return to the Add New Printer Configuration screen.

6 In order to directly use this PPD file, proceed as described in Procedure 8.3, “Adding
a New Local Printer” (page 157). Otherwise, click Cancel.
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8.5.1.2 Editing a Local Printer Configuration
By editing an existing configuration for a local printer you can not only change basic
settings as connection type and driver, but also adjust the default settings for paper size,
resolution, media source, etc. You can change the identifier of the printer by altering
the printer descriptions.

Procedure 8.5 Editing a Local Printer

1 Start the YaST printer module with Hardware > Printer

2 In the Printer Configurations screen, choose a local printer from the list and click
Edit.

3 Change the connection type or the driver as described in Procedure 8.3, “Adding a
New Local Printer” (page 157). This should only be necessary in case you have
problems with the current configuration.

4 Make this printer the default by checking Default Printer.

5 Adjust the default settings by clicking All Options for the Current Driver. To change
a setting, expand the list of options by clicking the relative + sign. Change the default
by clicking on an option. Apply your changes by clicking OK

8.5.2 Configuring Printing via the Network
with YaST

Network printers are not detected automatically. They must be configured manually
using the YaST printer module. Depending on your network setup, you can print to a
print server (CUPS, LPD, SMB, or IPX) or directly to a network printer (preferably via
TCP). Access the configuration view for network printing by choosing Printing via
Network from the left pane in the YaST printer module.

8.5.2.1 Using CUPS
In a Linux environment CUPS is usually used to print via the network. The simplest
setup is to only print via a single CUPS server which can directly be accessed by all
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clients. Printing via more than one CUPS server requires a running local CUPS daemon
that communicates with the remote CUPS servers.

Procedure 8.6 Printing via a Single CUPS server

1 Start the YaST printer module with Hardware > Printer

2 Launch the Print via Network screen from the left pane.

3 Check Do All Your Printing Directly via One Remote CUPS Server and specify the
name or IP address of the server.

4 Click Test the Server to make sure you have chosen the correct name/IP address.

5 Click OK to return to the Printer Configurations screen. All printers available via
the CUPS server are now listed.

Procedure 8.7 Printing via multiple CUPS servers

1 Start the YaST printer module with Hardware > Printer

2 Launch the Print via Network screen from the left pane.

3 Check Accept Printer Information from the Following Servers

4 Specify which servers to use under General Settings. You may accept con-
nections from all networks available, from the local network, or from specific hosts.
If you choose the latter option, you need to specify the hostnames or IP addresses,
as well.

5 Confirm by clicking OKand then Yes when asked to start a local CUPS server. After
the server has started you will return to the Printer Configurations screen. Click
Refresh list to see the printers detected by now. Click this button again, in case more
printer are to be available.

8.5.2.2 Using Print Servers other than CUPS
If your network offers print services via print servers other than CUPS, start the YaST
printer module with Hardware > Printer and launch the Print via Network screen from
the left pane. Start the Connection Wizard and choose the appropriate Connection type.
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Ask your network administrator for details on configuring a network printer in your
environment.

8.5.3 Sharing Printers Over the Network
Printers managed by a local CUPS daemon can be shared over the network and so turn
your machine into a CUPS server. Usually you share a printer by enabling CUPS' so-
called “browsing mode”. If browsing is enabled, the local printer queues are made
available on the network for listening to remote CUPS daemons. It is also possible to
set up a dedicated CUPS server that manages all printing queues and can directly be
accessed by remote clients. In this case it is not necessary to enable browsing.

Procedure 8.8 Sharing Printers

1 Start the YaST printer module with Hardware > Printer

2 Launch the Share Printers screen from the left pane.

3 Select Allow Remote Access. For more detailed configuration, additional options are
available:

• Check For computers within the local network and enable browsing mode by also
checking Publish printers by default within the local network.

• Add the network interface to be used by the CUPS server. If you want to share
your printers via specified network interfaces, add those in the input box below.

• In case you like to restrict access to your CUPS server to certain networks or IP
addresses, specify these via the two input boxes.

4 ClickOK to restart the CUPS server and return to the Printer Configurations screen.

5 Regarding CUPS and firewall settings, see http://en.opensuse.org/SDB:
CUPS_and_SANE_Firewall_settings.
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8.6 Setting Up a Scanner
You can configure a USB or SCSI scanner with YaST. The sane-backends package
contains hardware drivers and other essentials needed to use a scanner. Scanners con-
nected to a parallel port cannot be configured with YaST. If you own a HP All-In-One
device, see Section 8.6.1, “Configuring an HP All-In-One Device” (page 162), instruc-
tions on how to configure a network scanner are available at Section 8.6.3, “Scanning
over the Network” (page 163).

Procedure 8.9 Configuring a USB or SCSI Scanner

1 Connect your USB or SCSI scanner to your computer and turn it on.

2 Start YaST and select Hardware > Scanner. YaST builds the scanner database and
tries to detect your scanner model automatically.

If a USB or SCSI scanner is not properly detected, try Other > Restart Detection.

3 To activate the scanner select it from the list of detected scanners and click Edit.

4 Choose your model form the list and click Next and Finish.

5 Use Other > Test to make sure you have chosen the correct driver.

6 Leave the configuration screen with OK.

8.6.1 Configuring an HP All-In-One Device
An HP All-In-One device can be configured with YaST even if it is connected to the
parallel port or is made available via the network. If you own a USB HP All-In-One
device, start configuring as described in Procedure 8.9, “Configuring a USB or SCSI
Scanner” (page 162). If it is detected properly and the Test succeeds, it is ready to use.

If your USB device is not properly detected, or your HPAll-In-One device is connected
to the parallel port or the network, run the HP Device Manager:

1 Start YaST and select Hardware > Scanner. YaST loads the scanner database.
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2 Start the HP Device Manager with Other > Run hp-setup and follow the on-screen
instructions. After having finished the HP Device Manager, the YaST scanner
module automatically restarts the auto detection.

3 Test it by choosing Other > Test.

4 Leave the configuration screen with OK.

8.6.2 Sharing a Scanner over the Network
SUSE Linux Enterprise Server allows the sharing of a scanner over the network. To do
so, configure your scanner as follows:

1 Configure the scanner as described in Section 8.6, “Setting Up a Scanner” (page 162).

2 Choose Other > Scanning via Network.

3 Enter the hostnames of the clients (separated by a comma) that should be allowed
to use the scanner under Server Settings > Permitted Clients for saned and leave the
configuration dialog with OK.

8.6.3 Scanning over the Network
To use a scanner that is shared over the network, proceed as follows:

1 Start YaST and select Hardware > Scanner.

2 Open the network scanner configuration menu by Other > Scanning via Network.

3 Enter the hostname of the machine the scanner is connected to under Client Settings
> Servers Used for the net Metadriver

4 Leave with OK. The network scanner is now listed in the Scanner Configuration
window and is ready to use.
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9Installing or Removing
Software
Use YaST's software management tool to search for software components you want to
add or remove. YaST resolves all dependencies for you. To install packages not shipped
with the installation media, add additional software repositories to your setup and let
YaST manage them. Keep your system up-to-date by managing software updates with
the update applet.

Change the software collection of your system with the YaST Software Manager. This
YaST module is available in two toolkit flavors: Qt and ncurses; the Qt flavor is de-
scribed here.

NOTE: Confirmation and Review of Changes

When installing, updating or removing packages, any changes in the Software
Manager are not applied immediately but only after confirming them with Ac-
cept or Apply respectively. YaST maintains a list with all actions, allowing you
to review and modify your changes before applying them to the system.

9.1 Definition of Terms
Repository

A local or remote directory containing packages, plus additional information about
these packages (package meta-data).
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(Repository) Alias
A short name for a repository used by various zypper commands. The alias can be
chosen by the user when adding a repository and must be unique.

Product
Represents a whole product, for example SUSE® Linux Enterprise Server.

Pattern
A pattern is an installable group of packages dedicated to a certain purpose. For
example, the Laptop pattern contains all packages that are needed in a mobile
computing environment. Patterns define package dependencies (such as required
or recommended packages) and come with a preselection of packages marked for
installation. This ensures that the most important packages needed for a certain
purpose are available on your system after installation of the pattern. However, not
necessarily all packages in a pattern are preselected for installation and you can
manually select or deselect packages within a pattern according to your needs and
wishes.

Package
A package is a compressed file in rpm format that contains the files for a particular
program.

Patch
A patch consists of one or more packages and may be applied by means of
deltarpms. It may also introduce dependencies to packages that are not installed
yet.

Resolvable
An generic term for product, pattern, package or patch. The most commonly used
type of resolvable is a package or a patch.

deltarpm
A deltarpm consists only of the binary diff between two defined versions of a
package, and therefore has the smallest download size. Before being installed, the
full RPM package is rebuilt on the local machine.

Package Dependencies
Certain packages are dependent on other packages, such as shared libraries. In
other terms, a package may require other packages—if the required packages
are not available, the package cannot be installed. In addition to dependencies
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(package requirements) that must be fulfilled, some packages recommend other
packages. These recommended packages are only installed if they are actually
available, otherwise they are just ignored and the package recommending them is
installed nevertheless.

9.2 Using the KDE Interface (Qt)
The YaST Qt interface is started by default when using the desktops KDE, icewm, and
others. It is also used when invoking YaST from a remote terminal. Start the software
manager from the YaST Control Center by choosing Software > SoftwareManagement.
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9.2.1 Views for Searching Packages or
Patterns

The YaST software manager can install packages or patterns from all currently enabled
repositories. It offers different views and filters to make it easier to find the software
you are searching for. The Search view is the default view of the window. To change
view, click View and select one of the following entries from the drop-down list. The
selected view opens in a new tab.

Patterns
Lists all patterns available for installation on your system.

Package Groups
Lists all packages sorted by groups such as Graphics, Programming, or Security.

RPM Groups
Lists all packages sorted by functionality with groups and subgroups. For example
Networking > Email > Clients.

Languages
Filter to list all packages needed to add a new system language.

Repositories
Filter to list packages by repository. In order to select more than one repository,
hold the Ctrl key while clicking on repository names. The “pseudo repository”
@System lists all packages currently installed.

Search
Lets you search for a package according to certain criteria. Enter a search term and
press Enter. Refine your search by specifying where to Search In and by changing
the Search Mode. For example, if you do not know the package name but only the
name of the application that you are searching for, try including the package De-
scription in the search process.

Installation Summary
If you have already selected packages for installation, update or removal, this view
shows the changes that will be applied to your system as soon as you click Accept.
To filter for packages with a certain status in this view, activate or deactivate the
respective check boxes. Hit Shift + F1 for details on the status flags.
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TIP: Finding Packages not Belonging to an Active Repository

To list all packages that do not belong to an active repository, choose View >
Repositories > @System and then choose Secondary Filter > Unmaintained
Packages. This is useful, for example, if you have deleted a repository and
would like to make sure no packages from that repository remain installed.

9.2.2 Installing and Removing Packages or
Patterns

Certain packages are dependent on other packages, such as shared libraries. On the
other hand, some packages cannot coexist with others on the system. If possible, YaST
automatically resolves these dependencies or conflicts. If your choice results in a depen-
dency conflict that cannot be automatically solved, you need to solve it manually as
described in Section 9.2.4, “Checking Software Dependencies” (page 172).

NOTE: Removal of Packages

When removing any packages, by default YaST only removes the selected
packages. If you want YaST to also remove any other packages that become
unneeded after removal of the specified package, select Options > Cleanup
when deleting packages.

1 Search for packages as described in Section 9.2.1, “Views for Searching Packages
or Patterns” (page 168).

2 The packages found are listed in the right pane. To install a package or remove it,
right-click it and choose Install or Delete. If the relevant option is not available,
check the package status indicated by the symbol in front of the package name—hit
Shift + F1 for help.

TIP: Applying an Action to All Packages Listed

To apply an action to all packages listed in the right pane, choose an action
from Package > All in This List.

3 To install a pattern, right-click the pattern name and choose Install.

Installing or Removing Software 169



4 It is not possible to remove a pattern per se. Instead, select the packages of a pattern
you want to remove and mark them for removal.

5 In order to select more packages, repeat the steps mentioned above.

6 Before applying your changes, you can review or modify them by clicking View >
Installation Summary. By default, all packages that will change status, are listed.

7 In order to revert the status for a package, right-click the package and select one of
the following entries: Keep if the package was scheduled to be deleted or updated,
or Do Not Install if it was scheduled for installation. To abandon all changes and
close the Software Manager, click Cancel and Abandon

8 When you are finished, click Accept to apply your changes.

9 In case YaST found dependencies on other packages, a list of packages that have
additionally been chosen for installation, update or removal is presented. Click
Continue to accept them.

After all selected packages are installed, updated or removed, the YaST Software
Manager automatically terminates.

NOTE: Installing Source Packages

Installing source packages with YaST Software Manager is not possible at the
moment. Use the command line tool zypper for this purpose. For more infor-
mation, see Section “Installing Source Packages” (Chapter 6,Managing Software
with Command Line Tools, ↑Administration Guide).

9.2.3 Updating Packages
Instead of updating individual packages, you can also update all installed packages or
all packages from a certain repository. When mass updating packages, the following
aspects are generally considered:

• priorities of the repositories that provide the package,

• architecture of the package (for example, x86_64, i686, i586),
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• version number of the package,

• package vendor.

Which of the aspects has the highest importance for choosing the update candidates
depends on the respective update option you choose.

1 To update all installed packages to the latest version, choose Package > All Packages
> Update if Newer Version Available from the main menu.

All repositories are checked for possible update candidates, using the following
policy: YaST first tries to restrict the search to packages with the same architecture
and vendor like the installed one. If the search is positive, the “best” update candidate
from those is selected according to the process below. However, if no comparable
package of the same vendor can be found, the search is expanded to all packages
with the same architecture. If still no comparable package can be found, all packages
are considered and the “best” update candidate is selected according to the following
criteria:

1. Repository priority: Prefer the package from the repository with the highest prior-
ity.

2. If more than one package results from this selection, choose the one with the “best”
architecture (best choice: matching the architecture of the installed one; otherwise:
x86_64 > i686 > i586).

If the resulting package has a higher version number than the installed one, the in-
stalled package will be updated and replaced with the selected update candidate.

This option tries to avoid changes in architecture and vendor for the installed pack-
ages, but under certain circumstances, they are tolerated.

NOTE: Update Unconditionally

If you choose Package > All Packages > Update Unconditionally instead,
basically the same criteria apply but candidate package found is installed
unconditionally. Thus, choosing this option might actually lead to downgrad-
ing some packages.

2 To make sure that the packages for a mass update derive from a certain repository:
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Choose the repository from which to update as described in Section 9.2.1,
“Views for Searching Packages or Patterns” (page 168) .

2a

2b On the right hand side of the window, click Switch system packages to the
versions in this repository. This explicitly allows YaST to change the package
vendor when replacing the packages.

As soon as you proceed with Accept, all installed packages will be replaced
by packages deriving from this repository, if available. This may lead to
changes in vendor and architecture and even to downgrading some packages.

2c To refrain from this, click Cancel switching system packages to the versions
in this repository. Note that you can only cancel this until you press the Accept
button.

3 Before applying your changes, you can review or modify them by clicking View >
Installation Summary. By default, all packages that will change status, are listed.

4 If all options are set according to your wishes, confirm your changes with Accept to
start the mass update.

9.2.4 Checking Software Dependencies
Most packages are dependent on other packages. If a package, for example, uses a
shared library, it is dependent on the package providing this library. On the other hand
some packages cannot coexist with each other, causing a conflict (for example, you
can only install one mail transfer agent: sendmail or postfix). When installing or remov-
ing software, the Software Manager makes sure no dependencies or conflicts remain
unsolved to ensure system integrity.

In case there exists only one solution to resolve a dependency or a conflict, it is resolved
automatically. Multiple solutions always cause a conflict which needs to be resolved
manually. If solving a conflict involves a vendor or architecture change, it also needs
to be solved manually. When clicking Accept to apply any changes in the Software
Manager, you get an overview of all actions triggered by the automatic resolver which
you need to confirm.

By default, dependencies are automatically checked. A check is performed every time
you change a package status (for example, by marking a package for installation or re-
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moval). This is generally useful, but can become exhausting when manually resolving
a dependency conflict. To disable this function, uncheck Dependencies > Autocheck.
Manually perform a dependency check withDependencies >Check Now. A consistency
check is always performed when you confirm your selection with Accept.

To review a package's dependencies, right-click it and choose Show Solver Information.
Amap showing the dependencies opens. Packages that are already installed are displayed
in a green frame.

NOTE: Manually Solving Package Conflicts

Unless you are very experienced, follow the suggestions YaST makes when
handling package conflicts, otherwise you may not be able to resolve them.
Keep in mind that every change you make, potentially triggers other conflicts,
so you can easily end up with a steadily increasing number of conflicts. In case
this happens, Cancel the Software Manager, Abandon all your changes and
start again.

Figure 9.1 Conflict Management of the Software Manager
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9.3 Managing Software Repositories
and Services

If you want to install third-party software, add additional software repositories to your
system. By default, the product repositories such as SUSELinux Enterprise Server-DVD
11 SP2 and a matching update repository are automatically configured once you have
registered your system. For more information about registration, see Section 6.15.1.4,
“Novell Customer Center Configuration” (page 118). Depending on the initially selected
product, a separate language add-on repository with translations, dictionaries, etc. might
also be configured.

To manage repositories, start YaST and select Software > Software Repositories. The
Configured Software Repositories dialog opens. Here, you can alsomanage subscriptions
to so-called Services by changing the View at the right corner of the dialog to All Ser-
vices. A Service in this context is a Repository Index Service (RIS) that can offer one
or more software repositories. Such a Service can be changed dynamically by its admin-
istrator or vendor.

Each repository provides files describing content of the repository (package names,
versions, etc.). These repository description files are downloaded to a local cache that
is used by YaST. To ensure their integrity, software repositories can be signed with the
GPGKey of the repository maintainer.Whenever you add a new repository, YaST offers
the ability to import its key.

WARNING: Trusting External Software Sources

Before adding external software repositories to your list of repositories, make
sure this repository can be trusted. SUSE Linux Enterprise Server is not respon-
sible for any potential problems arising from software installed from third-
party software repositories.

9.3.1 Adding Software Repositories
You can either add repositories from a local harddisk, from a removable medium (like
a CD, DVD or a USB mass storage) or from a network.
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To add repositories from the Configured Software Repositories dialog in YaST proceed
as follows:

1 Click Add.

2 From the list of availableMedia Types specify the type matching your repository:

For network sources, it is usually sufficient to use the default option, Specify URL.

To add a repository from a removable medium or a local harddisk, choose the relevant
option and insert the medium or connect the USB device to the machine, respectively.

3 You can choose to Download Repository Description Files now. If the option is
unchecked, YaST will automatically download the files later, if needed. Click Next
to proceed.

4 When adding a repository from the network, enter the data you are prompted for.
Continue with Next.

5 Depending on the repository you have added, you might be asked if you want to
import the GPG key with which it is signed or asked to agree to a license.

After confirming these messages, YaST will download and parse the metadata and
add the repository to the list of Configured Repositories..

6 If needed, adjust the repository Properties as described in Section 9.3.2, “Managing
Repository Properties” (page 175) or confirm your changes with OK to close the
configuration dialog.

Now you can install software from this repository as described in Section 9.2, “Using
the KDE Interface (Qt)” (page 167).

9.3.2 Managing Repository Properties
The Configured Software Repositories overview of the Software Repositories lets you
change the following repository properties:

Status
The repository status can either be Enabled or Disabled. You can only install
packages from repositories that are enabled. To turn a repository off temporarily
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click Disable. You can also double-click on a repository name to toggle its status.
If you want to remove a repository completely, click Delete.

Refresh
When refreshing a repository, its content description (package names, versions,
etc.) is downloaded to a local cache that is used by YaST. It is sufficient to do this
once for static repositories such as CDs or DVDs, whereas repositories whose
content changes often should be refreshed frequently. The easiest way to keep a
repository's cache up-to-date is to choose Automatically Refresh. To do a manual
refresh click Refresh and select one of the options.

Keep Downloaded Packages
Packages from remote repositories are downloaded before being installed. By de-
fault, they are deleted upon a successful installation. Activating Keep Downloaded
Packages prevents the deletion of downloaded packages. The download location
is configured in/etc/zypp/zypp.conf, by default it is/var/cache/zypp/
packages.

Priority
The Priority of a repository is a value between 1 and 200, with 1 being the highest
priority and 200 the lowest priority. Any new repositories that are added with
YaST get a priority of 99 by default. If you do not care about a priority value for
a certain repository, you can also set the value to 0 to apply the default priority to
that repository (99). If a package is available in more than one repository, then the
repository with the highest priority takes precedence. This is useful if you want to
avoid downloading packages unnecessarily from the Internet by giving a local
repository (for example, a DVD) a higher priority.

IMPORTANT: Priority vs. Version

The repository with the highest priority takes precedence in any case.
Therefore, make sure that the update repository always has the highest
priority (20 by default), otherwise you might install an outdated version
that will not be updated until the next online update.

Name and URL
To change a repository name or its URL, select it from the list with a single-click
and then click Edit.
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9.3.3 Managing Repository Keys
To ensure their integrity, software repositories can be signed with the GPG Key of the
repository maintainer. Whenever you add a new repository, YaST offers to import its
key. Verify it as you would do with any other GPG key and make sure it does not
change. If you detect a key change, something might be wrong with the repository.
Disable the repository as an installation source until you know the cause of the key
change.

Tomanage all imported keys, clickGPGKeys... in theConfigured Software Repositories
dialog. Select an entry with the mouse to show the key properties at the bottom of the
window. Add, Edit or Delete keys with a click on the respective buttons.

9.4 Keeping the System Up-to-date
Novell offers a continuous stream of software security patches for your product. The
update applet informs you about the availability of patches and lets you easily install
them with just a few clicks.

9.4.1 Using the KDE Software Updater
The Software Updater icon resides in the system tray of your panel depicting a gearwheel
with a green arrow. To start Software Updater manually, choose System Settings >
SoftwareManagement > Software Updates from the main menu. Alternatively, Alt +
F2 and enter kpk_update.

NOTE: Icon Visibility

The Software Updater icon is only visible in the system tray, if patches are
available. Hover over the icon to see the number of patches available.

9.4.1.1 Installing Patches
1 Whenever software updates are available, the applet icon appears in the panel. Left-

click the Software Updater icon to launch the Review and Update software window.
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2 Select a patch for installation by ticking its checkbox. Get detailed information on
a patch by clicking on its title. To select all available patches for installation, tick
the checkbox in the table header.

3 Click Apply to start the patch installation.

4 In case you have started the patch installation for the first time, you will be asked to
enter the root password twice in order to proceed. If you also check Remember
authorization you will never be asked again to provide the password.

5 The Additional Changes window showing an installation summary opens. Click
Continue to finish the installation.

Figure 9.2 KDE Software Updater

The YaST Online Update offers advanced features to customize the patch installation.
Please refer to Chapter 1, YaST Online Update (↑Administration Guide) for more infor-
mation.

9.4.1.2 Configuring the KDE Software Updater
By default Software Updater checks for updates every 24 hours, notifies you when
patches are available and does not automatically install patches. These settings can be
changed with the Software Management settings. To open the Software Management
settings choose System Settings > SoftwareManagement > Settings from themainmenu.
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Alternatively, press Alt + F2 and enter kpk_settings. The settings for Software
Updater are available in the Update Settings section.

IMPORTANT: Patch Origin

The SoftwareManagement settings also allows you to configure the repositories
(Origin of Packages) to be used. This setting not only applies to Software Up-
dater but also to the KDE Software Management module (Get and Remove
Software).

Make sure the repository Updates for SUSE Linux Enterprise Server 11 SP2 is al-
ways selected—otherwise you will not receive patches.

9.4.2 Using the GNOME Update Applet
The update applet resides in the notification area of the panel. Its icon changes depending
on the availability and relevance of patches and the status of the update. To invoke the
applet manually, choose Computer >More Applications > System > Software Update.

NOTE: Icon visibility

By default, the update applet icon is only visible in the notification area, if
patches are available.

Open box with a globe
The update applet is busy (for example checking for updates or installing software).

Red Star with Exclamation Mark
Security patches are available.

Orange Star with an Up Arrow
Important patches are available.

Yellow Star with a Down Arrow
Trivial patches are available.

Yellow Triangle with Exclamation Mark
An error has occurred.
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9.4.2.1 Installing Patches
Procedure 9.1 Installing Patches

1 Whenever new patches are available, a notification message will appear and the
Update Applet icon will be visible in the notification area. Either click Install updates
in the notification message or click the icon to open the Software Update window.

2 All security and important patches are preselected. It is strongly recommended to
install these patches. Trivial patches can bemanually selected by ticking the respective
check boxes. Get detailed information on a patch by clicking on its title.

3 Click Install Updates to start the patch installation.

4 The Additional Confirmation Required window showing an installation summary
opens. Click Continue to proceed.

5 Enter the root password in the authentication screen and proceed with Authenticate.

Figure 9.3 GNOME Update Applet
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The YaST Online Update offers advanced features to customize the patch installation.
Please refer to Chapter 1, YaST Online Update (↑Administration Guide) for more infor-
mation.

9.4.2.2 Configuring the Software Update Applet
To configure the update applet, right-click the update icon in the panel and choose
Preferences. The configuration dialog lets you modify the following settings:

Check for Updates
Choose how often a check for updates is performed: Hourly, Daily, Weekly, or
Never.

Automatically Install
Configure whether patches are installed automatically or not (default). Automatic
installation can be chosen for either security patches only or for all patches.

Check for Major Upgrades
Choose how often a check for major upgrades is performed: Daily, Weekly, or
Never.

Check for updates when using mobile broadband
This configuration option is only available on mobile computers. Turned off by
default.

More options are configurable using gconf-editor: apps > gnome-packagekit.
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10Installing Add-On Products
Add-on products are system extensions. You can install a third party add-on product
or a special system extension of SUSE® Linux Enterprise Server (for example, a CD
with support for additional languages or a CD with binary drivers). To install a new
add-on, start YaST and select Software > Add-On Products . You can select various
types of product media, like CD, FTP, USB mass storage devices (such as USB flash
drives or disks) or a local directory. You can work also directly with ISO files. To add
an add-on as ISO file media, select Local ISO Image then enter the Path to ISO Image.
The Repository Name is arbitrary.

10.1 Add-Ons
To install a new add-on, proceed as follows:

1 In YaST select Software > Add-On Products to see an overview of already installed
add-on products.

2 To install a new add-on product, click Add.

3 From the list of availableMedia Types specify the type matching your repository.

4 To add a repository from a removable medium, choose the relevant option and insert
the medium or connect the USB device to the machine, respectively.
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5 You can choose to Download Repository Description Files now. If the option is
unchecked, YaST will automatically download the files later, if needed. Click Next
to proceed.

6 When adding a repository from the network, enter the data you are prompted for.
Continue with Next.

7 Depending on the repository you have added, youmay be asked if you want to import
the GPG key with which it is signed or asked to agree to a license.

After confirming these messages, YaST will download and parse the metadata and
add the repository to the list of Configured Repositories..

8 If needed, adjust the repository Properties as described in Section 9.3.2, “Managing
Repository Properties” (page 175) or confirm your changes with OK to close the
configuration dialog.

9 After having successfully added the repository for the add-on media, the software
manager starts and you can install packages. Refer to Chapter 9, Installing or Remov-
ing Software (page 165) for details.

10.2 Binary Drivers
Some hardware needs binary-only drivers to function properly. If you have such hard-
ware, refer to the release notes for more information about availability of binary drivers
for your system. To read the release notes, open YaST and selectMiscellaneous > Re-
lease Notes.

10.3 SUSE Software Development Kit
(SDK) 11

SUSE Software Development Kit 11 is an add-on for SUSE Linux Enterprise 11. It is
a complete tool kit for application development. In fact, to provide a comprehensive
build system, SUSE Software Development Kit 11 includes all the open source tools
that were used to build the SUSE Linux Enterprise Server product. It provides you - as
a developer, independent software vendor (ISV), or independent hardware vendor (IHV)
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- with all the tools needed to port applications to all the platforms supported by SUSE
Linux Enterprise Desktop and SUSE Linux Enterprise Server.

SUSE Software Development Kit also contains integrated development environments
(IDEs), debuggers, code editors, and other related tools. It supports most major program-
ming languages, including C, C++, Java, and most scripting languages. For your con-
venience, SUSE Software Development Kit includes multiple Perl packages that are
not included in SUSE Linux Enterprise.

For detailed information, refer to http://www.novell.com/developer/sle
_sdk.html. Use the YaST add-on installer and package manager to install SUSE
Software Development Kit 11.
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11Accessing the Internet
If you have chosen not to configure Internet access during the installation, you can
perform this task at any time using YaST. How to configure your computer to access
the Internet depends on your environment. If the computer you are installing is part of
a network which already is connected to the Internet, the only thing to do is to link your
machine to the network. If you are installing a machine that is directly connected to the
Internet, the hardware and the access to the Internet Service Provider (ISP) needs to be
set up.

Please refer to the checklists below to make sure you have all the necessary data ready
before starting to configure the Internet access.

11.1 Direct Internet Connection
When your computer is directly connected to the Internet, you first need to configure
the hardware that is used for this task. This can either be an internal device (such as an
ISDN card) or an external device (for example, a modem). In most cases it is detected
automatically.

Next, you need to enter the data provided by your ISP (such as login credentials, gate-
way, or name server, for example). You should have received a data sheet from your
ISP where all the necessary data is listed.

If you have successfully configured your hardware and ISP data, use the NetworkMan-
ager for managing the internet connection. See Chapter 25, Using NetworkManager
(↑Administration Guide) for details.
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11.1.1 Checklist DSL
There are different types of DSL devices available that use different point-to-point
protocol (PPP) methods:

• a regular ethernet card connected to the external DSLmodem uses PPP over Ethernet
(PPPoE). In Austria the Point-to-Point Tunneling Protocol (PPTP) is used. With
PPTP the external modem also has a static IP address.

• an internal DSL modem uses PPP over ATM (PPPoATM)

• an internal ADSL Fritz Card uses CAPI for ADSL

The DSL configuration module already contains the data for major ISPs in some
countries. If your ISP is not listed, you will need to know how name resolving (DNS)
and IP allocation is handled (in most cases this data is received automatically when
connecting). Regardless whether you choose an ISP from the list or add a custom
provider, you need to enter at least your login and password.

For configuration details, refer to Section “DSL” (Chapter 20, Basic Networking,
↑Administration Guide).

11.1.2 Checklist ISDN
In case your internal ISDN card is not detected automatically you will need to know
the vendor and the name of the device.

NOTE: ISDN Modem or Terminal Adapter

If you are using an external ISDN modem or terminal adapter, refer to Sec-
tion 11.1.3, “Checklist Modem” (page 189) instead.

In order to configure the ISDN device you will need the following data:

• ISDN Protocol (depends on your country)

• Area code and phone number.
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• Interface type (SyncPPP or RawIP). If unsure, select SyncPPP, because RawIP is
only used in connection with certain telephone systems.

• Local and remote IP addresses for the dial-in server and the gateway, in the case that
you were given a static IP address from your provider.

• The ISDN configuration module already contains the data for major ISPs in some
countries. If your ISP is not listed, you will need to know how name resolving (DNS)
and IP allocation is handled (in most cases this data is received automatically when
connecting). Regardless whether you chose an ISP from the list or added a custom
provider, you need to enter at least your login and password.

For configuration details, refer to Section “ISDN” (Chapter 20, Basic Networking,
↑Administration Guide).

11.1.3 Checklist Modem
If your modem is not detected automatically, you will need to know whether it is con-
nected to a serial port or to a USB port. Please note that not all USBmodems and internal
modems are supported by SUSE® Linux Enterprise Server.

The modem configuration module already contains the data for major ISPs in some
countries. If your ISP is not listed, you will need to know its dial-in number and how
name resolving (DNS) and IP allocation is handled (in most cases this data is received
automatically when connecting). Regardless whether you chose an ISP from the list or
added a custom provider, you need to enter at least your login and password.

For configuration details, refer to Section “Modem” (Chapter 20, Basic Networking,
↑Administration Guide).

11.1.4 Checklist Cable Modem
Accessing the Internet through the TV cable requires a cable modem. Such a modem
is connected to the computer via ethernet cable. Therefore it is only necessary to con-
figure your network card accordingly. For details, refer to Section “Cable Modem”
(Chapter 20, Basic Networking, ↑Administration Guide).
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11.2 Internet Connection Via Network
If your machine is part of a network which is already connected to the Internet, it is
very easy to gain Internet access (just configure your network card and connect your
machine to the existing network and you are done). This not only applies to large
company networks, but to small home networks as well. Even if the machine you are
installing is only connected to a router (e.g. a DSL router) it is already part of a network.
It is irrelevant whether you are using a wireless network adapter or a wired one.

NOTE: Routing and Name Services

In the following it is assumed that the network is connected to the Internet
and provides routing and name services. In case these services are provided
by a router, make sure the router is configured correctly before setting up the
client.

11.2.1 Checklist Network
If your network provides DHCP (Dynamic Host Configuration Protocol) check the
appropriate check boxwhen setting up the network card and you are done (all parameters
needed will be provided by the DHCP server).

If DHCP is not available, ask your network administrator for the following details:

• Hostname

• Name server

• Gateway

For configuration details for wired network cards, refer to Section “Configuring the
Network Card with YaST” (Chapter 20, Basic Networking, ↑Administration Guide),
for wireless network cards see Section “Configuration with YaST” (Chapter 17,Wireless
LAN, ↑Administration Guide).

190 Deployment Guide



12Managing Users with YaST
During installation, you chose a method for user authentication. This method is either
local (via /etc/passwd) or, if a network connection is established, via NIS, LDAP,
Kerberos or Samba (see Section 6.15.1.7, “User Authentication Method” (page 122) .
You can create or modify user accounts and change the authentication method with
YaST at any time.

Every user is assigned a system-wide user ID (UID). Apart from the users which can
log in to your machine, there are also a number of system users for internal use only.
Each user is assigned to one or more groups. Similar to system users, there are also
system groups for internal use.

12.1 User and Group Administration
Dialog

To administer users or groups, start YaST and click Security and Users > User and
Group Management. Alternatively, start the User and Group Administration dialog
directly by running yast2 users & from a command line.

Managing Users with YaST 191



Figure 12.1 YaST User and Group Administration

Depending on the set of users you choose to view and modify with, the dialog (local
users, network users, system users), the main window shows several tabs. These allow
you to execute the following tasks:

Managing User Accounts
From the Users tab create, modify, delete or temporarily disable user accounts as
described in Section 12.2, “Managing User Accounts” (page 193). Learn about ad-
vanced options like enforcing password policies, using encrypted home directories,
using fingerprint authentication, or managing disk quotas in Section 12.3, “Addi-
tional Options for User Accounts” (page 195).

Changing Default Settings
Local users accounts are created according to the settings defined on the Defaults
for NewUsers tab. Learn how to change the default group assignment, or the default
path and access permissions for home directories in Section 12.4, “ChangingDefault
Settings for Local Users” (page 202).

192 Deployment Guide



Assigning Users to Groups
Learn how to change the group assignment for individual users in Section 12.5,
“Assigning Users to Groups” (page 203).

Managing Groups
From the Groups tab, you can add, modify or delete existing groups. Refer to
Section 12.6, “Managing Groups” (page 203) for information on how to do this.

Changing the User Authentication Method
When your machine is connected to a network that provides user authentication
methods like NIS or LDAP, you can choose between several authenticationmethods
on the Authentication Settings tab. For more information, refer to Section 12.7,
“Changing the User Authentication Method” (page 205).

For user and group management, the dialog provides similar functionality. You can
easily switch between the user and group administration view by choosing the appro-
priate tab at the top of the dialog.

Filter options allow you to define the set of users or groups you want to modify: On
the Users or Group tab, click Set Filter to view and edit users or groups according to
certain categories, such as Local Users or LDAP Users, for instance (if you are part of
a network which uses LDAP). With Set Filter > Customize Filter you can also set up
and use a custom filter.

Depending on the filter you choose, not all of the following options and functions will
be available from the dialog.

12.2 Managing User Accounts
YaST offers to create, modify, delete or temporarily disable user accounts. Do not
modify user accounts unless you are an experienced user or administrator.

NOTE: Changing User IDs of Existing Users

File ownership is bound to the user ID, not to the user name. After a user ID
change, the files in the user's home directory are automatically adjusted to
reflect this change. However, after an ID change, the user no longer owns the
files he created elsewhere in the file system unless the file ownership for those
files are manually modified.
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In the following, learn how to set up default user accounts. For some further options,
such as auto login, login without password, setting up encrypted home directories or
managing quotas for users and groups, refer to Section 12.3, “Additional Options for
User Accounts” (page 195).

Procedure 12.1 Adding or Modifying User Accounts

1 Open the YaST User and Group Administration dialog and click the Users tab.

2 With Set Filter define the set of users you want to manage. The dialog shows a list
of users in the system and the groups the users belong to.

3 To modify options for an existing user, select an entry and click Edit.

To create a new user account, click Add.

4 Enter the appropriate user data on the first tab, such as Username (which is used
for login) and Password. This data is sufficient to create a new user. If you clickOK
now, the systemwill automatically assign a user ID and set all other values according
to the default.

5 If you want to adjust further details such as the user ID or the path to the user's home
directory, do so on the Details tab.

If you need to relocate the home directory of an existing user, enter the path to the
new home directory there and move the contents of the current home directory with
Move to New Location. Otherwise, a new home directory is created without any of
the existing data.

6 To force users to regularly change their password or set other password options,
switch to Password Settings and adjust the options. For more details, refer to Sec-
tion 12.3.2, “Enforcing Password Policies” (page 196).

7 If all options are set according to your wishes, click OK.

8 Click Expert Options >Write Changes Now to save all changes without exiting the
User and Group Administration dialog. Click OK to close the administration dialog
and to save the changes. A newly added user can now log in to the system using the
login name and password you created.
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TIP: Matching User IDs

For a new (local) user on a laptop which also needs to integrate into a network
environment where this user already has a user ID, it is useful to match the
(local) user ID to the ID in the network. This ensures that the file ownership of
the files the user creates “offline” is the same as if he had created them directly
on the network.

Procedure 12.2 Disabling or Deleting User Accounts

1 Open the YaST User and Group Administration dialog and click the Users tab.

2 To temporarily disable a user account without deleting it, select the user from the
list and click Edit. Activate Disable User Login. The user cannot log into your ma-
chine until you enable the account again.

3 To delete a user account, select the user from the list and clickDelete. Choose if you
also want to delete the user's home directory or if you want to retain the data.

12.3 Additional Options for User
Accounts

In addition to the settings for a default user account, SUSE® Linux Enterprise Server
offers further options, such as options to enforce password policies, use encrypted home
directories or define disk quotas for users and groups.

12.3.1 Automatic Login and Passwordless
Login

If you use the KDE or GNOME desktop environment you can configure Auto Login
for a certain user as well as Passwordless Login for all users. Auto login causes a user
to become automatically logged in to the desktop environment on boot. This function-
ality can only be activated for one user at a time. Login without password allows all
users to log in to the system after they have entered their username in the login manager.
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WARNING: Security Risk

Enabling Auto Login or Passwordless Login on a machine that can be accessed
by more than one person is a security risk. Without the need to authenticate,
any user can gain access to your system and your data. If your system contains
confidential data, do not use this functionality.

If you want to activate auto login or login without password, access these functions in
the YaST User and Group Administration with Expert Options > Login Settings.

12.3.2 Enforcing Password Policies
On any system with multiple users, it is a good idea to enforce at least basic password
security policies. Users should change their passwords regularly and use strong pass-
words that cannot easily be exploited. For local users, proceed as follows:

Procedure 12.3 Configuring Password Settings

1 Open the YaST User and Group Administration dialog and select the Users tab.

2 Select the user for which to change the password options and click Edit.

3 Switch to the Password Settings tab. The user's last password change is displayed
on the tab.

4 To make the user change his password at next login, activate Force Password
Change.

5 To enforce password rotation, set aMaximum Number of Days for the Same
Password and aMinimum Number of Days for the Same Password.

6 To remind the user to change his password before it expires, set a number ofDays
before Password Expiration to Issue Warning.

7 To restrict the period of time the user can log in after his password has expired,
change the value in Days after Password Expires with Usable Login.

8 You can also specify a certain expiration date for a password. Enter the Expiration
Date in YYYY-MM-DD format.
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9 For more information about the options and about the default values, click Help.

10 Apply your changes with OK.

12.3.3 Managing Encrypted Home
Directories

To protect data in home directories against theft and hard disk removal, you can create
encrypted home directories for users. These are encrypted with LUKS (Linux Unified
Key Setup), which results in an image and an image key being generated for the user.
The image key is protected with the user's login password. When the user logs into the
system, the encrypted home directory is mounted and the contents are made available
to the user.

NOTE: Fingerprint Reader Devices and Encrypted Home Directories

If you want to use a fingerprint reader device, you must not use encrypted
home directories. Otherwise logging in will fail, because decrypting during login
is not possible in combination with an active fingerprint reader device.

With YaST, you can create encrypted home directories for new or existing users. To
encrypt or modify encrypted home directories of already existing users, you need to
know the user's current login password. By default, all existing user data is copied to
the new encrypted home directory, but it is not deleted from the unencrypted directory.

WARNING: Security Restrictions

Encrypting a user's home directory does not provide strong security from other
users. If strong security is required, the system should not be physically shared.

Find background information about encrypted home directories and which actions to
take for stronger security in Section “Using Encrypted Home Directories” (Chapter 11,
Encrypting Partitions and Files, ↑Security Guide).

Procedure 12.4 Creating Encrypted Home Directories

1 Open the YaST User and Group Management dialog and click the Users tab.
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2 To encrypt the home directory of an existing user, select the user and click Edit.

Otherwise, click Add to create a new user account and enter the appropriate user
data on the first tab.

3 In the Details tab, activate Use Encrypted Home Directory. With Directory Size in
MB, specify the size of the encrypted image file to be created for this user.

4 Apply your settings with OK.

5 Enter the user's current login password to proceed if YaST prompts for it.

6 Click Expert Options >Write Changes Now to save all changes without exiting the
administration dialog. Click OK to close the administration dialog and save the
changes.
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Procedure 12.5 Modifying or Disabling Encrypted Home Directories

Of course, you can also disable the encryption of a home directory or change the size
of the image file at any time.

1 Open the YaST User and Group Administration dialog in the Users view.

2 Select a user from the list and click Edit.

3 If you want to disable the encryption, switch to the Details tab and disable Use En-
crypted Home Directory.

If you need to enlarge or reduce the size of the encrypted image file for this user,
change the Directory Size in MB.

4 Apply your settings with OK.

5 Enter the user's current login password to proceed if YaST prompts for it.

6 Click Expert Options >Write Changes Now to save all changes without exiting the
User and Group Administration dialog. Click OK to close the administration dialog
and to save the changes.

12.3.4 Using Fingerprint Authentication
If your system includes a fingerprint reader you can use biometric authentication in
addition to standard authentication via login and password. After registering their fin-
gerprint, users can log into the system either by swiping a finger on the fingerprint
reader or by typing in a password.

Fingerprints can be registered with YaST. Find detailed information about configuration
and use of fingerprint authentication in Chapter 7, Using the Fingerprint Reader (↑Se-
curity Guide). For a list of supported devices, refer to http://www.freedesktop
.org/wiki/Software/fprint/libfprint.

12.3.5 Managing Quotas
To prevent system capacities from being exhausted without notification, system admin-
istrators can set up quotas for users or groups. Quotas can be defined for one or more
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file systems and restrict the amount of disk space that can be used and the number of
inodes (index nodes) that can be created there. Inodes are data structures on a file system
that store basic information about a regular file, directory, or other file system object.
They store all attributes of a file system object (like user and group ownership, read,
write, or execute permissions), except file name and contents.

SUSE Linux Enterprise Server allows usage of soft and hard quotas. Soft quotas
usually define a warning level at which users are informed that they are nearing their
limit, whereas hard quotas define the limit at which write requests are denied. Addition-
ally, grace intervals can be defined that allow users or groups to temporarily violate
their quotas by certain amounts.

Procedure 12.6 Enabling Quota Support for a Partition

In order to configure quotas for certain users and groups, you need to enable quota
support for the respective partition in the YaST Expert Partitioner first.

1 In YaST, select System > Partitioner and click Yes to proceed.

2 In the Expert Partitioner, select the partition for which to enable quotas and click
Edit.

3 Click Fstab Options and activate Enable Quota Support. If the quota package is
not already installed, it will be installed once you confirm the respective message
with Yes.

4 Confirm your changes and leave the Expert Partitioner.

Procedure 12.7 Setting Up Quotas for Users or Groups

Now you can define soft or hard quotas for specific users or groups and set time periods
as grace intervals.

1 In the YaST User and Group Administration, select the user or the group you want
to set the quotas for and click Edit.

2 On the Plug-Ins tab, select theManage User Quota entry and click Launch to open
the Quota Configuration dialog.

3 From File System, select the partition to which the quota should apply.
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4 Below Size Limits, restrict the amount of disk space. Enter the number of 1 KB blocks
the user or group may have on this partition. Specify a Soft Limit and a Hard Limit
value.

5 Additionally, you can restrict the number of inodes the user or group may have on
the partition. Below Inodes Limits, enter a Soft Limit and Hard Limit.

6 You can only define grace intervals if the user or group has already exceeded the
soft limit specified for size or inodes. Otherwise, the time-related input fields are
not activated. Specify the time period for which the user or group is allowed to exceed
the limits set above.

7 Confirm your settings with OK.

8 Click Expert Options >Write Changes Now to save all changes without exiting the
User and Group Administration dialog. Click OK to close the administration dialog
and to save the changes.
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SUSE Linux Enterprise Server also ships command line tools like repquota or
warnquota with which system administrators can control the disk usage or send e-
mail notifications to users exceeding their quota. With quota_nld, administrators
can also forward kernel messages about exceeded quotas to D-BUS. For more informa-
tion, refer to the repquota, the warnquota and the quota_nld man page.

12.4 Changing Default Settings for
Local Users

When creating new local users, several default settings are used by YaST. These include,
for example, the primary group and the secondary groups the user belongs to, or the
access permissions of the user's home directory. You can change these default settings
to meet your requirements:

1 Open the YaST User and Group Administration dialog and select the Defaults for
New Users tab.

2 To change the primary group the new users should automatically belong to, select
another group from Default Group.

3 To modify the secondary groups for new users, add or change groups in Secondary
Groups. The group names must be separated by commas.

4 If you do not want to use /home/username as default path for new users' home
directories, modify the Path Prefix for Home Directory.

5 To change the default permission modes for newly created home directories, adjust
the umask value in Umask for Home Directory. For more information about umask,
refer to Chapter 10, Access Control Lists in Linux (↑Security Guide) and to the
umask man page.

6 For information about the individual options, click Help.

7 Apply your changes with OK.
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12.5 Assigning Users to Groups
Local users are assigned to several groups according to the default settings which you
can access from the User and Group Administration dialog on the Defaults for New
Users tab. In the following, learn how to modify an individual user's group assignment.
If you need to change the default group assignments for new users, refer to Section 12.4,
“Changing Default Settings for Local Users” (page 202).

Procedure 12.8 Changing a User's Group Assignment

1 Open the YaST User and Group Administration dialog and click the Users tab. It
shows a list of users and of the groups the users belong to.

2 Click Edit and switch to the Details tab.

3 To change the primary group the user belongs to, click Default Group and select the
group from the list.

4 To assign the user additional secondary groups, activate the corresponding check
boxes in the Additional Groups list.

5 Click OK to apply your changes.

6 Click Expert Options >Write Changes Now to save all changes without exiting the
User and Group Administration dialog. Click OK to close the administration dialog
and save the changes.

12.6 Managing Groups
With YaST you can also easily add, modify or delete groups.

Procedure 12.9 Creating and Modifying Groups

1 Open the YaST User and Group Management dialog and click the Groups tab.

2 With Set Filter define the set of groups you want to manage. The dialog shows a list
of groups in the system.

3 To create a new group, click Add.
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4 To modify an existing group, select the group and click Edit.

5 In the following dialog, enter or change the data. The list on the right shows an
overview of all available users and system users which can bemembers of the group.

6 To add existing users to a new group select them from the list of possible Group
Members by checking the corresponding box. To remove them from the group
uncheck the box.

7 Click OK to apply your changes.

8 Click Expert Options >Write Changes Now to save all changes without exiting the
User and Group Administration dialog.

In order to delete a group, it must not contain any group members. To delete a group,
select it from the list and click Delete. Click Expert Options >Write Changes Now to
save all changes without exiting the User and Group Administration dialog. Click OK
to close the administration dialog and to save the changes.
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12.7 Changing the User
Authentication Method

When your machine is connected to a network, you can change the authentication
method you set during installation. The following options are available:

NIS
Users are administered centrally on a NIS server for all systems in the network.
For details, see Chapter 3, Using NIS (↑Security Guide).

LDAP
Users are administered centrally on an LDAP server for all systems in the network.
For details about LDAP, see Chapter 4, LDAP—A Directory Service (↑Security
Guide).

You canmanage LDAP users with the YaST user module. All other LDAP settings,
including the default settings for LDAP users, have to be defined with the YaST
LDAP client module as described in Section “Configuring an LDAP Client with
YaST” (Chapter 4, LDAP—A Directory Service, ↑Security Guide) .

Kerberos
With Kerberos, a user registers once and then is trusted in the entire network for
the rest of the session.

Samba
SMB authentication is often used in mixed Linux and Windows networks. For de-
tails, see Chapter 26, Samba (↑Administration Guide).

eDirectory LDAP
eDirectory authentication is used in Novell networks.

To change the authentication method, proceed as follows:

1 Open the User and Group Administration dialog in YaST.

2 Click the Authentication Settings tab to show an overview of the available authenti-
cation methods and the current settings.
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3 To change the authentication method, click Configure and select the authentication
method you want to modify. This takes you directly to the client configuration
modules in YaST. For information about the configuration of the appropriate client,
refer to the following sections:

NIS: Section “Configuring NIS Clients” (Chapter 3, Using NIS, ↑Security Guide)

LDAP: Section “Configuring an LDAP Client with YaST” (Chapter 4, LDAP—A
Directory Service, ↑Security Guide)

Samba: Section “Configuring a Samba Client with YaST” (Chapter 26, Samba,
↑Administration Guide)

4 After accepting the configuration, return to the User and Group Administration
overview.

5 Click OK to close the administration dialog.
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13Changing Language and
Country Settings with YaST
Working in different countries or having to work in a multilingual environment requires
your computer to be set up to support this. SUSE® Linux Enterprise Server can handle
different locales in parallel. A locale is a set of parameters that defines the language
and country settings reflected in the user interface.

The main system language was selected during installation and keyboard and time zone
settings were adjusted. However, you can install additional languages on your system
and determine which of the installed languages should be the default.

For those tasks, use the YaST languagemodule as described in Section 13.1, “Changing
the System Language” (page 207). Install secondary languages to get optional localiza-
tions if you need to start applications or desktops in languages other than the primary
one.

Apart from that, the YaST timezone module allows you to adjust your country and
timezone settings accordingly. It also lets you synchronize your system clock against
a time server. For details, refer to Section 13.2, “Changing the Country and Time Set-
tings” (page 212).

13.1 Changing the System Language
Depending on how you use your desktop and whether you want to switch the entire
system to another language or just the desktop environment itself, there are several
ways to achieve this:
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Changing the System Language Globally
Proceed as described in Section 13.1.1, “Modifying System Languages with
YaST” (page 208) and Section 13.1.2, “Switching the Default System Lan-
guage” (page 210) to install additional localized packages with YaST and to set the
default language. Changes are effective after relogin. To ensure that the entire
system reflects the change, reboot the system or close and restart all running ser-
vices, applications, and programs.

Changing the Language for the Desktop Only
Provided you have previously installed the desired language packages for your
desktop environment with YaST as described below, you can switch the language
of your desktop using the desktop's control center. After the X server has been
restarted, your entire desktop reflects your new choice of language. Applications
not belonging to your desktop framework are not affected by this change and may
still appear in the language that was set in YaST.

Temporarily Switching Languages for One Application Only
You can also run a single application in another language (that has already been
installed with YaST). To do so, start it from the command line by specifying the
language code as described in Section 13.1.3, “Switching Languages for Individual
Applications” (page 211).

13.1.1 Modifying System Languages with
YaST

YaST knows two different language categories:

Primary Language
The primary language set in YaST applies to the entire system, including YaST
and the desktop environment. This language is used whenever available unless you
manually specify another language.

Secondary Languages
Install secondary languages to make your systemmultilingual. Languages installed
as secondary languages can be selected manually for a specific situation. For exam-
ple, use a secondary language to start an application in a certain language in order
to do word processing in this language.
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Before installing additional languages, determine which of them should be the default
system language (primary language) after you have installed them.

To access the YaST language module, start YaST and click System > Language. Alter-
natively, start the Languages dialog directly by running yast2 language & as user
root from a command line.

Procedure 13.1 Installing Additional Languages

When installing additional languages, YaST also allows you to set different locale set-
tings for the user root, see Step 4 (page 210). The option Locale Settings for User root
determines how the locale variables (LC_*) in the file/etc/sysconfig/language
are set for root. You can either set them to the same locale as for normal users, keep
it unaffected by any language changes or only set the variable RC_LC_CTYPE to the
same values as for the normal users. This variable sets the localization for language-
specific function calls.
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1 To add additional languages in the YaST language module, select the Secondary
Languages you wish to install.

2 To make a language the default language, set it as Primary Language.

3 Additionally, adapt the keyboard to the new primary language and adjust the time
zone, if appropriate.

TIP

For advanced keyboard or time zone settings, select Hardware > Keyboard
Layout or System > Date and Time in YaST to start the respective dialogs.
For more information, refer to Section 13.2, “Changing the Country and
Time Settings” (page 212).

4 To change language settings specific to the user root, click Details.

4a Set Locale Settings for User root to the desired value. For more information,
click Help.

4b Decide if you want to Use UTF-8 Encoding for root or not.

5 If your locale was not included in the list of primary languages available, try speci-
fying it with Detailed Locale Setting. However, some of these localizations may be
incomplete.

6 Confirm your changes in the dialogs with OK. If you have selected secondary lan-
guages, YaST installs the localized software packages for the additional languages.

The system is now multilingual. However, to start an application in a language other
than the primary one, you need to set the desired language explicitly as explained in
Section 13.1.3, “Switching Languages for Individual Applications” (page 211).

13.1.2 Switching the Default System
Language

1 To globally switch the default system language, start the YaST language module.
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2 Select the desired new system language as Primary Language.

IMPORTANT: Deleting Former System Languages

If you switch to a different primary language, the localized software packages
for the former primary language will be removed from the system. If you
want to switch the default system language but want to keep the former
primary language as additional language, add it as Secondary Language by
enabling the respective checkbox.

3 Adjust the keyboard and time zone options as desired.

4 Confirm your changes with OK.

5 After YaST has applied the changes, restart any X sessions (for example, by logging
out and logging in again) to make YaST and the desktop applications reflect your
new language settings.

13.1.3 Switching Languages for Individual
Applications

After you have installed the respective language with YaST, you can run a single appli-
cation in another language.

Standard X and GNOME Applications
Start the application from the command line by using the following command:
LANG=languageapplication

For example, to start f-spot in German, run LANG=de_DE f-spot. For other
languages, use the appropriate language code. Get a list of all language codes
available with the locale -av command.

KDE Applications
Start the application from the command line by using the following command:
KDE_LANG=languageapplication

For example, to start digiKam in German, run KDE_LANG=de digikam. For
other languages, use the appropriate language code.
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13.2 Changing the Country and Time
Settings

Using the YaST date and time module, adjust your system date, clock and time zone
information to the area you are working in. To access the YaST module, start YaST
and click System > Date and Time. Alternatively, start the Clock and Time Zone dialog
directly by running yast2 timezone & as user root from a command line.

First, select a general region, such as Europe. Choose an appropriate country that
matches the one you are working in, for example, Germany.

Depending on which operating systems run on your workstation, adjust the hardware
clock settings accordingly:

• If you run another operating system on your machine, such as Microsoft Windows*,
it is likely your system does not use UTC, but local time. In this case, uncheck
Hardware Clock Set To UTC.
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• If you only run Linux on your machine, set the hardware clock to UTC and have the
switch from standard time to daylight saving time performed automatically.

You can change the date and time manually or opt for synchronizing your machine
against an NTP server, either permanently or just for adjusting your hardware clock.

Procedure 13.2 Manually Adjusting Time and Date

1 In the YaST timezone module, click Change to set date and time.

2 SelectManually and enter date and time values.

3 Confirm your changes with Accept.

Procedure 13.3 Setting Date and Time With NTP Server

1 Click Change to set date and time.

2 Select Synchronize with NTP Server.

3 Enter the address of an NTP server, if not already populated.
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4 Click Synchronize Now, to get your system time set correctly.

5 If you want to make use of NTP permanently, enable Save NTP Configuration.

6 With theConfigure button, you can open the advancedNTP configuration. For details,
see Section “Configuring an NTP Client with YaST” (Chapter 22, Time Synchroniza-
tion with NTP, ↑Administration Guide).

7 Confirm your changes with Accept.
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14Remote Installation
SUSE® Linux Enterprise Server can be installed in different ways. As well as the
usual media installation covered in Chapter 6, Installation with YaST (page 89), you
can choose from various network-based approaches or even take a completely hands-
off approach to the installation of SUSE Linux Enterprise Server.

Eachmethod is introduced bymeans of two short check lists: one listing the prerequisites
for this method and the other illustrating the basic procedure. More detail is then pro-
vided for all the techniques used in these installation scenarios.

NOTE

In the following sections, the system to hold your new SUSE Linux Enterprise
Server installation is referred to as target system or installation target. The
term repository (previously called “installation source”) is used for all sources
of installation data. This includes physical media, such as CD and DVD, and
network servers distributing the installation data in your network.

14.1 Installation Scenarios for Remote
Installation

This section introduces the most common installation scenarios for remote installations.
For each scenario, carefully check the list of prerequisites and follow the procedure
outlined for this scenario. If in need of detailed instructions for a particular step, follow
the links provided for each one of them.
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IMPORTANT

The configuration of the X Window System is not part of any remote installation
process. After the installation has finished, log in to the target system as root,
enter telinit 3, and start SaX2 to configure the graphics hardware.

14.1.1 Simple Remote Installation via
VNC—Static Network Configuration

This type of installation still requires some degree of physical access to the target system
to boot for installation. The installation itself is entirely controlled by a remote worksta-
tion using VNC to connect to the installation program. User interaction is required as
with the manual installation in Chapter 6, Installation with YaST (page 89).

For this type of installation, make sure that the following requirements are met:

• Remote repository: NFS, HTTP, FTP, or SMB with working network connection.

• Target system with working network connection.

• Controlling system with working network connection and VNC viewer software or
Java-enabled browser (Firefox, Konqueror, Internet Explorer, Opera, etc.).

• Physical boot medium (CD, DVD, or USB flash drive) for booting the target system.

• Valid static IP addresses already assigned to the repository and the controlling system.

• Valid static IP address to assign to the target system.

To perform this kind of installation, proceed as follows:

1 Set up the repository as described in Section 14.2, “Setting Up the Server Holding
the Installation Sources” (page 223). Choose an NFS, HTTP, or FTP network server.
For an SMB repository, refer to Section 14.2.5, “Managing an SMB Reposito-
ry” (page 231).

2 Boot the target system using DVD1 of the SUSE Linux Enterprise Server media kit.
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3 When the boot screen of the target system appears, use the boot options prompt to
set the appropriate VNC options and the address of the repository. This is described
in detail in Section 14.4, “Booting the Target System for Installation” (page 243).

The target system boots to a text-based environment, giving the network address
and display number under which the graphical installation environment can be ad-
dressed by any VNC viewer application or browser. VNC installations announce
themselves over OpenSLP and if the firewall settings permit, they can be found using
Konqueror in service:/ or slp:/ mode.

4 On the controlling workstation, open a VNC viewing application or Web browser
and connect to the target system as described in Section 14.5.1, “VNC Installa-
tion” (page 247).

5 Perform the installation as described in Chapter 6, Installation with YaST (page 89).
Reconnect to the target system after it reboots for the final part of the installation.

6 Finish the installation.

14.1.2 Simple Remote Installation via
VNC—Dynamic Network
Configuration

This type of installation still requires some degree of physical access to the target system
to boot for installation. The network configuration is made with DHCP. The installation
itself is entirely controlled from a remote workstation using VNC to connect to the in-
staller, but still requires user interaction for the actual configuration efforts.

For this type of installation, make sure that the following requirements are met:

• Remote repository: NFS, HTTP, FTP, or SMB with working network connection.

• Target system with working network connection.

• Controlling system with working network connection and VNC viewer software or
Java-enabled browser (Firefox, Konqueror, Internet Explorer, or Opera).

• Boot the target system using DVD1 of the SUSE Linux Enterprise Server media kit.
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• Running DHCP server providing IP addresses.

To perform this kind of installation, proceed as follows:

1 Set up the repository as described in Section 14.2, “Setting Up the Server Holding
the Installation Sources” (page 223). Choose an NFS, HTTP, or FTP network server.
For an SMB repository, refer to Section 14.2.5, “Managing an SMB Reposito-
ry” (page 231).

2 Boot the target system using DVD1 of the SUSE Linux Enterprise Server media kit.

3 When the boot screen of the target system appears, use the boot options prompt to
set the appropriate VNC options and the address of the repository. This is described
in detail in Section 14.4, “Booting the Target System for Installation” (page 243).

The target system boots to a text-based environment, giving the network address
and display number under which the graphical installation environment can be ad-
dressed by any VNC viewer application or browser. VNC installations announce
themselves over OpenSLP and if the firewall settings permit, they can be found using
Konqueror in service:/ or slp:/ mode.

4 On the controlling workstation, open a VNC viewing application or Web browser
and connect to the target system as described in Section 14.5.1, “VNC Installa-
tion” (page 247).

5 Perform the installation as described in Chapter 6, Installation with YaST (page 89).
Reconnect to the target system after it reboots for the final part of the installation.

6 Finish the installation.

14.1.3 Remote Installation via VNC—PXE
Boot and Wake on LAN

This type of installation is completely hands-off. The target machine is started and
booted remotely. User interaction is only needed for the actual installation. This approach
is suitable for cross-site deployments.

To perform this type of installation, make sure that the following requirements are met:
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• Remote repository: NFS, HTTP, FTP, or SMB with working network connection.

• TFTP server.

• Running DHCP server for your network.

• Target system capable of PXE boot, networking, and Wake on LAN, plugged in and
connected to the network.

• Controlling system with working network connection and VNC viewer software or
Java-enabled browser (Firefox, Konqueror, Internet Explorer, or Opera).

To perform this type of installation, proceed as follows:

1 Set up the repository as described in Section 14.2, “Setting Up the Server Holding
the Installation Sources” (page 223). Choose an NFS, HTTP, or FTP network server
or configure an SMB repository as described in Section 14.2.5, “Managing an SMB
Repository” (page 231).

2 Set up a TFTP server to hold a boot image that can be pulled by the target system.
This is described in Section 14.3.2, “Setting Up a TFTP Server” (page 236).

3 Set up a DHCP server to provide IP addresses to all machines and reveal the location
of the TFTP server to the target system. This is described in Section 14.3.1, “Setting
Up a DHCP Server” (page 233).

4 Prepare the target system for PXE boot. This is described in further detail in Sec-
tion 14.3.5, “Preparing the Target System for PXE Boot” (page 242).

5 Initiate the boot process of the target system using Wake on LAN. This is described
in Section 14.3.7, “Wake on LAN” (page 243).

6 On the controlling workstation, open a VNC viewing application or Web browser
and connect to the target system as described in Section 14.5.1, “VNC Installa-
tion” (page 247).

7 Perform the installation as described in Chapter 6, Installation with YaST (page 89).
Reconnect to the target system after it reboots for the final part of the installation.

8 Finish the installation.
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14.1.4 Simple Remote Installation via
SSH—Static Network Configuration

This type of installation still requires some degree of physical access to the target system
to boot for installation and to determine the IP address of the installation target. The
installation itself is entirely controlled from a remote workstation using SSH to connect
to the installer. User interaction is required as with the regular installation described in
Chapter 6, Installation with YaST (page 89).

For this type of installation, make sure that the following requirements are met:

• Remote repository: NFS, HTTP, FTP, or SMB with working network connection.

• Target system with working network connection.

• Controlling system with working network connection and working SSH client soft-
ware.

• Boot the target system using DVD1 of the SUSE Linux Enterprise Server media kit.

• Valid static IP addresses already assigned to the repository and the controlling system.

• Valid static IP address to assign to the target system.

To perform this kind of installation, proceed as follows:

1 Set up the repository as described in Section 14.2, “Setting Up the Server Holding
the Installation Sources” (page 223). Choose an NFS, HTTP, or FTP network server.
For an SMB repository, refer to Section 14.2.5, “Managing an SMB Reposito-
ry” (page 231).

2 Boot the target system using DVD1 of the SUSE Linux Enterprise Server media kit.

3 When the boot screen of the target system appears, use the boot options prompt to
set the appropriate parameters for network connection, address of the repository,
and SSH enablement. This is described in detail in Section 14.4.2, “Using Custom
Boot Options” (page 244).
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The target system boots to a text-based environment, giving the network address
under which the graphical installation environment can be addressed by any SSH
client.

4 On the controlling workstation, open a terminal window and connect to the target
system as described in Section 14.5.2.2, “Connecting to the Installation Pro-
gram” (page 249).

5 Perform the installation as described in Chapter 6, Installation with YaST (page 89).
Reconnect to the target system after it reboots for the final part of the installation.

6 Finish the installation.

14.1.5 Simple Remote Installation via
SSH—Dynamic Network
Configuration

This type of installation still requires some degree of physical access to the target system
to boot for installation and determine the IP address of the installation target. The instal-
lation itself is entirely controlled from a remote workstation using VNC to connect to
the installer, but still requires user interaction for the actual configuration efforts.

For this type of installation, make sure that the following requirements are met:

• Remote repository: NFS, HTTP, FTP, or SMB with working network connection.

• Target system with working network connection.

• Controlling system with working network connection and working SSH client soft-
ware.

• Physical boot medium (CD, DVD, or USB flash drive) for booting the target system.

• Running DHCP server providing IP addresses.

To perform this kind of installation, proceed as follows:

1 Set up the repository source as described in Section 14.2, “Setting Up the Server
Holding the Installation Sources” (page 223). Choose an NFS, HTTP, or FTP network
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server. For an SMB repository, refer to Section 14.2.5, “Managing an SMB Reposi-
tory” (page 231).

2 Boot the target system using DVD1 of the SUSE Linux Enterprise Server media kit.

3 When the boot screen of the target system appears, use the boot options prompt to
pass the appropriate parameters for network connection, location of the installation
source, and SSH enablement. See Section 14.4.2, “Using Custom Boot Op-
tions” (page 244) for detailed instructions on the use of these parameters.

The target system boots to a text-based environment, giving you the network address
under which the graphical installation environment can be addressed by any SSH
client.

4 On the controlling workstation, open a terminal window and connect to the target
system as described in Section 14.5.2.2, “Connecting to the Installation Pro-
gram” (page 249).

5 Perform the installation as described in Chapter 6, Installation with YaST (page 89).
Reconnect to the target system after it reboots for the final part of the installation.

6 Finish the installation.

14.1.6 Remote Installation via SSH—PXE
Boot and Wake on LAN

This type of installation is completely hands-off. The target machine is started and
booted remotely.

To perform this type of installation, make sure that the following requirements are met:

• Remote repository: NFS, HTTP, FTP, or SMB with working network connection.

• TFTP server.

• Running DHCP server for your network, providing a static IP to the host to install.

• Target system capable of PXE boot, networking, and Wake on LAN, plugged in and
connected to the network.
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• Controlling system with working network connection and SSH client software.

To perform this type of installation, proceed as follows:

1 Set up the repository as described in Section 14.2, “Setting Up the Server Holding
the Installation Sources” (page 223). Choose an NFS, HTTP, or FTP network server.
For the configuration of an SMB repository, refer to Section 14.2.5, “Managing an
SMB Repository” (page 231).

2 Set up a TFTP server to hold a boot image that can be pulled by the target system.
This is described in Section 14.3.2, “Setting Up a TFTP Server” (page 236).

3 Set up a DHCP server to provide IP addresses to all machines and reveal the location
of the TFTP server to the target system. This is described in Section 14.3.1, “Setting
Up a DHCP Server” (page 233).

4 Prepare the target system for PXE boot. This is described in further detail in Sec-
tion 14.3.5, “Preparing the Target System for PXE Boot” (page 242).

5 Initiate the boot process of the target system using Wake on LAN. This is described
in Section 14.3.7, “Wake on LAN” (page 243).

6 On the controlling workstation, start an SSH client and connect to the target system
as described in Section 14.5.2, “SSH Installation” (page 249).

7 Perform the installation as described in Chapter 6, Installation with YaST (page 89).
Reconnect to the target system after it reboots for the final part of the installation.

8 Finish the installation.

14.2 Setting Up the Server Holding
the Installation Sources

Depending on the operating system running on the machine to use as the network instal-
lation source for SUSE Linux Enterprise Server, there are several options for the server
configuration. The easiest way to set up an installation server is to use YaST on SUSE
Linux Enterprise Server 11 SP2 or openSUSE 11.1 and higher.
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TIP

You can even use a Microsoft Windows machine as the installation server for
your Linux deployment. See Section 14.2.5, “Managing an SMB Reposito-
ry” (page 231) for details.

14.2.1 Setting Up an Installation Server
Using YaST

YaST offers a graphical tool for creating network repositories. It supports HTTP, FTP,
and NFS network installation servers.

1 Log in as root to the machine that should act as installation server.

2 Start YaST >Miscellaneous > Installation Server.

3 Select the repository type (HTTP, FTP, or NFS). The selected service is started au-
tomatically every time the system starts. If a service of the selected type is already
running on your system and you want to configure it manually for the server, deac-
tivate the automatic configuration of the server service with Do Not Configure Any
Network Services. In both cases, define the directory in which the installation data
should be made available on the server.

4 Configure the required repository type. This step relates to the automatic configuration
of server services. It is skipped when automatic configuration is deactivated.

Define an alias for the root directory of the FTP or HTTP server on which the instal-
lation data should be found. The repository will later be located under
ftp://Server-IP/Alias/Name (FTP) or under
http://Server-IP/Alias/Name (HTTP). Name stands for the name of the
repository, which is defined in the following step. If you selected NFS in the previous
step, define wild cards and export options. The NFS server will be accessible under
nfs://Server-IP/Name. Details of NFS and exports can be found in Chapter 27,
Sharing File Systems with NFS (↑Administration Guide).
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TIP: Firewall Settings

Make sure that the firewall settings of your server system allow traffic on
the ports for HTTP, NFS, and FTP. If they currently do not, enable Open Port
in Firewall or check Firewall Details first.

5 Configure the repository. Before the installationmedia are copied to their destination,
define the name of the repository (ideally, an easily remembered abbreviation of the
product and version). YaST allows providing ISO images of the media instead of
copies of the installation DVDs. If you want this, activate the relevant check box
and specify the directory path under which the ISO files can be found locally. De-
pending on the product to distribute using this installation server, it might be that
more add-on CDs or service pack CDs are required and should be added as extra
repositories. To announce your installation server in the network via OpenSLP, acti-
vate the appropriate option.

TIP

Consider announcing your repository via OpenSLP if your network setup
supports this option. This saves you from entering the network installation
path on every target machine. The target systems are just booted using the
SLP boot option and find the network repository without any further confi-
guration. For details on this option, refer to Section 14.4, “Booting the Target
System for Installation” (page 243).

6 Upload the installation data. The most lengthy step in configuring an installation
server is copying the actual installation media. Insert the media in the sequence re-
quested by YaST and wait for the copying procedure to end. When the sources have
been fully copied, return to the overview of existing repositories and close the con-
figuration by selecting Finish.

Your installation server is now fully configured and ready for service. It is automat-
ically started every time the system is started. No further intervention is required.
You only need to configure and start this service correctly by hand if you have deac-
tivated the automatic configuration of the selected network service with YaST as an
initial step.

To deactivate a repository, select the repository to remove then select Delete. The in-
stallation data are removed from the system. To deactivate the network service, use the
respective YaST module.
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If your installation server needs to provide the installation data for more than one
product of the product version, start the YaST installation server module and select Add
in the overview of existing repositories to configure the new repository.

14.2.2 Setting Up an NFS Repository
Manually

Setting up an NFS source for installation is basically done in two steps. In the first step,
create the directory structure holding the installation data and copy the installation
media over to this structure. Second, export the directory holding the installation data
to the network.

To create a directory to hold the installation data, proceed as follows:

1 Log in as root.

2 Create a directory that will later hold all installation data and change into this direc-
tory. For example:
mkdir install/product/productversion

cd install/product/productversion

Replaceproductwith an abbreviation of the product name andproductversion
with a string that contains the product name and version.

3 For each DVD contained in the media kit execute the following commands:

3a Copy the entire content of the installation DVD into the installation server
directory:
cp -a /media/path_to_your_DVD_drive .

Replace path_to_your_DVD_drive with the actual path under which
your DVD drive is addressed. Depending on the type of drive used in your
system, this can be cdrom, cdrecorder, dvd, or dvdrecorder.

3b Rename the directory to the DVD number:
mv path_to_your_DVD_drive DVDx

Replace x with the actual number of your DVD.
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On SUSELinux Enterprise Server, you can export the repository with NFS using YaST.
Proceed as follows:

1 Log in as root.

2 Start YaST > Network Services > NFS Server.

3 Select Start and Open Port in Firewall and click Next.

4 Select Add Directory and browse for the directory containing the installation sources,
in this case, productversion.

5 Select Add Host and enter the hostnames of the machines to which to export the in-
stallation data. Instead of specifying hostnames here, you could also use wild cards,
ranges of network addresses, or just the domain name of your network. Enter the
appropriate export options or leave the default, which works fine in most setups. For
more information about the syntax used in exporting NFS shares, read the exports
man page.

6 Click Finish. The NFS server holding the SUSE Linux Enterprise Server repository
is automatically started and integrated into the boot process.

If you prefer manually exporting the repository via NFS instead of using the YaST NFS
Server module, proceed as follows:

1 Log in as root.

2 Open the file /etc/exports and enter the following line:
/productversion *(ro,root_squash,sync)

This exports the directory /productversion to any host that is part of this net-
work or to any host that can connect to this server. To limit the access to this server,
use netmasks or domain names instead of the general wild card *. Refer to the
export man page for details. Save and exit this configuration file.

3 To add the NFS service to the list of servers started during system boot, execute the
following commands:
insserv /etc/init.d/nfsserver
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4 Start the NFS server with rcnfsserver start. If you need to change the con-
figuration of your NFS server later, modify the configuration file and restart the NFS
daemon with rcnfsserver restart.

Announcing the NFS server via OpenSLP makes its address known to all clients in
your network.

1 Log in as root.

2 Create the /etc/slp.reg.d/install.suse.nfs.reg configuration file
with the following lines:

# Register the NFS Installation Server
service:install.suse:nfs://$HOSTNAME/path_to_repository/DVD1,en,65535
description=NFS Repository

Replace path_to_repository with the actual path to the installation source
on your server.

3 Start the OpenSLP daemon with rcslpd start.

For more information about OpenSLP, refer to the package documentation located under
/usr/share/doc/packages/openslp/ or refer to Chapter 21, SLP Services
in the Network (↑Administration Guide). More Information about NFS, refer to Chap-
ter 27, Sharing File Systems with NFS (↑Administration Guide).

14.2.3 Setting Up an FTP Repository
Manually

Creating an FTP repository is very similar to creating an NFS repository. An FTP
repository can be announced over the network using OpenSLP as well.

1 Create a directory holding the installation sources as described in Section 14.2.2,
“Setting Up an NFS Repository Manually” (page 226).

2 Configure the FTP server to distribute the contents of your installation directory:

2a Log in as root and install the package vsftpd using the YaST software
management.
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2b Enter the FTP server root directory:
cd /srv/ftp

2c Create a subdirectory holding the installation sources in the FTP root directory:
mkdir repository

Replace repository with the product name.

2d Mount the contents of the installation repository into the change root environ-
ment of the FTP server:
mount --bind path_to_repository /srv/ftp/repository

Replacepath_to_repository andrepositorywith valuesmatching
your setup. If you need to make this permanent, add it to /etc/fstab.

2e Start vsftpd with vsftpd.

3 Announce the repository via OpenSLP, if this is supported by your network setup:

3a Create the/etc/slp.reg.d/install.suse.ftp.reg configuration
file with the following lines:

# Register the FTP Installation Server
service:install.suse:ftp://$HOSTNAME/repository/DVD1,en,65535
description=FTP Repository

Replace repository with the actual name to the repository directory on
your server. The service: line should be entered as one continuous line.

3b Start the OpenSLP daemon with rcslpd start.

TIP: Configuring an FTP Server with YaST

If you prefer using YaST over manually configuring the FTP installation server,
refer to Chapter 30, Setting up an FTP server with YaST (↑Administration Guide)
for more information on how to use the YaST FTP server module.
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14.2.4 Setting Up an HTTP Repository
Manually

Creating an HTTP repository is very similar to creating an NFS repository. An HTTP
repository can be announced over the network using OpenSLP as well.

1 Create a directory holding the installation sources as described in Section 14.2.2,
“Setting Up an NFS Repository Manually” (page 226).

2 Configure the HTTP server to distribute the contents of your installation directory:

2a Install the Web server Apache as described in Section “Installation” (Chap-
ter 29, The Apache HTTP Server, ↑Administration Guide).

2b Enter the root directory of the HTTP server (/srv/www/htdocs) and
create the subdirectory that will hold the installation sources:
mkdir repository

Replace repository with the product name.

2c Create a symbolic link from the location of the installation sources to the root
directory of the Web server (/srv/www/htdocs):
ln -s /path_to_repository /srv/www/htdocs/repository

2d Modify the configuration file of the HTTP server (/etc/apache2/
default-server.conf) to make it follow symbolic links. Replace the
following line:
Options None

with
Options Indexes FollowSymLinks

2e Reload the HTTP server configuration using rcapache2 reload.

3 Announce the repository via OpenSLP, if this is supported by your network setup:
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Create the/etc/slp.reg.d/install.suse.http.reg configuration
file with the following lines:

3a

# Register the HTTP Installation Server
service:install.suse:http://$HOSTNAME/repository/DVD1/,en,65535
description=HTTP Repository

Replace repository with the actual path to the repository on your server.
The service: line should be entered as one continuous line.

3b Start the OpenSLP daemon using rcslpd restart.

14.2.5 Managing an SMB Repository
Using SMB, you can import the installation sources from a Microsoft Windows server
and start your Linux deployment even with no Linux machine around.

To set up an exported Windows Share holding your SUSE Linux Enterprise Server
repository, proceed as follows:

1 Log in to your Windows machine.

2 Create a new folder that will hold the entire installation tree and name it INSTALL,
for example.

3 Export this share according the procedure outlined in yourWindows documentation.

4 Enter this share and create a subfolder, called product. Replace product with
the actual product name.

5 Enter the INSTALL/product folder and copy each DVD to a separate folder,
such as DVD1 and DVD2.

To use a SMB mounted share as a repository, proceed as follows:

1 Boot the installation target.

2 Select Installation.
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3 Press F4 for a selection of the repository.

4 Choose SMB and enter the Windows machine's name or IP address, the share name
(INSTALL/product/DVD1, in this example), username, and password.

After you hit Enter, YaST starts and you can perform the installation.

14.2.6 Using ISO Images of the Installation
Media on the Server

Instead of copying physical media into your server directory manually, you can also
mount the ISO images of the installation media into your installation server and use
them as a repository. To set up an HTTP, NFS or FTP server that uses ISO images in-
stead of media copies, proceed as follows:

1 Download the ISO images and save them to the machine to use as the installation
server.

2 Log in as root.

3 Choose and create an appropriate location for the installation data, as described in
Section 14.2.2, “Setting Up anNFSRepositoryManually” (page 226), Section 14.2.3,
“Setting Up an FTP Repository Manually” (page 228), or Section 14.2.4, “Setting
Up an HTTP Repository Manually” (page 230).

4 Create subdirectories for each DVD.

5 To mount and unpack each ISO image to the final location, issue the following
command:
mount -o loop path_to_isopath_to_repository/product/mediumx

Replace path_to_iso with the path to your local copy of the ISO image,
path_to_repositorywith the source directory of your server, productwith
the product name, and mediumx with the type (CD or DVD) and number of media
you are using.

6 Repeat the previous step to mount all ISO images needed for your product.
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7 Start your installation server as usual, as described in Section 14.2.2, “Setting Up
an NFS Repository Manually” (page 226), Section 14.2.3, “Setting Up an FTP
RepositoryManually” (page 228), or Section 14.2.4, “SettingUp anHTTPRepository
Manually” (page 230).

To automatically mount the ISO images at boot time, add the respective mount entries
to /etc/fstab. An entry according to the previous example would look like the
following:
path_to_iso path_to_repository/productmedium auto loop

14.3 Preparing the Boot of the Target
System

This section covers the configuration tasks needed in complex boot scenarios. It contains
ready-to-apply configuration examples for DHCP, PXE boot, TFTP, and Wake on
LAN.

14.3.1 Setting Up a DHCP Server
There are two ways to set up a DHCP server. For SUSE Linux Enterprise Server, YaST
provides a graphical interface to the process. Users can also manually edit the configu-
ration files. For more information about DHCP servers, see also Chapter 24, DHCP
(↑Administration Guide).

14.3.1.1 Setting Up a DHCP Server with YaST
To announce the TFTP server's location to the network clients and specify the boot
image file the installation target should use, add two declarations to your DHCP server
configuration.
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1 Log in as root to the machine hosting the DHCP server.

2 Start YaST > Network Services > DHCP Server.

3 Complete the setup wizard for basic DHCP server setup.

4 Select Expert Settings and select Yeswhen warned about leaving the start-up dialog.

5 In the Configured Declarations dialog, select the subnet in which the new system
should be located and click Edit.

6 In the Subnet Configuration dialog select Add to add a new option to the subnet's
configuration.

7 Select filename and enter pxelinux.0 as the value.

8 Add another option (next-server) and set its value to the address of the TFTP
server.

9 Select OK and Finish to complete the DHCP server configuration.

To configure DHCP to provide a static IP address to a specific host, enter the Expert
Settings of the DHCP server configuration module (Step 4 (page 234)) and add a new
declaration of the host type. Add the options hardware and fixed-address to
this host declaration and provide the appropriate values.

14.3.1.2 Setting Up a DHCP Server Manually
All the DHCP server needs to do, apart from providing automatic address allocation to
your network clients, is to announce the IP address of the TFTP server and the file that
needs to be pulled in by the installation routines on the target machine.

1 Log in as root to the machine hosting the DHCP server.

2 Append the following lines to a subnet configuration of your DHCP server's confi-
guration file located under /etc/dhcpd.conf:
subnet 192.168.1.0 netmask 255.255.255.0 {
range dynamic-bootp 192.168.1.200 192.168.1.228;
# PXE related stuff
#
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# "next-server" defines the tftp server that will be used
next-server ip_tftp_server:
#
# "filename" specifies the pxelinux image on the tftp server
# the server runs in chroot under /srv/tftpboot
filename "pxelinux.0";

}

Replace ip_of_the_tftp_server with the actual IP address of the TFTP
server. For more information about the options available in dhcpd.conf, refer to
the dhcpd.conf manual page.

3 Restart the DHCP server by executing rcdhcpd restart.

If you plan on using SSH for the remote control of a PXE andWake on LAN installation,
explicitly specify the IP address DHCP should provide to the installation target. To
achieve this, modify the above mentioned DHCP configuration according to the follow-
ing example:
group {

# PXE related stuff
#
# "next-server" defines the tftp server that will be used
next-server ip_tftp_server:
#
# "filename" specifies the pxelinux image on the tftp server
# the server runs in chroot under /srv/tftpboot
filename "pxelinux.0";
host test {

hardware ethernet mac_address;
fixed-address some_ip_address;
}

}

The host statement introduces the hostname of the installation target. To bind the
hostname and IP address to a specific host, you must know and specify the system's
hardware (MAC) address. Replace all the variables used in this example with the actual
values that match your environment.

After restarting the DHCP server, it provides a static IP to the host specified, enabling
you to connect to the system via SSH.

Remote Installation 235



14.3.2 Setting Up a TFTP Server
Set up a TFTP server with YaST on SUSE Linux Enterprise Server and SUSE Linux
Enterprise Server or set it upmanually on any other Linux operating system that supports
xinetd and TFTP. The TFTP server delivers the boot image to the target system once
it boots and sends a request for it.

14.3.2.1 Setting Up a TFTP Server Using YaST
1 Log in as root.

2 Start YaST > Network Services > TFTP Server and install the requested package.

3 Click Enable to make sure that the server is started and included in the boot routines.
No further action from your side is required to secure this. xinetd starts tftpd at boot
time.

4 Click Open Port in Firewall to open the appropriate port in the firewall running on
your machine. If there is no firewall running on your server, this option is not
available.

5 Click Browse to browse for the boot image directory. The default directory
/tftpboot is created and selected automatically.

6 Click Finish to apply your settings and start the server.

14.3.2.2 Setting Up a TFTP Server Manually
1 Log in as root and install the packages tftp and xinetd.

2 If unavailable, create/srv/tftpboot and/srv/tftpboot/pxelinux.cfg
directories.

3 Add the appropriate files needed for the boot image as described in Section 14.3.3,
“Using PXE Boot” (page 237).

4 Modify the configuration of xinetd located under /etc/xinetd.d to make sure
that the TFTP server is started on boot:
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4a If it does not exist, create a file called tftp under this directory with touch
tftp. Then run chmod 755 tftp.

4b Open the file tftp and add the following lines:
service tftp
{

socket_type = dgram
protocol = udp
wait = yes
user = root
server = /usr/sbin/in.tftpd
server_args = -s /srv/tftpboot
disable = no

}

4c Save the file and restart xinetd with rcxinetd restart.

14.3.3 Using PXE Boot
Some technical background information as well as PXE's complete specifications are
available in the Preboot Execution Environment (PXE) Specification (http://www
.pix.net/software/pxeboot/archive/pxespec.pdf).

1 Change to the directory boot/<architecture>/loader of your installation
repository and copy the linux, initrd, message, biostest, and memtest
files to the /srv/tftpboot directory by entering the following:
cp -a linux initrd message biostest memtest /srv/tftpboot

2 Install the syslinux package directly from your installation DVDs with YaST.

3 Copy the/usr/share/syslinux/pxelinux.0 file to the/srv/tftpboot
directory by entering the following:
cp -a /usr/share/syslinux/pxelinux.0 /srv/tftpboot

4 Change to the directory of your installation repository and copy the isolinux
.cfg file to /srv/tftpboot/pxelinux.cfg/default by entering the
following:
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cp -a boot/<architecture>/loader/isolinux.cfg
/srv/tftpboot/pxelinux.cfg/default

5 Edit the/srv/tftpboot/pxelinux.cfg/default file and remove the lines
beginning with readinfo and framebuffer.

6 Insert the following entries in the append lines of the default failsafe and apic
labels:

insmod=kernel module
By means of this entry, enter the network Kernel module needed to support
network installation on the PXE client. Replace kernel module with the
appropriate module name for your network device.

netdevice=interface
This entry defines the client's network interface that must be used for the network
installation. It is only necessary if the client is equipped with several network
cards and must be adapted accordingly. In case of a single network card, this
entry can be omitted.

install=nfs://ip_instserver/path_to_repository/DVD1
This entry defines the NFS server and the repository for the client installation.
Replace ip_instserver with the actual IP address of your installation
server. path_to_repository should be replaced with the actual path to
the repository. HTTP, FTP, or SMB repositories are addressed in a similar
manner, except for the protocol prefix, which should read http, ftp, or smb.

IMPORTANT

If you need to pass other boot options to the installation routines, such
as SSH or VNC boot parameters, append them to the install entry.
An overview of parameters and some examples are given in Section 14.4,
“Booting the Target System for Installation” (page 243).

TIP: Changing Kernel and initrd Filenames

It is possible to use different filenames for Kernel and initrd images. This is
useful if you want to provide different operating systems from the same
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boot server. However, you should be aware that only one dot is permitted
in the filenames that are provided by TFTP for the PXE boot.

An example/srv/tftpboot/pxelinux.cfg/default file follows. Adjust
the protocol prefix for the repository to match your network setup and specify your
preferred method of connecting to the installer by adding the vnc and
vncpassword or theusessh andsshpassword options to theinstall entry.
The lines separated by \must be entered as one continuous line without a line break
and without the \.
default harddisk

# default
label linux
kernel linux
append initrd=initrd ramdisk_size=65536 \

install=nfs://ip_instserver/path_to_repository/product/DVD1

# repair
label repair
kernel linux
append initrd=initrd splash=silent repair=1 showopts

# rescue
label rescue
kernel linux
append initrd=initrd ramdisk_size=65536 rescue=1

# bios test
label firmware
kernel linux
append initrd=biostest,initrd splash=silent install=exec:/bin/run_biostest
showopts

# memory test
label memtest
kernel memtest

# hard disk
label harddisk
localboot 0

implicit 0
display message
prompt 1
timeout 100
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7 Replace ip_instserver and path_to_repositorywith the values used in
your setup.

The following section serves as a short reference to the PXELINUX options used
in this setup. Find more information about the options available in the documentation
of the syslinux package located under /usr/share/doc/packages/
syslinux/.

14.3.4 PXELINUX Configuration Options
The options listed here are a subset of all the options available for the PXELINUX
configuration file.

DEFAULT kernel options...
Sets the default Kernel command line. If PXELINUX boots automatically, it acts
as if the entries after DEFAULT had been typed in at the boot prompt, except the
auto option is automatically added, indicating an automatic boot.

If no configuration file is present or no DEFAULT entry is present in the configu-
ration file, the default is the Kernel name “linux” with no options.

APPEND options...
Add one or more options to the Kernel command line. These are added for both
automatic and manual boots. The options are added at the very beginning of the
Kernel command line, usually permitting explicitly entered Kernel options to
override them.

LABEL label KERNEL image APPEND options...
Indicates that if label is entered as the Kernel to boot, PXELINUX should instead
boot image and the specified APPEND options should be used instead of the ones
specified in the global section of the file (before the first LABEL command). The
default for image is the same as label and, if no APPEND is given, the default
is to use the global entry (if any). Up to 128 LABEL entries are permitted.

Note that GRUB uses the following syntax:
title mytitle
kernel my_kernelmy_kernel_options
initrd myinitrd
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PXELINUX uses the following syntax:
label mylabel
kernel mykernel
append myoptions

Labels are mangled as if they were filenames and they must be unique after man-
gling. For example, the two labels “v2.6.30” and “v2.6.31” would not be distin-
guishable under PXELINUX because both mangle to the same DOS filename.

The Kernel does not have to be a Linux Kernel; it can be a boot sector or a COM-
BOOT file.

APPEND -
Append nothing. APPEND with a single hyphen as argument in a LABEL section
can be used to override a global APPEND.

LOCALBOOT type
On PXELINUX, specifying LOCALBOOT 0 instead of a KERNEL option means
invoking this particular label and causes a local disk boot instead of a Kernel boot.

DescriptionArgument

Perform a normal boot0

Perform a local boot with the Universal Network Driver
Interface (UNDI) driver still resident in memory

4

Perform a local boot with the entire PXE stack, including
the UNDI driver, still resident in memory

5

All other values are undefined. If you do not know what the UNDI or PXE stacks
are, specify 0.

TIMEOUT time-out
Indicates how long to wait at the boot prompt until booting automatically, in units
of 1/10 second. The time-out is canceled as soon as the user types anything on the
keyboard, assuming the user will complete the command begun. A time-out of zero
disables the time-out completely (this is also the default). The maximum possible
time-out value is 35996 (just less than one hour).
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PROMPT flag_val
If flag_val is 0, displays the boot prompt only if Shift or Alt is pressed or Caps
Lock or Scroll Lock is set (this is the default). If flag_val is 1, always displays
the boot prompt.
F2 filename
F1 filename
..etc...
F9 filename
F10 filename

Displays the indicated file on the screen when a function key is pressed at the boot
prompt. This can be used to implement preboot online help (presumably for the
Kernel command line options). For backward compatibility with earlier releases,
F10 can be also entered as F0. Note that there is currently no way to bind filenames
to F11 and F12.

14.3.5 Preparing the Target System for PXE
Boot

Prepare the system's BIOS for PXE boot by including the PXE option in the BIOS boot
order.

WARNING: BIOS Boot Order

Do not place the PXE option ahead of the hard disk boot option in the BIOS.
Otherwise this system would try to reinstall itself every time you boot it.

14.3.6 Preparing the Target System for
Wake on LAN

Wake on LAN (WOL) requires the appropriate BIOS option to be enabled prior to the
installation. Also, note down theMAC address of the target system. This data is needed
to initiate Wake on LAN.
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14.3.7 Wake on LAN
Wake on LAN allows a machine to be turned on by a special network packet containing
the machine's MAC address. Because every machine in the world has a unique MAC
identifier, you do not need to worry about accidentally turning on the wrong machine.

IMPORTANT: Wake on LAN across Different Network Segments

If the controlling machine is not located in the same network segment as the
installation target that should be awakened, either configure the WOL requests
to be sent as multicasts or remotely control a machine on that network segment
to act as the sender of these requests.

Users of SUSE Linux Enterprise Server can use a YaST module called WOL to easily
configure Wake on LAN. Users of other versions of SUSE Linux-based operating sys-
tems can use a command line tool.

14.3.8 Wake on LAN with YaST
1 Log in as root.

2 Start YaST > Network Services >WOL.

3 Click Add and enter the hostname and MAC address of the target system.

4 To turn on this machine, select the appropriate entry and clickWake up.

14.4 Booting the Target System for
Installation

Basically, there are two different ways to customize the boot process for installation
apart from those mentioned under Section 14.3.7, “Wake on LAN” (page 243) and
Section 14.3.3, “Using PXEBoot” (page 237). You can either use the default boot options
and function keys or use the boot options prompt of the installation boot screen to pass
any boot options that the installation Kernel might need on this particular hardware.
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14.4.1 Using the Default Boot Options
The boot options are described in detail in Chapter 6, Installation with YaST (page 89).
Generally, just selecting Installation starts the installation boot process.

If problems occur, use Installation—ACPI Disabled or Installation—Safe Settings. For
more information about troubleshooting the installation process, refer to Section “In-
stallation Problems” (Chapter 34, Common Problems and Their Solutions, ↑Adminis-
tration Guide).

The menu bar at the bottom screen offers some advanced functionality needed in some
setups. Using the F keys, you can specify additional options to pass to the installation
routines without having to know the detailed syntax of these parameters (see Sec-
tion 14.4.2, “Using Custom Boot Options” (page 244)). A detailed description of the
available function keys is available at Section 6.6, “The Boot Screen” (page 93).

14.4.2 Using Custom Boot Options
Using the appropriate set of boot options helps facilitate your installation procedure.
Many parameters can also be configured later using the linuxrc routines, but using the
boot options is easier. In some automated setups, the boot options can be provided with
initrd or an info file.

The following table lists all installation scenarios mentioned in this chapter with the
required parameters for booting and the corresponding boot options. Just append all of
them in the order they appear in this table to get one boot option string that is handed
to the installation routines. For example (all in one line):
install=xxx netdevice=xxx hostip=xxx netmask=xxx vnc=xxx vncpassword=xxx

Replace all the values xxx in this string with the values appropriate for your setup.
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Table 14.1 Installation (Boot) Scenarios Used in This Chapter

Boot OptionsParameters Needed
for Booting

Installation Scenario

None neededNone: system boots
automatically

Chapter 6, Installa-
tion with
YaST (page 89)

Section 14.1.1, “Sim-
ple Remote Installa-

• install=(nfs,http,
ftp,smb)://path_to
_instmedia

• Location of the in-
stallation server

tion via VNC—Static
Network Configura-
tion” (page 216)

• Network device
• IP address • netdevice=some

_netdevice (only• Netmask
• Gateway needed if several network

devices are available)• VNC enablement
• VNC password • hostip=some_ip

• netmask=some
_netmask

• gateway=ip_gateway
• vnc=1
• vncpassword=some
_password

Section 14.1.2, “Sim-
ple Remote Installa-

• install=(nfs,http,
ftp,smb)://path_to
_instmedia

• Location of the in-
stallation server

tion via VNC—Dy-
namicNetworkConfi-
guration” (page 217)

• VNC enablement
• VNC password • vnc=1

• vncpassword=some
_password

Not applicable; process man-
aged through PXE and
DHCP

Section 14.1.3, “Re-
mote Installation via
VNC—PXEBoot and

• Location of the in-
stallation server

• Location of the
TFTP serverWake on

LAN” (page 218) • VNC enablement
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Boot OptionsParameters Needed
for Booting

Installation Scenario

• VNC password

Section 14.1.4, “Sim-
ple Remote Installa-

• install=(nfs,http,
ftp,smb)://path_to
_instmedia

• Location of the in-
stallation server

tion via SSH—Static
Network Configura-
tion” (page 220)

• Network device
• IP address • netdevice=some

_netdevice (only• Netmask
• Gateway needed if several network

devices are available)• SSH enablement
• SSH password • hostip=some_ip

• netmask=some
_netmask

• gateway=ip_gateway
• usessh=1
• sshpassword=some
_password

Section 14.1.5, “Sim-
ple Remote Installa-

• install=(nfs,http,
ftp,smb)://path_to
_instmedia

• Location of the in-
stallation server

tion via SSH—Dy-
namicNetworkConfi-
guration” (page 221)

• SSH enablement
• SSH password • usessh=1

• sshpassword=some
_password

Not applicable; process man-
aged through PXE and
DHCP

Section 14.1.6, “Re-
mote Installation via
SSH—PXE Boot and

• Location of the in-
stallation server

• Location of the
TFTP serverWake on

LAN” (page 222) • SSH enablement
• SSH password

246 Deployment Guide



TIP: More Information about linuxrc Boot Options

Find more information about the linuxrc boot options used for booting a Linux
system at http://en.opensuse.org/SDB:Linuxrc.

14.5 Monitoring the Installation
Process

There are several options for remotely monitoring the installation process. If the proper
boot options have been specified while booting for installation, either VNC or SSH can
be used to control the installation and system configuration from a remote workstation.

14.5.1 VNC Installation
Using any VNC viewer software, you can remotely control the installation of SUSE
Linux Enterprise Server from virtually any operating system. This section introduces
the setup using a VNC viewer application or a Web browser.

14.5.1.1 Preparing for VNC Installation
All you need to do on the installation target to prepare for a VNC installation is to
provide the appropriate boot options at the initial boot for installation (see Section 14.4.2,
“Using Custom Boot Options” (page 244)). The target system boots into a text-based
environment and waits for a VNC client to connect to the installation program.

The installation program announces the IP address and display number needed to connect
for installation. If you have physical access to the target system, this information is
provided right after the system booted for installation. Enter this data when your VNC
client software prompts for it and provide your VNC password.

Because the installation target announces itself via OpenSLP, you can retrieve the address
information of the installation target via an SLP browser without the need for any
physical contact to the installation itself, provided your network setup and all machines
support OpenSLP:
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1 Start the KDE file and Web browser Konqueror.

2 Enter service://yast.installation.suse in the location bar. The target
system then appears as an icon in the Konqueror screen. Clicking this icon launches
the KDE VNC viewer in which to perform the installation. Alternatively, run your
VNC viewer software with the IP address provided and add :1 at the end of the IP
address for the display the installation is running on.

14.5.1.2 Connecting to the Installation Program
Basically, there are two ways to connect to a VNC server (the installation target in this
case). You can either start an independent VNC viewer application on any operating
system or connect using a Java-enabled Web browser.

Using VNC, you can control the installation of a Linux system from any other operating
system, including other Linux flavors, Windows, or Mac OS.

On a Linuxmachine, make sure that the package tightvnc is installed. On aWindows
machine, install the Windows port of this application, which can be obtained at the
TightVNC home page (http://www.tightvnc.com/download.html).

To connect to the installation program running on the target machine, proceed as follows:

1 Start the VNC viewer.

2 Enter the IP address and display number of the installation target as provided by the
SLP browser or the installation program itself:
ip_address:display_number

A window opens on your desktop displaying the YaST screens as in a normal local
installation.

Using aWeb browser to connect to the installation programmakes you totally indepen-
dent of any VNC software or the underlying operating system. As long as the browser
application has Java support enabled, you can use any browser (Firefox, Internet Ex-
plorer, Konqueror, Opera, etc.) to perform the installation of your Linux system.

To perform a VNC installation, proceed as follows:

1 Launch your preferred Web browser.
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2 Enter the following at the address prompt:
http://ip_address_of_target:5801

3 Enter your VNC password when prompted to do so. The browser window now dis-
plays the YaST screens as in a normal local installation.

14.5.2 SSH Installation
Using SSH, you can remotely control the installation of your Linux machine using any
SSH client software.

14.5.2.1 Preparing for SSH Installation
Apart from installing the appropriate software package (OpenSSH for Linux and PuTTY
for Windows), you just need to pass the appropriate boot options to enable SSH for
installation. See Section 14.4.2, “Using Custom Boot Options” (page 244) for details.
OpenSSH is installed by default on any SUSE Linux–based operating system.

14.5.2.2 Connecting to the Installation Program
1 Retrieve the installation target's IP address. If you have physical access to the target

machine, just take the IP address the installation routine provides at the console after
the initial boot. Otherwise take the IP address that has been assigned to this particular
host in the DHCP server configuration.

2 At a command line, enter the following command:
ssh -X root@
ip_address_of_target

Replace ip_address_of_target with the actual IP address of the installation
target.

3 When prompted for a username, enter root.

4 When prompted for the password, enter the password that has been set with the SSH
boot option. After you have successfully authenticated, a command line prompt for
the installation target appears.
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5 Enter yast to launch the installation program. Awindow opens showing the normal
YaST screens as described in Chapter 6, Installation with YaST (page 89).
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15Advanced Disk Setup
Sophisticated system configurations require specific disk setups. All common partitioning
tasks can be done with YaST. To get persistent device naming with block devices, use
the block devices below /dev/disk/by-id or /dev/disk/by-uuid. Logical
Volume Management (LVM) is a disk partitioning scheme that is designed to be much
more flexible than the physical partitioning used in standard setups. Its snapshot func-
tionality enables easy creation of data backups. Redundant Array of Independent Disks
(RAID) offers increased data integrity, performance, and fault tolerance. SUSE Linux
Enterprise Server also supports multipath I/O (see Chapter 7,Managing Multipath I/O
for Devices (↑SLES 11 SP2: Storage Administration Guide) for details), and there is
also the option to use iSCSI as a networked disk (read more about iSCSI in Chapter 13,
Mass Storage over IP Networks: iSCSI (↑SLES 11 SP2: StorageAdministrationGuide)).

15.1 Using the YaST Partitioner
With the expert partitioner, shown in Figure 15.1, “The YaST Partitioner” (page 252),
manually modify the partitioning of one or several hard disks. You can add, delete, re-
size, and edit partitions, as well as access the soft RAID, and LVM configuration.

WARNING: Repartitioning the Running System

Although it is possible to repartition your system while it is running, the risk
of making a mistake that causes the data loss is very high. Try to avoid reparti-
tioning your installed system and always do a complete backup of your data
before attempting to do so.

Advanced Disk Setup 251



Figure 15.1 The YaST Partitioner

TIP: IBM System z: Device Names

IBM System z recognize only DASD and SCSI hard disks. IDE hard disks are not
supported. This is why these devices appear in the partition table as dasda or
sda for the first recognized device.

All existing or suggested partitions on all connected hard disks are displayed in the list
of Available Storage in the YaST Expert Partitioner dialog. Entire hard disks are listed
as devices without numbers, such as /dev/sda (or /dev/dasda). Partitions are
listed as parts of these devices, such as /dev/sda1 (or /dev/dasda1, respectively).
The size, type, encryption status, file system, and mount point of the hard disks and
their partitions are also displayed. Themount point describes where the partition appears
in the Linux file system tree.

Several functional views are available on the lefthand System View. Use these views
to gather information about existing storage configurations, or to configure functions
like RAID, Volume Management, Crypt Files, or view filesystems with addi-
tional features, such as BTRFS, NFS, or TMPFS.

If you run the expert dialog during installation, any free hard disk space is also listed
and automatically selected. To provide more disk space to SUSE® Linux Enterprise
Server, free the needed space starting from the bottom toward the top of the list (starting
from the last partition of a hard disk toward the first). For example, if you have three
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partitions, you cannot use the second exclusively for SUSE Linux Enterprise Server
and retain the third and first for other operating systems.

15.1.1 Partition Types
TIP: IBM System z: Hard Disks

On the IBM System z platforms, SUSE Linux Enterprise Server supports SCSI
hard disks as well as DASDs (direct access storage devices). While SCSI disks
can be partitioned as described below, DASDs can have no more than three
partition entries in their partition tables.

Every hard disk has a partition table with space for four entries. Every entry in the
partition table corresponds to a primary partition or an extended partition. Only one
extended partition entry is allowed, however.

A primary partition simply consists of a continuous range of cylinders (physical disk
areas) assigned to a particular operating system. With primary partitions you would be
limited to four partitions per hard disk, because more do not fit in the partition table.
This is why extended partitions are used. Extended partitions are also continuous ranges
of disk cylinders, but an extended partition may be divided into logical partitions itself.
Logical partitions do not require entries in the partition table. In other words, an extended
partition is a container for logical partitions.

If you need more than four partitions, create an extended partition as the fourth partition
(or earlier). This extended partition should occupy the entire remaining free cylinder
range. Then create multiple logical partitions within the extended partition. The maxi-
mum number of logical partitions is 63, independent of the disk type. It does not matter
which types of partitions are used for Linux. Primary and logical partitions both function
normally.

TIP: GPT Partition Table

If you need to create more than 4 primary partitions on one hard disk, you
have to use the GPT partition type. This type removes the primary partitions
number restriction, and supports partitions bigger than 2 TB as well.

To use GPT, run the YaST Partitioner, click the relevant disk name in the System
View and choose Expert > Create New Partition Table > GPT.
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15.1.2 Creating a Partition
To create a partition from scratch select Hard Disks and then a hard disk with free
space. The actual modification can be done in the Partitions tab:

1 Select Add and specify the partition type (primary or extended). Create up to four
primary partitions or up to three primary partitions and one extended partition.
Within the extended partition, create several logical partitions (see Section 15.1.1,
“Partition Types” (page 253)).

2 Specify the size of the new partition. You can either choose to occupy all the free
unpartitioned space, or enter a custom size.

3 Select the file system to use and a mount point. YaST suggests a mount point for
each partition created. To use a different mount method, like mount by label, select
Fstab Options. For more information on supported filesystems, see Storage Admin-
istration Guide.

4 Specify additional file system options if your setup requires them. This is necessary,
for example, if you need persistent device names. For details on the available options,
refer to Section 15.1.3, “Editing a Partition” (page 257).

5 Click Finish to apply your partitioning setup and leave the partitioning module.

If you created the partition during installation, you are returned to the installation
overview screen.

15.1.2.1 Btrfs Partitioning
If you want to use Btrfs (see Chapter 4, Snapshots/Rollback with Snapper (↑Adminis-
tration Guide) and Storage Administration Guide, chapter Overview of File Systems in
Linux for more information on Btrfs) as your default filesystem for a newly installed
system, click Partitioning on the Installation Settings screen, and check Use Btrfs as
Default Filesystem. The installation system then suggests creating the /boot partition
formatted with Ext3 filesystem, and the root / partition formatted with Btrfs holding
a default set of subvolumes, which you can modify with the Expert Partitioner tool
later.
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The root filesystem is the default subvolume and it is not listed in the list of created
subvolumes. As a default Btrfs subvolume, it can be mounted as a normal filesystem.

It is possible to create snapshots of Btrfs subvolumes - either manually, or automatically
based on system events. For example when making changes to the filesystem, zypper
invokes the snapper command to create snapshots before and after the change. This
is useful if you are not satisfied with the change zyppermade and want to restore the
previous state. As snapper invoked by zypper snapshots the root filesystem by
default, it is reasonable to exclude specific directories from being snapshot, depending
on the nature of data they hold. And that is why YaST suggests creating the following
separate subvolumes.

Suggested Btrfs Subvolumes

/tmp /var/tmp /var/run
Directories with frequently changed content.

/var/spool
Contains user data, such as mails.

/var/log
Contains system and applications' log files which should never be rolled back.

/var/crash
Contains memory dumps of crashed kernels.

/srv
Contains data files belonging to FTP and HTTP servers.

/opt
Contains third party software.

TIP: Size of Btrfs Partition

Because saved snapshots require more disk space, it is recommended to reserve
more space for Btrfs partition than for a partition not capable of snapshotting
(such as Ext3). Recommended size for a root Btrfs partition with suggested
subvolumes is 20GB.
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Managing Btrfs Subvolumes using YaST

Subvolumes of a Btrfs partition can be now managed with the YaST Expert partitioner
module. You can add new or remove existing subvolumes.

Procedure 15.1 Btrfs Subvolumes with YaST

1 Start the YaST Expert Partitioner with System > Partitioner.

2 Choose BTRFS in the left System View pane.

3 Select the Btrfs partition whose subvolumes you need to manage and click Edit.

4 Click Subvolume Handling. You can see a list off all existing subvolumes of the se-
lected Btrfs partition. You can notice a number of
@/.snapshots/xyz/snapshot entries — each of these subvolumes belongs
to one existing snapshot.

5 Depending on whether you want to add or remove subvolumes, do the following:

5a To remove a subvolume, select it from the list of Exisitng Subvolumes and
click Remove.

5b To add a new subvolume, enter its name to the New Subvolume text field and
click Add new.
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Figure 15.2 Btrfs Subvolumes in YaST Partitioner

6 Confirm with OK and Finish.

7 Leave the partitioner with Finish.

15.1.3 Editing a Partition
When you create a new partition or modify an existing partition, you can set various
parameters. For new partitions, the default parameters set by YaST are usually sufficient
and do not require any modification. To edit your partition setup manually, proceed as
follows:

1 Select the partition.

2 Click Edit to edit the partition and set the parameters:
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File System ID
Even if you do not want to format the partition at this stage, assign it a file system
ID to ensure that the partition is registered correctly. Typical values are Linux,
Linux swap, Linux LVM, and Linux RAID.

File System
To change the partition file system, clickFormat Partition and select file system
type in the File System list.

SUSE Linux Enterprise Server supports several types of filesystems. Btrfs is
the Linux filesystem of choice because of its advanced features. It supports copy-
on-write functionality, creating snapshots, multi-device spanning, subvolumes,
and other useful techniques. ReiserFS, JFS, XFS, and Ext3 are journaling file
systems. These file systems are able to restore the system very quickly after a
system crash, utilizing write processes logged during the operation. Ext2 is not
a journaling file system, but it is adequate for smaller partitions because it does
not require much disk space for management.

NOTE: Support for Ext4 Filesystem

Because Btrfs proved to be more efficient and scalable than Ext4, SUSE
Linux Enterprise Server SP2 supports only read-only access to Ext4 parti-
tions. It is, however, still possible to access Ext4 partitions in a read-write
mode — you need to install the ext4-writeable package. Please
note that this operation is not supported and taints the Kernel.

Swap is a special format that allows the partition to be used as a virtual memory.
Create a swap partition of at least 256 MB. However, if you use up your swap
space, consider adding more memory to your system instead of adding more
swap space.

WARNING: Changing the file system

Changing the file system and reformatting partitions irreversibly deletes
all data from the partition.

For details on the various file systems, refer to Storage Administration Guide.
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Encrypt Device
If you activate the encryption, all data is written to the hard disk in encrypted
form. This increases the security of sensitive data, but reduces the system speed,
as the encryption takes some time to process. More information about the en-
cryption of file systems is provided in Chapter 11, Encrypting Partitions and
Files (↑Security Guide).

Mount Point
Specify the directory where the partition should be mounted in the file system
tree. Select from YaST suggestions or enter any other name.

Fstab Options
Specify various parameters contained in the global file system administration
file (/etc/fstab). The default settings should suffice for most setups. You
can, for example, change the file system identification from the device name to
a volume label. In the volume label, use all characters except / and space.

To get persistent devices names, use the mount option Device ID, UUID or
LABEL. In SUSE Linux Enterprise Server, persistent device names are enabled
by default.

NOTE: IBM System z: Mounting by path

Since mounting by ID causes problems on IBM System z when using disk-
to-disk copying for cloning purposes, devices are mounted by path in
/etc/fstab on IBM System z by default.

If you prefer to mount the partition by its label, you need to define one in the
Volume label text entry. For example, you could use the partition label HOME
for a partition intended to mount to /home.

If you intend to use quotas on the file system, use the mount option Enable
Quota Support. This must be done before you can define quotas for users in the
YaST User Management module. For further information on how to configure
user quota, refer to Section 12.3.5, “Managing Quotas” (page 199).

3 Select Finish to save the changes.
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NOTE: Resize Filesystems

To resize an existing file system, select the partition and use Resize. Note, that
it is not possible to resize partitions while mounted. To resize partitions, un-
mount the relevant partition before running the partitioner.

15.1.4 Expert Options
After you select a hard disk device (like sda) in the System View pane, you can access
the Expert... menu in the lower right part of the Expert Partitioner window. The menu
contains the following commands:

Create New Partition Table
This option helps you create a new partition table on the selected device.

WARNING: Creating a New Partition Table

Creating a new partition table on a device irreversibly removes all the
partitions and their data from that device.

Clone This Disk
This option helps you clone the device partition layout (but not the data) to other
available disk devices.

15.1.5 Advanced Options
After you select the hostname of the computer (the top-level of the tree in the System
View pane), you can access the Configure... menu in the lower right part of the Expert
Partitioner window. The menu contains the following commands:

Configure iSCSI
To access SCSI over IP block devices, you first have to configure iSCSI. This results
in additionally available devices in the main partition list.

Configure Multipath
Selecting this option helps you configure themultipath enhancement to the supported
mass storage devices.
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15.1.6 More Partitioning Tips
The following section includes a few hints and tips on partitioning that should help you
make the right decisions when setting up your system.

TIP: Cylinder Numbers

Note, that different partitioning tools may start counting the cylinders of a
partition with 0 or with 1. When calculating the number of cylinders, you should
always use the difference between the last and the first cylinder number and
add one.

15.1.6.1 Using swap
Swap is used to extend the available physical memory. It is then possible to use more
memory than physical RAM available. The memory management system of kernels
before 2.4.10 needed swap as a safety measure. Then, if you did not have twice the size
of your RAM in swap, the performance of the system suffered. These limitations no
longer exist.

Linux uses a page called “Least Recently Used” (LRU) to select pages that might be
moved from memory to disk. Therefore, running applications have more memory
available and caching works more smoothly.

If an application tries to allocate the maximum allowed memory, problems with swap
can arise. There are three major scenarios to look at:

System with no swap
The application gets the maximum allowed memory. All caches are freed, and thus
all other running applications are slowed. After a few minutes, the kernel's out-of-
memory kill mechanism activates and kills the process.

System with medіum sized swap (128 MB–512 MB)
At first, the system slows like a system without swap. After all physical RAM has
been allocated, swap space is used as well. At this point, the system becomes very
slow and it becomes impossible to run commands from remote. Depending on the
speed of the hard disks that run the swap space, the system stays in this condition
for about 10 to 15 minutes until the out-of-memory kill mechanism resolves the
issue. Note that you will need a certain amount of swap if the computer needs to
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perform a “suspend to disk”. In that case, the swap size should be large enough to
contain the necessary data from memory (512 MB–1GB).

System with lots of swap (several GB)
It is better to not have an application that is out of control and swapping excessively
in this case. If you use such application, the systemwill need many hours to recover.
In the process, it is likely that other processes get timeouts and faults, leaving the
system in an undefined state, even after killing the faulty process. In this case, do
a hard machine reboot and try to get it running again. Lots of swap is only useful
if you have an application that relies on this feature. Such applications (like
databases or graphics manipulation programs) often have an option to directly use
hard disk space for their needs. It is advisable to use this option instead of using
lots of swap space.

If your system is not out of control, but needs more swap after some time, it is possible
to extend the swap space online. If you prepared a partition for swap space, just add
this partition with YaST. If you do not have a partition available, you may also just use
a swap file to extend the swap. Swap files are generally slower than partitions, but
compared to physical ram, both are extremely slow so the actual difference is negligible.

Procedure 15.2 Adding a Swap File Manually

To add a swap file in the running system, proceed as follows:

1 Create an empty file in your system. For example, if you want to add a swap file
with 128 MB swap at /var/lib/swap/swapfile, use the commands:
mkdir -p /var/lib/swap
dd if=/dev/zero of=/var/lib/swap/swapfile bs=1M count=128

2 Initialize this swap file with the command
mkswap /var/lib/swap/swapfile

3 Activate the swap with the command
swapon /var/lib/swap/swapfile

To disable this swap file, use the command
swapoff /var/lib/swap/swapfile

4 Check the current available swap spaces with the command
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cat /proc/swaps

Note that at this point, it is only temporary swap space. After the next reboot, it is
no longer utilized.

5 To enable this swap file permanently, add the following line to /etc/fstab:
/var/lib/swap/swapfile swap swap defaults 0 0

15.1.7 Partitioning and LVM
From the Expert partitioner, access the LVM configuration by clicking the Volume
Management item in the System View pane. However, if a working LVM configuration
already exists on your system, it is automatically activated upon entering the initial
LVM configuration of a session. In this case, all disks containing a partition (belonging
to an activated volume group) cannot be repartitioned. The Linux kernel cannot reread
the modified partition table of a hard disk when any partition on this disk is in use. If
you already have a working LVM configuration on your system, physical repartitioning
should not be necessary. Instead, change the configuration of the logical volumes.

At the beginning of the physical volumes (PVs), information about the volume is written
to the partition. To reuse such a partition for other non-LVM purposes, it is advisable
to delete the beginning of this volume. For example, in the VG system and PV /dev/
sda2, do this with the command dd if=/dev/zero of=/dev/sda2 bs=512
count=1.

WARNING: File System for Booting

The file system used for booting (the root file system or /boot) must not be
stored on an LVM logical volume. Instead, store it on a normal physical partition.

For more details about LVM, see the Storage Administration Guide.

15.2 LVM Configuration
This section briefly describes the principles behind the Logical VolumeManager (LVM)
and its multipurpose features. In Section 15.2.2, “LVM Configuration with
YaST” (page 265), learn how to set up LVM with YaST.
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WARNING

Using LVM is sometimes associated with increased risk such as data loss. Risks
also include application crashes, power failures, and faulty commands. Save
your data before implementing LVM or reconfiguring volumes. Never work
without a backup.

15.2.1 The Logical Volume Manager
The LVM enables flexible distribution of hard disk space over several file systems. It
was developed because sometimes the need to change the segmenting of hard disk space
arises just after the initial partitioning has been done. Because it is difficult to modify
partitions on a running system, LVM provides a virtual pool (volume group, VG for
short) of memory space from which logical volumes (LVs) can be created as needed.
The operating system accesses these LVs instead of the physical partitions. Volume
groups can occupy more than one disk, so that several disks or parts of them may con-
stitute one single VG. This way, LVM provides a kind of abstraction from the physical
disk space that allows its segmentation to be changed in a much easier and safer way
thanwith physical repartitioning. Background information regarding physical partitioning
can be found in Section 15.1.1, “Partition Types” (page 253) and Section 15.1, “Using
the YaST Partitioner” (page 251).

Figure 15.3 Physical Partitioning versus LVM

Figure 15.3, “Physical Partitioning versus LVM” (page 264) compares physical parti-
tioning (left) with LVM segmentation (right). On the left side, one single disk has been
divided into three physical partitions (PART), each with a mount point (MP) assigned
so that the operating system can gain access. On the right side, two disks have been
divided into two and three physical partitions each. Two LVM volume groups (VG 1
and VG 2) have been defined. VG 1 contains two partitions from DISK 1 and one from
DISK 2. VG 2 contains the remaining two partitions fromDISK 2. In LVM, the physical
disk partitions that are incorporated in a volume group are called physical volumes
(PVs). Within the volume groups, four LVs (LV 1 through LV 4) have been defined.
They can be used by the operating system via the associated mount points. The border
between different LVs do not need to be aligned with any partition border. See the
border between LV 1 and LV 2 in this example.
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LVM features:

• Several hard disks or partitions can be combined in a large logical volume.

• Provided the configuration is suitable, an LV (such as /usr) can be enlarged if free
space is exhausted.

• With LVM, it is possible to add hard disks or LVs in a running system. However,
this requires hot-swappable hardware.

• It is possible to activate a "striping mode" that distributes the data stream of a LV
over several PVs. If these PVs reside on different disks, the read and write perfor-
mance is enhanced, as with RAID 0.

• The snapshot feature enables consistent backups (especially for servers) of the running
system.

With these features, LVM is ready for heavily used home PCs or small servers. LVM
is well-suited for the user with a growing data stock (as in the case of databases, music
archives, or user directories). This would allow file systems that are larger than the
physical hard disk. Another advantage of LVM is that up to 256 LVs can be added.
However, working with LVM is different from working with conventional partitions.
Instructions and further information about configuring LVM is available in the official
LVM HOWTO at http://tldp.org/HOWTO/LVM-HOWTO/.

Starting from Kernel version 2.6, LVM version 2 is available, which is backward-
compatible with the previous LVMand enables the continuedmanagement of old volume
groups. When creating new volume groups, decide whether to use the new format or
the backward-compatible version. LVM 2 does not require any kernel patches. It makes
use of the device mapper integrated in kernel 2.6. This kernel only supports LVM ver-
sion 2. Therefore, when talking about LVM, this section always refers to LVMversion 2.

15.2.2 LVM Configuration with YaST
The YaST LVM configuration can be reached from the YaST Expert Partitioner (see
Section 15.1, “Using the YaST Partitioner” (page 251)) within theVolumeManagement
item in the System View pane. The Expert Partitioner allows you to edit and delete ex-
isting partitions and also create new ones that need to be used with LVM. The first task
is to create PVs that provide space to a volume group:
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1 Select a hard disk from Hard Disks.

2 Change to the Partitions tab.

3 Click Add and enter the desired size of the PV on this disk.

4 Use Do not format partition and change the File System ID to 0x8E Linux LVM. Do
not mount this partition.

5 Repeat this procedure until you have defined all the desired physical volumes on the
available disks.

15.2.2.1 Creating Volume Groups
If no volume group exists on your system, you must add one (see Figure 15.4, “Creating
a Volume Group” (page 267)). It is possible to create additional groups by clicking on
Volume Management in the System View pane, and then on Add Volume Group. One
single volume group is usually sufficient.

1 Enter a name for the VG, for example, system.

2 Select the desired Physical Extend Size. This value defines the size of a physical
block in the volume group. All the disk space in a volume group is handled in blocks
of this size.

3 Add the prepared PVs to the VG by selecting the device and clicking on Add. Select-
ing several devices is possible by holding Ctrl while selecting the devices.

4 Select Finish to make the VG available to further configuration steps.
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Figure 15.4 Creating a Volume Group

If you have multiple volume groups defined and want to add or remove PVs, select the
volume group in the VolumeManagement list and clickResize. In the following window,
you can add or remove PVs to the selected volume group.

15.2.2.2 Configuring Logical Volumes
After the volume group has been filled with PVs, define the LVs which the operating
system should use in the next dialog. Choose the current volume group and change to
the Logical Volumes tab. Add, Edit, Resize, and Delete LVs as needed until all space
in the volume group has been occupied. Assign at least one LV to each volume group.
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Figure 15.5 Logical Volume Management

Click Add and go through the wizard-like pop-up that opens:

1. Enter the name of the LV. For a partition that should be mounted to /home, a self-
explanatory name like HOME could be used.

2. Select the size and the number of stripes of the LV. If you have only one PV, selecting
more than one stripe is not useful.

3. Choose the filesystem to use on the LV as well as the mount point.

By using stripes it is possible to distribute the data stream in the LV among several PVs
(striping). However, striping a volume can only be done over different PVs, each pro-
viding at least the amount of space of the volume. The maximum number of stripes
equals to the number of PVs, where Stripe "1" means "no striping". Striping onlymakes
sense with PVs on different hard disks, otherwise performance will decrease.

WARNING: Striping

YaST cannot, at this point, verify the correctness of your entries concerning
striping. Any mistake made here is apparent only later when the LVM is imple-
mented on disk.
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If you have already configured LVM on your system, the existing logical volumes can
also be used. Before continuing, assign appropriate mount points to these LVs. With
Finish, return to the YaST Expert Partitioner and finish your work there.

15.3 Soft RAID Configuration
The purpose of RAID (redundant array of independent disks) is to combine several
hard disk partitions into one large virtual hard disk to optimize performance and/or
data security. Most RAID controllers use the SCSI protocol because it can address a
larger number of hard disks in a more effective way than the IDE protocol. It is also
more suitable for the parallel command processing. There are some RAID controllers
that support IDE or SATA hard disks. Soft RAID provides the advantages of RAID
systemswithout the additional cost of hardware RAID controllers. However, this requires
some CPU time and has memory requirements that make it unsuitable for high perfor-
mance computers.

With SUSE® Linux Enterprise Server , you can combine several hard disks into one
soft RAID system. RAID implies several strategies for combining several hard disks
in a RAID system, each with different goals, advantages, and characteristics. These
variations are commonly known as RAID levels.

Common RAID levels are:

RAID 0
This level improves the performance of your data access by spreading out blocks
of each file across multiple disk drives. Actually, this is not really a RAID, because
it does not provide data backup, but the name RAID 0 for this type of system is
commonly used. With RAID 0, two or more hard disks are pooled together. Perfor-
mance is enhanced, but the RAID system is destroyed and your data lost if even
one hard disk fails.

RAID 1
This level provides adequate security for your data, because the data is copied to
another hard disk 1:1. This is known as hard disk mirroring. If one disk is destroyed,
a copy of its contents is available on the other one. All disks but one could be
damaged without endangering your data. However, if the damage is not detected,
the damaged data can be mirrored to the undamaged disk. This could result in the
same loss of data. The writing performance suffers in the copying process compared
to using single disk access (10 to 20 % slower), but read access is significantly
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faster in comparison to any one of the normal physical hard disks. The reason is
that the duplicate data can be parallel-scanned. Generally it can be said that Level 1
provides nearly twice the read transfer rate of single disks and almost the same
write transfer rate as single disks.

RAID 5
RAID 5 is an optimized compromise between Level 0 and Level 1, in terms of
performance and redundancy. The hard disk space equals the number of disks used
minus one. The data is distributed over the hard disks as with RAID 0. Parity blocks,
created on one of the partitions, exist for security reasons. They are linked to each
other with XOR, enabling the contents to be reconstructed by the corresponding
parity block in case of system failure. With RAID 5, no more than one hard disk
can fail at the same time. If one hard disk fails, it must be replaced as soon as pos-
sible to avoid the risk of losing data.

RAID 6
To further increase the reliability of the RAID system, it is possible to use RAID 6.
In this level, even if two disks fail, the array still can be reconstructed.With RAID 6,
at least 4 hard disks are needed to run the array. Note that when running as software
raid, this configuration needs a considerable amount of CPU time and memory.

RAID 10 (RAID 1+0)
This RAID implementation combines features of RAID 0 and RAID 1: the data
are first mirrored in separate disk arrays, which are inserted into a new RAID 0;
type array. In each RAID 1 sub-array, one disk can fail without any damage to the
data. RAID 10 is used for database application where a huge load is expected.

Other RAID Levels
Several other RAID levels have been developed (RAID 2, RAID 3, RAID 4, RAIDn,
RAID 10, RAID 0+1, RAID 30, RAID 50, etc.), some of them being proprietary
implementations created by hardware vendors. These levels are not very common
and therefore are not explained here.

15.3.1 Soft RAID Configuration with YaST
The YaST RAID configuration can be reached from the YaST Expert Partitioner, de-
scribed in Section 15.1, “Using the YaST Partitioner” (page 251). This partitioning tool
enables you to edit and delete existing partitions and create new ones to be used with
soft RAID:
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1 Select a hard disk from Hard Disks.

2 Change to the Partitions tab.

3 Click Add and enter the desired size of the raid partition on this disk.

4 Use Do not Format the Partition and change the File System ID to 0xFD Linux
RAID. Do not mount this partition.

5 Repeat this procedure until you have defined all the desired physical volumes on the
available disks.

For RAID 0 and RAID 1, at least two partitions are needed—for RAID 1, usually ex-
actly two and no more. If RAID 5 is used, at least three partitions are required. It is
recommended to utilize partitions of the same size only. The RAID partitions should
be located on different hard disks to decrease the risk of losing data if one is defective
(RAID 1 and 5) and to optimize the performance of RAID 0. After creating all the
partitions to use with RAID, click RAID > Add RAID to start the RAID configuration.

In the next dialog, choose between RAID levels 0, 1, 5, 6 and 10. Then, select all parti-
tions with either the “Linux RAID” or “Linux native” type that should be used by the
RAID system. No swap or DOS partitions are shown.
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Figure 15.6 RAID Partitions

To add a previously unassigned partition to the selected RAID volume, first click the
partition then Add. Assign all partitions reserved for RAID. Otherwise, the space on
the partition remains unused. After assigning all partitions, click Next to select the
available RAID Options.

In this last step, set the file system to use as well as encryption and the mount point for
the RAID volume. After completing the configuration with Finish, see the /dev/md0
device and others indicated with RAID in the expert partitioner.

15.3.2 Troubleshooting
Check the file/proc/mdstat to find out whether a RAID partition has been damaged.
In the event of a system failure, shut down your Linux system and replace the defective
hard disk with a new one partitioned the same way. Then restart your system and enter
the commandmdadm /dev/mdX --add /dev/sdX. Replace 'X' with your partic-
ular device identifiers. This integrates the hard disk automatically into the RAID system
and fully reconstructs it.

Note that although you can access all data during the rebuild, you may encounter some
performance issues until the RAID has been fully rebuilt.
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15.3.3 For More Information
Configuration instructions andmore details for soft RAID can be found in the HOWTOs
at:

• /usr/share/doc/packages/mdadm/Software-RAID.HOWTO.html

• http://raid.wiki.kernel.org

Linux RAID mailing lists are available, such as http://marc.info/?l=linux
-raid.
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16Subscription Management
Any machine running SUSE Linux Enterprise Server 11 or SUSE Linux Enterprise
Desktop 11 can be configured to register against local Subscription Management Tool
server to download software updates instead of communicating directly with the Novell
Customer Center and the NU servers. To use an SMT server for client registration and
as a local update source, you must configure the SMT server in your network first. The
SMT server software is distributed as an add-on for SUSE Linux Enterprise Server and
its configuration is described in the Subscription Management Tool Guide. There is no
need to install any add-on on the clients to be configured for registering against an SMT
server.

To register a client against an SMT server, you need to equip the client with the server's
URL. As client and server communicate via the HTTPS protocol during registration,
you also need to make sure the client trusts the server's certificate. In case your SMT
server is set up to use the default server certificate, the CA certificate will be available
on the SMT server via HTTP protocol at http://FQDN/smt.crt. In this case you
do not have to concern yourself with the certificate: the registration process will auto-
matically download the CA certificate from there, unless configured otherwise. You
must enter a path to the server's CA certificate if the certificate was issued by an external
certificate authority.

NOTE: Registering Against *.novell.com Subdomain

If you try to register against any *.novell.com subdomain, the certificate
will not be downloaded during registration (for security reasons), and certificate
handling will not be done. In such cases, use a different domain name or a
plain IP address.
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There are several ways to provide this information and to configure the client machine
to use SMT. The first way is to provide the needed information via kernel parameters
at boot time. The second way is to configure clients using an AutoYaST profile. There
is also a script distributed with Subscription Management Tool,
clientSetup4SMT.sh, which can be run on a client to make it register against a
specified SMT server. These methods are described in the following sections:

16.1 Using Kernel Parameters to
Access an SMT Server

Any client can be configured to use SMT by providing the following kernel parameters
during machine boot: regurl and regcert. The first parameter is mandatory, the
latter is optional.

regurl
URL of the SMT server. The URL needs to be in the following format:
https://FQDN/center/regsvc/ with FQDN being the fully qualified
hostname of the SMT server. It must be identical to the FQDN of the server certifi-
cate used on the SMT server. Example:
regurl=https://smt.example.com/center/regsvc/

regcert
Location of the SMT server's CA certificate. Specify one of the following locations:

URL
Remote location (http, https or ftp) fromwhich the certificate can be download-
ed. Example:
regcert=http://smt.example.com/smt.crt

Floppy
Specifies a location on a floppy. The floppy has to be inserted at boot time
(you will not be prompted to insert it if it is missing). The value must start with
the string floppy, followed by the path to the certificate. Example:
regcert=floppy/smt/smt-ca.crt

Local Path
Absolute path to the certificate on the local machine. Example:
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regcert=/data/inst/smt/smt-ca.cert

Interactive
Use ask to open a pop-up menu during installation where you can specify the
path to the certificate. Do not use this option with AutoYaST. Example:
regcert=ask

Deactivate Certificate Installation
Use done if either the certificate will be installed by an add-on product, or if
you are using a certificate issued by an official certificate authority. Example:
regcert=done

WARNING: Beware of Typing Errors

Make sure the values you enter are correct. If regurl has not been specified
correctly, the registration of the update source will fail.

If a wrong value for regcert has been entered, you will be prompted for a
local path to the certificate. In case regcert is not specified at all, it will default
to http://FQDN/smt.crt with FQDN being the name of the SMT server.

WARNING: Change of SMT Server Certificate

If the SMT server gets a new certificate from a new and untrusted CA, the
clients need to fetch the new CA certificate file. This is done automatically with
the registration process but only if a URL was used at installation time to retrieve
the certificate, or if the regcert parameter was omitted and thus, the default
URL is used. If the certificate was loaded using any other method (such as
floppy or local path), the CA certificate will not be updated.

16.2 Configuring Clients Using
AutoYaST Profile

Clients can be configured to register with SMT server via AutoYaST profile. For gen-
eral information about creating AutoYaST profiles and preparing automatic installation,
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refer to Chapter 21, Automated Installation (page 313). In this section, only SMT spe-
cific configuration is described.

To configure SMT specific data using AutoYaST, follow these steps:

1 As root, start YaST and selectMiscellaneous > Autoinstallation to start the
graphical AutoYaST front-end.

From a command line, you can start the graphical AutoYaST front-end with the
yast2 autoyast command.

2 Open an existing profile using File > Open, create a profile based on the current
system's configuration using Tools > Create Reference Profile, or just work with an
empty profile.

3 Select Support >Novell Customer Center Configuration. An overview of the current
configuration is shown.

4 Click Edit.

5 To register while installing automatically, select Run Product Registration. You can
include information from your systemwithHardware Profile andOptional Informa-
tion.

6 Set the URL of the SMT Server and, optionally, the location of the SMT Certificate.
The possible values are the same as for the kernel parametersregurl and regcert
(see Section 16.1, “Using Kernel Parameters to Access an SMT Server” (page 276)).
The only exception is that the ask value for regcert does not work in AutoYaST,
because it requires user interaction. If using it, the registration process will be skipped.

7 Perform all other configuration needed for the systems to be deployed.

8 Select File > Save As and enter a filename for the profile, such as autoinst.xml.
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16.3 Configuring Clients Using the
clientSetup4SMT.sh Script

The /usr/share/doc/packages/smt/clientSetup4SMT.sh script is
provided with SMT. This script allows to configure a client machine to use a SMT
server or to reconfigure it to use a different SMT server.

To configure a client machine to use SMT with the clientSetup4SMT.sh script,
follow these steps:

1 Copy the/usr/share/doc/packages/smt/clientSetup4SMT.sh script
from your SMT server to the client machine.

2 As root, execute the script on the client machine. The script can be executed in
two ways. In the first case, the script name is followed by the registration URL:
./clientSetup4SMT.sh registration_URL, for example,
./clientSetup4SMT.sh
https://smt.example.com/center/regsvc. In the second case, the script
name is followed by the --host option followed by hostname of the SMT server:
./clientSetup4SMT.sh --host server_hostname, for example,
./clientSetup4SMT.sh --host smt.example.com.

3 The script downloads the server's CA certificate. Accept it by pressing y.

4 The script performs all necessary modifications on the client. However, the registra-
tion itself is not performed by the script.

5 Perform a registration by executing suse_register or running yast2
inst_suse_register module on the client.

16.4 Registering Clients Against SMT
Test Environment

To configure a client to register against the test environment instead the production
environment, modify /etc/suseRegister.conf on the client machine by setting:
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register = command=register&testenv=1

For more information about using SMTwith a test environment, refer to the Subscription
Management Tool Guide.
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Part III. Imaging and Creating
Products





17KIWI
KIWI is a system for creating operating system images. An image is a directory with
a file containing the operating system, its applications and configurations, the filesystem
structure of the OS, possible additional metadata, and (depending on the image type)
also disk geometry and partition table data. With KIWI you can create LiveCDs and
LiveDVDs, USB sticks, virtual disk to play in full virtual systems like VMware, XEN
images for paravirtualization in a hypervisor, and a PXE environment to boot from
network.

17.1 Prerequisites for KIWI
To build images with KIWI, you need the following preconditions:

1. Free sufficient disk space for the operation.

2. KIWI is split into several packages, targeted to different image types. In any case,
you need the base package kiwi. Depending on your target image, you need the
following packages:

Package NameImage Type

kiwi-desc-oembootInstallation Media

kiwi-desc-xenbootVirtualization
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Package NameImage Type

kiwi-desc-usbbootUSB Sticks

kiwi-desc-netbootNetwork Client

3. Install the kiwi-doc package. You can find some example configurations to get
an idea about structure and content.

4. Know the KIWI configuration file and its structure. It is based on a RELAX NG
schema and documented in the kiwi package under /usr/share/doc/
packages/kiwi/kiwi.html. You need this document, if you want to create
the configuration file from scratch or when you want to insert elements or attributes.

17.2 Knowing KIWI’s Build Process
The building process of KIWI is separated into three steps:

1. Physical Extend (Preparation) This stage prepares the content of your new
filesystem. During this step the root directory is created, you determine which
packages are installed on your image andwhich user configuration files are included.

2. Logical Extend (Creation) This stage requires a successful preparation step. The
logical extend step creates the operating system image based on the first step.

3. Deployment The resulting image type can be deployed with different methods like
installed on a hard disk or played by a virtualization system (VMware, Qemu, Virtu-
alBox).

17.3 Image Description
KIWI needs an image description to build an image type. The image description is a
directory which contains at least a file config.xml, or alternatively with the extension
*.kiwi.
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17.3.1 Contents of Image Description
The following table contains additional optional information. However, most of this
information is mandatory for the later functionality of the operating system:

Table 17.1 Additional Files and Directories For Image Description

DescriptionFile/Directory

optional subdirectory. Contains Bash scripts which
are executed after the installation of all the image
packages.

config/

optional configuration script while creating the
physical extend

config.sh

configuration file for each image description, ex-
plained in Section 17.3.2 (page 286)

config.xml

archive, only used for ISO imagesconfig-cdroot.tgz

manipulate extracted data from config
-cdroot.tgz

config-cdroot.sh

configuration file created by AutoYaSTconfig-yast
-autoyast.xml

configuration file for controlling the YaST first-
boot service

config-yast
-firstboot.xml

optional configuration script while creating the
preparation step

images.sh

contains other directories, special files, and scripts
which are changed after the installation of all im-
age packages

root/
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17.3.2 The config.xml File
All information about an image description is stored in the central configuration XML
file config.xml. Each time KIWI is executed, config.xml is validated against
an RELAX NG schema (see http://www.relaxng.org for more information
about this schema language). Therefore, it is recommended to use an adequate XML
editor with RELAX NG support or to use the documentation about the schema in the
HTML file /usr/share/doc/packages/kiwi/schema/kiwi.xsd.html.

The configuration file consists of several parts:

• some description about the author, contact information, and a short explanation.

• preferences option needed for the logical extent stage.

• information about the users, their name, their home directories, and their passwords.

• links to repositories.

• a list of packages that are used for the definied image type.

• and other less important information which can be viewed in the above HTML file
of the RELAX NG schema documentation.

A skeleton of the file is shown in the following example:
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Example 17.1 KIWI Configuration File
<image schemeversion="2.0" name="...">

<description type="system">
<author>...</author>
<contact>...</contact>
<specification>...</specification>

</description>
<preferences>

<type primary="true" boot="..." flags="...">iso</type>
<type boot="..." filesystem="ext3" format="vmdk">vmx</type>
<type boot="..." filesystem="ext3">xen</type>
<type boot="..." filesystem="squashfs" flags="unified">oem</type>
<version>2.7.0</version>
<size unit="M">780</size>
<packagemanager>zypper</packagemanager>
<rpm-check-signatures>False</rpm-check-signatures>
<rpm-force>False</rpm-force>
<locale>en_US.UTF-8</locale>
<oem-swap>no</oem-swap>
<oem-boot-title>USB</oem-boot-title>

</preferences>
<users group="users">

<user name="root" pwd="" home="/root"/>
</users>
<repository type="rpm-md">

<source path="/home/rpmdir"/>
</repository>
<packages type="image" patternPackageType="onlyRequired">

<package name="yast2-live-installer"/>
<package name="pam"/>
<!-- List of packages reduced -->

</packages>

The root element of every KIWI configuration file. Each file requires the version
number. An optional kiwirevision attribute can be used to specify an SVN
revision of KIWI.
Contains mandatory descriptions with information about the creator of this image
descriptions, its contact address and a short explanation.
Contains mandatory preferences with information about the version of this image,
the used package manager, the supported image types, and other settings.
The optional users element contains a list of all users which are added to the
image. The user element contains the name, the path to its home directory,
password, and the shell.
Contains a mandatory list of repositories used by the package manager.
Contains a mandatory list of packages which are included into the image.

More details about the configuration file is shown in the HTML page above.
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17.4 Creating Appliances with KIWI
This section describes how to create appliances with KIWI. An appliance is an especial-
ly-designed operating system for a specific task. For example, you can create an appli-
ance with the focus on office programs.

17.4.1 Creating a Local Installation Source
All examples in kiwi-doc packages need a valid installation source to create an image.
Usually the examples connect to a network resource. The higher the network bandwidth,
the faster the image creation. If you do not have a fast network or you do not want to
use it, create a local installation resource. Proceed as follows:

1 Collect your installation DVD.

2 Open a shell and become root.

3 Create the directory for your local installation directory. The examples use usually
the path /image/CDs/full-VERSION-ARCH. Replace the placeholders
VERSION and ARCH with the respective values.

4 Mount the medium. Replace the DRIVE placeholder with the respective device
(usually dvd, cdrom, etc.):
mount -o loop /dev/DRIVE /mnt

5 Copy all the content of the medium into the installation directory:
cp -a /mnt/* /images/CDs/full-VERSION-ARCH

To use the local installation source, all you need to do is to enable it in the repository
element:
<repository type="...">
<!-- Remove the comment markers in the next line -->
<!-- <source path="/image/CDs/full-VERSION-ARCH" -->
<source path="opensuse://openSUSE:11.0/standard"/>

</repository>
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17.4.2 Creating an Image
An image is a virtual disk image containing all partitions, boot loader information, and
packages as it resides on a real disk. To create an ISO image, proceed as follows:

1 Install the packages kiwi and kiwi-doc and resolve any dependencies.

2 Open a shell and become root.

3 Copy the directory /usr/share/doc/packages/kiwi/examples/suse
-11.0/suse-oem-preload to your current directory.

4 Open the file config.xml and locate the element repository. If you want to
use a local installation source, refer to Section 17.4.1 (page 288) for more information.

5 Execute KIWI with the following command to prepare the first stage (“physical ex-
tend”):
kiwi --prepare suse-oem-preload --root oem

6 Build the ISO image:
kiwi --create oem --type iso --destdir /tmp/myoem

17.4.3 Creating Preload Image with NFS
To create an image with NFS functionality, proceed as follows:

1 Open a shell and become root.

2 Copy the directory /usr/share/doc/packages/kiwi/examples/suse
-11.1/suse-oem-preload to your current directory.

3 Open the file suse-oem-preload/config.xml and locate the packages
element with the attribute type="image".

4 Insert the following line between <packages type="image"> and
</packages> and save the file:
<package name="nfs-client"/>
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5 Rebuild the image as described in Step 5 (page 289).

17.5 For More Information
Find more information about KIWI in the following documents:

• http://developer.berlios.de/projects/kiwi—Homepage of KIWI

• file:///usr/share/doc/packages/kiwi/kiwi.pdf—Extensive de-
scription about the KIWI Image System
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18Creating Add-On Products
With Add-on Creator
An Add-On is a special designed media, usually a CD or DVD, to extend your product.
The Add-on Creator was developed to support our customers and partners and simplify
third-party software distribution for all SUSE products.

18.1 Creating Images
To create an Add-On CD, proceed as follows:

1 Start YaST and open the Add-On Creator module. A window opens.

2 If you have not run this module before, click on Create an Add-On from the Be-
ginning to start. In case you have already created an Add-On, the window shows
a list of all created Add-Ons. Click Add to start.

3 Enter the product name and version of your Add-On and give some further options:

• Choose the required product upon which it is based.

• Select the path to additional Add-On packages. You need this, if you need fur-
ther RPM packages which are not included in your base product (this step is
optional).

• Select the path with the required product packages (this step is optional).

Creating Add-On Products With Add-on Creator 291



4 Correct the product definition and enter a vendor name. Disable Show Only Re-
quired Keywords to display more keywords.

5 Change the package descriptions. Use Add Language to insert a new language
and add translated descriptions (this step is optional).

6 Add new patterns. With patterns you can group your RPM packages. Use New to
add a new pattern name and change the respective attributes in the list below (this
step is optional).

7 Modify the output settings. Enter a path to your output directory and change the
name of the ISO name (changing the name of the ISO is optional). Additionally,
you can modify further features:

• Use Configure Workflow... to enter files to customize your product workflow.

• Use Optional Files... to add files to your Add-On product. The first part can
be used to insert information about the Add-On in the info.txt file. Use the
license files to display a window with Agree and Disagree buttons before the
installation starts. More files can be added in the README section.

The second part can be used to storeCOPYRIGHT andCOPYING files in various
languages.

8 Sign your Add-On product with your GPG key. Signing your product with your
GPG key provides evidence of the origin of your product. If you do not have a
key, create one first and enter the respective passphrase twice.

9 Check your product in the overview and proceed with Finish.

10 Use the Build button to start the process. Finish closes the window.

18.2 Add-On Structure
If you create an Add-On product, the following overview contains the structure of the
files and directories:
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ARCHIVES.gz
Contains the gzipped contents of all RPM files. It is actually a listing of the rpm
command with the options -qil for each RPM file.

Changelog
Contains all the changes of the RPM files.

content
Contains information about your Add-On product.

content.asc
Contains the signature file from GPG.

content.key, gpg-pubkey-NUMBER.asc
The public GPG key.

INDEX.gz
Contains a list of all RPM files and packed with gzip.

ls-lR.gz
Contains a list of all files and directories of your Add-On product medium.

media.N/
Contains files with basic information about the Add-On media set. The directory
is numered, so media.1/ is for the first Add-On medium. Additional media have
a consecutive number.

suse/
Contains sub directories with architecture-specific information. Exceptions are
noarch/ for architecture-independent packages, and src/ for source packages.
Proprietary software packages are stored under nosrc/.

18.3 For More Information
Find more information in the following documents:

• http://old-en.opensuse.org/KIWI—KIWI Project
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• http://old-en.opensuse.org/Creating_YaST_Installation
_Sources—YaST installation source creation

• http://old-en.opensuse.org/Standards/YaST2_repository
_metadata—YaST metadata description

• http://developer.novell.com/wiki/index.php/Creating_Add
-ons—
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19Creating Images with YaST
Product Creator
TheYaST Product Creator is a unified graphical front-end for KIWI andAdd-on Creator.
It was developed to provide image creation functionality in one place. All tools integrated
in the YaST Product Creator are also available as separate YaSTmodules or applications.

19.1 Prerequisites for Product Creator
Before you can create images with the YaST Product Creator, make sure you meet the
following prerequisites:

1. Install the package yast2-product-creator from the SDK under http://
www.novell.com/developer/sle_sdk.html. This package needs other
packages. Make sure you fullfill all dependencies.

2. Free sufficient disk space for this operation.

19.2 Creating Images
The Product Creator uses KIWI to create an image of a product. In case you are inter-
ested in manually developing such images, refer to Chapter 17, KIWI (page 283).

To create an image, proceed as follows:

1 If you are starting the Product Creator for the first time, enter the configuration name
and choose the method for adding packages to the ISO image.
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If you have used the Product Creator already, select Add to create a new product
definition and enter the configuration name and choose the method.

2 Select or deselect package sources. To select a source, select it from the table and
click Select. WithCreate New... execute the Add-on Creator, see Chapter 18,Creating
Add-On Products With Add-on Creator (page 291) for more information. To add a
different source, add the source in the YaST Installation Sources module first then
run the Product Creator again. After source selection, click Next.

NOTE: Unsupported Target Architectures

Do not change the target architecture. KIWI does not presently support the
building of different architectures.

3 Enter the path in which to create the skeleton directory. Choose whether toGenerate
ISO Image File or Create Directory Tree Only. Use the other options to insert
metadata. Click Next.

4 Edit the content of the isolinux.cfg file, if it is a part of the configuration. In
most cases you can leave it as it is. If the file is not part of the configuration, add it
now with Load File. Click Next.

5 Select your software. All package dependencies are solved automatically after Apply
is clicked.

6 Sign your product withDigitally Sign the Product on theMedium, if needed. Provide
a key for your product configuration. Signing your product with your GPG key
provides evidence of the origin of your product. After key configuration, click Next.

7 Review the summary. To change any option, use Back. To confirm your new product
configuration, click Finish.

Your product definition is now completed. The Product Creator allows you to choose
from the following actions:

• Create Product Creates an ISO image of the selected product. If there is something
missing, the process will be aborted. Correct the error and repeat the configuration.

• Create Image with KIWI... Use the pull-down menu to choose from different target
formats, such as Live media or Xen images.
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19.3 For More Information
Findmore information about creating system images and related topics in the following
documents:

• Chapter 17, KIWI (page 283)

• http://old-en.opensuse.org/KIWI—The KIWI project

• /usr/share/doc/packages/kiwi/kiwi.pdf—KIWI documentation
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20Deploying Customized
Preinstallations
Rolling out customized preinstallations of SUSE Linux Enterprise Server to a large
number of identical machines spares you from installing each one of them separately
and provides a standardized installation for the end users. With YaST Firstboot, create
customized preinstallation images and determine the workflow for the final personal-
ization steps that involve end user interaction (as opposed to AutoYaST, which allows
completely automated installations; for more information, see Chapter 21, Automated
Installation (page 313)).

Creating a custom installation, rolling it out to your hardware, and personalizing the
final product involves the following steps:

1 Prepare the master machine whose disk needs to be cloned to the client machines.
For more information, refer to Section 20.1, “Preparing the Master Ma-
chine” (page 300).

2 Customize the firstboot workflow. For more information, refer to Section 20.2,
“Customizing the Firstboot Installation” (page 300).

3 Clone the master machine's disk and roll this image out to the clients' disks. For more
information, refer to Section 20.3, “Cloning the Master Installation” (page 310).

4 Have the end user personalize the instance of SUSE Linux Enterprise Server. For
more information, refer to Section 20.4, “Personalizing the Installation” (page 310).
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20.1 Preparing the Master Machine
To prepare a master machine for a firstboot workflow, proceed as follows:

1 Insert the installation media into the master machine.

2 Boot the machine.

3 Perform a normal installation including all necessary configuration steps and wait
for the installed machine to boot. Also install the yast2-firstboot package.

4 To define your own workflow of YaST configuration steps for the end user or to
add your ownYaSTmodules to this workflow, proceed to Section 20.2, “Customizing
the Firstboot Installation” (page 300). Otherwise proceed directly to Step 5 (page 300).

5 Enable firstboot as root:

Create an empty file/var/lib/YaST2/reconfig_system to trigger firstboot's
execution. This file will be deleted once the firstboot configuration has been success-
fully accomplished. Create this file using the following command:
touch /var/lib/YaST2/reconfig_system

6 Proceed to Section 20.3, “Cloning the Master Installation” (page 310).

20.2 Customizing the Firstboot
Installation

Customizing the firstboot installation workflow may involve several different compo-
nents. Customizing them is optional. If you do not make any changes, firstboot performs
the installation using the default settings. The following options are available:

• Customizing messages to the user, as described in Section 20.2.1, “Customizing
YaST Messages” (page 301).

• Customizing licenses and license actions, as described in Section 20.2.2, “Customizing
the License Action” (page 302).
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• Customizing the release notes to display, as described in Section 20.2.3, “Customizing
the Release Notes” (page 303).

• Customizing the order and number of components involved in the installation, as
described in Section 20.2.4, “Customizing the Workflow” (page 303).

• Configuring additional optional scripts, as described in Section 20.2.5, “Configuring
Additional Scripts” (page 308).

To customize any of these components, modify the following configuration files:

/etc/sysconfig/firstboot
Configure various aspects of firstboot (such as release notes, scripts, and license
actions).

/etc/YaST2/firstboot.xml
Configure the installation workflow by enabling or disabling components or adding
custom ones.

Provide translations for such a customized installation workflow, as described in
Section 20.2.6, “Providing Translations of the Installation Workflow” (page 308).

If you want to customize more than just the workflow components, refer the control
.xml documentation at http://doc.opensuse.org/projects/YaST/
SLES11/tdg/inst_in_general_chap.html#product_control.

20.2.1 Customizing YaST Messages
By default, an installation of SUSE Linux Enterprise Server contains several default
messages that are localized and displayed at certain stages of the installation process.
These include a welcome message, a license message, and a congratulatory message
at the end of installation. You can replace any of these with your own versions and in-
clude localized versions of them in the installation. To include your own welcome
message, proceed as follows:

1 Log in as root.

2 Open the /etc/sysconfig/firstboot configuration file and apply the fol-
lowing changes:
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2a Set FIRSTBOOT_WELCOME_DIR to the directory path where you want to
store the files containing the welcome message and the localized versions,
for example:
FIRSTBOOT_WELCOME_DIR="/usr/share/firstboot/"

2b If your welcome message has filenames other than welcome.txt and
welcome_locale.txt (where locale matches the ISO 639 language
codes such as “cs” or “de”), specify the filename pattern in
FIRSTBOOT_WELCOME_PATTERNS. For example:
FIRSTBOOT_WELCOME_PATTERNS="mywelcome.txt"

If unset, the default value of welcome.txt is assumed.

3 Create the welcome file and the localized versions and place them in the directory
specified in the /etc/sysconfig/firstboot configuration file.

Proceed in a similar way to configure customized license and finish messages. These
variables are FIRSTBOOT_LICENSE_DIR and FIRSTBOOT_FINISH_FILE.

Change the SHOW_Y2CC_CHECKBOX to “yes” if the user needs to be able to start
YaST directly after performing the installation.

20.2.2 Customizing the License Action
You can customize the way the installation system reacts to a user's refusal to accept
the license agreement. There are three different ways which the system could react to
this scenario:

halt
The firstboot installation is aborted and the entire system shuts down. This is the
default setting.

continue
The firstboot installation continues.

abort
The firstboot installation is aborted, but the system attempts to boot.
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Make your choice and set LICENSE_REFUSAL_ACTION to the appropriate value.

20.2.3 Customizing the Release Notes
Depending on if you have changed the instance of SUSE Linux Enterprise Server you
are deploying with firstboot, you probably need to educate the end users about important
aspects of their new operating system. A standard installation uses release notes (dis-
played during one of the final stages of the installation) to provide important information
to the users. To have your own modified release notes displayed as part of a firstboot
installation, proceed as follows:

1 Create your own release notes file. Use the RTF format as in the example file in
/usr/share/doc/release-notes and save the result asRELEASE-NOTES
.en.rtf (for English).

2 Store optional localized versions next to the original version and replace the en part
of the filename with the actual ISO 639 language code, such as de for German.

3 Open the firstboot configuration file from /etc/sysconfig/firstboot and
setFIRSTBOOT_RELEASE_NOTES_PATH to the actual directorywhere the release
notes files are stored.

20.2.4 Customizing the Workflow
By default, a standard firstboot workflow includes the following components:

• Language Selection

• Welcome

• License Agreement

• Host Name

• Network

• Time and Date

• Desktop
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• root Password

• User Authentication Method

• User Management

• Hardware Configuration

• Finish Setup

This standard layout of a firstboot installation workflow is not mandatory. You can
enable or disable certain components or integrate your ownmodules into the workflow.
To modify the firstboot workflow, manually edit the firstboot configuration file /etc/
YaST2/firstboot.xml. This XML file is a subset of the standard control.xml
file that is used by YaST to control the installation workflow.

For an overview about proposals, see Example 20.1, “Configuring the Proposal
Screens” (page 304). This provides you with enough background to modify the firstboot
installation workflow. The basic syntax of the firstboot configuration file (plus how the
key elements are configured) is explained with this example.

Example 20.1 Configuring the Proposal Screens

…
<proposals config:type="list">

<proposal>
<name>firstboot_hardware</name>
<mode>installation</mode>
<stage>firstboot</stage>
<label>Hardware Configuration</label>
<proposal_modules config:type="list">

<proposal_module>printer</proposal_module>
</proposal_modules>

</proposal>
<proposal>
…
</proposal>

</proposals>

The container for all proposals that should be part of the firstboot workflow.
The container for an individual proposal.
The internal name of the proposal.
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The mode of this proposal. Do not make any changes here. For a firstboot instal-
lation, this must be set to installation.
The stage of the installation process at which this proposal is invoked. Do not
make any changes here. For a firstboot installation, this must be set to
firstboot.
The label to be displayed on the proposal.
The container for all modules that are part of the proposal screen.
One or more modules that are part of the proposal screen.

The next section of the firstboot configuration file consists of the workflow definition.
All modules that should be part of the firstboot installation workflow must be listed
here.

Example 20.2 Configuring the Workflow Section

<workflows config:type="list">
<workflow>

<defaults>
<enable_back>yes</enable_back>
<enable_next>yes</enable_next>
<archs>all</archs>

</defaults>
<stage>firstboot</stage>
<label>Configuration</label>
<mode>installation</mode>
… <!–– list of modules ––>
</modules>

</workflow>
</workflows>
…

The overall structure of the workflows section is very similar to that of the
proposals section. A container holds the workflow elements and the workflow ele-
ments all include stage, label and mode information (just as the proposals introduced
in Example 20.1, “Configuring the Proposal Screens” (page 304)). The most notable
difference is the defaults section, which contains basic design information for the
workflow components:

enable_back
Include the Back button in all dialogs.

enable_next
Include the Next button in all dialogs.

Deploying Customized Preinstallations 305



archs
Specify the hardware architectures on which this workflow should be used.

Example 20.3 Configuring the List of Workflow Components

<modules config:type="list">
<module>

<label>Language</label>
<enabled config:type="boolean">false</enabled>
<name>firstboot_language</name>

</module>
<modules>

The container for all components of the workflow.
The module definition.
The label displayed with the module.
The switch to enable or disable this component in the workflow.
The module name. The module itself must be located under /usr/share/
YaST2/clients and have the .ycp file suffix.

To make changes to the number or order of proposal screens during the firstboot instal-
lation, proceed as follows:

1 Open the firstboot configuration file at /etc/YaST2/firstboot.xml.

2 Delete or add proposal screens or change the order of the existing ones:

• To delete an entire proposal, remove the proposal element including all its
subelements from the proposals section and remove the respective module
element (with subelements) from the workflow.

• To add a new proposal, create a new proposal element and fill in all the required
subelements. Make sure that the proposal exists as a YaST module in /usr/
share/YaST2/clients.

• To change the order of proposals, move the respectivemodule elements containing
the proposal screens around in the workflow. Note that there may be dependencies
to other installation steps that require a certain order of proposals and workflow
components.
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3 Apply your changes and close the configuration file.

You can always change the workflow of the configuration steps when the default does
not meet your needs. Enable or disable certain modules in the workflow (or add your
own custom ones).

To toggle the status of a module in the firstboot workflow, proceed as follows:

1 Open the /etc/YaST2/firstboot.xml configuration file.

2 Change the value for the enabled element from true to false to disable the
module or from false to true to enable it again.

<module>
<label>Time and Date</label>
<enabled config:type="boolean">true</enabled>
<name>firstboot_timezone</name>

</module>

3 Apply your changes and close the configuration file.

To add a custom made module to the workflow, proceed as follows:

1 Create your own YaST module and store the module file module_name.ycp in
/usr/share/YaST2/clients.

2 Open the /etc/YaST2/firstboot.xml configuration file.

3 Determine at which point in the workflow your new module should be run. In doing
so, make sure that possible dependencies to other steps in the workflow are taken
into account and resolved.

4 Create a newmodule element inside themodules container and add the appropriate
subelements:
<modules config:type="list">

…
<module>

<label>my_module</label>
<enabled config:type="boolean">true</enabled>
<name>filename_my_module</name>

</module>
</modules>
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4a Enter the label to be displayed on your module in the label element.

4b Make sure that enabled is set to true to have your module included in
the workflow.

4c Enter the filename of your module in the name element. Omit the full path
and the .ycp suffix.

5 Apply your settings and close the configuration file.

TIP: Finding Connected Network Interface For Auto-Configuration

If the target hardware may feature more than one network interface add the
network-autoconfig package to the application image.
network-autoconfigmakes sure that during firstboot all available ethernet
interfaces are cycled until one is successfully configured with DHCP.

20.2.5 Configuring Additional Scripts
Firstboot can be configured to execute additional scripts after the firstboot workflow
has been completed. To add additional scripts to the firstboot sequence, proceed as
follows:

1 Open the /etc/sysconfig/firstboot configuration file and make sure that
the path specified for SCRIPT_DIR is correct. The default value is/usr/share/
firstboot/scripts.

2 Create your shell script, store it in the specified directory, and apply the appropriate
file permissions.

20.2.6 Providing Translations of the
Installation Workflow

Depending on the end user it could be desirable to offer translations of the customized
workflow. Those translations could be necessary, if you customized the workflow by
changing the /etc/YaST2/firstboot.xml file, as described in Section 20.2.4,
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“Customizing the Workflow” (page 303). This is different from the localization of cus-
tomized YaST messages, which is already described in Section 20.2.1, “Customizing
YaST Messages” (page 301).

If you have changed/etc/YaST2/firstboot.xml and introduced string changes,
generate a new translation template file (.pot file) and use the gettext tool chain
to translate and finally install the translated files in the YaST locale directories (/usr/
share/YaST2/locale) as compiled .mo files. Proceed as follows:

1 Change the textdomain setting from:
<textdomain>firstboot</textdomain>

to, for example,
<textdomain>firstboot-oem</textdomain>

2 Use xgettext to extract the translatable strings to the translation template file (
.pot file), for example to firstboot-oem.pot:
xgettext -L Glade -o firstboot-oem.pot /etc/YaST2/firstboot.xml

3 Start the translation process. Then package the translated files (.LL_code.po
files) the same way as translations of the other projects and install the compiled
firstboot-oem.mo files.

If you need translations for additional or changed YaST modules, provide translations
within such a module itself. If you just changed an existing module, make sure to change
also its textdomain statement to avoid undesired side-effects.

TIP: For More Information

For more information about YaST development, refer to http://en
.opensuse.org/openSUSE:YaST_development. Detailed information
about YaST firstboot can be found at http://doc.opensuse.org/
projects/YaST/SLES11/tdg/bk09ch01s02.html.
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20.3 Cloning the Master Installation
Clone themaster machine's disk using any of the imagingmechanisms available to you,
and roll these images out to the target machines. For more information about imaging
see Chapter 17, KIWI (page 283).

20.4 Personalizing the Installation
As soon as the cloned disk image is booted, firstboot starts and the installation proceeds
exactly as laid out in Section 20.2.4, “Customizing theWorkflow” (page 303). Only the
components included in the firstboot workflow configuration are started. All other in-
stallation steps are skipped. The end user adjusts language, keyboard, network, and
password settings to personalize the workstation. Once this process is finished, a firstboot
installed system behaves as any other instance of SUSE Linux Enterprise Server.
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Part IV. Automated Installations





21Automated Installation
AutoYaST allows you to install SUSE®Linux Enterprise on a large number of machines
in parallel. The AutoYaST technology offers great flexibility to adjust deployments to
heterogeneous hardware. This chapter tells you how to prepare a simple automated in-
stallation and lay out an advanced scenario involving different hardware types and in-
stallation purposes.

21.1 Simple Mass Installation
IMPORTANT: Identical Hardware

This scenario assumes you are rolling out SUSE Linux Enterprise to a set of
machines with exactly the same hardware configuration.

To prepare for an AutoYaST mass installation, proceed as follows:

1 Create an AutoYaST profile that contains the installation details needed for your
deployment as described in Section 21.1.1, “Creating an AutoYaST Pro-
file” (page 314).

2 Determine the source of the AutoYaST profile and the parameter to pass to the in-
stallation routines as described in Section 21.1.2, “Distributing the Profile and De-
termining the autoyast Parameter” (page 316).

3 Determine the source of the SUSE Linux Enterprise installation data as described
in Section 21.1.3, “Providing the Installation Data” (page 318).
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4 Determine and set up the boot scenario for autoinstallation as described in Sec-
tion 21.1.4, “Setting Up the Boot Scenario” (page 319).

5 Pass the command line to the installation routines by adding the parameters manually
or by creating an info file as described in Section 21.1.5, “Creating the info
File” (page 321).

6 Start the autoinstallation process as described in Section 21.1.6, “Initiating and
Monitoring the Autoinstallation” (page 324).

21.1.1 Creating an AutoYaST Profile
An AutoYaST profile tells AutoYaST what to install and how to configure the installed
system to get a completely ready-to-use system in the end. It can be created in several
different ways:

• Clone a fresh installation from a reference machine to a set of identical machines

• Use the AutoYaST GUI to create and modify a profile to meet your requirements

• Use an XML editor and create a profile from scratch

To clone a fresh reference installation, proceed as follows:

1 Perform a normal installation.

2 After you complete the hardware configuration and read the release notes, check
Clone This System for AutoYaST, if it is not yet checked by default. This creates a
ready-to-use profile as /root/autoyast.xml that can be used to create clones
of this particular installation.

To use the AutoYaST GUI to create a profile from an existing system configuration
and modify it to your needs, proceed as follows:

1 As root, start YaST.

2 SelectMiscellaneous > Autoinstallation to start the graphical AutoYaST front-end.

3 Select Tools > Create Reference Profile to prepare AutoYaST to mirror the current
system configuration into an AutoYaST profile.
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4 Aswell as the default resources (like boot loader, partitioning, and software selection),
you can add various other aspects of your system to the profile by checking the items
in the list in Create a Reference Control File.

5 Click Create to have YaST gather all the system information and write it to a new
profile.

6 To proceed, choose one of the following:

• If the profile is complete and matches your requirements, select File > Save as
and enter a filename for the profile, such as autoyast.xml.

• Modify the reference profile by selecting the appropriate configuration aspects
(such as “Hardware/Printer”) from the tree view to the left and clickingConfigure.
The respective YaST module starts but your settings are written to the AutoYaST
profile instead of applied to your system. When done, select File > Save as and
enter a suitable name for the profile.

7 Leave the AutoYaST module with File > Exit.

Figure 21.1 Editing an AutoYaST Profile with the AutoYaST Front-End
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21.1.2 Distributing the Profile and
Determining the autoyast Parameter

The AutoYaST profile can be distributed in several different ways. Depending on the
protocol used to distribute the profile data, different AutoYaST parameters are used to
make the profile location known to the installation routines on the client. The location
of the profile is passed to the installation routines by means of the boot prompt or an
info file that is loaded upon boot. The following options are available:

DescriptionParameterProfile
Loca-
tion

Makes the installation rou-
tines look for the control file

autoyast=file://pathFile

in the specified path (rela-
tive to source root directo-
ry—file:///autoyast
.xml if in the top directory
of a CD-ROM).

Makes the installation rou-
tines look for the control file

autoyast=device://pathDevice

on a storage device. Only
the device name is need-
ed—/dev/sda1 is wrong,
use sda1 instead.

Makes the installation rou-
tines look for the control file

autoyast=floppy://pathFloppy

on a floppy in the floppy
drive. This option is especial-
ly useful, if you want to boot
from CD-ROM.
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DescriptionParameterProfile
Loca-
tion

Has the installation routines
retrieve the control file from
an NFS server.

autoyast=nfs://server/
path

NFS

Has the installation routines
retrieve the control file from
an HTTP server.

autoyast=http://server/
path

HTTP

Has the installation routines
retrieve the control file from
an HTTPS server.

autoyast=https://server/
path

HTTPS

Has the installation routines
retrieve the control file from
a TFTP server.

autoyast=tftp://server/
path

TFTP

Has the installation routines
retrieve the control file from
an FTP server.

autoyast=ftp://server/
path

FTP

Replace the server and path placeholders with values matching your actual setup.

AutoYaST includes a feature that allows the binding of certain profiles to the client's
MAC address. Without having to alter the autoyast= parameter, you can have the
same setup install several different instances using different profiles.

To use this, proceed as follows:

1 Create separate profiles with the MAC address of the client as the filename and put
them on the HTTP server that holds your AutoYaST profiles.

2 Omit the exact path including the filenamewhen creating theautoyast= parameter,
for example:
autoyast=tftp://192.168.1.115/
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3 Start the autoinstallation.

YaST tries to determine the location of the profile in the following way:

1. YaST searches for the profile using its own IP address in uppercase hexadecimal,
for example, 192.0.2.91 is C000025B.

2. If this file is not found, YaST removes one hex digit and tries again. This action is
repeated eight times until the file with the correct name is found.

3. If that still fails, it tries locating a file with the MAC address of the clients as the
filename. The MAC address of the example client is 0080C8F6484C.

4. If the MAC address–named file cannot be found, YaST searches for a file named
default (in lowercase). An example sequence of addresses where YaST searches
for the AutoYaST profile looks as follows:

C000025B
C000025
C00002
C0000
C000
C00
C0
C
0080C8F6484C
default

21.1.3 Providing the Installation Data
The installation data can be provided by means of the product CDs or DVDs or using
a network installation source. If the product CDs are used as the installation source,
physical access to the client to be installed is needed, because the boot process needs
to be initiated manually and the CDs need to be changed.

To provide the installation sources over the network, set up a network installation
server (HTTP, NFS, FTP) as described in Section 14.2.1, “Setting Up an Installation
Server Using YaST” (page 224). Use an info file to pass the server's location to the
installation routines.
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21.1.4 Setting Up the Boot Scenario
The client can be booted in several different ways:

Network Boot
As with a normal remote installation, autoinstallation can be initiated with Wake
on LAN and PXE, the boot image and control file can be pulled in via TFTP, and
the installation sources from any network installation server.

Bootable CD-ROM
You can use the original SUSE Linux Enterprise media to boot the system for au-
toinstallation and pull in the control file from a network location or a floppy. Alter-
nately, create your own custom CD-ROM holding both the installation sources and
the AutoYaST profile.

The following sections provide a basic outline of the procedures for network boot or
boot from CD-ROM.

21.1.4.1 Preparing for Network Boot
Network booting with Wake on LAN, PXE, and TFTP is discussed in Section 14.1.3,
“Remote Installation via VNC—PXE Boot and Wake on LAN” (page 218). To make
the setup introduced there work for autoinstallation, modify the featured PXE Linux
configuration file (/srv/tftp/pxelinux.cfg/default) to contain the
autoyast parameter pointing to the location of the AutoYaST profile. An example
entry for a standard installation looks like this:

default linux

# default label linux
kernel linux
append initrd=initrd install=http://192.168.1.115/install/suse-enterprise/

The same example for autoinstallation looks like this:

default linux

# default label linux
kernel linux
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append initrd=initrd install=http://192.168.1.115/install/suse-enterprise/
\

autoyast=nfs://192.168.1.110/profiles/autoyast.xml

Replace the example IP addresses and paths with the data used in your setup.

21.1.4.2 Preparing to Boot from CD-ROM
There are several ways in which booting from CD-ROM can come into play in Auto-
YaST installations. Choose from the following scenarios:

Boot from SUSE Linux Enterprise Media, Get the Profile over the Network
Use this approach if a totally network-based scenario is not possible (for example,
if your hardware does not support PXE) and you have physical access to system
to install during most of the process.

You need:

• The SUSE Linux Enterprise media

• A network server providing the profile data (see Section 21.1.2, “Distributing
the Profile and Determining the autoyast Parameter” (page 316) for details)

• A floppy containing the info file that tells the installation routines where to
find the profile

or

Access to the boot prompt of the system to install where you manually enter the
autoyast= parameter

Boot and Install from SUSE Linux Enterprise Media, Get the Profile from a Floppy
Use this approach if an entirely network-based installation scenario would not
work. It requires physical access to the system to be installed for turning on the
target machine, or, in the second case, to enter the profile's location at the boot
prompt. In both cases, you may also need to change media depending on the scope
of installation.

You need:

• The SUSE Linux Enterprise media
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• A floppy holding both the profile and the info file

or

Access to the boot prompt of the target to enter the autoyast= parameter

Boot and Install from Custom Media, Get the Profile from the Media
If you just need to install a limited number of software packages and the number
of targets is relatively low, creating your own custom CD holding both the installa-
tion data and the profile itself might prove a good idea, especially if no network is
available in your setup.

21.1.5 Creating the info File
The installation routines at the target need to be made aware of all the different compo-
nents of the AutoYaST framework. This is done by creating a command line containing
all the parameters needed to locate the AutoYaST components, installation sources,
and the parameters needed to control the installation process.

Do this by manually passing these parameters at the boot prompt of the installation or
by providing a file called info that is read by the installation routines (linuxrc). The
former requires physical access to any client to install, which makes this approach un-
suitable for large deployments. The latter enables you to provide the info file on some
media that is prepared and inserted into the clients' drives prior to the autoinstallation.
Alternatively, use PXE boot and include the linuxrc parameters in the pxelinux
.cfg/default file as shown in Section 21.1.4.1, “Preparing for Network
Boot” (page 319).

The following parameters are commonly used for linuxrc. For more information, refer
to the AutoYaST package documentation under /usr/share/doc/packages/
autoyast.

IMPORTANT: Separating Parameters and Values

When passing parameters to linuxrc at the boot prompt, use = to separate
parameter and value. When using an info file, separate parameter and value
with :.
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ValueKeyword

The network device to use for network setup (for
BOOTP/DHCP requests). Only needed if several network
devices are available.

netdevice

When empty, the client sends a BOOTP request. Other-
wise the client is configured using the specified data.

hostip

Netmask for the selected network.netmask

Default gateway.gateway

Name server.nameserver

Location of the the control file to use for the automatic
installation, such as
autoyast=nfs//192.168.1.110/profiles/.

autoyast

Location of the installation source, such as
install=nfs://192.168.1.110/CDs/.

install

If set to 1, enables VNC remote controlled installation.vnc

The password for VNC.vncpassword

If set to 1, enables SSH remote controlled installation.usessh

If set to 1, sets up the network. Normally this is done
automatically, but you need to set netsetup=1 in case

netsetup

the installation repository is provided locally (e.g. via
DVD or local iso image) and the info file is loaded from
the network.

If your autoinstallation scenario involves client configuration via DHCP and a network
installation source, and you want to monitor the installation process using VNC, your
info would look like this:
autoyast:profile_source install:install_source vnc:1 vncpassword:some_password
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If you prefer a static network setup at installation time, your info file would look like
the following:

autoyast:profile_source \
install:install_source \
hostip:some_ip \
netmask:some_netmask \
gateway:some_gateway

The \ indicates that the line breaks have only been added for the sake of readability.
All options must be entered as one continuous string.

The info data can be made available to linuxrc in various different ways:

• As a file on a floppy or CD Rom that is in the client's drive at installation time. Add
the info parameter similar to info=floppy:/info or info=cd:/info.

• As a file in the root directory of the initial RAM disk used for booting the system
provided either from custom installation media or via PXE boot.

• As part of the AutoYaST profile. In this case, the AutoYaST file needs to be called
info to enable linuxrc to parse it. An example for this approach is given below.

• By means of an URL that points to the location of the info file. The syntax for this
looks like info=http://www.example.com/info.

linuxrc looks for a string (start_linuxrc_conf) in the profile that represents the
beginning of the file. If it is found, it parses the content starting from that string and
finishes when the string end_linuxrc_conf is found. The options are stored in the
profile as follows:
....

<install>
....

<init>
<info_file>

<![CDATA[
#
# Don't remove the following line:
# start_linuxrc_conf
#
install: nfs:server/path
vnc: 1
vncpassword: test
autoyast: file:///info

Automated Installation 323



# end_linuxrc_conf
# Do not remove the above comment
#
]]>

</info_file>
</init>

......
</install>

....

linuxrc loads the profile containing the boot parameters instead of the traditional info
file. The install: parameter points to the location of the installation sources. vnc
and vncpassword indicate the use of VNC for installation monitoring. The
autoyast parameter tells linuxrc to treat info as an AutoYaST profile.

21.1.6 Initiating and Monitoring the
Autoinstallation

After you have provided all the infrastructure mentioned above (profile, installation
source, and info file), you can go ahead and start the autoinstallation. Depending on
the scenario chosen for booting and monitoring the process, physical interaction with
the client may be needed:

• If the client system boots from any kind of physical media, either product media or
custom CDs, you need to insert these into the client's drives.

• If the client is not switched on via Wake on LAN, you need to at least switch on the
client machine.

• If you have not opted for remote controlled autoinstallation, the graphical feedback
fromAutoYaST is sent to the client's attachedmonitor or, if you use a headless client,
to a serial console.

To enable remote controlled autoinstallation, use the VNC or SSH parameters described
in Section 21.1.5, “Creating the info File” (page 321) and connect to the client from
another machine as described in Section 14.5, “Monitoring the Installation Pro-
cess” (page 247).
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21.2 Rule-Based Autoinstallation
The following sections introduce the basic concept of rule-based installation using
AutoYaST and provide an example scenario that enables you to create your own custom
autoinstallation setup.

21.2.1 Understanding Rule-Based
Autoinstallation

Rule-based AutoYaST installation allows you to cope with heterogeneous hardware
environments:

• Does your site contain hardware of different vendors?

• Are the machines on your site of different hardware configuration (for example, using
different devices or using different memory and disk sizes)?

• Do you intend to install across different domains and need to distinguish between
them?

What rule-based autoinstallation does is, basically, generate a custom profile to match
a heterogeneous scenario by merging several profiles into one. Each rule describes one
particular distinctive feature of your setup (such as disk size) and tells AutoYaSTwhich
profile to use when the rule matches. Several rules describing different features of your
setup are combined in an AutoYaST rules.xml file. The rule stack is then processed
and AutoYaST generates the final profile by merging the different profiles matching
the AutoYaST rules into one. To illustrate this procedure, refer to Section 21.2.2, “Ex-
ample Scenario for Rule-Based Autoinstallation” (page 327).

Rule-based AutoYaST offers you great flexibility in planning and executing your SUSE
Linux Enterprise deployment. You can:

• Create rules for matching any of the predefined system attributes in AutoYaST

• Combine multiple system attributes (such as disk size and kernel architecture) into
one rule by using logical operators
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• Create custom rules by running shell scripts and passing their output to the AutoYaST
framework. The number of custom rules is limited to five.

NOTE

For more information about rule creation and usage with AutoYaST, refer to
the package's documentation under /usr/share/doc/packages/
autoyast2/html/index.html, Chapter Rules and Classes.

To prepare for a rule-based AutoYaST mass installation, proceed as follows:

1 Create several AutoYaST profiles that contain the installation details needed for
your heterogeneous setup as described in Section 21.1.1, “Creating an AutoYaST
Profile” (page 314).

2 Define rules to match the system attributes of your hardware setup as shown in
Section 21.2.2, “Example Scenario for Rule-Based Autoinstallation” (page 327).

3 Determine the source of the AutoYaST profile and the parameter to pass to the in-
stallation routines as described in Section 21.1.2, “Distributing the Profile and De-
termining the autoyast Parameter” (page 316).

4 Determine the source of the SUSE Linux Enterprise installation data as described
in Section 21.1.3, “Providing the Installation Data” (page 318)

5 Pass the command line to the installation routines by adding the parameters manually
or by creating an info file as described in Section 21.1.5, “Creating the info
File” (page 321).

6 Determine and set up the boot scenario for autoinstallation as described in Sec-
tion 21.1.4, “Setting Up the Boot Scenario” (page 319).

7 Start the autoinstallation process as described in Section 21.1.6, “Initiating and
Monitoring the Autoinstallation” (page 324).
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21.2.2 Example Scenario for Rule-Based
Autoinstallation

To get a basic understanding of how rules are created, think of the following example,
depicted in Figure 21.2, “AutoYaST Rules” (page 327). One run of AutoYaST installs
the following setup:

A Print Server
This machine just needs a minimal installation without a desktop environment and
a limited set of software packages.

Workstations in the Engineering Department
These machines need a desktop environment and a broad set of development soft-
ware.

Laptops in the Sales Department
These machines need a desktop environment and a limited set of specialized appli-
cations, such as office and calendaring software.

Figure 21.2 AutoYaST Rules

In a first step, use one of the methods outlined in Section 21.1.1, “Creating an AutoYaST
Profile” (page 314) to create profiles for each use case. In this example, you would
create print.xml, engineering.xml, and sales.xml.

In the second step, create rules to distinguish the three hardware types from one another
and to tell AutoYaST which profile to use. Use an algorithm similar to the following
to set up the rules:

1. Does the machine have an IP of 192.168.2.253? Then make it the print server.

2. Does the machine have PCMCIA hardware and feature an Intel chipset? Then con-
sider it an Intel laptop and install the sales department software selection.

3. If none of the above is true, consider the machine a developer workstation and install
accordingly.

Roughly sketched, this translates into a rules.xml file with the following content:
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<?xml version="1.0"?>
<!DOCTYPE autoinstall SYSTEM "/usr/share/autoinstall/dtd/rules.dtd">
<autoinstall xmlns="http://www.suse.com/1.0/yast2ns"
xmlns:config="http://www.suse.com/1.0/configns">
<rules config:type="list">

<rule>
<hostaddress>

<match>192.168.2.253</match>
<match_type>exact</match_type>

</hostaddress>
<result>

<profile>print.xml</profile>
<continue config:type="boolean">false</continue>

</result>
</rule>
<rule>

<haspcmcia>
<match>1</match>
<match_type>exact</match_type>

</haspcmcia>
<custom1>

<script>
if grep -i intel /proc/cpuinfo > /dev/null; then
echo -n "intel"
else
echo -n "non_intel"
fi;

</script>
<match>*</match>
<match_type>exact</match_type>

</custom1>
<result>

<profile>sales.xml</profile>
<continue config:type="boolean">false</continue>

</result>
<operator>and</operator>

</rule>
<rule>

<haspcmcia>
<match>0</match>
<match_type>exact</match_type>

</haspcmcia>
<result>

<profile>engineering.xml</profile>
<continue config:type="boolean">false</continue>

</result>
</rule>

</rules>
</autoinstall>
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When distributing the rules file, make sure that the rules directory resides under the
profiles directory, specified in the autoyast=protocol:serverip/
profiles/URL. AutoYaST looks for arules subdirectory containing a file named
rules.xml first then loads and merges the profiles specified in the rules file.

The rest of the autoinstallation procedure is carried out as usual.

21.3 For More Information
For in-depth information about the AutoYaST technology, refer to the documentation
installed alongwith the software. It is located under/usr/share/doc/packages/
autoyast2. The most recent edition of this documentation can be found at http://
www.suse.de/~ug/autoyast_doc/index.html.
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22
Automated Upgrade from
SUSE Linux Enterprise 11 SP1
to 11 SP2
The following procedure is a way to do a mass upgrade unattended from SUSE Linux
Enterprise 11 SP1 to SUSE Linux Enterprise 11 SP2. Several preparation steps are
needed to create a suitable AutoYaST profile. AutoYaST finally will execute the upgrade
process.

22.1 Preparing the AutoYaST Profile
The AutoYaST profile for the automated upgrade uses the same file format as the
AutoYaST installation. For more information about AutoYaST, see Chapter 21, Auto-
mated Installation (page 313) and the external AutoYaST documentation at http://
www.suse.de/~ug/autoyast_doc/index.html.

However, for obvious reasons, there are some parts of the system (e.g, partitioning)
that do not make sense to be configured during the upgrade. On the other hand, it is
useful to set upgrade-specific options by means of the AutoYaST profile.

22.1.1 Upgrade
The upgrade options define the behavior of the dependency solver during upgrade:
<upgrade>

<only_installed_packages
config:type="boolean">false</only_installed_packages>

<stop_on_solver_conflict
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config:type="boolean">true</stop_on_solver_conflict>
</upgrade>

only_installed_packages
Set to true for package-based upgrades (recommended for upgrading to the next
service pack of the same product) or false for pattern-based upgrades (recom-
mended for an upgrade between versions of a product, e.g. from SLES10 to
SLES11).

stop_on_solver_conflict
Defines whether to show the proposal in case of failure to resolve package depen-
dencies interactively (recommended to be set to true, but this could result in an
interactive process, during which the user must to resolve the conflicts manually.

22.1.2 Software Selection
The software selection options define, which components to select or deselect in addition
to the results of the resolver:
<software>
<packages config:type="list">

<package>autoyast2-installation</package>
<package>apparmor-profile-editor</package>

</packages>
<patterns config:type="list">

<pattern>base</pattern>
</patterns>
<remove-packages config:type="list"/>
<remove-patterns config:type="list"/>

</software>

It is especially important to set packages or patterns for being selected or deselected in
order to resolve package conflicts and thus to avoid the need for interactive intervention.
Once the upgrade is done, the newly created autoupg_updated.xml file contains
these packages and patterns plus those that were selected or deselected for any other
reason.

22.1.3 Backup Before Upgrade
The backup before upgrade options match these features in the upgrade proposal.
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<backup>
<sysconfig config:type="boolean">true</sysconfig>
<modified config:type="boolean">true</modified>
<remove_old config:type="boolean">false</remove_old>

</backup>

sysconfig
defines whether to backup sysconfig before upgrading.

modified
defines whether to backup the modified configuration files before upgrading.

remove_old
defines whether to remove old backups from previous upgrades.

22.2 Running the Automated Upgrade
To start the automated upgrade, boot the installation media and pass the AutoYaST
profile to it. There are two ways to pass the profile to the system:

• Pass the profile to the kernel command line the same way as for the AutoYaST instal-
lation (use the autoupgrade=1
autoyast=http://host/path/profile.xml parameter. For System z,
this is the only possibility.

• Pass the autoupgrade=1 parameter to the kernel command line. Before you start
the upgrade, copy the profile to /root/autoupg.xml. Then there is no need for
any additional kernel parameter.

The latter approach allows you to have a single installation kernel command line for
even different machines—just copy the appropriate profile into its filesystem.

As long as you have only one SUSE Linux Enterprise system installed on your machine,
there are no package conflicts and you did not set the profile to stop on the upgrade
proposal, the complete process will be non-interactive. In case you enter the upgrade
proposal, you can modify its settings for the upgrade.

After the upgrade finishes, YaST writes the /root/autoupg-updated.xml file,
which contains the profile with applied software selection changes done in the proposal.
This is especially useful in case of mass upgrades of machines with the same package

Automated Upgrade from SUSE Linux Enterprise 11 SP1 to 11 SP2 333



selection. This way, conflict resolutions from one machine can easily be applied on
other machines, which consequently will get these conflicts resolved automatically and
the upgrade itself will be non-interactive.

If there are more SUSE Linux Enterprise systems installed on the machine, you will
always be asked, which one to upgrade—there is no way to select it in advance.

22.3 GRUB Menu Section for Booting
into the Upgrade

An alternate way to boot the system is to create an additional section in the GRUB
menu (and similar for other bootloaders and other architectures), which starts the instal-
lation. The following example assumes that there is a separate /boot partition, which
is referred in GRUB as (hd0,0):
title Upgrade

root (hd0,0)
kernel /upgrade/linux
install=inst_source_url autoupgrade=1
autoyast=autoyast_profile_url vga=0x314
initrd /upgrade/initrd

The above example assumes that the installation kernel and the installation initrd
are located in the /boot/upgrade directory.

On System z, you must add the parameters to the PARM file—proceed the same way
as you do when performing an AutoYaST-driven installation.

22.4 Second Stage of the Upgrade
The automated upgrade by default does not perform configuration changes during the
second stage of the upgrade. The only exception is network configuration, which needs
to be set to be preserved in the AutoYaST upgrade profile.

If configuration adjustment of some system areas is needed after the upgrade (e.g.,
configuring a new service), add the relevant sections to the AutoYaST profile for the
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upgrade and the configuration of the selected system areas will be saved during the
upgrade.

WARNING: AutoYaST Supplied Configuration Replaces Exisiting
Configuration

Be warned that existing configuration of that system area will be replaced and
thus destroyed by the AutoYaST configuration.

Normally, the only configuration adjustment, which should be present in the AutoYaST
profile, is the registration of the system with Subscription Management Tool (SMT) or
Novell Customer Center (NCC). If this is missing, the system will not get the update
repository and updates will not be possible—unless configured later again.

22.5 Limitations and Hints

22.5.1 NetworkManager and Registration
In case of using NetworkManager for managing network devices and network connec-
tions, network connection is not available during the second stage of the upgrade. This
prevents the system from performing the registration.

22.5.2 Cleaning Up Upgrade Setting
If you do any changes in your system in order to trigger the upgrade process (e.g.,
adding a new section to the bootloader menu), you probably want to remove it after the
upgrade is done.

You can do it automatically with a post-installation script. Find an examples in the
AutoYaST documentation at http://www.suse.de/~ug/autoyast_doc/
createprofile.scripts.html. A sample script cleaning up GRUB's menu
.lst is included in the sample autoupg.xml file. Make sure that the script matches
your particular set-up and that it does not remove more than you actually want!
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22.5.3 For More Information
• Linuxrc Documentation: http://en.opensuse.org/SDB:Linuxrc
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23Automated Deployment of
Preload Images
With KIWI you are able to create operating system images. This chapter describes the
process of deploying a system image to an empty client machine. For this, you have to
create a preload image which contains a bootable RAW image. This file contains two
important parts: a partition table and the actual operating system. This RAW image
will be written to the empty hard disk and the operating system extends to the remaining
disk space at first boot.

To create such an image, see Section 17.4.2, “Creating an Image” (page 289). When
you build the ISO image, you can find the RAW file in the destination folder. There
are many ways to dump a raw image onto a disk.

• Plug the disk into a deployment server and just copy the image to the raw device.

• Provide the raw image by means of a HTTP or FTP server and dump it on the disk
of the client machine.

• Create a netboot image to get the image and dump it on the disk. This is a good
method for mass deployment.

• Boot a rescue disk and do the dump manually from the rescue image.

For a quick start, it is good to use one of the methods described in Section 23.1, “De-
ploying system manually from rescue image” (page 338).
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23.1 Deploying systemmanually from
rescue image

Deploying with generated ISO file from KIWI:

1. Burn the ISO image you get from the KIWI building process, see Section 17.4.2,
“Creating an Image” (page 289) on CD/DVD

2. Boot from this medium onto the client machine.

3. Select the hard disk for installation.

4. Restart the client machine and boot from hard disk.

Deploying over rescue system:

1. Boot the client machine with a rescue system. Such systems are available on all
SUSE installation CDs or DVDs.

2. Log in as root. Do not enter password.

3. Configure your network. If you have DHCP available in your network, this is
merely the command ifup-dhcp eth0. If you must do this manually, use
the command ip to configure your network. The output starting DHCP also tells
you the IP address of the computer.

4. Listen on an unused port of your network like 1234 and dump the incoming
data to disk with the following command:
netcat -l -p 1234 > /dev/sda

5. On the imaging server, send the raw image to the client machine with the com-
mand:
netcat <IP of client> 1234 < $HOME/preload_image/<image_name>

6. When the image is transferred, remove the rescue system from your CD or DVD
drive and shutdown the client machine. On reboot, the boot loader GRUB should
be started on the client and the firstboot system will take over.
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23.2 Automated Deployment with PXE
Boot

When doing mulitple installations of an operating system on similar hardware, it is
useful to put some effort into preparing a mass deployment of the operating system and
to minimize the time needed for the actual deployment. This chapter describes this
process. The goal is to simply plug in a computer, connect it to a network, start a network
boot, and wait until it powers down.

The following actions have to be performed in order to accomplish this task:

Setup a boot and install server
A dedicated machine is needed, that should be prepared to offer PXE boot as well
as an ftp or web server to provide a preload image. It is a good idea to give the
machine enough memory to hold all necessary installation data in memory. For a
default installation, you should have at least 4 GByte of memory. All the necessary
tasks can be accomplished with SUSE Linux Enterprise Server. For more details,
see Section 23.2.1, “Setup a Boot and Install Server” (page 340).

Prepare a preload Image
The actual installation is done by the copying of a raw image of the operating system
to the new harddisk. All features and settings must be prepared and tested carefully.
To provide such an image, KIWI can be used (available in the SDK of the SUSE
Linux Enterprise operating system). More information about image creation with
KIWI is available in Chapter 17, KIWI (page 283). For more details about the re-
quirements of the preload image, see Section 23.2.2, “Creating a Preload Im-
age” (page 340).

Create an initial system for deployment
This is a task that requires some linux expertise. A description on how this can be
achieved by means of an example installation is available at Section 23.2.3, “Cre-
ating a Initial System to Deploy a Preload Image” (page 341).

Configure the boot server for automatic deployment
PXE boot must be told to boot the installation system, that in turn will take the
preload image from the server and copy it to the harddisk.
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23.2.1 Setup a Boot and Install Server
There are four steps to accomplish in order to perform this task after a SUSE Linux
Enterprise Server installation:

1 Set up the installation source as described in Section 14.2, “Setting Up the Server
Holding the Installation Sources” (page 223). Choose an HTTP, or FTP network
server.

2 Set up a TFTP server to hold a boot image (this image will be created in a later step).
This is described in Section 14.3.2, “Setting Up a TFTP Server” (page 236).

3 Set up a DHCP server to assign IP addresses to all machines and to reveal the location
of the TFTP server to the target system. This is described in Section 14.3.1, “Setting
Up a DHCP Server” (page 233).

4 Prepare the installation server PXE boot. This is described in further detail in Sec-
tion 14.3.3, “Using PXE Boot” (page 237).

Note that the actual installation process will greatly benefit if you provide enough
memory on this machine to hold the preload image. Also, using gigabit ethernet will
speedup the deployment process considerably compared to slower networks.

23.2.2 Creating a Preload Image
The process of creating images with KIWI is described in Section 17.4.2, “Creating an
Image” (page 289). However, to create a useful image for mass deployment, several
considerations should be taken into account:

• A typical preload image will use the following type:
<type primary="true" filesystem="ext3" boot="oemboot/suse-SLES11">vmx</type>

• During the setup of a preload image, the image creation process is runmultiple times.
The repositories needed to build the image should be available on the local computer.

• Depending on the desired usage of the preload, some effort should be invested in
configuring firstboot. Find more details about firstboot in Chapter 20, Deploying
Customized Preinstallations (page 299). With this method you can also require the
user to do initial configurations at the first bootup of the system.
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• Many additional features can be configured into the image, like adding update
repositories or doing an update on initial bootup. However, it is impossible to describe
all possibilities in this document, and (depending on the requirements) the creation
of the preload image requires in-depth knowledge of the imaging system KIWI, as
well as several other technologies used in SUSE Linux Enterprise Server.

The actual image to be deployed should be available from the ftp or http server that
you provided on the installation server.

23.2.3 Creating a Initial System to Deploy a
Preload Image

In order to run an automatic deployment, it is necessary to start an initial linux system
on the target computer. During a typical installation, the kernel and initial ram filesystem
are read from some boot medium and started by the bios. The needed functionality can
be implemented in the ram filesystem, which together with the kernel will serve as the
initial system.

The main features that must be provided by the initial system is the enabling of access
to the harddisk and the making available of the network connection. Both of these
functions are dependent on the hardware onto which you want to deploy. In theory it
is possible to create an initial system from scratch, but to ease this task it is also possible
to modify the initial ram filesystem used by the machine during boot.

The following procedure is just one example of how to create the needed initial ram
filesystem:

1 Do a standard installation of SUSE Linux Enterprise Server on the target system.

2 Install the package busybox on the system.

3 Create a new ram filesystem with the following command:
mkinitrd -f busybox -D eth0

Note that eth0 represents the ethernet device to which your network cable is at-
tached. The parameter -f busybox adds the multi call binary busybox to the
ram filesystem. After doing this, many standard unix commands are available
inside this system.
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4 Copy the new ram filesystem and the kernel to your boot server with the command:
scp /boot/initrd /boot/vmlinuz pxe.example.com:

Replace pxe.example.com with the name of your local boot server or ip address.

5 Log into your bootserver as user root, and create a directory where you can
modify the ram filesystem:
mkdir ~/bootimage

6 Change your working directory to this directory with the command cd
~/bootimage.

7 Unpack the previously copied initial ram filesystem with the command:
zcat ../initrd | cpio -i

8 Edit the file run_all.sh.

9 Search for the following line, delete it and the rest of the file:
[ "$debug" ] && echo preping 21-nfs.sh

10 Add the following lines to the end of the files run_all.sh:
[ "$debug" ] && echo preping 92-install.sh
[ "$debug" ] && echo running 92-install.sh
source boot/92-install.sh
[ "$modules" ] && load_modules

11 Create a new script boot/92-install.sh with the following content:
#!/bin/bash
if [ "$(get_param rawimage)" ]; then
rawimage=$(get_param rawimage)
if [ "$(get_param rawdevice)" ]; then
rawdevice=$(get_param rawdevice)
echo "wget -O ${rawdevice} ${rawimage}"
wget -O ${rawdevice} ${rawimage}
sync
sleep 5
echo "DONE"

fi
fi
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# /bin/bash
/bin/poweroff -f

12 If you want to have a debug shell before the computer switches off, remove the
comment sign before /bin/bash.

13 Make this script executable with the command chmod 755
boot/92-install.sh.

14 Create a new initial ram filesystem with the commands:
mkdir -p /srv/tftpboot
find . | cpio --quiet -H newc -o | gzip -9 -n > \
/srv/tftpboot/initrd.boot

15 Copy the kernel to this directory:
cp ../vmlinuz /srv/tftpboot/linux.boot

The initial ram filesystem is now prepared to take two new kernel command line param-
eters. The parameter rawimage=<URL> is used to identify the location of the preload
image. Any URL that is understood by wget can be used. The parameter
rawdevice=<device> is used to identify the block device for the harddisk on the
target machine.

23.2.4 Boot Server Configuration
The configuration of the boot server is covered in detail in several different chapters
as listed in Section 23.2.1, “Setup a Boot and Install Server” (page 340). This section
should give a check list that covers steps that are necessary to configure the system.

• Setup a dhcp server. The subnet where the machines are installed needs the additional
lines:
filename "pxelinux.0";
next-server 192.168.1.115;

In this example, 192.168.1.115 is the ip address of the PXE server pxe.example.com.
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• Configure a PXE server as described in Section 14.3.3, “Using PXEBoot” (page 237).
When editing /srv/tftpboot/pxelinux.cfg/default, add the following
entries:
default bootinstall
label bootinstall
kernel linux.boot
append initrd=initrd.boot \
rawimage=ftp://192.168.1.115/preload/preloadimage.raw rawdevice=/dev/sda

• Setup an ftp server and copy your prepared preload image to/srv/ftp/preload/
preloadimage.raw.

Test your setup by booting the target systemwith PXE network boot. This will automat-
ically copy the prepared preload image to harddisk and switch off the machine when
ready.
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AGNU Licenses
This appendix contains the GNU General Public License Version 2 and the GNU Free
Documentation License Version 1.2.

GNU General Public License
Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc. 59 Temple Place - Suite 330, Boston, MA 02111-1307, USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

Preamble
The licenses for most software are designed to take away your freedom to share and change it. By contrast, the GNU General Public License is intended
to guarantee your freedom to share and change free software--to make sure the software is free for all its users. This General Public License applies to
most of the Free Software Foundation’s software and to any other program whose authors commit to using it. (Some other Free Software Foundation
software is covered by the GNU Library General Public License instead.) You can apply it to your programs, too.

Whenwe speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed to make sure that you have the freedom
to distribute copies of free software (and charge for this service if you wish), that you receive source code or can get it if you want it, that you can change
the software or use pieces of it in new free programs; and that you know you can do these things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or to ask you to surrender the rights. These restrictions
translate to certain responsibilities for you if you distribute copies of the software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must give the recipients all the rights that you have. You must
make sure that they, too, receive or can get the source code. And you must show them these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which gives you legal permission to copy, distribute
and/or modify the software.

Also, for each author’s protection and ours, we want to make certain that everyone understands that there is no warranty for this free software. If the
software is modified by someone else and passed on, we want its recipients to know that what they have is not the original, so that any problems introduced
by others will not reflect on the original authors’ reputations.

Finally, any free program is threatened constantly by software patents. We wish to avoid the danger that redistributors of a free program will individu-
ally obtain patent licenses, in effect making the program proprietary. To prevent this, we have made it clear that any patent must be licensed for everyone’s
free use or not licensed at all.

The precise terms and conditions for copying, distribution and modification follow.



GNUGENERAL PUBLIC LICENSE TERMS AND CONDITIONS FOR COPYING, DISTRIBUTIONANDMODIFICATION
0. This License applies to any program or other work which contains a notice placed by the copyright holder saying it may be distributed under the
terms of this General Public License. The “Program”, below, refers to any such program or work, and a “work based on the Program” means either the
Program or any derivative work under copyright law: that is to say, a work containing the Program or a portion of it, either verbatim or with modifications
and/or translated into another language. (Hereinafter, translation is included without limitation in the term “modification”.) Each licensee is addressed
as “you”.

Activities other than copying, distribution and modification are not covered by this License; they are outside its scope. The act of running the Program
is not restricted, and the output from the Program is covered only if its contents constitute a work based on the Program (independent of having been
made by running the Program). Whether that is true depends on what the Program does.

1. You may copy and distribute verbatim copies of the Program’s source code as you receive it, in any medium, provided that you conspicuously and
appropriately publish on each copy an appropriate copyright notice and disclaimer of warranty; keep intact all the notices that refer to this License and
to the absence of any warranty; and give any other recipients of the Program a copy of this License along with the Program.

You may charge a fee for the physical act of transferring a copy, and you may at your option offer warranty protection in exchange for a fee.

2. You may modify your copy or copies of the Program or any portion of it, thus forming a work based on the Program, and copy and distribute such
modifications or work under the terms of Section 1 above, provided that you also meet all of these conditions:

a) You must cause the modified files to carry prominent notices stating that you changed the files and the date of any change.

b) You must cause any work that you distribute or publish, that in whole or in part contains or is derived from the Program or any part thereof, to be
licensed as a whole at no charge to all third parties under the terms of this License.

c) If the modified program normally reads commands interactively when run, you must cause it, when started running for such interactive use in the
most ordinary way, to print or display an announcement including an appropriate copyright notice and a notice that there is no warranty (or else, saying
that you provide a warranty) and that users may redistribute the program under these conditions, and telling the user how to view a copy of this License.
(Exception: if the Program itself is interactive but does not normally print such an announcement, your work based on the Program is not required to
print an announcement.)

These requirements apply to the modified work as a whole. If identifiable sections of that work are not derived from the Program, and can be reasonably
considered independent and separate works in themselves, then this License, and its terms, do not apply to those sections when you distribute them as
separate works. But when you distribute the same sections as part of a whole which is a work based on the Program, the distribution of the whole must
be on the terms of this License, whose permissions for other licensees extend to the entire whole, and thus to each and every part regardless of who
wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by you; rather, the intent is to exercise the right to
control the distribution of derivative or collective works based on the Program.

In addition, mere aggregation of another work not based on the Program with the Program (or with a work based on the Program) on a volume of a
storage or distribution medium does not bring the other work under the scope of this License.

3. You may copy and distribute the Program (or a work based on it, under Section 2) in object code or executable form under the terms of Sections 1
and 2 above provided that you also do one of the following:

a) Accompany it with the complete corresponding machine-readable source code, which must be distributed under the terms of Sections 1 and 2 above
on a medium customarily used for software interchange; or,

b) Accompany it with a written offer, valid for at least three years, to give any third party, for a charge no more than your cost of physically performing
source distribution, a complete machine-readable copy of the corresponding source code, to be distributed under the terms of Sections 1 and 2 above
on a medium customarily used for software interchange; or,

c) Accompany it with the information you received as to the offer to distribute corresponding source code. (This alternative is allowed only for non-
commercial distribution and only if you received the program in object code or executable form with such an offer, in accord with Subsection b above.)

The source code for a work means the preferred form of the work for making modifications to it. For an executable work, complete source code means
all the source code for all modules it contains, plus any associated interface definition files, plus the scripts used to control compilation and installation
of the executable. However, as a special exception, the source code distributed need not include anything that is normally distributed (in either source
or binary form) with the major components (compiler, kernel, and so on) of the operating system on which the executable runs, unless that component
itself accompanies the executable.

If distribution of executable or object code is made by offering access to copy from a designated place, then offering equivalent access to copy the
source code from the same place counts as distribution of the source code, even though third parties are not compelled to copy the source along with
the object code.

4. You may not copy, modify, sublicense, or distribute the Program except as expressly provided under this License. Any attempt otherwise to copy,
modify, sublicense or distribute the Program is void, and will automatically terminate your rights under this License. However, parties who have received
copies, or rights, from you under this License will not have their licenses terminated so long as such parties remain in full compliance.

5. You are not required to accept this License, since you have not signed it. However, nothing else grants you permission to modify or distribute the
Program or its derivative works. These actions are prohibited by law if you do not accept this License. Therefore, by modifying or distributing the
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Program (or any work based on the Program), you indicate your acceptance of this License to do so, and all its terms and conditions for copying, dis-
tributing or modifying the Program or works based on it.

6. Each time you redistribute the Program (or any work based on the Program), the recipient automatically receives a license from the original licensor
to copy, distribute or modify the Program subject to these terms and conditions. You may not impose any further restrictions on the recipients’ exercise
of the rights granted herein. You are not responsible for enforcing compliance by third parties to this License.

7. If, as a consequence of a court judgment or allegation of patent infringement or for any other reason (not limited to patent issues), conditions are
imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of this License, they do not excuse you from the conditions
of this License. If you cannot distribute so as to satisfy simultaneously your obligations under this License and any other pertinent obligations, then as
a consequence you may not distribute the Program at all. For example, if a patent license would not permit royalty-free redistribution of the Program
by all those who receive copies directly or indirectly through you, then the only way you could satisfy both it and this License would be to refrain en-
tirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under any particular circumstance, the balance of the section is intended to apply and the
section as a whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property right claims or to contest validity of any such claims; this
section has the sole purpose of protecting the integrity of the free software distribution system, which is implemented by public license practices. Many
people have made generous contributions to the wide range of software distributed through that system in reliance on consistent application of that
system; it is up to the author/donor to decide if he or she is willing to distribute software through any other system and a licensee cannot impose that
choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the rest of this License.

8. If the distribution and/or use of the Program is restricted in certain countries either by patents or by copyrighted interfaces, the original copyright
holder who places the Program under this License may add an explicit geographical distribution limitation excluding those countries, so that distribution
is permitted only in or among countries not thus excluded. In such case, this License incorporates the limitation as if written in the body of this License.

9. The Free Software Foundation may publish revised and/or new versions of the General Public License from time to time. Such new versions will
be similar in spirit to the present version, but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Program specifies a version number of this License which applies to it and “any later
version”, you have the option of following the terms and conditions either of that version or of any later version published by the Free Software Foun-
dation. If the Program does not specify a version number of this License, you may choose any version ever published by the Free Software Foundation.

10. If you wish to incorporate parts of the Program into other free programs whose distribution conditions are different, write to the author to ask for
permission. For software which is copyrighted by the Free Software Foundation, write to the Free Software Foundation; we sometimes make exceptions
for this. Our decision will be guided by the two goals of preserving the free status of all derivatives of our free software and of promoting the sharing
and reuse of software generally.

NO WARRANTY

11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT
PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER
PARTIES PROVIDE THE PROGRAM “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING,
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE
ENTIRERISKASTOTHEQUALITYANDPERFORMANCEOFTHEPROGRAMISWITHYOU.SHOULDTHEPROGRAMPROVEDEFECTIVE,
YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT HOLDER, OR
ANY OTHER PARTY WHOMAYMODIFY AND/OR REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR
DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR
INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE
ORLOSSES SUSTAINEDBYYOUORTHIRDPARTIESORAFAILUREOFTHEPROGRAMTOOPERATEWITHANYOTHERPROGRAMS),
EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS

How to Apply These Terms to Your New Programs
If you develop a new program, and you want it to be of the greatest possible use to the public, the best way to achieve this is to make it free software
which everyone can redistribute and change under these terms.

To do so, attach the following notices to the program. It is safest to attach them to the start of each source file to most effectively convey the exclusion
of warranty; and each file should have at least the “copyright” line and a pointer to where the full notice is found.

one line to give the program’s name and an idea of what it does.
Copyright (C) yyyy name of author
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This program is free software; you can redistribute it and/or
modify it under the terms of the GNU General Public License
as published by the Free Software Foundation; either version 2
of the License, or (at your option) any later version.

This program is distributed in the hope that it will be useful,
but WITHOUT ANY WARRANTY; without even the implied warranty of
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the
GNU General Public License for more details.

You should have received a copy of the GNU General Public License
along with this program; if not, write to the Free Software
Foundation, Inc., 59 Temple Place - Suite 330, Boston, MA 02111-1307, USA.

Also add information on how to contact you by electronic and paper mail.

If the program is interactive, make it output a short notice like this when it starts in an interactive mode:

Gnomovision version 69, Copyright (C) year name of author
Gnomovision comes with ABSOLUTELY NO WARRANTY; for details
type `show w’. This is free software, and you are welcome
to redistribute it under certain conditions; type `show c’
for details.

The hypothetical commands `show w’ and `show c’ should show the appropriate parts of the General Public License. Of course, the commands you use
may be called something other than `show w’ and `show c’; they could even be mouse-clicks or menu items--whatever suits your program.

You should also get your employer (if you work as a programmer) or your school, if any, to sign a “copyright disclaimer” for the program, if necessary.
Here is a sample; alter the names:

Yoyodyne, Inc., hereby disclaims all copyright
interest in the program `Gnomovision’
(which makes passes at compilers) written
by James Hacker.

signature of Ty Coon, 1 April 1989
Ty Coon, President of Vice

This General Public License does not permit incorporating your program into proprietary programs. If your program is a subroutine library, you may
consider it more useful to permit linking proprietary applications with the library. If this is what you want to do, use the GNU Lesser General Public
License [http://www.fsf.org/licenses/lgpl.html] instead of this License.

GNU Free Documentation License
Version 1.2, November 2002

Copyright (C) 2000,2001,2002 Free Software Foundation, Inc. 59 Temple Place, Suite 330, Boston, MA 02111-1307 USA

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

PREAMBLE
The purpose of this License is to make a manual, textbook, or other functional and useful document “free” in the sense of freedom: to assure everyone
the effective freedom to copy and redistribute it, with or without modifying it, either commercially or noncommercially. Secondarily, this License preserves
for the author and publisher a way to get credit for their work, while not being considered responsible for modifications made by others.

This License is a kind of “copyleft”, which means that derivative works of the document must themselves be free in the same sense. It complements
the GNU General Public License, which is a copyleft license designed for free software.

348 Deployment Guide

http://www.fsf.org/licenses/lgpl.html


We have designed this License in order to use it for manuals for free software, because free software needs free documentation: a free program should
come with manuals providing the same freedoms that the software does. But this License is not limited to software manuals; it can be used for any
textual work, regardless of subject matter or whether it is published as a printed book. We recommend this License principally for works whose purpose
is instruction or reference.

APPLICABILITY AND DEFINITIONS
This License applies to any manual or other work, in any medium, that contains a notice placed by the copyright holder saying it can be distributed under
the terms of this License. Such a notice grants a world-wide, royalty-free license, unlimited in duration, to use that work under the conditions stated
herein. The “Document”, below, refers to any such manual or work. Any member of the public is a licensee, and is addressed as “you”. You accept the
license if you copy, modify or distribute the work in a way requiring permission under copyright law.

A “Modified Version” of the Document means any work containing the Document or a portion of it, either copied verbatim, or with modifications
and/or translated into another language.

A “Secondary Section” is a named appendix or a front-matter section of the Document that deals exclusively with the relationship of the publishers or
authors of the Document to the Document’s overall subject (or to related matters) and contains nothing that could fall directly within that overall subject.
(Thus, if the Document is in part a textbook of mathematics, a Secondary Section may not explain any mathematics.) The relationship could be a matter
of historical connection with the subject or with related matters, or of legal, commercial, philosophical, ethical or political position regarding them.

The “Invariant Sections” are certain Secondary Sections whose titles are designated, as being those of Invariant Sections, in the notice that says that the
Document is released under this License. If a section does not fit the above definition of Secondary then it is not allowed to be designated as Invariant.
The Document may contain zero Invariant Sections. If the Document does not identify any Invariant Sections then there are none.

The “Cover Texts” are certain short passages of text that are listed, as Front-Cover Texts or Back-Cover Texts, in the notice that says that the Document
is released under this License. A Front-Cover Text may be at most 5 words, and a Back-Cover Text may be at most 25 words.

A “Transparent” copy of the Document means a machine-readable copy, represented in a format whose specification is available to the general public,
that is suitable for revising the document straightforwardly with generic text editors or (for images composed of pixels) generic paint programs or (for
drawings) some widely available drawing editor, and that is suitable for input to text formatters or for automatic translation to a variety of formats
suitable for input to text formatters. A copy made in an otherwise Transparent file format whose markup, or absence of markup, has been arranged to
thwart or discourage subsequent modification by readers is not Transparent. An image format is not Transparent if used for any substantial amount of
text. A copy that is not “Transparent” is called “Opaque”.

Examples of suitable formats for Transparent copies include plain ASCII without markup, Texinfo input format, LaTeX input format, SGML or XML
using a publicly available DTD, and standard-conforming simple HTML, PostScript or PDF designed for human modification. Examples of transparent
image formats include PNG, XCF and JPG. Opaque formats include proprietary formats that can be read and edited only by proprietary word processors,
SGML or XML for which the DTD and/or processing tools are not generally available, and the machine-generated HTML, PostScript or PDF produced
by some word processors for output purposes only.

The “Title Page” means, for a printed book, the title page itself, plus such following pages as are needed to hold, legibly, the material this License requires
to appear in the title page. For works in formats which do not have any title page as such, “Title Page” means the text near the most prominent appearance
of the work’s title, preceding the beginning of the body of the text.

A section “Entitled XYZ” means a named subunit of the Document whose title either is precisely XYZ or contains XYZ in parentheses following text
that translates XYZ in another language. (Here XYZ stands for a specific section name mentioned below, such as “Acknowledgements”, “Dedications”,
“Endorsements”, or “History”.) To “Preserve the Title” of such a section when you modify the Document means that it remains a section “Entitled
XYZ” according to this definition.

The Document may includeWarranty Disclaimers next to the notice which states that this License applies to the Document. TheseWarranty Disclaimers
are considered to be included by reference in this License, but only as regards disclaimingwarranties: any other implication that theseWarranty Disclaimers
may have is void and has no effect on the meaning of this License.

VERBATIM COPYING
You may copy and distribute the Document in any medium, either commercially or noncommercially, provided that this License, the copyright notices,
and the license notice saying this License applies to the Document are reproduced in all copies, and that you add no other conditions whatsoever to
those of this License. You may not use technical measures to obstruct or control the reading or further copying of the copies you make or distribute.
However, you may accept compensation in exchange for copies. If you distribute a large enough number of copies you must also follow the conditions
in section 3.

You may also lend copies, under the same conditions stated above, and you may publicly display copies.

COPYING IN QUANTITY
If you publish printed copies (or copies in media that commonly have printed covers) of the Document, numbering more than 100, and the Document’s
license notice requires Cover Texts, you must enclose the copies in covers that carry, clearly and legibly, all these Cover Texts: Front-Cover Texts on
the front cover, and Back-Cover Texts on the back cover. Both covers must also clearly and legibly identify you as the publisher of these copies. The
front cover must present the full title with all words of the title equally prominent and visible. You may add other material on the covers in addition.
Copying with changes limited to the covers, as long as they preserve the title of the Document and satisfy these conditions, can be treated as verbatim
copying in other respects.
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If the required texts for either cover are too voluminous to fit legibly, you should put the first ones listed (as many as fit reasonably) on the actual cover,
and continue the rest onto adjacent pages.

If you publish or distribute Opaque copies of the Document numbering more than 100, you must either include a machine-readable Transparent copy
along with each Opaque copy, or state in or with each Opaque copy a computer-network location fromwhich the general network-using public has access
to download using public-standard network protocols a complete Transparent copy of the Document, free of added material. If you use the latter option,
you must take reasonably prudent steps, when you begin distribution of Opaque copies in quantity, to ensure that this Transparent copy will remain thus
accessible at the stated location until at least one year after the last time you distribute an Opaque copy (directly or through your agents or retailers) of
that edition to the public.

It is requested, but not required, that you contact the authors of the Document well before redistributing any large number of copies, to give them a
chance to provide you with an updated version of the Document.

MODIFICATIONS
You may copy and distribute a Modified Version of the Document under the conditions of sections 2 and 3 above, provided that you release the Modified
Version under precisely this License, with the Modified Version filling the role of the Document, thus licensing distribution and modification of the
Modified Version to whoever possesses a copy of it. In addition, you must do these things in the Modified Version:

A. Use in the Title Page (and on the covers, if any) a title distinct from that of the Document, and from those of previous versions (which should, if
there were any, be listed in the History section of the Document). You may use the same title as a previous version if the original publisher of that version
gives permission.

B. List on the Title Page, as authors, one or more persons or entities responsible for authorship of the modifications in the Modified Version, together
with at least five of the principal authors of the Document (all of its principal authors, if it has fewer than five), unless they release you from this require-
ment.

C. State on the Title page the name of the publisher of the Modified Version, as the publisher.

D. Preserve all the copyright notices of the Document.

E. Add an appropriate copyright notice for your modifications adjacent to the other copyright notices.

F. Include, immediately after the copyright notices, a license notice giving the public permission to use the Modified Version under the terms of this
License, in the form shown in the Addendum below.

G. Preserve in that license notice the full lists of Invariant Sections and required Cover Texts given in the Document’s license notice.

H. Include an unaltered copy of this License.

I. Preserve the section Entitled “History”, Preserve its Title, and add to it an item stating at least the title, year, new authors, and publisher of the
Modified Version as given on the Title Page. If there is no section Entitled “History” in the Document, create one stating the title, year, authors, and
publisher of the Document as given on its Title Page, then add an item describing the Modified Version as stated in the previous sentence.

J. Preserve the network location, if any, given in the Document for public access to a Transparent copy of the Document, and likewise the network
locations given in the Document for previous versions it was based on. These may be placed in the “History” section. You may omit a network location
for a work that was published at least four years before the Document itself, or if the original publisher of the version it refers to gives permission.

K. For any section Entitled “Acknowledgements” or “Dedications”, Preserve the Title of the section, and preserve in the section all the substance and
tone of each of the contributor acknowledgements and/or dedications given therein.

L. Preserve all the Invariant Sections of the Document, unaltered in their text and in their titles. Section numbers or the equivalent are not considered
part of the section titles.

M. Delete any section Entitled “Endorsements”. Such a section may not be included in the Modified Version.

N. Do not retitle any existing section to be Entitled “Endorsements” or to conflict in title with any Invariant Section.

O. Preserve any Warranty Disclaimers.

If the Modified Version includes new front-matter sections or appendices that qualify as Secondary Sections and contain no material copied from the
Document, you may at your option designate some or all of these sections as invariant. To do this, add their titles to the list of Invariant Sections in the
Modified Version’s license notice. These titles must be distinct from any other section titles.

Youmay add a section Entitled “Endorsements”, provided it contains nothing but endorsements of yourModified Version by various parties--for example,
statements of peer review or that the text has been approved by an organization as the authoritative definition of a standard.

You may add a passage of up to five words as a Front-Cover Text, and a passage of up to 25 words as a Back-Cover Text, to the end of the list of
Cover Texts in the Modified Version. Only one passage of Front-Cover Text and one of Back-Cover Text may be added by (or through arrangements
made by) any one entity. If the Document already includes a cover text for the same cover, previously added by you or by arrangement made by the
same entity you are acting on behalf of, you may not add another; but you may replace the old one, on explicit permission from the previous publisher
that added the old one.
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The author(s) and publisher(s) of the Document do not by this License give permission to use their names for publicity for or to assert or imply endorsement
of any Modified Version.

COMBINING DOCUMENTS
You may combine the Document with other documents released under this License, under the terms defined in section 4 above for modified versions,
provided that you include in the combination all of the Invariant Sections of all of the original documents, unmodified, and list them all as Invariant
Sections of your combined work in its license notice, and that you preserve all their Warranty Disclaimers.

The combined work need only contain one copy of this License, and multiple identical Invariant Sections may be replaced with a single copy. If there
are multiple Invariant Sections with the same name but different contents, make the title of each such section unique by adding at the end of it, in
parentheses, the name of the original author or publisher of that section if known, or else a unique number. Make the same adjustment to the section titles
in the list of Invariant Sections in the license notice of the combined work.

In the combination, you must combine any sections Entitled “History” in the various original documents, forming one section Entitled “History”; likewise
combine any sections Entitled “Acknowledgements”, and any sections Entitled “Dedications”. You must delete all sections Entitled “Endorsements”.

COLLECTIONS OF DOCUMENTS
Youmaymake a collection consisting of the Document and other documents released under this License, and replace the individual copies of this License
in the various documents with a single copy that is included in the collection, provided that you follow the rules of this License for verbatim copying
of each of the documents in all other respects.

You may extract a single document from such a collection, and distribute it individually under this License, provided you insert a copy of this License
into the extracted document, and follow this License in all other respects regarding verbatim copying of that document.

AGGREGATION WITH INDEPENDENT WORKS
A compilation of the Document or its derivatives with other separate and independent documents or works, in or on a volume of a storage or distribution
medium, is called an “aggregate” if the copyright resulting from the compilation is not used to limit the legal rights of the compilation’s users beyond
what the individual works permit. When the Document is included in an aggregate, this License does not apply to the other works in the aggregate which
are not themselves derivative works of the Document.

If the Cover Text requirement of section 3 is applicable to these copies of the Document, then if the Document is less than one half of the entire aggregate,
the Document’s Cover Texts may be placed on covers that bracket the Document within the aggregate, or the electronic equivalent of covers if the
Document is in electronic form. Otherwise they must appear on printed covers that bracket the whole aggregate.

TRANSLATION
Translation is considered a kind of modification, so you may distribute translations of the Document under the terms of section 4. Replacing Invariant
Sections with translations requires special permission from their copyright holders, but you may include translations of some or all Invariant Sections
in addition to the original versions of these Invariant Sections. You may include a translation of this License, and all the license notices in the Document,
and any Warranty Disclaimers, provided that you also include the original English version of this License and the original versions of those notices and
disclaimers. In case of a disagreement between the translation and the original version of this License or a notice or disclaimer, the original version will
prevail.

If a section in the Document is Entitled “Acknowledgements”, “Dedications”, or “History”, the requirement (section 4) to Preserve its Title (section 1)
will typically require changing the actual title.

TERMINATION
You may not copy, modify, sublicense, or distribute the Document except as expressly provided for under this License. Any other attempt to copy,
modify, sublicense or distribute the Document is void, and will automatically terminate your rights under this License. However, parties who have received
copies, or rights, from you under this License will not have their licenses terminated so long as such parties remain in full compliance.

FUTURE REVISIONS OF THIS LICENSE
The Free Software Foundation may publish new, revised versions of the GNU Free Documentation License from time to time. Such new versions will
be similar in spirit to the present version, but may differ in detail to address new problems or concerns. See http://www.gnu.org/copyleft/.

Each version of the License is given a distinguishing version number. If the Document specifies that a particular numbered version of this License “or
any later version” applies to it, you have the option of following the terms and conditions either of that specified version or of any later version that has
been published (not as a draft) by the Free Software Foundation. If the Document does not specify a version number of this License, you may choose
any version ever published (not as a draft) by the Free Software Foundation.

ADDENDUM: How to use this License for your documents
To use this License in a document you have written, include a copy of the License in the document and put the following copyright and license notices
just after the title page:

Copyright (c) YEAR YOUR NAME.
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Permission is granted to copy, distribute and/or modify this document
under the terms of the GNU Free Documentation License, Version 1.2
or any later version published by the Free Software Foundation;
with no Invariant Sections, no Front-Cover Texts, and no Back-Cover Texts.
A copy of the license is included in the section entitled “GNU
Free Documentation License”.

If you have Invariant Sections, Front-Cover Texts and Back-Cover Texts, replace the “with...Texts.” line with this:

with the Invariant Sections being LIST THEIR TITLES, with the
Front-Cover Texts being LIST, and with the Back-Cover Texts being LIST.

If you have Invariant Sections without Cover Texts, or some other combination of the three, merge those two alternatives to suit the situation.

If your document contains nontrivial examples of program code, we recommend releasing these examples in parallel under your choice of free software
license, such as the GNU General Public License, to permit their use in free software.
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